EXTENDED BUFFER MANAGER and SNAPSHOT UPGRADE FEATURE User Guide

Supporting

Version 6.1.00 of EXTENDED BUFFER MANAGER for DB2
Version 6.1.00 of EXTENDED BUFFER MANAGER for IMS
Version 6.1.00 of SNAPSHOT UPGRADE FEATURE for DB2
Version 6.1.00 of SNAPSHOT UPGRADE FEATURE for IMS
Version 6.1.00 of SNAPSHOT UPGRADE FEATURE for VSAM

June 2013
Contacting BMC Software

Several methods are available for contacting BMC Software.

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada

<table>
<thead>
<tr>
<th>Address</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC SOFTWARE INC 2101 CITYWEST BLVD HOUSTON TX 77042-2827 USA</td>
<td>1 713 918 8800</td>
<td>1 713 918 8000 or 1 800 841 2031</td>
</tr>
</tbody>
</table>

Outside United States and Canada

<table>
<thead>
<tr>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>+01 713 918 8800</td>
<td>+01 713 918 8000</td>
</tr>
</tbody>
</table>

© Copyright 1998-2013 BMC Software, Inc.

BMC, BMC Software, and the BMC Software logo are the exclusive properties of BMC Software, Inc., are registered with the U.S. Patent and Trademark Office, and may be registered or pending registration in other countries. All other BMC trademarks, service marks, and logos may be registered or pending registration in the U.S. or in other countries. All other trademarks or registered trademarks are the property of their respective owners.

CICS, Current, DB2, FlashCopy, Hiperspace, IBM, IMS, MVS, OS/390, Parallel Sysplex, RACF, System z, VTAM, and z/OS are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

The information included in this documentation is the proprietary and confidential information of BMC Software, Inc., its affiliates, or licensors. Your use of this information is subject to the terms and conditions of the applicable End User License agreement for the product and to the proprietary and restricted rights notices included in the product documentation.

Restricted rights legend

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED—RIGHTS RESERVED UNDER THE COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer software by the U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14, DFARS 252.227-7013, DFARS 252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended from time to time. Contractor/Manufacturer is BMC SOFTWARE INC, 2101 CITYWEST BLVD, HOUSTON TX 77042-2827, USA. Any contract notices should be sent to this address.
Customer support

Support website
You can obtain technical support from BMC 24 hours a day, 7 days a week at http://www.bmc.com/support. From this website, you can:

- Read overviews about support services and programs that BMC offers
- Find the most current information about BMC products
- Search a database for problems similar to yours and possible solutions
- Order or download product documentation
- Download products and maintenance
- Report a problem or ask a question
- Subscribe to receive proactive e-mail alerts
- Find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and telephone numbers

Support by telephone or e-mail
In the United States and Canada, if you need technical support and do not have access to the web, call 1 800 537 1813 or send an e-mail message to customer_support@bmc.com. (In the subject line, enter SupID:yourSupportContractID, such as SupID:12345). Outside the United States and Canada, contact your local support center for assistance.

Before contacting BMC
Have the following information available so that Customer Support can begin working on your issue immediately:

- Product information
  - Product name
  - Product version (release number)
  - License number and password (trial or permanent)
- Operating system and environment information
  - Machine type
  - Operating system type, version, and service pack or other maintenance level such as PUT or PTF
  - System hardware configuration
  - Serial numbers
  - Related software (database, application, and communication) including type, version, and service pack or maintenance level
- Sequence of events leading to the problem
- Commands and options that you used
- Messages received (and the time and date that you received them)
  - Product error messages
  - Messages from the operating system, such as file system full
  - Messages from related software
License key and password information

If you have questions about your license key or password, contact Customer Support through one of the following methods:

- Send an e-mail message to customer_support@bmc.com. (In the Subject line, enter SupID:yourSupportContractID, such as SupID:12345.)
- In the United States and Canada, call 1 800 537 1813. Outside the United States and Canada, contact your local support center for assistance.
Contents

About this book ................................. 13
Related publications .............................. 13
Conventions ........................................ 14
Syntax statements ................................. 14
Summary of changes ............................. 15

Chapter 1 Overview of EXTENDED BUFFER MANAGER 19
How XBM and SUF promote data availability ........................................ 19
   Increased data availability by using snapshots ................................. 20
   XBM and zIIP processing ......................................................... 23
Features of XBM ...................................................................... 24
   XBM component architecture ................................................. 24
   XBM control structures ......................................................... 26
   XBM repository .................................................................... 28
   XBM ISPF interface ............................................................. 28
   XBM commands .................................................................. 28
   XBM monitor ...................................................................... 29
How XBM communicates in a data sharing environment ....................... 30
Task overview: Setting up XBM to perform snapshot processing ............ 31
Task overview: Setting up XBM for zIIP processing .............................. 34

Chapter 2 Configuring and managing the XBM subsystem 35
XBM prerequisites and installation ...................................................... 35
MVS security considerations for XBM .............................................. 35
Multiple XBM subsystems on an MVS system .................................... 36
Granting user authorizations for XBM .............................................. 36
   Configuring CA-ACF2 security ............................................. 37
   Configuring CA-Top Secret security ..................................... 38
   Configuring RACF security .................................................. 39
Using XBM user exits .................................................................. 42
Managing the XBM repository ....................................................... 44
   Allocating the XBM repository data sets ................................. 44
   Maintaining consistency of repository data sets ....................... 45
   Enforcing repository sharing ............................................... 45
Handling I/O errors while writing to the repository .......................... 47
   Adding repository data sets .................................................. 47
Chapter 5  Enabling software snapshots  109

Supported software .................................................................109
Overview of the extended buffer ........................................110
Structure of the extended buffer ........................................110
How XBM and snapshot utilities populate the extended buffer ...110
How XBM caches pages ...................................................111
Choosing cache types ..........................................................112
Cache size ........................................................................112
Cache types supported by XBM ........................................112
Cache type advantages and disadvantages .........................114
Simulate mode and snapshot processing ...............................116
Using compression ............................................................116
Determining candidates for compression .........................116
Enabling compression .....................................................117
Performing a software snapshot .........................................118
Defining an extended buffer in a configuration ....................118
Creating a snapshot template for software snapshots ..........122
Activating a configuration ................................................125
Activating a management set ..........................................127
Planning for a point of consistency ..................................128
Running the utility job ...................................................129
Reviewing the status of a software snapshot job ................131
Where to go from here ...................................................132
<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Enabling hardware snapshots</th>
<th>133</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding hardware snapshots</td>
<td>..........................................................</td>
<td>133</td>
</tr>
<tr>
<td>Supported software</td>
<td>..........................................................</td>
<td>133</td>
</tr>
<tr>
<td>Supported hardware</td>
<td>..........................................................</td>
<td>134</td>
</tr>
<tr>
<td>Suspending and resuming mirrors</td>
<td>..........................................................</td>
<td>134</td>
</tr>
<tr>
<td>Enabling SSI snapshots in SSI options and snapshot templates</td>
<td>..................................................</td>
<td>135</td>
</tr>
<tr>
<td>Performing hardware snapshots</td>
<td>..........................................................</td>
<td>136</td>
</tr>
<tr>
<td>Setting up the hardware environment</td>
<td>..........................................................</td>
<td>136</td>
</tr>
<tr>
<td>Setting SSI options for hardware snapshots</td>
<td>..................................................</td>
<td>142</td>
</tr>
<tr>
<td>Creating a snapshot template for a hardware snapshot</td>
<td>..................................................</td>
<td>145</td>
</tr>
<tr>
<td>Activating the management set</td>
<td>..........................................................</td>
<td>148</td>
</tr>
<tr>
<td>Running the utility job</td>
<td>..........................................................</td>
<td>148</td>
</tr>
<tr>
<td>Reviewing the status of a hardware snapshot job</td>
<td>..................................................</td>
<td>148</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Enabling Instant Snapshots</th>
<th>151</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported software</td>
<td>..........................................................</td>
<td>152</td>
</tr>
<tr>
<td>Supported hardware</td>
<td>..........................................................</td>
<td>152</td>
</tr>
<tr>
<td>How Instant Snapshots work</td>
<td>..........................................................</td>
<td>153</td>
</tr>
<tr>
<td>Performing Instant Snapshots</td>
<td>..........................................................</td>
<td>153</td>
</tr>
<tr>
<td>Setting up the hardware environment</td>
<td>..................................................</td>
<td>154</td>
</tr>
<tr>
<td>Setting SSI options for Instant Snapshots</td>
<td>..................................................</td>
<td>158</td>
</tr>
<tr>
<td>Running the utility job</td>
<td>..........................................................</td>
<td>160</td>
</tr>
<tr>
<td>Reviewing the status of an Instant Snapshot job</td>
<td>..................................................</td>
<td>160</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 8</th>
<th>Getting started with monitoring</th>
<th>163</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying information through the XBM consoles</td>
<td>..................................................</td>
<td>163</td>
</tr>
<tr>
<td>What type of performance and statistical information is available through the monitors</td>
<td>..................................................</td>
<td>165</td>
</tr>
<tr>
<td>XBM performance monitor</td>
<td>..........................................................</td>
<td>165</td>
</tr>
<tr>
<td>Managing information within the monitors</td>
<td>..................................................</td>
<td>165</td>
</tr>
<tr>
<td>What status information is available about the snapshot-enabled utilities</td>
<td>..................................................</td>
<td>166</td>
</tr>
<tr>
<td>Using the S/R monitor</td>
<td>..........................................................</td>
<td>166</td>
</tr>
<tr>
<td>Using the XBM Utility monitor</td>
<td>..................................................</td>
<td>167</td>
</tr>
<tr>
<td>How to display and manage storage devices within XBM</td>
<td>..................................................</td>
<td>167</td>
</tr>
<tr>
<td>Types of activities</td>
<td>..........................................................</td>
<td>168</td>
</tr>
<tr>
<td>Using the SSI monitor</td>
<td>..........................................................</td>
<td>168</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9</th>
<th>Monitoring BMC snapshot-enabled utilities</th>
<th>171</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying XBM status information</td>
<td>..........................................................</td>
<td>171</td>
</tr>
<tr>
<td>Displaying the status of a management set</td>
<td>..................................................</td>
<td>171</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Displaying performance statistics and status</td>
<td>173</td>
<td></td>
</tr>
<tr>
<td>Displaying suspend/resume group status</td>
<td>175</td>
<td></td>
</tr>
<tr>
<td>Displaying data set statistics for snapshot utilities</td>
<td>180</td>
<td></td>
</tr>
<tr>
<td>Statistics to check</td>
<td>192</td>
<td></td>
</tr>
<tr>
<td>Using the Utility monitor</td>
<td>192</td>
<td></td>
</tr>
<tr>
<td>Displaying utility job statistics with the Utility monitor</td>
<td>193</td>
<td></td>
</tr>
<tr>
<td>Displaying XBM utility program job statistics</td>
<td>196</td>
<td></td>
</tr>
<tr>
<td>Displaying COPY PLUS utility job statistics</td>
<td>199</td>
<td></td>
</tr>
<tr>
<td>Displaying REORG PLUS Online feature utility job statistics</td>
<td>202</td>
<td></td>
</tr>
<tr>
<td>Issuing commands from the XBM Utility monitor</td>
<td>207</td>
<td></td>
</tr>
<tr>
<td>Displaying the last command sent to a utility</td>
<td>207</td>
<td></td>
</tr>
</tbody>
</table>

Chapter 10        Monitoring and managing storage devices  209

- Using the SSI monitor                                             209
  - Understanding DASD volume status information                             209
  - Accessing the SSI monitor                                               210
- Displaying generic DASD volumes                                      212
  - Displaying summary information about the DASD volume status             213
  - Displaying general information for an individual DASD volume           214
  - Displaying detailed information about individual DASD volumes          215
- Managing PPRC objects                                               216
  - Displaying PPRC devices                                               217
  - Establishing a PPRC pair                                               221
  - Reestablishing a PPRC pair                                             223
  - Suspending PPRC operations for a pair                                  223
  - Removing a pair from PPRC operations                                   223
  - Recovering a secondary PPRC device                                     224
  - Displaying information about a mirrored PPRC device                    225
- Managing EMC TimeFinder objects                                      225
  - Displaying EMC TimeFinder devices                                      226
  - Establishing a standard device BCV pair                                 230
  - Reestablishing a standard device BCV pair                               231
  - Splitting a standard device BCV pair                                    232
  - Restoring data to a standard device from a BCV                         232
  - Holding and releasing a BCV                                            233
  - Displaying information about a BCV                                      233
  - Monitoring and managing virtual volumes                                234
  - Managing virtual devices                                               235
- Managing Hitachi ShadowImage and Remote Copy objects                  235
  - Displaying Hitachi ShadowImage and Remote Copy devices                  236
  - Establishing a PPRC pair with Hitachi devices                           240
Reestablishing a pair for a suspended Hitachi device .................................. 241
Suspending PPRC operations for Hitachi devices ........................................ 242
Removing the relationship between a pair of a Hitachi devices ............... 242
Recovering a secondary Hitachi device ..................................................... 243
Displaying information about a mirrored Hitachi device ........................... 244

Appendix A  Navigating the XBM ISPF interface  245
Introducing the File List panel ........................................................................ 245
Understanding panel elements ....................................................................... 247
Displaying files on the File List panel ............................................................ 250
Using the Locate command ........................................................................... 251
Sorting the files ............................................................................................. 251
Using selection criteria to view files ............................................................. 252
Printing file lists ............................................................................................ 253
Performing ISPF actions ................................................................................ 253
Using the action bar pull-down ...................................................................... 254
Using action codes ......................................................................................... 254
Using function keys ....................................................................................... 254
Using ISPF Fastpath commands ................................................................. 254
Understanding XBM pattern-matching ......................................................... 255
Using the pattern-matching characters ......................................................... 255
Finding XBM subsystems ............................................................................... 257
Using pattern-matching characters in the XBM$OPTS member ............... 258
Using Help for the ISPF interface ................................................................. 258

Appendix B  XBM commands  261
Commands for managing XBM objects and subsystems ............................. 261
ACTIVATE command ..................................................................................... 263
Comment command ....................................................................................... 264
DEACTIVATE command ............................................................................... 265
DISPLAY command ....................................................................................... 265
PING command ............................................................................................. 267
RESETSTA command .................................................................................. 267
ROUTE command ......................................................................................... 268
SEND command ........................................................................................... 269
SET SIMULATE command ........................................................................... 270
START command ........................................................................................ 270
STOP command ........................................................................................... 270
XCFCleanup command .................................................................................. 271
Commands for managing SSI options ......................................................... 272
Commands for generating tracing information ............................................. 276
XBM ISPF Fastpath commands .................................................................279

Appendix C  XBM options .................................................................283
VSAM options .........................................................................................283
Cache options for the extended buffer ..................................................284
Snapshot template options for software snapshots ................................286
SSI options for hardware snapshots .........................................................287
Snapshot template options for hardware snapshots ................................291
SSI options for Instant Snapshots ..........................................................293

Appendix D  SMF reporting .................................................................295
Cache statistics record layout .................................................................295
Data set statistics record layout ..............................................................298

Appendix E  Using the XBM utility program for a VSAM snapshot copy ..................................................311
Setting region size .................................................................................312
Preparing the CICS environment ..........................................................312
Creating JCL ............................................................................................313
  Supported IDCAMS keywords .................................................................316
  Valid XBM utility program keywords .......................................................316
Establishing a quiesce ...........................................................................321
Running the job ......................................................................................321
Running restartable jobs ......................................................................322
Reviewing output ...................................................................................322
About this book

This book contains detailed information about the EXTENDED BUFFER MANAGER (XBM) products from BMC Software and is intended for system administrators and database administrators.

To use this book, you should be familiar with the following items:

- your database management system (DBMS)
- IBM MVS systems, job control language (JCL), and the Interactive System Productivity Facility (ISPF)

For example, you should know how to respond to ISPF panels.

Like most BMC documentation, this book is available in printed and online formats. To request printed books or to view online books and notices (such as release notes and technical bulletins), see the support website at http://www.bmc.com/support.

Note

Online books are formatted as PDF or HTML files. To view, print, or copy PDF books, use the free Adobe Reader from Adobe Systems. If your product installation does not install the reader, you can obtain the reader at http://www.adobe.com.

The software also offers online Help. To access Help, press F1 within any product or click the Help button in graphical user interfaces (GUIs).

Related publications

From the BMC Support Central website, you can use the following methods to access related publications that support your product or solution:

- Link to the BMC Documentation Center (https://webapps.bmc.com/infocenter/index.jsp) to browse documentation sets.
- View BMC Quick Course Demos (short overviews of selected product concepts, tasks, or features), which are included in the BMC Documentation Center.
Read individual product documents (books and notices) within the “A – Z Supported Product List.”

You can order hardcopy documentation from your BMC sales representative or from the support site. You can also subscribe to proactive alerts to receive e-mail messages when notices are issued.

Tip
You can access the BMC Support Central site at http://www.bmc.com/support.

Conventions

This document uses the following special conventions:

- All syntax, operating system terms, and literal examples are presented in this typeface.

- Variable text in path names, system messages, or syntax is displayed in italic text:
  testsys/instance/fileName

- This document uses a symbol to show menu sequences. For example, Actions => Create Test instructs you to choose the Create Test command from the Actions menu.

Syntax statements

This topic explains conventions for showing syntax statements.

A sample statement follows:

```
COMMAND KEYWORD1 [KEYWORD2 | KEYWORD3] KEYWORD4={YES | NO} fileName...
```

<table>
<thead>
<tr>
<th>Convention</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items in italic type represent variables that you must replace with a name or value. If a variable is represented by two or more words, initial capitals distinguish the second and subsequent words.</td>
<td>alias</td>
</tr>
<tr>
<td></td>
<td>databaseDirectory</td>
</tr>
<tr>
<td></td>
<td>serverHostName</td>
</tr>
</tbody>
</table>
### Summary of changes

This topic summarizes product changes and enhancements by version number and release date.

#### Version 6.1.00—June 14, 2013

- XBM now includes the following changes in its support of EMC devices:

  — XBM now supports IBM FlashCopy for EMC devices, depending on the availability of the EMC SYMMETRIX CONTROL FACILITY (EMCSCF) and FlashCopy-enabled EMC devices in the environment.

  — If EMCSCF software is enabled, XBM uses the EMC TimeFinder functionality for snapshot processing.

  — If EMCSCF software is not enabled and the EMC devices support FlashCopy, XBM uses the FlashCopy functionality for snapshot processing.

  — If a snapshot initially fails on an EMC storage device in an environment where the EXTENTALLOCATION parameter is set to AUTO, XBM now automatically retries the snapshot with the EXTENTALLOCATION parameter set to Y (yes).

- XBM was enhanced to update the Coupling Facility (CF) statistics (including the HWM — High Water Mark for Storage and Directories value) whenever a...
snapshot fails due to the coupling facility being full. When a CF full error occurs, XBM now generates an error with reason code 2128. Message BMC73833I has been added to summarize usage information for the Coupling Facility (CF) cache. The message indicates the name of the structure, how much storage is currently being used, the highest historical usage, and the total space allocated for the cache. The message is included in output for the DISPLAY XBM command.

- When you issue the DISPLAY COMPONENT command, the output now displays a message if the component is not active. XBM also checks the status of component hooks and issues a message if any are disabled.

<table>
<thead>
<tr>
<th>Original SPE date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>April 2010</td>
<td>Provided a new XBM component that enables use of IBM System z Integrated Information Processors (zIIPs). The new component gives supported BMC products the option to use enclave service request blocks (SRBs) to enable zIIP processing while running jobs.</td>
</tr>
<tr>
<td>August 2009</td>
<td>Enabled support of EMC virtual devices. To use virtual volumes, you must configure XBM and set Storage Systems Integration (SSI) options to recognize these devices.</td>
</tr>
</tbody>
</table>

- This release incorporates changes that were introduced in the following small programming enhancements (SPEs):

- This release streamlines the XBM product and interface by removing obsolete functionality.

- The product code includes recent problem fixes.

**Version 5.6.00—February 23, 2009**

The following changes have been made to the product:

- XBM version 5.6.00 supports multiple versions of XBM in one coupling facility (CF) group in a parallel sysplex environment. Previously, all XBM subsystems in a CF group had to use the same product version. This change facilitates upgrading to new versions of XBM. You can phase in new versions of the XBM subsystem instead of converting all XBM subsystems at once. For more information, see “Working with different versions of XBM in a parallel sysplex environment” on page 76.
XBM was updated to support current IBM EAV (Extended Address Volumes), storage.

XBM now provides a way to determine which PTFs have been applied to the product. XBM issues message BMC73165I to the XBM SYSPRINT during startup. This message lists all of the PTFs that have been applied.

XBM version 5.6.00 incorporates a small programming enhancement (SPE) that was released for version 5.5.00. That SPE provided the following enhancements:

— XBM now provides Storage Systems Integration (SSI) options that you can specify at startup (xbmxinit), or through a console command, if you want to override particular hardware device settings. For more information, see “Commands for managing SSI options” on page 272.

— XBM sometimes generated potentially misleading messages when stopping or starting a component or displaying status. The messages made it difficult to determine whether an entire component or only particular features of that component were affected (for example, the I/O caching features versus the snapshot processing features).

This problem no longer occurs. XBM issues messages BMC73164I and BMC73055I only when they accurately describe the status of the component within the user environment.

— The SSI component of XBM provides an interface between the BMC snapshot-enabled utilities and hardware devices during Instant Snapshot processing. Hardware devices sometimes return vendor-specific messages about operations and errors to the SSI component. XBM can now pass these messages back to the BMC snapshot-enabled utility so that the utility can display them.

— To improve snapshot performance, XBM now uses READ TRACK DATA under the following conditions:

   — XBM is running under ESAME.

   — The hardware device supports using READ TRACK DATA.

   — The number of records to be read is at least one track’s worth.

— XBM now features improved processing for high-priority commands (such as DISPLAY or STOP) and requests from an ISPF XBM monitor session. This enhancement ensures that higher priority-requests are processed in a timely fashion.

— XBM includes new tracing features to facilitate problem diagnosis and resolution. BMC Customer Support might ask you to run these new traces if you encounter an issue and need assistance. For more information, see “Commands for generating tracing information” on page 276.
—XBM can now access data buffers for reads from DASD in memory that resides above the 32-bit boundary. Consequently, XBM and the BMC snapshot-enabled utilities are no longer bound by the 2-GB address limit for hardware snapshots. Also, the ability to retain larger amounts of data in memory accelerates processing time.

■ The product code includes recent problem fixes.

■ Additional performance improvements were made.

## Version 5.5.00—December 21, 2006

The following changes have been made to the product:

■ XBM can now perform actions upon remote XBM subsystems from the XBM ISPF interface. Previously, you could only view remote XBM subsystems from the XBM ISPF interface and could not perform actions.

■ Performance improvements have reduced the amount of time that discovery process requires when the Storage Systems Integration (SSI) component starts. This discovery process locates all of the supported storage devices in the environment.

■ XBM no longer uses Key 8 common storage area (CSA). As a result, XBM is now compatible with the new option in IBM z/OS version 1.8 that prevents the acquisition of user key CSA. Previous versions of XBM cannot be used on z/OS 1.8 systems if that option is enabled.

■ XBM now interacts with the ADRDSSU module more efficiently than in previous versions. This module is associated with hardware snapshot processing.

■ For product distribution by tape, the XBM files moved from the C-series tape set to the B-series tape set.

■ The product code includes recent problem fixes.

■ In addition, updates to the DB2 component of XBM prepare the product for anticipated changes that will occur in the next version of the IBM DB2® Universal Database product.
Overview of EXTENDED BUFFER MANAGER

This chapter introduces the EXTENDED BUFFER MANAGER (XBM) product and its associated SNAPSHOT UPGRADE FEATURE (SUF) technology.

This chapter includes the following topics:

- “How XBM and SUF promote data availability” on page 19
- “Features of XBM” on page 24
- “How XBM communicates in a data sharing environment” on page 30
- “Task overview: Setting up XBM to perform snapshot processing” on page 31
- “Task overview: Setting up XBM for zIIP processing” on page 34

How XBM and SUF promote data availability

In today’s business environment, data availability is crucial as information-processing capabilities evolve to better accommodate round-the-clock, global business operations.

Organizations relying on mainframe applications need the ability to create backup copies of databases with minimal interruption of business-critical application processing. Shrinking batch windows and growing batch workloads are becoming increasingly problematic for many users.

The XBM products work with selected BMC high-performance utilities to provide increased data availability. XBM also integrates with other BMC products to let you proactively manage system-wide performance and data availability.
The XBM user interface contains options that are not used with the snapshot, monitoring, or IBM System z Integrated Information Processor (zIIP) processing features of XBM. This manual does not discuss these options.

---

### Increased data availability by using snapshots

XBM increases data availability when used with supported BMC utilities to create snapshots. XBM increases data availability by using these methods:

- Software snapshots
- Hardware (SSI-assisted) snapshots
- Instant Snapshots

#### Traditional snapshots

Software and hardware snapshots are also called *traditional snapshots*.

A traditional snapshot allows the supported utility to process data while the database remains available for updates. When the snapshot process starts, the database takes a brief outage to establish a point of consistency. At this point, XBM starts to provide data to the supported utility:

- For software snapshots, XBM monitors write requests to the database for the data objects that are being processed. When a record changes, XBM stores a preimage of the record in its software cache.

- For hardware snapshots, XBM uses intelligent storage to provide preimage records from a *frozen* copy of the database to the utility.

As the utility reads database records during its job, XBM satisfies the read request of the utility with the preimage from either the hardware device or software cache. In this manner the data read by the utility for that database is as it existed when the point of consistency was established, while the source database continues to be updated.

#### Instant Snapshots

Instant Snapshots are significantly different from traditional snapshots.

When processing an Instant Snapshot, XBM uses the appropriate intelligent storage interface to create (or *snap*) a copy of physical data on a storage device to a different
location on the same device (or on another device within the same control unit or frame). A copy of the data remains on the storage device after the utility finishes processing the job. XBM can also snap, or reapply, this copied data back to the original location for recovery.

XBM works with supported BMC utilities to create this physical data copy and recover by using the copy. Instant Snapshots derive their name from the speed at which the copy and recovery occur: Instant Snapshots require no host I/O to copy the data set.

**BMC utilities that use snapshots**

Some BMC utilities can be used with XBM and SUF to provide snapshot functionality.

Table 1 on page 21 lists the BMC utilities that can perform snapshot processing. The types of snapshots and supported features vary by utility. For information about the features that are enabled for a particular utility, see the documentation for that utility.

**Table 1: Snapshot-enabled utilities**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Snapshot-enabled utilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM DB2</td>
<td>■ COPY PLUS for DB2</td>
</tr>
<tr>
<td></td>
<td>■ CHECK PLUS for DB2</td>
</tr>
<tr>
<td></td>
<td>■ LOADPLUS for DB2</td>
</tr>
<tr>
<td></td>
<td>■ RECOVER PLUS for DB2</td>
</tr>
<tr>
<td></td>
<td>■ REORG PLUS for DB2</td>
</tr>
<tr>
<td></td>
<td>■ UNLOAD PLUS for DB2</td>
</tr>
<tr>
<td>IBM IMS</td>
<td>■ IMAGE COPY PLUS</td>
</tr>
<tr>
<td></td>
<td>■ MAXM Reorg/EP</td>
</tr>
<tr>
<td></td>
<td>■ MAXM Reorg/Online</td>
</tr>
<tr>
<td></td>
<td>■ RECOVERY PLUS for IMS</td>
</tr>
</tbody>
</table>
Platform | Snapshot-enabled utilities
--- | ---
IBM VSAM | XBM utility program (a VSAM and sequential data set copy utility)
 | RECOVERY UTILITY for VSAM
mirror reporting only | MainView SRM Reporting

**Snapshot storage devices**

Different snapshot types support different hardware devices.

Table 2 on page 22 lists the supported storage devices.

**Table 2: Supported hardware devices**

<table>
<thead>
<tr>
<th>Snapshot type</th>
<th>Supported hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSI-assisted (hardware) snapshots</td>
<td>EMC Symmetrix</td>
</tr>
<tr>
<td></td>
<td>Hitachi 7700E/9900 devices capable of Peer-to-Peer Remote Copy (PPRC) or IBM FlashCopy Version 2 operations</td>
</tr>
<tr>
<td></td>
<td>IBM Enterprise Storage Subsystem (Shark) devices capable of PPRC or FlashCopy Version 2 operations (including Extended Address Volumes (EAV))</td>
</tr>
<tr>
<td></td>
<td>IBM RAMAC Virtual Array (RVA)</td>
</tr>
<tr>
<td></td>
<td>Oracle StorageTek Shared Virtual Array (SVA)</td>
</tr>
<tr>
<td></td>
<td>any other storage device capable of generic PPRC</td>
</tr>
</tbody>
</table>

| Instant Snapshots | EMC Symmetrix |
| Hitachi 7700E/9900 devices capable of FlashCopy version 2 operations |
| IBM Enterprise Storage Subsystem (Shark) devices capable of PPRC or FlashCopy 2 operations (including EAVs) |
| IBM RVA |
| Oracle StorageTek SVA |
Note
Support for IBM RAMAC Virtual Array (RVA) and Oracle StorageTek Shared Virtual (SVA) products will be phased out in a future release of XBM.

For more information about snapshot processing, see “Task overview: Setting up XBM to perform snapshot processing” on page 31.

SNAPSHOT UPGRADE FEATURE support for BMC utilities and solutions

The SNAPSHOT UPGRADE FEATURE (SUF) is a subset of XBM. This feature allows supported BMC utilities to use XBM snapshot technology when processing snapshots.

SUF is included as a component in multiple BMC solutions:

- Backup and Recovery Solution for IMS
- Database Administration for DB2
- Database Performance for DB2
- Recovery Management for DB2

You can also license SUF separately from the solutions and use it with the supported BMC utilities to perform snapshot processing. SUF as a stand-alone component is available for DB2, IMS, and VSAM.

XBM and zIIP processing

XBM provides the zIIP component for XBM that enables use of zIIPs.

The component provides supported BMC products the option to use enclave service request blocks (SRBs) to enable zIIP processing while running jobs. If a zIIP is available, XBM attempts to offload eligible processing to the zIIP. If the zIIP is busy or not available, normal processing continues on a general-purpose processor. The zIIP component for XBM does not require a separate license. You may use this feature as long as you have an installed authorized version of XBM or SUF and at least one supported BMC product.

Note
To enable zIIP processing, you must start and maintain an XBM subsystem in your environment.
Features of XBM

XBM provides several features to assist you with managing system performance and data availability.

This topic describes the following features and the XBM component architecture that enables them:

- XBM control structures
- XBM repository
- XBM ISPF interface
- XBM commands
- XBM monitors

XBM component architecture

XBM is designed to isolate functions for a specific product into a component structure.

Table 3 on page 24 shows the components that are available for XBM.

Table 3: Components of XBM

<table>
<thead>
<tr>
<th>Component</th>
<th>Major functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>VSAM</td>
<td>Supporting snapshot processing for VSAM data with supported BMC utilities and the XBM utility program</td>
</tr>
<tr>
<td>DB2</td>
<td>Supporting local and sysplex-wide snapshot utilities processing for DB2-managed objects</td>
</tr>
<tr>
<td>IMS</td>
<td>Supporting local and sysplex-wide snapshot utilities processing for IMS-managed objects</td>
</tr>
</tbody>
</table>
### Component Major functions

**Parallel Sysplex Support (PSS)**
- Supporting snapshot utilities processing for DB2 or IMS in a sysplex environment
- Maintaining PSS statistics of all XBM subsystems in a sysplex environment

**Storage Systems Integration (SSI)**
- Supporting snapshot processing by using intelligent storage DASD devices
- Providing an interface to allow active manipulation of storage devices
- Monitoring storage device status

**zIIP**
- Enabling zIIP processing in supported BMC utilities

**Note**
The SSI component is automatically authorized when you authorize the DB2, IMS, or VSAM component. The PSS component is automatically authorized when you authorize the DB2 or IMS component. The zIIP component does not require separate authorization.

The XBM components that you authorize and the passwords that you need depend on the features of XBM that you are implementing. Table 4 on page 25 describes how to authorize different features of XBM.

**Table 4: Authorizing XBM components**

<table>
<thead>
<tr>
<th>Features implemented</th>
<th>Type of password needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot features only</td>
<td>- If you received XBM or SUF as part of a solution, use the solution-level password to authorize the XBM components. For more information, see the installation guide for your solution.</td>
</tr>
<tr>
<td></td>
<td>- If you received XBM or SUF as a stand-alone product, use a SUF for DB2 (XBS), SUF for IMS (XBU), or SUF for VSAM (XBA) password.</td>
</tr>
<tr>
<td>Hardware monitoring features only</td>
<td>Use the solution-level password to authorize the SSI component of XBM.</td>
</tr>
<tr>
<td>zIIP processing</td>
<td>The zIIP component of XBM is authorized when you use any of the other XBM or SUF passwords. No separate authorization is required.</td>
</tr>
</tbody>
</table>

For information about BMC product authorization and how to obtain a password, see the *Installation System User Guide*. 
XBM control structures

The XBM control structures provide you with flexibility in configuring the extended buffer and in specifying the data that you want XBM to manage.

Table 5 on page 26 describes these structures.

Table 5: Types of control structures

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurations</td>
<td>Cache definitions for managing the extended buffer</td>
</tr>
<tr>
<td>Management sets</td>
<td>Object definitions for managing data that contain snapshot templates</td>
</tr>
<tr>
<td>Options</td>
<td>Processing options that control XBM in general and control how some XBM components interact in their particular environments</td>
</tr>
</tbody>
</table>

XBM stores management set and configuration definitions in the XBM repository, with the general options that you have specified. XBM uses information from these control structures to determine what data to process and how to manage it.

When you activate a configuration, XBM creates the cache for the extended buffer.

Configurations

*Configurations* are the XBM control structures that you define to specify the types and size of storage for the XBM extended buffer.

The following storage types are available for the extended buffer:

- Page-fixed virtual storage
- Pageable virtual storage
- Data space
- Expanded storage-only (ESO) hiperspace

Management sets

A *management set* defines the snapshot template for the snapshots that you want to process.

Software and hardware snapshots use snapshot templates to specify the format of the cache and other attributes. You specify and activate a single template that applies to all snapshot jobs that run while that template is activated. Instant Snapshots do not use snapshot templates.
The snapshot template, which is saved in a management set, is the XBM control structure that you use to specify attributes to be associated with each data set when performing a snapshot. A template consists of attributes that specify how to handle the data objects during snapshot processing. The template also controls whether to enable hardware snapshots. You create snapshot templates through the ISPF interface. The snapshot-enabled utility controls which data sets are processed.

You specify the characteristics described in Table 6 on page 27 in your snapshot template.

**Table 6: Attributes in the snapshot template**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache limits</td>
<td>The maximum amount of storage to provide for the managed object. If the object definition includes multiple data sets, the cache limit is a maximum per data set.</td>
</tr>
<tr>
<td>Cache type</td>
<td>The type of storage in which to cache managed objects</td>
</tr>
<tr>
<td>Priority</td>
<td>A number that determines the managed object’s precedence when there is contention for cache</td>
</tr>
<tr>
<td>Compress</td>
<td>Whether to enable compression for this object</td>
</tr>
<tr>
<td>SSI-assisted snapshot</td>
<td>Whether snapshot processing using intelligent storage DASD is enabled. (To enable hardware snapshots, you must also set SSI options. For more information, see “Performing hardware snapshots” on page 136.)</td>
</tr>
</tbody>
</table>

Attributes in the snapshot template, including cache type, cache limit, compression, and whether SSI-processing is enabled, affect how XBM operates during software and hardware snapshot processing.

**Options**

XBM provides options, some of which are component-specific, to allow you to control specific XBM processing functions.

Table 7 on page 27 describes the available types of options.

**Table 7: Options**

<table>
<thead>
<tr>
<th>Type of option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBM</td>
<td>Processing options that control XBM in general</td>
</tr>
<tr>
<td>VSAM</td>
<td>Processing options that control VSAM snapshots</td>
</tr>
<tr>
<td>IMS</td>
<td>Processing options that control IMS object tracking information</td>
</tr>
<tr>
<td>PSS</td>
<td>Processing options that control XBM in a sysplex environment</td>
</tr>
</tbody>
</table>
### XBM repository

The XBM repository stores all management sets, configurations, and option information. XBM writes changes to the repository when you perform one of the following actions:

- Create and save a new management set or configuration
- Save changes to an existing management set or configuration
- Save changes to options
- Start an XBM component

When you activate a management set or configuration, XBM copies the file into memory. If you make changes to the management set or configuration while it is active, XBM saves the changes to the XBM repository. However, the active copy of the file remains unchanged until you reactivate the file. XBM uses a single set of XBM options, which is copied into memory when you start XBM.

### XBM ISPF interface

XBM features a CUA-compliant ISPF interface. You use this menu-driven interface to customize XBM and set up data on your system for snapshot processing.

For more information about the XBM ISPF interface, see “Navigating the XBM ISPF interface” on page 245.

### XBM commands

XBM provides commands that you can use through the ISPF interface command line or the IBM MVS console.

Table 8 on page 29 describes the types of commands that are available.
Table 8: Types of commands

<table>
<thead>
<tr>
<th>Type of command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBM MVS system console commands</td>
<td>By issuing XBM commands from your MVS console, you can perform some of the actions that you perform from the XBM ISPF interface.</td>
</tr>
<tr>
<td>XBM Fastpath commands</td>
<td>From the XBM ISPF interface, you can issue Fastpath commands that circumvent the XBM menus and speed your navigation through the ISPF interface.</td>
</tr>
<tr>
<td>Monitor commands for snapshot utilities</td>
<td>The XBM Utility monitor is a tool that XBM provides to monitor the progress of snapshot jobs. The monitor provides a direct pathway for routing commands to some snapshot utilities. Using the monitor, you can issue basic commands to control the progress of your snapshot jobs.</td>
</tr>
</tbody>
</table>

For more information about commands, see “XBM commands” on page 261.

**XBM monitor**

The XBM monitor provides records of activity and statistical information from the XBM subsystem.

You can display XBM monitor output on the screen, or you can print the output to the ISPF print data set.

Table 9 describes the types of information that the XBM monitor can record.

Table 9: Types of monitoring information

<table>
<thead>
<tr>
<th>Type of information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status and progress</td>
<td>These monitors display the current status and progress of snapshot utilities and suspend/resume groups. They also display information about storage devices and enable manipulation of supported intelligent storage devices.</td>
</tr>
<tr>
<td>Diagnostic trace</td>
<td>BMC Customer Support uses the diagnostic trace to help diagnose problems in the product.</td>
</tr>
<tr>
<td>Exception trace</td>
<td>BMC Customer Support uses the exception trace.</td>
</tr>
</tbody>
</table>

You can reset these statistics without restarting XBM, enabling you to measure performance on demand without negatively affecting XBM operation.

You can optionally record historical information about the subsystem’s operation to System Management Facilities (SMF) records. You can analyze these records to detect trends and to determine the effectiveness of XBM over time. For more information about SMF reporting, see “SMF reporting” on page 295.
XBM performance statistics and status information

To assist you in monitoring and tuning XBM performance specifically for your system, XBM provides several types of statistical information.

Table 10 on page 30 describes these statistics.

Table 10: Types of performance statistics and status information

<table>
<thead>
<tr>
<th>Type of statistics</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended buffer</td>
<td>Performance statistics for the extended buffer and its caches</td>
</tr>
<tr>
<td>PSS</td>
<td>Storage space usage and read/write performance statistics for the XBM cache,</td>
</tr>
<tr>
<td></td>
<td>list, and lock structures</td>
</tr>
<tr>
<td>SSI DASD volume status</td>
<td>Number and status of DASD volumes and information about specific DASD</td>
</tr>
<tr>
<td></td>
<td>volumes</td>
</tr>
<tr>
<td>Snapshot utilities</td>
<td>Performance statistics for all snapshot utilities’ data sets on the MVS</td>
</tr>
<tr>
<td></td>
<td>system where XBM is running, and information about specific snapshot</td>
</tr>
<tr>
<td></td>
<td>utilities’ data sets</td>
</tr>
<tr>
<td>Suspend/resume group status</td>
<td>Information about the mirroring status of suspend/resume groups, including</td>
</tr>
<tr>
<td></td>
<td>the number of groups that are defined as suspend/resume and the number of</td>
</tr>
<tr>
<td></td>
<td>groups that are suspended or resumed</td>
</tr>
</tbody>
</table>

For more information about monitoring, see “Getting started with monitoring” on page 163.

XBM environment

XBM runs as a formal MVS subsystem.

XBM monitors registered utility I/O when using the snapshot component of XBM with supported BMC utilities. XBM for SSI monitors DASD device status.

For more information about setting up the XBM subsystem, see “Configuring and managing the XBM subsystem” on page 35.

How XBM communicates in a data sharing environment

XBM communicates with other facilities in your MVS data sharing environment.

Figure 1 on page 31 shows this interaction.
For more information about configuring XBM in a sysplex environment, see “Using XBM in a parallel sysplex environment” on page 65.

**Note**

- To run Snapshot Copy jobs for DB2 in a sysplex, XBM for DB2 and the PSS component must be installed on each MVS system in your DB2 data sharing group.

- To run Snapshot Copy jobs for IMS in a sysplex, XBM for IMS and the PSS component must be installed on each MVS system in your data sharing environment.

- The versions of all XBM subsystems in the data sharing group can be different (within one version of each other) to facilitate product upgrades.

**Figure 1: XBM in a data sharing environment**

**Task overview: Setting up XBM to perform snapshot processing**

The way that you set up XBM for processing differs according to the type of snapshot that you are processing (software snapshots, hardware snapshots, or Instant Snapshots).

**Table 11 on page 32** describes the tasks that you perform and where to find additional information.
Table 11: Setting up XBM for snapshot processing

<table>
<thead>
<tr>
<th>Step</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing to use XBM for snapshot processing</td>
<td>Note: Typically, these preparatory tasks are performed only once or sporadically.</td>
</tr>
<tr>
<td>Install XBM.</td>
<td><em>Installation System User Guide</em> and <em>BMC Products and Solutions for DB2 Configuration Guide</em></td>
</tr>
<tr>
<td>Configure security.</td>
<td>“Granting user authorizations for XBM” on page 36</td>
</tr>
<tr>
<td>Start the XBM subsystem and components.</td>
<td>■ “Starting the XBM subsystem” on page 47</td>
</tr>
<tr>
<td></td>
<td>■ “Working with XBM components” on page 58</td>
</tr>
<tr>
<td>Set XBM options.</td>
<td>“Setting XBM options” on page 62</td>
</tr>
<tr>
<td>Set up XBM and the PSS component for a data sharing environment (if applicable).</td>
<td>“Using XBM in a parallel sysplex environment” on page 65</td>
</tr>
<tr>
<td>Performing a software snapshot</td>
<td></td>
</tr>
<tr>
<td>Specify the characteristics of the extended buffer by defining a configuration.</td>
<td>“Defining an extended buffer in a configuration” on page 118</td>
</tr>
<tr>
<td>Create a snapshot template in a management set to define the cache and snapshot attributes.</td>
<td>“Creating a snapshot template for software snapshots” on page 122</td>
</tr>
<tr>
<td>Activate the configuration and management set to indicate that they are ready to participate in a snapshot.</td>
<td>■ “Activating a configuration” on page 125</td>
</tr>
<tr>
<td></td>
<td>■ “Activating a management set” on page 127</td>
</tr>
<tr>
<td>Plan for a point of consistency.</td>
<td>“Planning for a point of consistency” on page 128</td>
</tr>
<tr>
<td>Run the utility job. Specify the appropriate syntax in your utility’s job control card, and submit the job.</td>
<td>“Running the utility job” on page 129</td>
</tr>
<tr>
<td>Performing a hardware snapshot</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Reference</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
</tr>
<tr>
<td>Set up the hardware environment.</td>
<td>“Setting up the hardware environment” on page 136</td>
</tr>
<tr>
<td>Set SSI options to configure the SSI component.</td>
<td>“Enabling SSI snapshots in SSI options and snapshot templates” on page 135</td>
</tr>
<tr>
<td>Create a snapshot utilities’ template in a management set to define snapshot attributes.</td>
<td>“Creating a snapshot template for a hardware snapshot” on page 145</td>
</tr>
<tr>
<td>Activate the management set to indicate that the template is ready to participate in a snapshot.</td>
<td>“Activating a management set” on page 127</td>
</tr>
<tr>
<td>Run the utility job. Specify the appropriate syntax in your utility’s job control card and submit the job.</td>
<td>“Running the utility job” on page 148</td>
</tr>
<tr>
<td>Manage the hardware through XBM (if necessary).</td>
<td>“Monitoring and managing storage devices” on page 209</td>
</tr>
</tbody>
</table>

**Performing an Instant Snapshot**

<table>
<thead>
<tr>
<th>Step</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up the hardware environment.</td>
<td>“Setting up the hardware environment” on page 154</td>
</tr>
<tr>
<td>Set SSI options to configure the SSI component.</td>
<td>“Setting SSI options for Instant Snapshots” on page 158</td>
</tr>
<tr>
<td>Create and run a BMC utility job that requests the Instant Snapshot.</td>
<td>“Running the utility job” on page 160</td>
</tr>
<tr>
<td>Manage the hardware through XBM (if necessary).</td>
<td>“Monitoring and managing storage devices” on page 209</td>
</tr>
</tbody>
</table>

**Monitoring the snapshots**

<table>
<thead>
<tr>
<th>Step</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review the status of a snapshot job.</td>
<td>■ “Reviewing the status of a software snapshot job” on page 131</td>
</tr>
<tr>
<td></td>
<td>■ “Reviewing the status of a hardware snapshot job” on page 148</td>
</tr>
<tr>
<td></td>
<td>■ “Reviewing the status of an Instant Snapshot job” on page 160</td>
</tr>
<tr>
<td>Display the progress of snapshot jobs through the XBM monitors.</td>
<td>“Monitoring and managing storage devices” on page 209</td>
</tr>
</tbody>
</table>
Task overview: Setting up XBM for zIIP processing

XBM enables zIIP processing in enabled BMC products.

The only requirements to use zIIP processing are that you have an XBM subsystem configured and running. Table 12 on page 34 describes the tasks that you perform.

Table 12: Setting up XBM for zIIP processing

<table>
<thead>
<tr>
<th>Step</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install XBM.</td>
<td><em>Installation System User Guide</em> and <em>BMC Products and Solutions for DB2 Configuration Guide</em></td>
</tr>
<tr>
<td>Configure security.</td>
<td>“Granting user authorizations for XBM” on page 36</td>
</tr>
<tr>
<td>Start the XBM subsystem and components.</td>
<td>■ “Starting the XBM subsystem” on page 47</td>
</tr>
<tr>
<td></td>
<td>■ “Working with XBM components” on page 58</td>
</tr>
<tr>
<td>Set up XBM and the PSS component for a data sharing environment (if applicable).</td>
<td>“Using XBM in a parallel sysplex environment” on page 65</td>
</tr>
</tbody>
</table>

*Note*

Typically, these preparatory tasks are performed only once or sporadically.
Configuring and managing the XBM subsystem

This chapter explains how to configure and manage the EXTENDED BUFFER MANAGER (XBM) subsystem that controls snapshot processing for SUF when using the XBM products.

XBM prerequisites and installation

You install XBM by using the OS/390 and z/OS Installation System.

The Installation System User Guide and BMC Products and Solutions for DB2 Configuration Guide list installation prerequisites and explain installation options and instructions.

MVS security considerations for XBM

Your MVS security system assigns the XBM user ID based on entries in the equivalent of the IBM Resource Access Control Facility (RACF) ICHRIN03 table.

This table contains the name of the started task procedure and the user ID that should be assigned to it. XBM requires a valid RACF user ID.

The XBM user ID requires UPDATE authority to the XBM load library. This authority enables XBM to update the product authorization table if XBM must be temporarily executed on a backup processor. The XBM user ID also requires READ authority to the integrated catalog facility (ICF) catalog.

For snapshot processing, the XBM user ID needs READ access to the data sets upon being copied by the snapshot-enabled utilities. The user ID also needs UPDATE access to any data sets to which snapshot-enabled utilities are restoring data.
Multiple XBM subsystems on an MVS system

Although a single XBM subsystem can manage any combination of supported DBMS types, you can also define multiple XBM subsystems on the same MVS system.

For example, you could set up separate XBM subsystems to manage IMS data and DB2 data. To accommodate a large quantity of data, you could also set up one XBM subsystem to handle one DB2 instance, and another to handle another DB2 instance.

For snapshot processing, you might need additional XBM subsystems when the following conditions exist:

- You are processing more than 2 GB of preimages from a single DBMS instance by using data space (DSP) cache.
- Other DBMS instances need additional DSP cache.

A DSP cache is limited to 2 GB in size. If you operate in 64-bit mode and require more than a 2-GB cache, use private virtual storage (PVS). A PVS cache can be up to 511 GB.

For snapshot processing, only one XBM subsystem registers the data set and that XBM subsystem sends data sharing registrations to all member XBM subsystems. When you have defined multiple XBM subsystems and need to stop them, you can stop the XBM subsystems in any order.

Granting user authorizations for XBM

The XBM security interface allows maximum flexibility in controlling access to XBM functions.

Through the security interface, you can control ISPF access to XBM for a user or a group of users. For example, you can control the ability to change information in the XBM repository and the size of the XBM cache. However, the security interface does not prohibit users from using the ISPF interface to monitor XBM.

You can control access to XBM functions through IBM RACF (version 1.9 or later) or through other security packages that are compatible with the System Authorization Facility (SAF), such as the CA Technologies CA-ACF2 or CA-Top Secret products.

XBM security does not check commands from any MVS system console, including the IBM System Display and Search Facility (SDSF). XBM security checks only commands that are entered through the XBM ISPF interface.
In addition to RACF and other SAF-compatible security packages, the XBM security interface provides two exit points for user-written security routines. For more information, see “Using XBM user exits” on page 42.

The security interface is optional for RACF users and CA-Top Secret users. If you do not implement security access to XBM, its functions are unsecured and available to any user with access to the XBM ISPF interface.

**Note**

If you are using CA-ACF2, the security interface is not optional. By default, CA-ACF2 secures all functions. If you want an unsecured environment, you must implement XBM security and give access to all XBM users, or create an XBM user exit to bypass security checking.

---

**Configuring CA-ACF2 security**

You can use CA-ACF2 to secure XBM by defining resource rules for access to XBM functions.

This procedure explains how to use resource rules.

**To configure CA-ACF2 security**

1. Ensure that SAF is enabled on your MVS system.

   XBM issues a RACROUTE macro to SAF to determine whether a request can be approved.

2. Update the INFODIR record as follows:

   ```
   CHANGE INFODIR TYPES(R-RFAC)
   ```

3. Refresh the INFODIR record.

4. Define resource rules to provide access authority to users of specific XBM actions and resources, by using the following format:

   ```
   $KEY(BMCXB.MSSID.ACTION.OBJECT *********)TYPE(FAC)
   ```

   The variables represent the following values:

   - **ssid** represents the XBM subsystem ID.
   - **action** represents the XBM action.
   - **object** represents the XBM object or resource name.
For more information about defining a resource profile, see “RACF resource profiles” on page 39.

5 Rebuild the FAC resource rule by performing an initial program load (IPL) of MVS, or by issuing the following MVS MODIFY command:

```
F ACF2,REBUILD(FAC)
```

For more information about CA-ACF2, see the vendor-provided user documentation for that product.

## Configuring CA-Top Secret security

You can use CA-Top Secret to secure XBM by defining resource profiles for access to XBM functions.

### To configure CA-Top Secret security

1 Ensure that SAF is enabled on your MVS system.

XBM issues a RACROUTE macro to SAF to determine if a request can be approved.

2 Add the XBM resource profile BMCXBM and the XBM subsystem (indicated by the ssid):

```
TSS ADD(departmentACID) IBMFAC(BMCXBM)
TSS ADD(departmentACID) IBMFAC(ssid)
```

3 Permit access to the XBM resource profile BMCXBM and the XBM subsystem:

```
TSS PER(userId or profile) IBMFAC(BMCXBM.ssidx.action.object)
    ACCESS(Control or higher)
TSS PER(userId or profile) IBMFAC(ssid) ACCESS(UPDATE)
```

Resource profiles for XBM require the following form:

```
BMCXBM.ssidx.action.object
```

The variables represent the following values:

- **ssid** represents the XBM subsystem ID.
- **action** represents the XBM action.
- **object** represents the XBM object or resource name.

For more information about the XBM resource profile, including values for action and object, see “RACF resource profiles” on page 39. For more information
about CA-Top Secret, see the vendor-provided user documentation for that product.

Configuring RACF security

If you are using the RACF system security package in your system environment, you must have certain authorizations. For more information about RACF, see the IBM RACF documentation.

RACF user ID

Installations frequently allow the security system to assign a default user ID to the XBM started tasks.

Consequently, tasks can be added without requiring an update to the equivalent of the RACF ICHRIN03 table. This table contains the name of the started-task procedure and the user ID that should be assigned to it.

If you want to use this method to establish security for the XBM started tasks in your environment, grant started tasks the necessary user ID authorizations. If you do not want XBM to use this default user ID, you must modify ICHRIN03 to assign a different user ID to XBM.

Note
If RACF is configured on your MVS system to allow an unknown user, you do not need to supply a user ID for the XBM started task. The XBM started task can run as a RACF unknown user.

RACF resource profiles

To secure XBM functions by using RACF security, you should use one or more RACF resource profiles that are defined with a class of Facility.

A facility-class resource profile lets you protect your nonstandard resources, such as program actions. These resource profiles let you control access to one or more resources with similar names and identical security requirements and protect a group of related resources.

Note
Each user or group that is given access to an XBM RACF resource profile must have an access level of Control or higher.
Define a RACF resource profile as follows:

\texttt{BMCXBM.ssidd.action.object}

The variables represent the following values:

- \texttt{BMCXBM} specifies that the profile is for XBM.
- \texttt{ssid} represents the name of the XBM subsystem.
- \texttt{action} represents the XBM function to be secured.
- \texttt{object} represents the XBM object or resource name to be secured.

Wildcard patterns are supported for \texttt{ssid}, \texttt{action}, and \texttt{object}, according to RACF rules.

Table 13 on page 40 defines the values for \texttt{action} and \texttt{object}.

### Table 13: Security action and object values

<table>
<thead>
<tr>
<th>Action</th>
<th>Object</th>
<th>Action description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN</td>
<td>CONFIG</td>
<td>Activates a configuration</td>
</tr>
<tr>
<td></td>
<td>MS</td>
<td>Activates or deactivates a management set</td>
</tr>
<tr>
<td>COPY</td>
<td>EMCSYMM</td>
<td>Splits a Business Continuance Volume (BCV) device</td>
</tr>
<tr>
<td></td>
<td>PPRC</td>
<td>Splits a Peer-to-Peer Remote Copy (PPRC) device</td>
</tr>
<tr>
<td>MAINT</td>
<td>CONFIG</td>
<td>Adds, updates, deletes, or renames a configuration</td>
</tr>
<tr>
<td></td>
<td>MS</td>
<td>Adds, updates, deletes, or renames a management set</td>
</tr>
<tr>
<td></td>
<td>OPTION</td>
<td>Changes XBM, IMS, PSS, SSI, and VSAM options</td>
</tr>
<tr>
<td>PROTECT</td>
<td>EMCSYMM</td>
<td>Controls the hold or release of a BCV device</td>
</tr>
<tr>
<td>RESET</td>
<td>DATASET</td>
<td>Resets data set statistics</td>
</tr>
<tr>
<td>RESTORE</td>
<td>EMCSYMM</td>
<td>Restores or incrementally restores a standard volume from a BCV</td>
</tr>
<tr>
<td>SNAP</td>
<td>DATASET</td>
<td>Controls Instant Snapshot support for utility jobs</td>
</tr>
<tr>
<td></td>
<td>VVOLUME</td>
<td>Controls hardware snapshot support for virtual volumes</td>
</tr>
<tr>
<td>SSIALLOW</td>
<td>LMIRROR</td>
<td>Controls the SSI option to make local mirrors available for EMC Symmetrix Remote Data Facility (SRDF) snapshots</td>
</tr>
<tr>
<td></td>
<td>RMIRROR</td>
<td>Controls the SSI option to make remote mirrors available for EMC SRDF snapshots</td>
</tr>
<tr>
<td></td>
<td>SYNC@REG</td>
<td>Controls the SSI option to synchronize EMC BCVs at snapshot registration</td>
</tr>
<tr>
<td>Action</td>
<td>Object</td>
<td>Action description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>SYNC</td>
<td>EMCSYMM</td>
<td>Establishes or reestablishes a BCV from a standard volume</td>
</tr>
<tr>
<td>PPRC</td>
<td></td>
<td>Establishes or reestablishes a PPRC volume from a standard volume</td>
</tr>
<tr>
<td>SYSTEM</td>
<td>COMPONENT</td>
<td>Starts or stops the XBM, DB2, IMS, PSS, SSI, and VSAM components</td>
</tr>
<tr>
<td></td>
<td>SENDCMD</td>
<td>Explicitly or implicitly issues the XBM SEND command to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>communicate with a utility job that is connected to the utility</td>
</tr>
<tr>
<td></td>
<td>SIMULATE</td>
<td>Sets simulate mode</td>
</tr>
<tr>
<td></td>
<td>STOPXBM</td>
<td>Terminates XBM processing</td>
</tr>
<tr>
<td></td>
<td>SNAPSHOT</td>
<td>Runs jobs that use XBM snapshot utilities</td>
</tr>
<tr>
<td></td>
<td>UTILJOB</td>
<td>Connects to the utility monitor (for users of snapshot utilities)</td>
</tr>
<tr>
<td></td>
<td>ZIIP</td>
<td>Uses zIIP feature</td>
</tr>
</tbody>
</table>

### Examples of RACF resource profiles

This section provides examples of defining resource profiles with different access levels:

- **Controlling access to XBM maintenance actions**

  The following example shows how you can control access to all XBM maintenance actions for configurations (add, update, rename, and delete) on an XBM subsystem named XBMP:

  \[
  \text{BMCXBM.XBMP.MAINT.CONFIG}
  \]

  To control access to all XBM maintenance actions for configurations, management sets, and options, use the following profile:

  \[
  \text{BMCXBM.XBMP.MAINT.*}
  \]

- **Controlling access to all XBM subsystems and actions**

  To control access to all XBM subsystems and all XBM actions (ADMIN, MAINT, and SYSTEM) for all XBM resources, use the following profile:

  \[
  \text{BMCXBM.*.*.*}
  \]

  When XBM is started as a job or a started task, it activates a configuration. If you are using the security interface, XBM must be in the RACF started-task table and must have an associated RACF user ID.
Controlling access to intelligent storage manipulation

To control access to intelligent storage manipulation (split and establish storage device mirrors) on an XBM subsystem, use the following profiles:

- **BMCXBM.XBMP.COPY.*** (to control mirror split)
- **BMCXBM.XBMP.SYNC.*** (to control mirror establish)

**Note**

These actions must be available to the user ID of any snapshot jobs that are expected to use SSI-enabled hardware features, such as hardware snapshots or Instant Snapshots. Otherwise, limit access to users who are expected to manipulate intelligent storage features.

Controlling access to virtual volume snapshots

If you enable virtual volume snapshots, you should define a resource profile as follows:

- **BMCXBM.ssid.SNAP.VVOLUME**

In this profile, *ssid* indicates the XBM subsystem. SNAP and VVOLUME indicate the function and object to be secured.

No RACF authorization by default

If you are running MVS with no RACF authorization by default, you must authorize the following resource profiles to the XBM started task.

At a minimum, the XBM started task requires authorization to these resource profiles to successfully initialize:

- **BMCXBM.ssid.MAINT.CONFIG**
- **BMCXBM.ssid.ADMIN.CONFIG**

The variable *ssid* represents the name of the XBM subsystem.

**Note**

Any user or group that has access to the resource profile must have an access level of Control or higher, and these profiles must be defined with a class of Facility. This class of profile will enable you to protect your nonstandard resources, such as program actions.

Using XBM user exits

XBM provides the ability for your installation to write either or both of the following security exits: XBMXAEX1 and XBMXAEX2.
You can use these exits to provide security for installations without an SAF-compatible security package, or you can use them to supplement an SAF-compatible security package.

If the exit routines are in your XBM load library, XBM calls the routines. You can pass parameters to these exits by using the standard ALC conventions.

**XBMXAEX1 exit**

XBM calls the XBMXAEX1 exit after XBM gets the user ID.

The exit passes a pointer to a copy of the user ID. The copied user ID is eight characters long. If required, the user ID is padded with blanks.

You can use this exit to change the user ID in any way, because you are changing only what XBM sees as a user ID. XBM does not check any return codes.

**XBMXAEX2 exit**

XBM calls the XBMXAEX2 exit when a user attempts to perform any of the protected action and object pairs.

“RACF resource profiles” on page 39 describes the protected action and object pairs.

XBM passes the following parameters to this exit:

- A pointer to the user ID, which the XBMXAEX1 exit might have modified
  The user ID is eight characters. If required, the user ID is padded with blanks.

- A pointer to the fully qualified action.object
  This parameter is variable in length and is delimited by a null (X'00').

For example, if the user is trying to activate a configuration on XBMP, the second parameter points to the following string of characters:

| BMCXBMB.XBMP.ADMIN.CONFIG |

A null (X'00') immediately follows the character string.

The exit returns a return code. You can use this exit to pass a return code to XBM that can result in bypassing any further security checking.

Table 14 on page 44 describes the required return codes.
### Managing the XBM repository

The XBM repository stores all management sets and configurations that you define. The XBM repository also stores the XBM options that you have specified. When you save an XBM file or change the XBM options, XBM writes the changes to the repository. When you install XBM, you allocate the data sets for the XBM repository.

The repository consists of at least one internally managed VSAM keyed-sequenced data set (KSDS). You can allocate up to nine repository data sets per XBM subsystem, with the additional data sets serving only as backup copies. BMC recommends that you allocate at least two copies of the XBM repository and place them on different devices.

No matter how many data sets you allocate for the XBM repository, XBM keeps all data sets current. Maintaining multiple copies of the XBM repository on different devices helps ensure that you will not lose data that is stored in the XBM repository.

**Note**

Before upgrading to a new version or release of XBM, you should always make a backup copy of your existing repository. Repository formats are not backward compatible. If you do not back up your repository before you upgrade, you can revert to an earlier version, but you might have to re-create your repository (including management sets, configurations, and any XBM options that you specified).

### Allocating the XBM repository data sets

When you install XBM, you allocate the repository data sets.

By default, each repository data set is one cylinder. This size is normally sufficient to hold the XBM object definitions. XBM uses the following ddname in the XBM PROC for the repository data sets:

\[
\text{XBMREPnnn}
\]
This value represents the ddname of the data set or data sets that comprise the XBM repository. The variable \( nn \) represents a number from 01 through 09. That is, the ddnames can be XBMREP01 through XBMREP09.

**WARNING**

XBM repository data sets cannot be extended-format KSDS.

---

**Maintaining consistency of repository data sets**

During initialization, XBM checks the repository data sets for consistency.

The first record in a repository data set is a timestamp record. When the repository data sets are opened, the timestamps are compared to ensure that all data sets are current. If one or more of the data sets need to be rebuilt, the data set with the most recent timestamp is used to rebuild the remaining data sets and update the timestamp record for the remaining data sets, as illustrated in Figure 2 on page 45.

**Figure 2: XBM repository data sets**

---

**Enforcing repository sharing**

If you have the PSS component, XBM gives you the option of enforcing repository sharing.
Repository sharing ensures that each XBM subsystem in a data sharing group has access to the same common repository information. For stand-alone XBM subsystems, repository sharing is typically unnecessary.

**Note**
If one XBM subsystem in a data sharing group has repository sharing enforced, all XBM subsystems in the group must have repository sharing enforced. To control shared repository access, XBM uses SYSTEMS-wide enqueues. Although it is sometimes common practice to demote SYSTEMS-wide enqueues to SYSTEM-wide enqueues to enhance system performance, BMC recommends that you refrain from demoting XBM ENQs (major name BMCXBM).

XBM keeps all shared repository records current. XBM also ensures that only one user at a time can edit a repository record.

The records that are shared among repositories depend on the type of record. XBM converts records that you save into two types: *global* and *local*. XBM manages these record types as described in the following sections.

**Global records**

XBM configurations and management sets are classified as *global records*.

These records are shared among all XBM subsystems in the MVS complex. Consequently, any changes that you make to a global record (a management set, for example) on one XBM subsystem are seen by all other XBM subsystems.

Although global records themselves are shared among XBM subsystems, the implementation of global records is specific to each XBM subsystem. Therefore, activation or deactivation of a global record on one XBM subsystem will not cause that action to occur on any other XBM subsystem.

**Local records**

XBM options and components are classified as *local records*. Although local records are saved in a shared repository, they are specific only to a single XBM subsystem. Options or components that you save on one XBM subsystem have no effect on other XBM subsystems, and you can modify those options or components on the XBM subsystem where they were created.
Handling I/O errors while writing to the repository

If XBM detects an I/O error while writing to, or reading from, a repository data set, XBM de-allocates the data set that caused the error, issues an error message, and writes an exception trace record.

XBM continues processing with the remaining repository data sets. If no repository data sets are accessible, XBM continues to operate but no changes to configurations, management sets, or the XBM options can be made.

Adding repository data sets

You can add repository data sets anytime after installation by allocating a new KSDS VSAM data set as you did when you installed XBM.

Put the specification for the new data set in the XBM PROC. The next time you start XBM, XBM updates the new repository to make the data set current with the other repository data sets and maintains the new repository as an active repository.

Starting the XBM subsystem

This section describes how to define the XBM started task and start the ISPF interface.

**Note**

If you also need to restart your DB2 or IMS subsystem, ensure that the XBM subsystem has completely started before starting the DBMS. When XBM finishes initializing, it issues message BMC73150I. Do not start the DBMS until XBM issues this message. By waiting until XBM initializes, you ensure that XBM will communicate properly with the DBMS. If your DB2 or IMS subsystem is available before you start the XBM subsystem, you do not need to restart that subsystem. XBM will communicate with that DBMS normally.

Defining and starting the XBM started task

XBM started tasks are initialized by submitting the started-task procedure. More than one XBM subsystem can be started by using single or multiple procedure members.
To create an XBM procedure in your system library

1. Copy the XBM PROC from the install HLQ/JCL to your system PROCLIB (where HLQ is the high-level qualifier you specified during installation).

2. Edit the PROC parameters as desired. You do not need to change the parameters before you start XBM for the first time.

Figure 3 on page 48 shows an example of the JCL for the procedure.

Figure 3: Sample of JCL for XBM started task

```
//XBM         PROC CONFIG='*',MS=,XBMGRP=,SYS=,XSSI=
//*===================================================================
//*           (C)COPYRIGHT 1993 - 2013 BMC SOFTWARE
//*           AS AN UNPUBLISHED WORK.
//*===================================================================
//XBM         EXEC PGM=XBMXMAIN,REGION=0M,TIME=1440,
//            PARM=('CONFIG=&CONFIG MS=&MS ',
//            ' XBMGROUP=&XBMGRP SYS=&SYS SSI=&XSSI')
//********************************************************************
//STEPLIB     DD DISP=SHR,DSN=hlq.XBMLINK           (xbm/Solution loadlib)
//            DD DISP=SHR,DSN=hlq.BBLINK            (BMC Security modules)
//BMCPSWD     DD DISP=SHR,DSN=securityLibraryName  (if used for auth)
//SYSPRINT    DD SYSOUT=*,DCB=RECFM=VA
//XBMXINIT    DD DUMMY  *** XBM.INITIALIZATION.COMMAND.FILE  ***
//PROIGN      DD DUMMY
//X37IGN      DD DUMMY
//XBMXTASK    DD DISP=SHR,DSN=yourlib.SVAA(OR IXFP).SIBLINK
//            DD DISP=SHR,DSN=yourlib.SVAA(OR IXFP).SIBLOAD
//            DD DISP=SHR,DSN=yourlib.SVAA(OR IXFP).STKLOAD
//XBMREP01    DD DISP=SHR,DSN=hlq.VSAM.XBMREP01
//XBMREP02    DD DISP=SHR,DSN=hlq.VSAM.XBMREP02
```

**Note**
You must specify the location of the modules for security password checking and for authorization:

- You must include the location of the security modules in the XBM STEPLIB or the linklist. The security modules are typically located in the XBM.BBLINK library.

- You can specify the location of the authorization modules by either including them in an XBM STEPLIB library or in the LINKLIST, or by using the BMCPSWD DD statement and including them in the specified library.

3. Submit the JCL to start the XBM subsystem.

**Parameters**

This section describes the parameters that the XBM procedure accepts.
CONFIG

The first time that you start XBM, you do not have a configuration file to specify. Consequently, XBM activates the DEFAULT_CONFIG configuration. During subsequent restarts, if you do not specify a CONFIG parameter, XBM activates the last active configuration.

MS

The first time that you start XBM, you do not have a management set (MS) to specify. Because management sets do not have default values, a management set does not activate automatically. During subsequent restarts, XBM activates a management set only if you specify it or add the ACTIVATE commands to your XBMXINIT data set.

XBMGROUP

This parameter specifies the name of the cross-system coupling facility (XCF) group that you want this XBM subsystem to join when the PSS component is started, if applicable. This name must match the first level of the structure name for the XBM structures defined in your coupling facility resource manager (CFRM) policy. The first time that you start XBM, the default for this parameter is XBMGROUP.

If you specify an XCF group name by using this parameter, you must perform the following tasks before the XBM subsystem can join the group:

1. Set the Join sysplex group when PSS started option to Yes on the PSS Options subpanel.
2. Start the PSS component.

Note

The XBMGROUP parameter overrides any XCF group name that you enter in the Sysplex group name field on the PSS Options subpanel. If you enter an XCF group name on the MVS command to start the XBM started task, that group name overrides the XBMGROUP parameter and the group name on the PSS Options subpanel.

SYS

The XBM subsystem name (identified as XBMID by DB2 utilities, or XBMSSID by IMS utilities) is the first four characters of the started-task procedure, or it is the name specified with the SYS parameter (a maximum of four characters). The SYS parameter takes higher precedence.
This subsystem name must

■ Start with a letter
■ Be two to four characters in length
■ Contain only the letters A-Z, the numbers 0-9, $, or #

Note the following considerations when setting up your system name:

■ If you specify an invalid value in the SYS parameter, XBM starts the subsystem by using the first four characters of the name of the started task or job as the XBM subsystem name. For example, if your site has naming conventions that require you to name the started task DB2AXBM (where DB2A is a valid DB2 subsystem name), the SYS parameter lets you name your XBM subsystem so that it does not conflict with the DB2 subsystem name, another XBM subsystem name, or an MVS command.

■ You can use a single PROC for multiple subsystems if you want to use XBM in a data sharing environment and you use the &SYSCLONE symbolic from MVS system symbols. For more information, see “Defining PROCs for use with multiple XBM subsystems” on page 56.

■ You can use the same XBM SSID on multiple XBM subsystems in a non-datasharing environment.

XBM uses systems-wide enqueues in order to add an extra layer of protection for the XBM repository and to provide data sharing capability. If you do not intend to use XBM in a data sharing environment with shared repositories, you can use the same XBM ID on each LPAR/JES SSID. To do so, you must update the GRSRNLxx member in SYS1.PARMLIB and correctly modify the SYSTEMS EXCLUSION LIST.

Any resource named in this list is treated as a local resource when an ENQ, DEQ, or RESERVE macro is issued for the resource and is specified with a scope of SYSTEMS.

If you are not running with shared repositories, you must ensure that each repository has unique names to avoid ENQ conflicts.

You can use the &SYSNAME parameter (D SYMBOLS) to differentiate the repository from a single PROC. For example, after you use IDCAMS to define the data sets for your XBM started tasks, use the following example in the PROC to allocate the different repository on each LPAR.

```
//XBMREP01 DD DISP=SHR, DSN=HLQ.XBM.&SYSNAME..XBMREP01
```
Example

Assume that you have an XBM SSID of XBMP. You would update the SYSTEMS EXCLUSION LIST in SYS1.PARMLIB(GRSRNLxx) with the QNAME of BMCXB, the RNAME value of XBMP, and the TYPE value of SPECIFIC, as follows:

```
RNLDEF RNL(EXCL) TYPE(SPECIFIC)
    QNAME(BMCXB)
    RNAME(XBMP)
```

You can use TYPE(SPECIFIC) only for a 4-byte XBM SSID.

If you have a 3-byte SSID name (for example, XBM), use a generic resource name entry to match a portion of a resource name. A match occurs whenever the specified portion of the generic resource name entry matches the beginning of the same portion of an input search argument.

```
RNLDEF RNL(EXCL) TYPE(GENERIC)
    QNAME(BMCXB)
    RNAME(XBM)
```

You can dynamically activate the updated RNL by using the `SET GRSRNL=xx` IBM z/OS operator command. You must restart any active XBM subsystems to pick up the change.

To show all resources for the BMCXB major QNAME, issue the following DISPLAY command:

```
D GRS,RES=(BMCXB,*)
```

WARNING

The SYS parameter on the started task JCL (or on the XBM START command) names the XBM subsystem only. Do not use any MVS subsystem name, DB2 subsystem name, or MVS subsystem command for the SYS parameter.

XDB2, XIMS, XVSAM, XSSI, XPSS, XZIIP

These parameters specify whether the indicated component will start when the XBM subsystem starts.

By default, all components with a valid password start when you start the XBM subsystem the first time. Upon subsequent starts of the XBM subsystem, XBM components will try to resume the state that they were in when the XBM subsystem stopped. Authorized components that were running will restart, but components that were stopped or disabled will not start. If you do not want a component to start, specify N or NO for the corresponding parameter value.

For example, if you do not want the SSI component to start, enter `XSSI='NO'` as a parameter for the PROC. If you want to restart the component later, you can use the XBM ISPF interface or the START console command.
If you are using SUF and are not planning to use hardware snapshots or Instant Snapshots, BMC recommends that you specify not to start the SSI component. Doing so bypasses the device discovery phase and reduces startup times.

**DD statements**

The start procedure includes DD statements that you should define.

Table 15 on page 52 describes the DD statements.

### Table 15: DD statements for XBM started task

<table>
<thead>
<tr>
<th>DD statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBMREP&lt;nn&gt;</td>
<td>This statement is required. It references the XBM repository data sets. The suffix &lt;nn&gt; represents a number from 01 through 09. If you allocate multiple repository data sets, the number suffixes must be sequential and begin with 01. In the sample JCL for an XBM started task in “Defining and starting the XBM started task” on page 47, two repository data sets are allocated.</td>
</tr>
<tr>
<td>XBMXTASK</td>
<td>This statement is required when using IBM RVA or StorageTek SVA devices for Instant Snapshots or SSI-assisted (hardware) snapshots. This statement references the location of the library containing the SIBBATCH program. If you reference the SIBBATCH library location using the MVS linklist, delete or comment out this DD statement.</td>
</tr>
<tr>
<td>BMCPSWD</td>
<td>This optional statement specifies the location of the XBM authorization modules. At initialization, XBM attempts to find authorization modules in the BMCPSWD DD statement, or a if BMCPSWD library is not used, within the XBM STEPLIB or linklist. If XBM cannot find the authorization modules, XBM component activation fails. <strong>Note:</strong> If you specify both the BMCPSWD statement in the PROC and include authorization modules within your STEPLIB or linklist, XBM uses only the authorization modules specified in the BMCPSWD statement to authorize the product.</td>
</tr>
<tr>
<td>PROIGN</td>
<td>This statement is required when using XBM and FlashCopy version 2 to process snapshots in the same environment as the BMC MainView SRM product. This statement prevents MainView SRM from changing the snapshot allocations. If you use another product to manage volume allocation or volume pooling, see that product’s documentation for information about how to exclude XBM from that management.</td>
</tr>
<tr>
<td>X37IGN</td>
<td>This statement protects XBM from STOPX37 processing.</td>
</tr>
</tbody>
</table>
This optional statement points to an XBM initialization command file. This command file allows you to specify commands for XBM to perform automatically during initialization.

**Note**
BMC recommends that you specify REGION=0M, which allows XBM to dynamically obtain enough storage to allocate its internal structures. If XBM does not have the storage necessary to create internal structures, initialization fails. If you use IEFUSI exits to limit region size, specify a minimum REGION=65M to allow XBM enough storage to allocate its internal structures.

### Using the XBM initialization command file

The XBM initialization command file allows you to specify commands for XBM to perform automatically following initialization.

For example, you can instruct XBM to activate several management sets after initialization.

The XBMXINIT DD statement that is included in the XBM PROC points to the command file. The command file is a data set you create that lists the commands that you want to execute. Figure 4 on page 53 shows an example of an XBM initialization command file.

**Figure 4: XBM initialization command file**

```
* *****XBM INITIALIZATION COMMAND FILE*****
* COMMAND TO ACTIVATE MANAGEMENT SETS
ACT MS PRODUCTION_1
* *************************************************
```

The command file in Figure 4 on page 53 supports the comment operator command, "* " (asterisk followed by a space). You can include the comment command in the file to provide descriptive text. Comments are echoed to SYSPRINT and the MVS console.

**Note**
BMC does not recommend activating a configuration by using the initialization command file. If you do not specify a configuration in the PROC, XBM automatically activates the last configuration that was used before it starts to process the initialization command file. If you then activate a configuration in the command file, XBM must deactivate the configuration it started with the PROC before activating the new configuration.
Starting the ISPF interface

The XBM task must be fully initialized before it can communicate with the ISPF interface.

To invoke the ISPF interface, enter one of the following TSO commands.

- `%XBMISPF 'optionsMember'
- `EXEC 'libraryName(XBMISPF)' 'optionsMember'

**Note**
The second command invokes XBMISPF explicitly from a library. For either command, specifying the options member is optional.

Displaying the status of the XBM subsystem

The DISPLAY XBM command provides information about the XBM subsystem.

You can display this information by using the ISPF interface or by issuing an MVS system console command.

**To display XBM status by using the ISPF interface**

1. From the File List panel, choose **Console => XBM** and press **Enter** to display the Console - XBM subpanel (**Figure 5 on page 54**).

   **Figure 5: Console - XBM subpanel**

   ![Console - XBM subpanel](image)

2. In the **Command** field, type **1 (Display)** and press **Enter**.
3 If you are using the PSS component, respond to the Destination subsystem subpanel (Figure 6 on page 55) by specifying the XBM subsystem for which you want to display status and pressing Enter.

**Figure 6: Destination subsystem subpanel**

4 On the Console Output subpanel (Figure 7 on page 55), review the output of the DISPLAY XBM command.

**Figure 7: DISPLAY XBM command output**

---

**Note**

XBM also writes the output to the XBM subsystem SYSPRINT data set. XBM buffers the output before it is written to SYSPRINT. If you look immediately at the SYSPRINT data set after issuing the DISPLAY command, some lines of output might still be in the buffer.
To display XBM status by using the MVS system console

1. From the MVS system console, enter the following command:

   \texttt{ssid DISPLAY XBM}

   The variable \textit{ssid} represents the name of the XBM subsystem.

Output from the \texttt{DISPLAY XBM} command

Output from the \texttt{DISPLAY XBM} command indicates the following information:

- Version of XBM that you are running
- Status of the DB2, IMS, SSI, PSS, or VSAM components
- Name of the active configuration
- Names of all active management sets
- Whether XBM is running in simulate mode

Defining PROCs for use with multiple XBM subsystems

If you want to set up multiple XBM subsystems, perform the following steps:

1. Use the Installation System to unload the XBM libraries to a common XBM load library.

2. On each system where you want to run XBM, create an XBM PROC that points to the common XBM load library.

\textbf{Note}

XBM repositories can be shared among XBM subsystems. However, to create unique repositories for each XBM subsystem, run the $C10VSAM job and provide a different data set name for the repository on each XBM subsystem.

As an alternative to creating multiple PROCs, you can also use one of the following methods to enable the use of a single PROC to start multiple XBM subsystems:

- Override the SYS parameter to a unique XBM SSID when you issue the \texttt{START XBM} command. For example, issue

  $\texttt{START XBM,SYS=XBM1}$ to start the XBM subsystem on SYS1
—START XBM,SYS=XBM2 to start the XBM subsystem on SYS2 and so on.

Use the &SYSCLONE symbolic from the MVS system symbols as part of the SYS parameter.

Using &SYSCLONE allows you to create unique XBM SSIDs across the sysplex without having separate PROCs. You can create two-, three-, or four-character IDs by combining &SYSCLONE with other literal characters. Table 16 on page 57 provides examples of using &SYSCLONE with other characters to produce unique identifiers.

Table 16: Using &SYSCLONE in the SYS parameter

<table>
<thead>
<tr>
<th>Specification</th>
<th>Results</th>
<th>Examples</th>
</tr>
</thead>
</table>
| SYS=&SYSCLONE | two-character, unique subsystem identifier | — Subsystem SYSO: XBMSSID=SO
               |                     | — Subsystem SYSP: XBMSSID=SP |
| SYS= A &SYSCLONE | three-character, unique subsystem identifier | — Subsystem SYSO: XBMSSID=ASO
               |                     | — Subsystem SYSP: XBMSSID=ASP |
| SYS= XB &SYSCLONE | four-character, unique system identifier | — Subsystem SYSO: XBMSSID=XBSO
               |                     | — Subsystem SYSP: XBMSSID=XBSP |
| SYS= AH &SYSCLONE | four-character, unique system identifier | — Subsystem SYSO: XBMSSID=AHSO
               |                     | — Subsystem SYSP: XBMSSID=AHSP |

To determine the value of &SYSCLONE at your site, contact your system programmer.
Working with XBM components

Starting XBM automatically starts the XBM components.

When XBM is running, you can stop and start any component. If you stop components, the XBM subsystem remains active, but no objects are cached and no statistics are available. You can issue the STOP COMPONENT and START COMPONENT commands either through the XBM ISPF interface or the MVS system console.

When you first start XBM, it attempts to initialize each component, whether or not the component is licensed. An exception is the PSS component, which you must explicitly start the first time. XBM then records the license status of each component and issues message BMC73167E for unlicensed components. On subsequent startups, XBM attempts to initialize only licensed components. If you license a component at a later date, you must manually start the component by using the ISPF interface or the XBM START COMPONENT command to update the XBM license status for that component. The component then starts automatically on subsequent startups.

**Note**
If you do not want a particular component to start when XBM starts, you can override the default behavior by specifying parameters in the XBMPROC. For more information about the XBMPROC, see “Starting the ISPF interface” on page 54.

Starting and stopping components

This procedure explains how to start or stop an XBM component. You can use either the ISPF interface or the MVS system console.

**Note**
During the initial start of an XBM subsystem, all authorized components will be started. If that XBM subsystem is stopped, only those components that were active when the XBM subsystem was shut down will be active when the XBM subsystem is restarted. If a component was stopped or inactive when the XBM subsystem was stopped, that component will need to be manually restarted after XBM restarts. The only exception to this if the started task includes a XDB2, XIMS, XVSAM, XSSI, XPSS, or XZIIP keyword that specifies to start that component upon restart.
To start or stop components by using the ISPF interface

1. From the File List panel, choose Console => Components and press Enter to display the Console - Component subpanel (Figure 8 on page 59).

Figure 8: Console - Component subpanel (start / stop)

2. In the Name field, type the name of the component that you want to stop or start.

   Note

   You can use pattern-matching characters in this field. For example, type * in the Name field to stop or start all components. For more information, see “Understanding XBM pattern-matching” on page 255.

3. In the Command field, type 3 (Stop) or 2 (Start) and press Enter to stop or start the component.

   Note

   In a data sharing environment, you can start or stop a PSS component only by using the XBM ISPF interface on the same system as the XBM subsystem. To start or stop a PSS component on another system, you must use the MVS console.

To start or stop components by using the MVS system console

You can use the MVS system console to stop and start XBM components.

1. To stop the component from the MVS system console, use the following command:

   ```
   ssid STOP COMPONENT componentName
   ```

   The variable ssid represents the name of the XBM subsystem, and the variable componentName represents the XBM component (DB2, IMS, PSS, SSI, VSAM, ZIIP, or *) that you are stopping.

2. To start the component from the MVS system console, use the following command:

   ```
   ssid START COMPONENT componentName
   ```
The variable \textit{ssid} represents the name of the XBM subsystem, and the variable \textit{componentName} represents the XBM component (DB2, IMS, SSI, VSAM, ZIIP, or *) that you are starting.

\textbf{Tip}

In a data sharing environment, you can use the XBM ROUTE command to start or stop any XBM component (except the PSS component) in the data sharing group. Use the following command:

\begin{verbatim}
xbmgroup ROUTE ssid STOP COMPONENT componentName
\end{verbatim}

The variables represent the following values:

- \textit{xbmgroup} represents the name of the XCF group.
- \textit{ssid} represents the name of the XBM subsystem.
- \textit{componentName} represents the XBM component (DB2, IMS, SSI, VSAM, ZIIP, or *) that you are stopping or starting.

\textbf{Note}

Specifying an XCF group name on the XBM start command overrides both the XBMGROUP parameter on the XBM PROC and the group name on the PSS Options subpanel.

### Displaying the status of an XBM component

The DISPLAY COMPONENT displays the active status of an XBM component. You can display the status of a component by using either the ISPF interface or the MVS system console.

**To display component status by using the ISPF interface**

1. From the File List panel, choose \textbf{Console} \to \textbf{Components} and press \textbf{Enter} to display the Console - Component subpanel (Figure 9 on page 60).

\begin{figure}
\centering
\includegraphics[width=\textwidth]{Console_Component.png}
\caption{Console - Component subpanel (display)}
\end{figure}

- Enter component command information and press Enter.
- Name . . . *
- Command . . 1 1. Display
- 2. Start
- 3. Stop
2 In the **Name** field, type the name of the component for which you want to display status.

**Note**

Type * in the **Name** field to display all components. You can use XBM pattern-matching characters in this field. For more information, see “Understanding XBM pattern-matching” on page 255.

3 In the **Command** field, type 1 (Display) and press **Enter**.

4 If you are using the PSS component, respond to the Destination subsystem subpanel by specifying the XBM subsystem for which you want to display the status and pressing **Enter**.

5 On the Console Output subpanel (Figure 10 on page 61), review the output of the DISPLAY COMPONENT command.

Figure 10: DISPLAY COMPONENT command output

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Options</th>
<th>Console</th>
<th>Monitor</th>
<th>User</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Viewing XBM4(XBMQA) from XBM4</td>
<td>Row 1 to 13 of 108</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note

XBM also writes the output to the XBM subsystem SYSPRINT data set. XBM buffers the output before it is written to SYSPRINT. If you look immediately at the SYSPRINT data set after issuing the DISPLAY command, some lines of output might still be in the buffer.

To display component status by using the MVS system console

1 From the MVS system console, use the following command:

```plaintext
ssid DISPLAY COMPONENT componentName
```

The variable `ssid` represents the name of the XBM subsystem, and the variable `componentName` represents the name of the XBM component for which you want to display status (DB2, IMS, PSS, SSI, VSAM, ZIIP, or *).
Setting XBM options

XBM uses a set of global options to determine how to keep records and route codes in your environment. An option also controls whether to limit XBM cache allocations if a request exceeds available resources.

The XBM options control such activities as

- Enabling System Management Facilities (SMF) reporting
- Setting the SMF record number
- Setting the interval for SMF records
- Setting the interval for statistics
- Setting the MVS system console WTO route codes
- Limiting excessive cache

XBM saves option values in the XBM repository. When you install XBM, the default values are in effect. You can specify or modify XBM options at any time. Changes to the option values take effect immediately. New interval values for SMF records and statistics take effect when the current interval expires.

Understanding XBM options

Table 17 on page 62 describes the different XBM options that you can set.

Table 17: XBM options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Statistics interval period | The period of time (in seconds) over which statistical data is gathered for interval (short-term) statistics
The statistics reset at the beginning of each interval. While XBM is running, it gathers statistics constantly. The default value is 60 seconds. |
| SMF interval               | The interval between writing SMF records
SMF records include cache statistics and data set statistics. The default value is 3600 seconds.                                             |
| SMF record number          | The record type to use for writing XBM data to SMF
SMF reserves record types 200 through 255 for user-written records.
Choose a record type that is not in use, and have your system programmer activate the user type. The default value is type 245. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF recording active</td>
<td>Whether to enable or disable SMF recording. SMF recording provides historical statistics that you can use with the statistics provided by XBM online monitors. The default value is No (recording disabled).</td>
</tr>
<tr>
<td>WTO route codes</td>
<td>The MVS console route codes that XBM uses to send messages to the consoles for display. For more information, see the IBM MVS/ESA Routing and Descriptor Codes document. The default values are codes 02 and 11.</td>
</tr>
</tbody>
</table>
| Limit excessive cache | Whether to prevent storage allocations for the extended buffer that exceed the system’s available resources. The default value is Yes, which limits excessive cache. With this setting, XBM deactivates an active configuration that contains a cache specification exceeding available resources. XBM does not fall back to the previously active configuration. You must change the configuration or activate another configuration. The following rules apply to Limit excessive cache:  
  - XBM does not check ESO hiperspace caches.  
  - XBM checks fixed virtual storage caches against the available real storage frames. If the cache is larger than the available amount, XBM does not create the cache and deactivates the configuration.  
  - XBM checks pageable virtual storage and data space caches against the frames available in auxiliary storage. If the cache is larger than the available amount, XBM does not create the cache and deactivates the configuration. |
| Translate messages to upper case | Whether to enable XBM to convert messages that are issued in the XBM address space, such as SYSPRINT and trace messages to uppercase. The default value is No. |
1. From the File List panel, choose **Options => XBM options** and press **Enter** to display the XBM Options subpanel (Figure 11 on page 64).

**Figure 11: XBM Options subpanel**

```
<table>
<thead>
<tr>
<th>Select</th>
<th>XBM Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>1=Ope</td>
<td>Statistics interval period . . 60 Seconds</td>
</tr>
<tr>
<td>S</td>
<td>SMF interval . . . . . . . . . 60 Seconds</td>
</tr>
<tr>
<td>A</td>
<td>SMF record number . . . . . . 230 (200-255)</td>
</tr>
<tr>
<td>*</td>
<td>SMF recording active . . . . . . 2 1. Yes</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select from the following list of WTO route codes.</td>
</tr>
<tr>
<td></td>
<td>01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16</td>
</tr>
<tr>
<td></td>
<td>_ / _ _ _ _ _ _ _ _ / _ _ _ _ _ _ _ _</td>
</tr>
<tr>
<td></td>
<td>Limit excessive cache . . . . . . . 2 1. Yes</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Translate messages to upper case . . . . . . 2 1. Yes</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Comma</td>
<td></td>
</tr>
<tr>
<td>F1=H</td>
<td>F1=Help   F12=Cancel</td>
</tr>
<tr>
<td>F7=B</td>
<td></td>
</tr>
</tbody>
</table>
```

2. In the entry field of each option, type the desired values.

For an explanation of each field, see “Understanding XBM options” on page 62.

3. Press **Enter** to activate the new values and save them in the XBM repository.
Using XBM in a parallel sysplex environment

The Parallel Sysplex Support (PSS) component allows you to perform snapshot processing in a DB2 sysplex or IMS data sharing environment.

When the PSS component is active and running in a sysplex, EXTENDED BUFFER MANAGER (XBM) subsystems communicate within the sysplex group and monitor shared table spaces.

To use the PSS component, you must complete the following prerequisites:

1. Add the required XBM structures to your coupling facility resource manager (CFRM) policy.
2. Install and initialize an XBM for DB2 subsystem on each CPU that is running DB2 in the sysplex or an XBM for IMS subsystem on each CPU that is running IMS.
3. Specify appropriate values on the PSS Options subpanel through the XBM ISPF interface.
4. Stop and restart the PSS component on each XBM subsystem.

These steps are required only in a data sharing environment. The following sections explain each of these steps in greater detail.

This chapter also describes how to display PSS subsystem status and performance statistics.

Adding XBM structures to the CFRM policy

This section describes things to consider when adding the required XBM structures to the CFRM policy.
These considerations include the different types of structures that need to be added, XBM support of REBUILD for coupling facility structures, and how to add the XBM structures.

Understanding coupling facility structure types

You must add a single cache structure and a single list structure to your CFRM policy to use XBM for snapshot processing.

You need only one set of the required structures to use XBM for one or more DB2 or IMS data sharing groups. Subsequent sections describe these structures.

Cache structure

The cache structure stores updated data that belongs to a registered, shared table space for use by XBM snapshot processing anywhere in the sysplex group. The cache structure requires coupling facility storage space to accommodate caching requirements. The amount of space required depends on the number of data sets and the frequency of update activity of those data sets.

You must avoid a full cache structure. If the cache fills, snapshot jobs can fail.

List structure

The list structure stores control information about the registered, shared data sets controlled across the sysplex environment.

The list structure requires one 512-byte block entry per shared data set. Thus, the amount of space required depends on the number of data sets for which DB2 or IMS performs I/O. Start with an initial structure size of 5 MB and a maximum structure size of 17 MB. If necessary, XBM can dynamically increase the size of the structure to the maximum that you specify. (Approximately 2000 data sets per 1 MB.)

When a DB2 object is registered during a snapshot request, the DB2 object remains in the list structure and is reused as long as the structure remains in use. All entries remain in the LIST1 structure until one of the following situations occur:

- All XBM subsystems in the XBMGROUP are shut down.
- The PSS component is stopped on all XBM subsystems in the XBMGROUP.

As long as an XBM started task or the PSS component is initialized for any XBM subsystem in the XBMGROUP, the XBM coupling facility structures remain.
Rebuilding the coupling facility structure

XBM supports system-managed rebuild for coupling facility structures. System-managed rebuild provides for the planned reconfiguration of the coupling facilities that contain the XBM structures. You can use system-managed rebuild if your system meets the following minimum requirements:

- Coupling facility level 8
- The CFRM policy set to allow system-managed rebuild
- An IBM-supported version of IBM OS/390 or z/OS that is active on all systems in the sysplex

If your system does not meet these minimum requirements, ensure that you allocate adequate storage space for each structure for snapshot processing. A structure that is too small can quickly amass data until it fills. If structures fill, snapshot processing might be unsuccessful.

Using system-managed coupling facility duplexing

XBM supports IBM system-managed coupling facility (CF) duplexing, which creates a redundant CF structure to avoid service outages caused by a CF failure, and system-managed CF duplexing rebuild.

However, system-managed CF duplexing can impact performance because of the increased traffic involved with communication to two CF structures. Review the IBM documentation that discusses the performance impact of system-managed CF duplexing before adding it to your environment.

Adding required structures to the CFRM policy

To perform snapshot processing in a sysplex environment, XBM requires structure entries in the CFRM policy couple data set.

These entries define XBM structure information to the CF.

Note
This section explains the basic steps for configuring the PSS component. For detailed information about configuring a CF application, see the IBM MVS/ESA Setting Up a Sysplex document.
Adding XBM structures to the CFRM policy requires the following tasks. Each task is explained in detail in following sections.

1. Ensure that slots are available to add XBM structures to the policy.

2. Understand XBM’s use of CF storage space and verify available storage.

3. Update the policy data set to include the XBM structure entries.

### Ensuring policy slot availability for XBM structures

To add the three XBM structure entries, you must have three structure slots available in the CFRM policy couple data set.

To determine whether you have structure slots available, check the ITEM NAME(STR) NUMBER(xx) parameter that initializes the CFRM couple data set. This parameter defines the total number of structure slots that you can include in your CFRM policy.

To check this structure slot parameter, review the control cards you submitted when you ran the format utility for CFRM couple data sets. If those control cards are unavailable, run the report utility to display the contents of the CFRM couple data set. (For the names of these utilities, see the IBM MVS/ESA Setting Up a Sysplex document.) Compare the structure slot parameter number to the number of structures you included in the CFRM couple data set.

If you have three additional structure slots, you can continue with the next task (understanding CF space usage). If you have fewer than three structure slots, use one of the following methods to create additional slots in the policy for XBM structures:

- Delete the required number of unused, existing structure entries from the policy.

- Using the format utility for CFRM couple data sets, create a new couple data set with a larger structure slot parameter and activate that data set.

### Understanding CF space usage

In addition to the structure slots, you must have enough storage space in your CF to support the maximum size that you specify for the XBM structures.

Processing environments are unique and vary widely, and no formula exists to determine the CF size that fits your environment. BMC recommends that you use the CF sizes that are specified in the samples in “Updating the policy data set” on page 70 as a good, initial starting point. Over time, you should monitor the CF structures and tailor them to your specific processing load.
The amount that you define will be allocated, but MVS determines how much is actually acquired when the PSS component is initialized. When approximately 75 percent of the acquired CF resource has been used, XBM invokes MVS IXLALTER expansion services. At this point, the structure attempts to expand a set amount and processing continues until the 75 percent threshold is again reached. XBM repeats this process until the acquired resource can no longer expand due to the defined SIZE parameter. Because XBM does not acquire all of the defined CF cache until the cache is actually needed, defining a larger SIZE should not be a major concern. Coordinate with the person responsible for MVS/CF resource configuration at your site to determine a suitable starting SIZE for XBM in your environment.

Use the XBM CF monitor to verify actual resource usage, as described in “Displaying XBM subsystem information and PSS performance statistics” on page 80. Additionally, CF statistics are displayed in the XBM SYSPRINT when one of the following events occur:

- You issue the DISPLAY COMPONENT PSS or DISPLAY COMPONENT * command

  The following figure shows an example of the CF information contained in SYSPRINT when you issue one of these commands.

  ```
  BMC73055I  09.24.36 XOSM PSS component active for Snapshot
  BMC73059I  09.24.36 XOSM Snapshot support for component PSS enabled
  BMC73800I* 09.24.36 XOSM Joined XBM group XBMQA as member BMCXBM@XOSM on system SYSM at 09:23:53 on Jul 15, 2011
  BMC73833I* 09.24.36 XOSM CF Structure XBMQA_CACHE1
               storage: used = 2 K, HWM = 2 K, total allocation = 4932 K
  ```

- You issue the DISPLAY COMPONENT XBM command

  The following figure shows an example of the CF information contained in SYSPRINT when you issue the DISPLAY COMPONENT XBM command.

  ```
  BMC73150I* 09.24.49 XOSM XBM Version 6.1.00 initialization complete at 09:23:59
  BMC73059I  09.24.49 XOSM Snapshot support for component PSS enabled
  BMC73800I* 09.24.49 XOSM Joined XBM group XBMQA as member BMCXBM@XOSM on system SYSM at 09:23:59
  BMC73833I* 09.24.49 XOSM CF Structure XBMQA_CACHE1
               storage: used = 2 K, HWM = 2 K, total allocation = 4932 K
  ```

- You stop the PSS component

- XBM shuts down

If CF resources are exhausted, snapshot jobs can fail. Initial workload monitoring and tailoring can prevent an inadequate CF resource definition in your CFRM policy from causing snapshot failures.

To change CF size (if you allocated too much or too little initially), you must first stop the PSS component on all XBM subsystems in the data sharing group to deallocate the CF structures. Make the appropriate policy change and then restart the PSS component on each XBM subsystem.
**Note**

MVS uses an undetermined portion of the CF structure to maintain its own control blocks. Therefore, the XBM high-water mark (HWM) for CF usage will never reach the defined SIZE value, and CF write failures can occur when the HWM is seen to be less than the defined SIZE.

If your coupling facility does not have the storage space that the examples indicate, try specifying structures with a smaller maximum size. To check available coupling facility storage space from the MVS console, enter the following command:

```
DISPLAY CF
```

Figure 12 on page 70 shows an example of the display. The FREE SPACE statistic shows the current storage available in each partition of the coupling facility.

**Figure 12: Sample coupling facility display**

D CF
IXL150I 10.35.43 DISPLAY CF 906
COUPLING FACILITY 009674.IBM.02.0000000400087
PARTITION: 2 CPCID: 00
CONTROL UNIT ID: FFF9
NAMED CFPART02
COUPLING FACILITY SPACE UTILIZATION
ALLOCATED SPACE 602368 K  DUMP SPACE UTILIZATION 0 K
STRUCTURES: 2048 K
DUMP SPACE: 411648 K  TABLE COUNT: 0
FREE SPACE: 1016064 K  FREE DUMP SPACE: 2048 K
TOTAL SPACE: 2048 K
MAX REQUESTED DUMP SPACE: 0 K
VOLATILE: YES  STORAGE INCREMENT SIZE: 256 K
CFLEVEL: 3

COUPLING FACILITY SPACE CONFIGURATION
IN USE FREE TOTAL
CONTROL SPACE: 604416 K  411648 K  1016064 K
NON-CONTROL SPACE: 0 K  0 K  0 K

SENDER PATH PHYSICAL LOGICAL STATUS
68 ONLINE ONLINE VALID
69 OFFLINE ONLINE NOT OPERATIONAL

COUPLING FACILITY DEVICE SUBCHANNEL STATUS
FFF0 ODE0 OPERATIONAL/NOT IN USE
FFF1 ODE1 OPERATIONAL/NOT IN USE
FFF2 ODE2 OPERATIONAL/IN USE
FFF3 ODE3 OPERATIONAL/IN USE

COUPLING FACILITY 009674.IBM.02.0000000400087
PARTITION: 1 CPCID: 00
CONTROL UNIT ID: FFFE

**Updating the policy data set**

To add the XBM structure entries to your CFRM policy, you submit JCL that runs the administrative data utility that updates your policy data set.
You include the syntax for the XBM entries in this JCL. Figure 13 on page 71 and Figure 14 on page 71 show examples of these XBM entries. Ensure that your structure names match those shown in the examples.

**Note**

Specify the structure size in 1-KB blocks.

**Figure 13: Sample XBM structure entries for CFRM Policy (without INITSIZE parameter)**

```plaintext
STRUCTURE_NAME(XBMGROUP_CACHE1)
SIZE(204800)
PREFLIST(CFNAME1,CFNAME2)

STRUCTURE_NAME(XBMGROUP_LIST1)
SIZE(34816)
PREFLIST(CFNAME1,CFNAME2)
```

*XBMGROUP* is the name of the cross-system coupling facility (XCF) group that XBM joins upon initialization. You specify this name on the PSS Options subpanel.

**Figure 14 on page 71** shows an example of the XBM structure entries. The example uses the INITSIZE parameter. Using the INITSIZE parameter in your CFRM policy will cause dynamic expansion. Using XBM with dynamic expansion can cause a delay to the DB2 write, which in turn might cause the DB2 buffer pools to back up.

**Figure 14: Sample XBM structure entries for CFRM policy (with INITSIZE parameter)**

```plaintext
STRUCTURE_NAME(XBMGROUP_CACHE1)
INITSIZE(104448)
SIZE(204800)
PREFLIST(CFNAME1,CFNAME2)

STRUCTURE_NAME(XBMGROUP_LIST1)
INITSIZE(5120)
SIZE(34816)
PREFLIST(CFNAME1,CFNAME2)
```

**Note**

BMC recommends that you do not use the INITSIZE parameter.

For detailed information about the syntax of policy entries and the procedure to use when submitting JCL for policy updates, see the IBM MVS/ESA Setting Up a Sysplex document.

**XBMGROUP considerations**

The XBMGROUP parameter identifies the name of the XCF group that you want this XBM subsystem to join when the PSS component is started.

When you use the XBMGROUP parameter, consider the following guidelines:
The XBMGROUP name must match the first level of the structure name for the XBM structures that are defined in your CFRM policy. The first time you start XBM, the default for this parameter is **XBMGROUP**.

You must define one CFRM policy structure for each XBMGROUP that you use. You can use multiple XBMGROUPs.

You can use one started task PROC to start the XBM subsystem on any system with shared DASD. Each XBM subsystem in a sysplex environment must have a unique subsystem ID. For separate sysplex systems, copy the XBM load and DLIB libraries to the other system.

Each LPAR that has a data sharing DB2 instance must have its own XBM subsystem. The XBM subsystem associated with an LPAR allows XBM to monitor and keep track of sysplex-wide, DB2 data sharing activity for that LPAR. If any of the data sharing DB2 instances in your environment are not covered by an XBM subsystem, snapshot utility processing might fail. Although you can use a single data sharing XBMGROUP for multiple DB2 data sharing groups, BMC recommends having a separate XBMGROUP for each critical DB2 group. Doing so prevents performance or processing problems in one DB2 data sharing group from affecting the performance of another DB2 group.

Each LPAR requires one XBM started task.

Specify the XBMGROUP on the PSS Options subpanel in the XBM ISPF interface. For more information, see “Setting PSS options” on page 79. You can also specify the XBMGROUP in the XBM started task. See “Starting the ISPF interface” on page 54.

BMC recommends using a shared XBM repository for different XBM subsystems in the same XBMGROUP. Doing so allows you to make changes to all XBM subsystems at once. To use a shared repository, set the **Enforce shared repository** option to Yes when setting PSS options. However, if you want to define a separate snapshot template for different XBM subsystems, you might want to keep separate XBM repositories.

If you want to separate XBM data sharing workloads, two or more XBM CF GROUP structures should have separate XBMGROUPs.

Although DB2 data sharing groups are independent and do not affect each other, using one XBMGROUP for all of the DB2 groups allows one LPAR to affect processing on another LPAR. For example, an emergency initial program load (IPL) of a system could cause a utility to fail on another system because the IPL caused an XBM subsystem to fail. This interdependency occurs because all XBM members in an XBM data sharing group must track each other’s activity.

To avoid this problem, BMC recommends separating the coupling facility GROUP structures on different LPARs. If you do so, the separate XBM XCF groups will not impact another XCF group’s DB2 environment. Separate XCF groups on different LPARs will not allow an IPL to affect other XCF utilities. Separate
XBMGROUPs require defining separate CFRM policy definitions for each XBMGROUP.

**Working with XBM subsystems in sysplex environments**

This section describes different aspects for working with XBM subsystems in a sysplex environment:

- Initializing XBM subsystems in a data sharing environment
- Adding a DBMS member to a data sharing group during snapshot processing
- Working with different versions of XBM in a parallel sysplex environment
- Stopping remote XBM subsystems in a parallel sysplex environment

**Initializing XBM subsystems in a data sharing environment**

An XBM subsystem must be active on each LPAR that is running DB2 or IMS in the data sharing group before you start the PSS component.

The PSS component requires active XBM subsystems on each LPAR for successful registration of all shared table spaces in the data sharing group.

*Note*

XBM repositories can be shared among XBM subsystems. However, to create unique repositories for each XBM subsystem, run the $C10VSAM job and provide a different data set name for the repository on each XBM subsystem.

If you want to set up multiple XBM subsystems, you must first use the installation system to unload the XBM libraries to a common XBM load library. Next, on each system where you want to run XBM, create an XBM PROC that points to the common XBM load library.

As an alternative to creating multiple PROCs, you can also use one of the following methods to enable the use of a single PROC to start multiple XBM subsystems:

- Override the SYS parameter to a unique XBM SSID when you issue the START XBM command, as in the following examples:

  —START XBM,SYS=XBM1 to start the XBM subsystem on SYS1
—START XBM, SYS=XBM2 to start the XBM subsystem on SYS2

- Use the &SYSCLONE symbolic from the MVS system symbols as part of the SYS parameter.

Doing so allows you to create unique XBM SSIDs across the sysplex without having separate PROCs. You can create two-, three-, or four-character IDs by combining &SYSCLONE with other literal characters. Table 18 on page 74 provides examples of using &SYSCLONE with other characters to produce unique identifiers.

**Table 18: Using &SYSCLONE in the SYS parameter**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Results</th>
<th>Examples</th>
</tr>
</thead>
</table>
| SYS=&SYSCLONE | two-character, unique subsystem identifier | - Subsystem SYSO: XBMSSID=SO  
- Subsystem SYSP: XBMSSID=SP |
| SYS= A &SYSCLONE | three-character, unique subsystem identifier | - Subsystem SYSO: XBMSSID=ASO  
- Subsystem SYSP: XBMSSID=ASP |
| SYS= XB &SYSCLONE | four-character, unique system identifier | - Subsystem SYSO: XBMSSID=XBSO  
- Subsystem SYSP: XBMSSID=XBSP |
| SYS= AH &SYSCLONE | four-character, unique system identifier | - Subsystem SYSO: XBMSSID=AHSO  
- Subsystem SYSP: XBMSSID=AHSP |

To determine the value of &SYSCLONE at your site, contact your system administrator.
Adding a DBMS member to a data sharing group during snapshot processing

In a data sharing environment, you might need to add a new DBMS member on a different MVS system to a sysplex DBMS group.

XBM can support the newly arriving DBMS member if you start an XBM subsystem on the remote MVS system and allow it to fully initialize before starting the DBMS.

When an XBM subsystem becomes active as a member of an existing XBM sysplex group, the XBM subsystem attempts to synchronize with snapshots that are active on other XBM subsystems in the sysplex. This process is called remote arrival snapshot synchronization. XBM performs this process so that data sharing DB2 subsystems or IMS regions and jobs can be started on members of the sysplex, and snapshots that were initiated on other systems will not fail because XBM detects a lack of XBM coverage.

XBM starts this process near the end of the XBM initialization phase when the XBM subsystem first starts up. It occurs immediately before XBM issues the following message:

```
BMC73150I XBM Version <versionNumber> Initialization Complete at <time> on <date>.
```

This process also occurs if components are individually activated, and XBM determines that it now has an active PSS component and either an active IMS or DB2 component.

The newly arriving XBM subsystem, which is remote to the originator of the in-progress snapshots, requests that existing XBM subsystems send information about any active snapshots that they are processing. The originator (the local subsystem) responds with the requested information. Upon completion of this process, the remote and local XBM subsystems are synchronized, thus enabling the joining DBMS member to be fully supported for all snapshot processing that is in progress in the sysplex.

**WARNING**

Ensure that the XBM subsystem is fully initialized and has completed synchronization on the remote MVS system before you attempt to start the DBMS. Otherwise, any in-progress snapshots might fail in the sysplex group. When the XBM subsystem completes synchronization, it issues the following message:

```
BMC73566I <ssid> Snapshot synchronization completed; <remoteSssid> on <systemName>. Snapshots sent = <n>.
```

Do not start your DBMS until XBM issues this message.
Working with different versions of XBM in a parallel sysplex environment

You can configure XBM to enable different versions of XBM to operate together in a single CF group in a parallel sysplex environment.

Previous versions of XBM required that all XBM subsystems in a CF group be the same version of XBM.

To enable XBM 5.5.00 to work with XBM 5.6.00, you must apply maintenance to XBM 5.5.00 that enables this functionality.

This feature facilitates rolling newer versions of XBM into a sysplex without having to upgrade all XBM subsystems in the sysplex at one time. Versions can span multiple releases so it is not necessary to always stay within one release of your current version. Although BMC does not recommend that you run indefinitely in a mixed multiple version XBM environment, all XBM snapshot features work as if the XBM subsystems were of the same version.

Note

XBM allows ISPF interface and actions to the local member as well as to remote XBM members in the PSS group. With shared XBM repositories, some ISPF actions, such as defining or activating structures, can be routed to all group members or to a single specified member. For more information about accessing remote XBM subsystems, see “Displaying XBM subsystem information and PSS performance statistics” on page 80.

If you use nonshared repositories in a multi-version XBMGROUP, some ISPF functions interact only with the XBM subsystem being displayed. For example, activating or deactivating a management set or configuration affects only the selected XBM subsystem and does not impact all members. This behavior occurs because the repositories are not shared, so the action being taken cannot be recorded across repositories.

Stopping remote XBM subsystems in a parallel sysplex environment

If you stop a remote XBM subsystem while snapshot processing is active, unpredictable results might occur.

You should always stop the remote DB2 subsystem before you stop the XBM subsystem.
To stop the remote XBM subsystem

1. Stop the remote data-sharing DB2 subsystem before attempting to stop the remote XBM subsystem.

2. Ensure that XBM issued message BMC73504I. This message indicates that the cleanup process for stopping the DB2 subsystem has completed.

3. After the message is displayed, issue the STOP,FORCE command for the appropriate XBM subsystem.

You might need to perform these steps when a sysplex member LPAR has to undergo an IPL or if an LPAR processing load needs to be reduced or eliminated (including the XBM subsystem running on that LPAR).

---

**WARNING**

Stopping an XBM subsystem that is needed to support an active member data-sharing DB2 member could produce unpredictable results in active snapshot processing. Review your environment before stopping a remote XBM subsystem.

---

Setting PSS options

You specify option values through the ISPF interface to control how the PSS component functions in a data sharing environment.

XBM stores the option values in the XBM repository. XBM uses default values for the PSS options when you start the XBM subsystem for the first time. After you start XBM, you can specify or change PSS options at any time.

---

**Note**

To use the ISPF interface to access multiple XBM subsystems in a data sharing environment, BMC recommends modifying the XBM$OPTS member to include pattern-matching characters for the XBM subsystem ID. For more information, see “Using pattern-matching characters in the XBM$OPTS member” on page 258.

---

Overview of PSS options

PSS options control the PSS component.

*Table 19 on page 78 describes the different options.*
You can override the XCF group name and join sysplex group options that you specify on the PSS Options subpanel. To do so, specify an XCF group name on the XBM start command, or specify an XBMGROUP parameter on the XBM PROC.

Table 19: PSS options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sysplex group name</td>
<td>The name of the XCF group that you want this XBM subsystem to join when the PSS component is started. This name must match the first level of the structure name for the XBM structures that are defined in your CFRM policy. The default is XBMGROUP. Alternatively, you can specify the XCF group name in the XBMGROUP parameter on the XBM PROC. For information about the XBMGROUP parameter, see “Starting the ISPF interface” on page 54.</td>
</tr>
<tr>
<td>Join sysplex group when PSS started</td>
<td>Whether this XBM subsystem should automatically join the specified XCF group when you start the PSS component. To have this XBM subsystem join the specified XCF group, first set this option to Yes and then start the PSS component. The default is 2 (No).</td>
</tr>
<tr>
<td>Enforce shared repository</td>
<td>Whether all XBM subsystems in the XCF group should be forced to share a single repository. The default is 2 (No).</td>
</tr>
<tr>
<td>Sysplex processing time-out</td>
<td>The amount of time in seconds that an XBM data sharing group member should wait for a response from the coupling facility before timing out. This parameter takes effect when you exit the PSS Options subpanel. The default is 60.</td>
</tr>
<tr>
<td>Global IO caching allowed</td>
<td>not applicable for snapshot processing</td>
</tr>
<tr>
<td>Remote XBM subsystem time-out</td>
<td>A user-specific value that defines the amount of time (in seconds) that an XBM data sharing group member should wait for a response from the remote XBM subsystem before timing out. The XBM ISPF interface uses this value instead of the global PSS time-out setting when displaying remote XBM subsystem information in the monitors. The valid range for this value is from 1 through 9999 seconds. This value is stored in your ISPF user profile and remains in place until you specify a new value. The default value is 60 seconds. <strong>Note:</strong> This value is directly related to the Remote XBM subsystem size limit option. The higher you set the message size limit, the higher you need to set the time-out value because of the amount of time it takes to process the data from the remote XBM subsystem. If you do not specify an adequate time-out value, XBM might not be able to display the returned information in the ISPF interface. BMC recommends that you adjust these numbers conservatively because they can impact XCF performance.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remote XBM subsystem size limit</td>
<td>A user-specific value that defines the maximum amount of data that can be returned from any one request to display information in the ISPF interface from a remote XBM subsystem. The valid range for this value is from 99 through 99999 KB. For example, entering a value of 99 limits the amount of information to 99 KB (101,376 bytes). This value is stored in your ISPF user profile. The default value is 4999 KB. Note: Ensure that you set this number high enough to process the amount of data that is likely to be returned from the remote XBM subsystem. BMC recommends that you adjust this value conservatively because it can impact XCF performance. Also, ensure that you adjust the Remote XBM subsystem time-out value to a length appropriate for the amount of data you are processing. For each thousand lines of data, XBM requires approximately a 1-MB message size. For information about using the XBM ISPF interface to display remote XBM subsystems, see “Displaying detailed information for a remote XBM subsystem” on page 80.</td>
</tr>
</tbody>
</table>

### Setting PSS options

This procedure explains how to use the ISPF interface to specify the PSS options.

1. From the File List panel, choose **Options => PSS options** and press **Enter** to display the PSS Options subpanel (Figure 15 on page 79).

   **Figure 15: PSS Options subpanel**

   ![PSS Options subpanel](image)

   - **Sysplex group name** . . . . . . . . . XBMQA2
   - **Join sysplex group when PSS started** 1. Yes 2. No
   - **Enforce shared repository** . . . . . 1. Yes 2. No
   - **Sysplex processing time-out** . . . . . 180 seconds (1-9999)
   - **Global IO caching allowed** . . . . . 1. Yes 2. No
   - **Remote XBM subsystem time-out** . . . . 60 seconds (1-9999)
   - **Remote XBM subsystem size limit** . . 4999 KB (99-99999)

2. In the entry fields, type the desired values.

   For explanations of each field, see “Overview of PSS options” on page 77.
3 Press Enter to activate the new values and save them in the XBM repository.

XBM saves changes to these values in the XBM repository and uses the new values the next time you start the PSS component.

**Note**
Changes to the **Sysplex processing time-out** option goes into effect immediately after you make the change.

### Displaying XBM subsystem information and PSS performance statistics

This section explains how to display remote XBM subsystems in the ISPF interface, active XBM subsystems in a data sharing group through the console or ROUTE command, and performance statistics for the PSS component and the related structures through the XBM monitors.

### Displaying detailed information for a remote XBM subsystem

When you connect to the ISPF interface initially, you connect to the local XBM subsystem that is available on the LPAR that you are accessing.

However, you can also display a remote XBM subsystem through the ISPF interface if the remote and local XBM subsystems belong to the same XCF group. The File List and monitors will reflect the information for the remote XBM subsystems, instead of the local XBM subsystem. The PSS component enables communication between the remote and local XBM subsystems.

After accessing the remote XBM subsystem, you can interact with it just as you would with the local XBM subsystem.

**Before you begin**

Before using the ISPF interface to access a remote XBM subsystem, review the following considerations:

- Review your PSS options for the **Remote XBM subsystem size limit** and **Remote XBM subsystem time-out** values. Ensure that these values are large enough to support the amount of data that you want to display for the remote XBM subsystem. BMC recommends adjusting these values conservatively because they
can have an impact on XCF performance. For each thousand lines of data, XBM requires approximately a 1-MB message size.

- If you generate an ETRACE or DTRACE while displaying a remote XBM subsystem, the output of the trace is for the local XBM subsystem, not the remote XBM subsystem.

- You cannot issue a TERM SNAPSHOT command to terminate a snapshot on a remote XBM subsystem. You must connect to the XBM subsystem locally to issue the command.

- If you are using a component-specific monitor (such as the IMS, DB2, or SSI monitor), the associated component must be active on the remote XBM subsystem.

- If you are viewing a remote XBM subsystem, you cannot issue the following commands to components through the XBM ISPF interface:
  
  — The STOP command to the PSS component
  
  — The STOP or STOP FORCE commands to the XBM subsystem

If you attempt to issue these commands, XBM does not process the command and generates message BMC73916I Selection not currently available. If you want to issue these commands to the PSS component or XBM subsystem, use the ROUTE command instead (as documented in “ROUTE command” on page 268).

To access a remote XBM subsystem

1. From the File List panel, choose View => View XBM Subsystem to display the XBM Subsystem Selection panel (Figure 16 on page 81).

Figure 16: XBM Subsystem Selection subpanel

The asterisk after a Version number indicates that the version of that XBM subsystem differs from that of the local system.
Tip
Alternatively, you can enter VIEWXBM in the Command area to display the XBM Subsystem Selection panel.

In the selection field next to the XBM subsystem that you want to display, type / or S and press Enter.

The File List panel returns. The name of the XBM subsystem that you are currently displaying is listed at the top of the panel. You can now use the XBM ISPF interface to manage this XBM subsystem.

Displaying status information for active XBM subsystems

You can also display status information for XBM subsystems that are in the same XCF group.

To do so, use either the ROUTE command from the MVS system console or the console within the ISPF interface. This procedure explains how to display this status information.

To display status information by using the ROUTE command

1 Display status for all XBM subsystems in the XCFGROUP or for a selected XBM subsystem, as follows:

- To route the DISPLAY command to display the status of all XBM subsystems in the XCF group, use the ROUTE command with a pattern-matching character as shown in the following example:

  /xbmsid ROUTE * DISPLAY XBM

  Alternatively, you can use the shorter version of the commands:

  /xbmsid ROU * DIS XBM

- To route the DISPLAY command to display the status of a component for a specific XBM subsystem (XBMA), specify the name of the XBM subsystem for which you want to display information in the ROUTE command as shown in the following example:

  /xbmsid ROUTE XBMA DISPLAY COMPONENT DB2

  Alternatively, you can use the shorter version of the commands:

  /xbmsid ROU XBMA DIS COMP DB2

For more information about using this command, see “ROUTE command” on page 268.
To display status information by using the console

1. From the File List panel, choose **Console => XBM** and press **Enter** to display the Console - XBM subpanel.

2. In the **Command** field, type 1 (Display) and press **Enter**.

   The Destination subsystem panel is displayed.

3. In the **Destination** field, type the appropriate number to select what to display:
   - The local XBM subsystem (that is, the one to which you initially connected)
   - All XBM subsystems that are in the same XCF group as the local XBM subsystem
   - A specific XBM subsystem within the XCF group

   If you choose to display a specific XBM subsystem, you must enter the name in the **XBM subsystem** field. You can use pattern-matching characters to display multiple XBM subsystems whose names match the pattern.

4. Press **Enter** to display the Console Output panel.

   This panel displays the status information for the XBM subsystems that you selected.

5. When you finish reviewing the Console Output panel, press **F12** until you return to the File List panel.

Displaying PSS statistics

XBM provides general statistics for the XBM structures that are contained in the coupling facility. This procedure explains how to display statistics for PSS objects.

1. On the File List panel, choose **Monitor => XBM performance**.

2. On the Extended Buffer panel, press **F5** to display the Cache Facility structure subpanel.

3. Review the statistics for the cache, list, and lock structure, pressing **F8** to cycle through the statistics.
Types of available statistics

You can display statistics for these structures:

- Cache structure
- List structure
- Lock structure

Note

When reviewing PSS statistics, remember that writes occur on the system that acts as the castout owner. Consequently, the PSS statistics that you are displaying on one XBM subsystem might include write statistics for all or no XBM subsystems in the data sharing group, even though read statistics appear.

Displaying statistics for the PSS coupling facility structure

The Coupling Facility structure subpanel provides information about the cache, link, and list structure for the extended buffer.

Figure 17 on page 84 shows an example of this panel.

Figure 17: Coupling Facility structure subpanel

Table 20 on page 84 describes the statistics that the subpanel provides.

Table 20: Statistics for the PSS coupling facility structure

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure name</td>
<td>Name of this coupling facility structure</td>
</tr>
<tr>
<td>Type</td>
<td>Type of coupling facility structure (cache, list, or lock)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection name</td>
<td>Unique ID that the coupling facility assigned to this structure connection</td>
</tr>
<tr>
<td>Size</td>
<td>Size of the structure allocated in the coupling facility</td>
</tr>
<tr>
<td>Data bytes used</td>
<td>Number of bytes of the allocated storage currently in use for this structure</td>
</tr>
<tr>
<td>Used pct</td>
<td>Percentage of the allocated storage for the coupling facility structure data area that is currently in use. If 100 percent of the data area or directories is used, the coupling facility cannot process XBM requests.</td>
</tr>
<tr>
<td>Directories</td>
<td>Number of directory entries used to track eligible data set</td>
</tr>
<tr>
<td>Used pct</td>
<td>Percentage of the total directory entries that are currently in use. If 100 percent of the data area or directories is used, the coupling facility cannot process XBM requests.</td>
</tr>
<tr>
<td>Directory reads</td>
<td>Number of reads from the cache structure’s directory. This field remains at zero for the list structure because the list structure has no directory.</td>
</tr>
<tr>
<td>Buffer fulls</td>
<td>Number of times that a local buffer filled while reading from the directory for the cache structure</td>
</tr>
<tr>
<td>Deletes</td>
<td>Number of times that data was deleted from this structure</td>
</tr>
<tr>
<td>Timeouts</td>
<td>Number of times that access attempts to this structure timed out (returning no data)</td>
</tr>
<tr>
<td>Data bytes HWM</td>
<td>High-water mark (the largest amount at one time) of data bytes occupying the allocated storage for this structure</td>
</tr>
<tr>
<td>Directories HWM</td>
<td>High-water mark (the largest amount at one time) of directories occupying the allocated storage for this structure</td>
</tr>
<tr>
<td>Total - Reads</td>
<td>Number of reads that this structure satisfied</td>
</tr>
<tr>
<td>Failures - Reads</td>
<td>Number of failures that occurred during attempts to read from this structure</td>
</tr>
<tr>
<td>Rate - Reads</td>
<td>Rate (in I/Os per second) at which data is read from this structure</td>
</tr>
<tr>
<td>Xfer - Reads</td>
<td>Read transfer response time (in seconds) when data is read from this structure</td>
</tr>
<tr>
<td>Total - Writes</td>
<td>Number of writes that this structure satisfied</td>
</tr>
<tr>
<td>Failures - Writes</td>
<td>Number of failures that occurred during attempts to write to this structure</td>
</tr>
<tr>
<td>Rate - Writes</td>
<td>Rate (in I/Os per second) at which data is written to this structure</td>
</tr>
<tr>
<td>Xfer - Writes</td>
<td>Write transfer response time (in seconds) when data is written to this structure</td>
</tr>
</tbody>
</table>
Getting started with snapshot processing

The SNAPSHOT UPGRADE FEATURE (SUF) of the EXTENDED BUFFER MANAGER (XBM) product provides an interface to the snapshot-enabled BMC utilities.

This interface allows the utilities to use XBM snapshot technology while performing their individual purposes. Traditional software and hardware snapshots typically allow the utilities to significantly reduce the amount of time that databases have to be unavailable while the utilities perform various maintenance tasks. Instant Snapshots provide an extremely fast way to create a physical copy of the data upon which the utility can operate. For more information about how your utility uses the snapshot features offered by XBM, see the documentation for your utility.

To use the snapshot features of XBM with your utility, you must first understand the different types of snapshots that XBM provides and enable XBM to process the types of snapshots that you need. This chapter provides an overview of how to use XBM for snapshot processing. Subsequent chapters discuss the different types of snapshots in more detail.

Snapshot types that XBM can process

To increase data availability for supported BMC utilities, XBM can process the following types of snapshots:

- Traditional snapshots (software or hardware)
- Instant Snapshots

Overview of traditional snapshots

Software and hardware snapshots are also called traditional snapshots.
A traditional snapshot allows the supported utility to process data while a database remains available for updates. When the snapshot process starts, the database takes a very brief outage to establish a point of consistency.

At this point, XBM starts to provide the data to the supported utility consistent with that point of time:

- For software snapshots, XBM monitors write requests to the database for the data objects being processed. When a record is changed, XBM stores a preimage of the record in its software cache.

- For hardware snapshots, XBM uses intelligent storage to provide preimage records from a "frozen" copy of the database to the utility.

As the utility reads database records during its job, XBM satisfies the read request of the utility with the preimage from either the hardware device or software cache. In this manner the data read by the utility for that database is as it existed when the point of consistency was established, while the source database continues to be updated.

The following sections describe these processes in more detail.

**Software snapshots**

Software snapshots go through the following process:

1. When a configuration and a management set containing a snapshot template are activated and a snapshot utility job (one of the BMC high-performance utilities or the XBM utility program) is then started, the utility registers the objects that will be processed with XBM. XBM targets these objects as active.

2. The utility establishes a point of consistency, a *quiesce* point. How the quiesce point is established depends on the utility.

3. The snapshot job starts. As the snapshot job progresses, XBM monitors write requests that update the targeted objects:

   - If a write request is issued for a targeted object, XBM places an image of the page before it is updated (called a *preimage*) in the extended buffer. If the utility subsequently issues a read request for the updated page, XBM satisfies the request by using the preimage from the extended buffer.

   - If the utility needs the preimage but the preimage is not available in cache (due to a cache failure or some other problem), XBM sends a return code and reason
code back to the utility. The utility then determines whether to continue or terminate the operation.

After the utility uses the preimage, the used preimage is removed from the XBM cache.

**Note**

For restartable snapshot jobs, preimages continue to be cached in the extended buffer, though the utility jobs might have temporarily stopped. XBM does not remove the preimages from the extended buffer until the job completes or you manually terminate the job.

---

**Hardware snapshots**

Hardware (or SSI-assisted) snapshots differ from software snapshots. Instead of using a software cache to store preimages, XBM exploits storage devices to provide preimage data to a BMC utility.

Typically, the steps in the hardware snapshot process are as follows:

1. A mirrored pair is established between a volume and its user-controlled mirror. The data on the mirror remains synchronized with the data on the standard volume.

2. When the snapshot utility job is submitted, the utility registers the data sets with XBM and snapshot processing starts.

3. The snapshot utility issues a quiesce or otherwise establishes the necessary point of consistency.

4. The snapshot utility indicates to XBM that the snapshot should be started:
   - For a **volume-level snapshot**, the user-controlled mirror is separated from the standard volume where the registered data sets reside. This separation splits the link between the two volumes, leaving a point-in-time copy of the data on the mirror. Updates to the standard volume can continue.
   - For a **data-set-level snapshot**, XBM issues the appropriate request to have the data set replicated, or snapped, within the intelligent storage control unit. A hardware-vendor-specific API is called to create a point-in-time copy of the data set. Updates to the registered data sets can continue.

5. When the snapshot utility begins processing data, XBM provides the snapshot utility with access to the preimage data on the mirror or in the replicated data set. Doing so allows the snapshot to process the data as it was before any concurrent update activity.
6 When snapshot processing is completed, XBM initiates reconnection of the volumes or deletes the temporary data sets.

If the volumes or data sets cannot be separated when the snapshot process begins (for example, if the volumes are busy reconnecting from an earlier separation), XBM can seamlessly fall back to a traditional software snapshot by using the XBM cache to provide preimages to the utility.

Overview of Instant Snapshots

Instant Snapshots are significantly different from traditional snapshots.

When processing an Instant Snapshot, XBM uses the appropriate intelligent storage interface to create (or snap) a copy of physical data on a storage device to a different location on the same device (or on another device within the same control unit or frame). A copy of the data remains on the storage device after the utility has finished processing the job. XBM can also snap, or reapply, this copied data back to the original location for recovery.

XBM works with supported BMC utilities to create this physical data copy and recover by using the copy. Instant Snapshots derive their name from the speed at which the copy and recovery occur—Instant Snapshots require no host I/O to copy the data set.

How the SSI component works

The Storage Systems Integration (SSI) component is an XBM component that provides the following functions:

- Snapshot processing by using intelligent storage DASD devices
- An interface to allow active manipulation of storage devices
- A monitor to show storage device status

To perform a traditional hardware or Instant Snapshot, you must enable the SSI component. XBM requires this component to communicate to the supported hardware devices.

When you start the SSI component, either at initial startup of XBM or manually, it discovers the available intelligent hardware devices. The amount of time that the discovery process takes depends on the number of hardware devices you have. This discovery process determines the hardware snapshot capability of supported devices. For each device, the SSI component determines whether volume-level or
data-set-level snapshots (or both) are allowed. The SSI component also passes this information to the SSI monitor, so that the XBM ISPF interface can display the hardware devices. Through the SSI monitor, you can issue commands to the hardware, such as displaying device information, establishing pairs, suspending pairs, and so on. (For more information about these commands, see “Monitoring and managing storage devices” on page 209.)

To control whether the SSI component starts when the XBM subsystem starts, use the XSSI keyword in the XBM PROC (as described in “Parameters” on page 48). To start or stop the SSI component manually, use the procedure described in “Starting and stopping components” on page 58.

SSI component options enable you to control how XBM processes the snapshots. These options control such things as whether to allow hardware snapshot and Instant Snapshots, as well as whether to perform volume-level or data-set-level snapshots. For more information, see “Specifying snapshot types through options” on page 96.

XBM provides commands that allow you to set some commonly used vendor-specific hardware device options. For more information, see “Commands for managing SSI options” on page 272.

Note
The SSI component cannot access devices for which unit control blocks (UCBs) are dynamically added, changed, or deleted while the SSI component is running. When a device is dynamically added, XBM issues a message that warns you that you must restart the SSI component. The SSI component will not be able to recognize that device until it has discovered the UCB for the device during initialization. For information about restarting your SSI component, see “Starting and stopping components” on page 58.

If you remove a device dynamically, the SSI component issues a message that indicates that the device was removed. XBM will no longer be able to obtain information about the device. The removed device will be ignored by the snapshot process and unavailable for any future requests.

Which type of snapshots to use

This section compares the various types of snapshots in the following categories:

- Choosing the type of snapshot
- Using data-set-level or volume-level hardware snapshots
- Determining snapshot type by hardware
These comparisons help you determine which snapshot to use based on your goals, your environment, and the type of hardware that you have available. In addition, you need to consider which snapshot types your utilities support.

## Choosing the type of snapshot

The best snapshot type to use depends on your main objective.

Table 21 on page 92 describes three major objectives and the optimal snapshot type for each one.

*Note*
Different BMC utilities support different types of snapshots. For information about the types of snapshots your utility supports, see the documentation for your utility.

<table>
<thead>
<tr>
<th>Objective</th>
<th>Best snapshot type</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Minimize outage time       | Software snapshot | Software snapshots (where the utility actually copies the data) are the fastest and most economical method. They use extended memory to save page preimages, and only use memory for pages updated during the snapshot.  
Note: A software snapshot is faster than a hardware snapshot; however, the cache size is limited to 511 GB and can require a significant amount of auxiliary storage. |
| Maximize success rate      | Hardware snapshots| Hardware snapshots can potentially use whatever hardware is available (mirroring, data set snaps) to establish a point-in-time image that the utility copies. They relieve the resource demand for software snapshots. Hardware snapshots can fall back to software snapshots if the hardware attempt fails for any reason. |
| Minimize recovery time     | Instant Snapshots | Instant Snapshots duplicate data sets without any program copying data. They can duplicate back to the original data set (restore for recovery). They support SHRLEVEL CHANGE for DB2 to allow for an outage-free backup. |

Table 22 on page 93 indicates the relative order of each snapshot type for each of the objectives.
Table 22: Ranking snapshot objectives

<table>
<thead>
<tr>
<th>Objective</th>
<th>First choice</th>
<th>Second choice</th>
<th>Third choice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize recovery time</td>
<td>Instant</td>
<td>Software</td>
<td>Hardware</td>
</tr>
<tr>
<td>Minimize outages</td>
<td>Software</td>
<td>Hardware</td>
<td>Instant</td>
</tr>
<tr>
<td>Maximize success rate</td>
<td>Hardware</td>
<td>Software</td>
<td>Instant</td>
</tr>
</tbody>
</table>

Using data-set-level or volume-level hardware snapshots

For a hardware snapshot, you have the option of performing a volume-level or data-set-level snapshot. The type of snapshot you should use depends on your environment and the capability of the devices on which the data resides.

For a relatively low number of data sets, the difference in speed between the volume- and the data-set-level snapshot is not significant. However, as the number of data sets increases, the volume-level snapshot can become increasingly faster. The difference in speed is attributable to two elements: the number of calls required to the hardware vendor API and the duration of those calls.

If a number of data sets are co-located on a given volume, a single hardware API call to split the volume mirror results in a point-in-time instance of all data sets contained on that volume. Conversely, if the data sets are widely scattered or the volumes are not mirrored, a data-set-level snapshot might be the better alternative.

Each hardware vendor API call requires a relatively constant, although different, amount of time. The volume mirror split call requires a few seconds while the data-set-level snapshot takes longer due to required MVS allocation. Knowledge about the location and concentration of the data sets is instrumental in determining which type of hardware snapshot to choose.

Finally, you might obtain the desired result by allowing snapshots to use whichever method is available on the DASD that contains the data sets. Depending on your environment, it might be better to select one method or the other, or to use the SSI and snapshot template options to vary the methods during the day. For Instant Snapshots, the data-set-level snapshot is the only method and is automatically selected.

Note

When the utility is used to actually copy the data, a software snapshot is always faster than a hardware snapshot. However, you must ensure that you have a cache defined that is sufficient to handle the preimages for your snapshot jobs.
Determining snapshot type by supported hardware devices

Table 23 on page 94 indicates which snapshot types can use the hardware devices that XBM currently supports.

For traditional hardware snapshots, the supported intelligent hardware devices depend on whether it is a volume-level or data-set-level snapshot.

Table 23: Device support by snapshot type

<table>
<thead>
<tr>
<th>Device type</th>
<th>Traditional hardware snapshots</th>
<th>Instant Snapshots</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Volume level</td>
<td>Data set level</td>
</tr>
<tr>
<td>EMC TimeFinder</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>IBM RVA</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>STK SVA</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Hitachi FlashCopy</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Hitachi ShadowImage</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Hitachi HRC 2</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>PPRC</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>IBM FlashCopy</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

*a* Support for IBM RAMAC Virtual Array (RVA) and Oracle StorageTek Shared Virtual (SVA) products will be phased out in a future release of XBM.

*b* Locally accessible volumes

Controlling which types of snapshots are enabled

This section describes techniques that you use to control which types of snapshots are enabled:

- To enable software snapshots, you must define a configuration that specifies the types of cache allowed (as described in “Enabling software snapshots” on page 109) and a snapshot template (“Specifying a snapshot template” on page 95).

- To enable hardware snapshots, you must specify a snapshot template (“Specifying a snapshot template” on page 95) and set SSI options to allow hardware snapshots (“Specifying snapshot types through options” on page 96).
To enable Instant Snapshots, you set SSI options to allow Instant Snapshots (“Specifying snapshot types through options” on page 96).

This section also describes enabling software snapshots to act as a fallback to hardware snapshots (“Enabling fallback to software snapshots” on page 97) and describes briefly how the utilities call different snapshots (“Requesting the snapshot in the utilities” on page 97).

**Specifying a snapshot template**

Software and hardware snapshots use snapshot templates to specify the format of the cache and other attributes.

You specify and activate a single template that applies to all snapshot jobs that run while that template is activated. Instant Snapshots do not use snapshot templates.

The snapshot template, which is saved in a management set, is the XBM control structure that you use to specify attributes to be associated with each data set when performing a snapshot. A template consists of attributes that specify how to handle the data objects during snapshot processing. The template also controls whether to enable hardware snapshots. You create snapshot templates through the ISPF interface.

**Note**

The supported BMC utility that you are using with XBM controls which objects will participate in the snapshot job. The snapshot template specifies the characteristics to be applied to the data set.

You specify the characteristics described in Table 24 on page 95 in your snapshot template.

**Table 24: Attributes in the snapshot template**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache limits</td>
<td>The maximum amount of storage to provide for the managed object</td>
</tr>
<tr>
<td></td>
<td>If the object definition includes multiple data sets, the cache limit is a maximum per data set.</td>
</tr>
<tr>
<td>Cache type</td>
<td>The type of storage in which to cache managed objects</td>
</tr>
<tr>
<td>Compress</td>
<td>Whether to enable compression for this object definition</td>
</tr>
<tr>
<td>SSI-assisted snapshot</td>
<td>Whether to enable snapshot processing using intelligent storage DASD</td>
</tr>
</tbody>
</table>
|                            | (To enable hardware snapshots, you must also set SSI options. For more information, see “Enabling hardware snapshots” on page 133.)
Attributes in the snapshot template, including cache type, cache limit, compression, and whether SSI-processing is enabled, affect how XBM operates during software and hardware snapshot processing.

**Note**
A single snapshot template manages all snapshot objects in a job. Therefore, all snapshot objects have the same relative priority.

### Specifying snapshot types through options

You control the type of snapshot by specifying options for the SSI component or through the use of a snapshot template.

You use the XBM ISPF interface to perform these functions. With SSI options, you can specify whether to allow Instant Snapshots or hardware snapshots.

For hardware snapshots, you can also specify whether to allow data-set-level snapshots, as well as whether to allow XBM to split a currently established mirror if the data-set-level snapshot cannot be performed.

**Note**
The default for XBM is to allow data-set-level snapshots. If you do not want to allow this, you must change the options for the SSI component.

Table 25 on page 96 describes the options that you set to control the type of snapshot that is performed. For more information about these options, see “Performing hardware snapshots” on page 136 or “Performing Instant Snapshots” on page 153.

#### Table 25: Controlling the snapshot types

<table>
<thead>
<tr>
<th>Control mechanism</th>
<th>Instant</th>
<th>Hardware</th>
<th>Software only</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Data set snap</td>
<td>Volume split</td>
</tr>
<tr>
<td>SSI Options</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow Instant Snapshots</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow SSI assisted snapshots</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Allow data set snap</td>
<td>Y</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>-- SMS options</td>
<td></td>
<td>optional</td>
<td></td>
</tr>
<tr>
<td>Allow volume mirror split</td>
<td></td>
<td>Y</td>
<td></td>
</tr>
</tbody>
</table>
### Enabling fallback to software snapshots

To ensure snapshot completion, you can enable both hardware and software snapshots for your data sources.

If you enable both hardware and software snapshots, XBM attempts to perform a hardware snapshot. If for any reason this snapshot fails, XBM transparently falls back to performing a software snapshot.

To enable XBM to fall back to a software snapshot from a failed hardware snapshot, you must set up a software snapshot cache and define the options, as listed in “Specifying snapshot types through options" on page 96.

If the data set resides on devices that support both data-set-level and volume-level snapshots, XBM attempts to perform a data set snapshot and then a volume split before falling back to a software snapshot.

### Requesting the snapshot in the utilities

In addition to setting up XBM to do snapshots, you must request the snapshot through your BMC snapshot-enabled utility.
The utilities handle this request in differing ways. For information about how a utility requests and uses snapshots, see the documentation for your utility.

**How do I set up XBM to enable snapshot processing**

This section provides brief overviews of the tasks that you perform to enable XBM for each type of snapshot processing.

For a detailed explanation about each task, see the chapters for the snapshot types that you are specifying.

*Note*

While you must configure and enable XBM to be able to process the different types of snapshots, the snapshot-enabled utility actually launches the snapshot job and determines the data source upon which snapshot processing is performed.

Before you set up XBM to enable snapshot processing, you need to complete the tasks described in Table 26 on page 98.

**Table 26: Tasks to complete before setting up snapshot processing**

<table>
<thead>
<tr>
<th>Task description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install XBM.</td>
<td><em>Installation System User Guide and BMC Products and Solutions for DB2 Configuration Guide</em></td>
</tr>
<tr>
<td>Configure security.</td>
<td>“Granting user authorizations for XBM” on page 36</td>
</tr>
<tr>
<td>Start the XBM subsystem and components.</td>
<td>■ “Starting the XBM subsystem” on page 47</td>
</tr>
<tr>
<td></td>
<td>■ “Working with XBM components” on page 58</td>
</tr>
<tr>
<td>Set XBM options.</td>
<td>“Setting XBM options” on page 62</td>
</tr>
<tr>
<td>Set up XBM and the PSS component for a data sharing environment (if applicable).</td>
<td>“Using XBM in a parallel sysplex environment” on page 65</td>
</tr>
</tbody>
</table>

**Enabling XBM to process software snapshots**

To enable XBM to process software snapshots, complete the tasks shown in Table 27 on page 99 in the order listed.
Table 27: Tasks for enabling software snapshots

<table>
<thead>
<tr>
<th>Task</th>
<th>How to complete this task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the characteristics of the extended buffer by defining a configuration.</td>
<td>To perform this task, choose the cache types and sizes that you want to use for the buffer that will contain the pre-images for the snapshot-enabled utilities.</td>
<td>“Defining an extended buffer in a configuration” on page 118</td>
</tr>
<tr>
<td>Create a snapshot template in a management set to define the cache and snapshot attributes.</td>
<td>Through the ISPF interface, define the cache size, and compression options that XBM uses for each data set that undergoes snapshot processing.</td>
<td>“Creating a snapshot template for software snapshots” on page 122</td>
</tr>
<tr>
<td>Activate the configuration.</td>
<td>Through the ISPF interface, activate the configuration to indicate that your configuration is ready to participate in a snapshot.</td>
<td>“Activating a configuration” on page 125</td>
</tr>
<tr>
<td>Activate the snapshot template.</td>
<td>Through the ISPF interface, activate the management set that contains the snapshot template that you want to use.</td>
<td>“Activating a management set” on page 127</td>
</tr>
<tr>
<td>Plan for a point of consistency.</td>
<td>Use the methods available for your snapshot-enabled utility to establish the consistency point.</td>
<td>“Planning for a point of consistency” on page 128</td>
</tr>
<tr>
<td>Run the utility job.</td>
<td>Specify the appropriate syntax in your utility’s job control card, and submit the job.</td>
<td>“Running the utility job” on page 129</td>
</tr>
</tbody>
</table>

Enabling XBM to process traditional hardware snapshots

To enable XBM to process traditional hardware snapshots, complete the tasks shown in the following table in the order listed.

Table 28: Tasks for enabling traditional hardware snapshots

<table>
<thead>
<tr>
<th>Task</th>
<th>How to complete the task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up the hardware environment.</td>
<td>Hardware snapshots rely on user-controlled mirrored pairs or data set replications to obtain a preimage of registered data sets. Mirrors must be synchronized with the source volume before the snapshot can begin. Consult your storage device documentation or vendor to ensure that your pairs are set up and working correctly before beginning a hardware snapshot.</td>
<td>“Setting up the hardware environment” on page 136</td>
</tr>
<tr>
<td>Task</td>
<td>How to complete the task</td>
<td>Reference</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configure the SSI component.</td>
<td>In the ISPF interface, set SSI options to configure the SSI component. The SSI options control such things as:</td>
<td>“Setting SSI options for hardware snapshots” on page 142</td>
</tr>
<tr>
<td></td>
<td>■ The display of hardware devices</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Whether the SSI component is enabled</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Whether to allow data set snaps or volume mirror splits</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Data set options</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Support of remote hardware</td>
<td></td>
</tr>
<tr>
<td>Create a snapshot utilities template in a management set to define snapshot attributes.</td>
<td>Through the ISPF interface, create a management set to contain the snapshot template that you want to use. In the snapshot template, control whether hardware snapshots can be performed and other hardware-specific options.</td>
<td>“Creating a snapshot template for a hardware snapshot” on page 145</td>
</tr>
<tr>
<td>Activate the snapshot template.</td>
<td>Through the ISPF interface, activate the management set that contains the snapshot template that you want to use.</td>
<td>“Activating the management set” on page 148</td>
</tr>
<tr>
<td>Run the utility job.</td>
<td>Initiate your utility job by following the instructions provided in the utility documentation. When the snapshot job begins, XBM first attempts a hardware snapshot to provide preimages to the snapshot utility. If the appropriate mirrored pair or data set snapshot capability is unavailable and you have specified a software cache, XBM falls back to a software snapshot to successfully complete the snapshot job.</td>
<td>“Running the utility job” on page 148</td>
</tr>
<tr>
<td>Review the status of the snapshot job.</td>
<td>Review the messages that XBM generated.</td>
<td>“Reviewing the status of a hardware snapshot job” on page 148</td>
</tr>
</tbody>
</table>

### Enabling XBM to process Instant Snapshots

To enable XBM to process Instant Snapshots, complete the tasks shown in the following table in the order listed.
<table>
<thead>
<tr>
<th>Task</th>
<th>How to complete the task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up the hardware environment.</td>
<td>XBM and the SSI component require one of the supported intelligent hardware storage devices and appropriate supporting software for Instant Snapshots. These devices and their accompanying software should be installed, configured, and running successfully on your system.</td>
<td>“Setting up the hardware environment” on page 154</td>
</tr>
<tr>
<td>Configure the SSI component with the SSI options.</td>
<td>To configure the SSI component, use the XBM ISPF interface to set SSI options. The SSI options control whether XBM enables hardware snapshots and Instant Snapshots. SSI options also control whether XBM monitors display all DASD devices or only DASD devices upon which snapshots can be performed.</td>
<td>“Setting SSI options for Instant Snapshots” on page 158</td>
</tr>
<tr>
<td>Create and run a BMC utility job that requests the Instant Snapshot.</td>
<td>Initiate your utility job by following the instructions provided in the utility documentation. Note that the utility job must specifically request an Instant Snapshot (referred to by some utilities as a DSSNAP).</td>
<td>“Running the utility job” on page 160</td>
</tr>
<tr>
<td>Review the status of the snapshot job.</td>
<td>Review the messages that XBM generated.</td>
<td>“Reviewing the status of an Instant Snapshot job” on page 160</td>
</tr>
</tbody>
</table>

### Monitoring and controlling hardware devices

XBM provides monitors for showing the status of hardware devices and functions.

XBM includes monitors for the following types of objects:

- PPRC objects
- EMC TimeFinder objects
- Hitachi ShadowImage and Remote Copy objects

Figure 18 on page 102 shows an example of a hardware monitor for EMC TimeFinder objects. This monitor shows the EMC TimeFinder devices that XBM discovered when the XBM subsystem was started. This information includes such
items as the total number of standard volumes and business continuance volumes (BCVs), as well as information about specific devices.

**Figure 18: Example of a hardware monitor**

```
EMC TimeFinder Objects on 04/19/2008 at 16:57: Row 1 to 7 of 2,072

STD devices . . :   2000           BCV devices . . . :     72
Synchronized . . :   1848           SRDF sources . . :    132
Sync in progress :      0           SRDF targets . . :     29

Select actions on the following EMC TimeFinder objects, then press enter.
1=Zoom 2=Establish 3=ReEstablish 4=Split 5=Restore 6=IncRestore
7=HoldBCV 8=ReleaseBCV

S   Addr  DType  Status   Volser  DNum  Type  Sync    PDev  SRDF
_   0BC0  3390   Online   AFXBC0  0340  STD   Yes     05A5  No
_   0BC1  3390   Online   AFXBC1  0341  STD   Yes     05A6  No
_   0BC2  3390   Online   AFXBC2  0342  STD   Yes     05A7  No
_   0BC3  3390   Online   AFXBC3  0343  STD   Yes     05A8  No
_   0BC4  3390   Online   AFXBC4  0344  STD   Yes     05A9  No

BMC739571 View is by SRDF. View selection filtering is active.

Command ===> ______________________________________________________________
```

**How the DBMS type affects snapshot processing**

XBM and SUF support the following database types for snapshot processing:

- DB2
- IMS
- VSAM

This section describes any special considerations based on the DBMS of the data.

**DB2 snapshots**

The snapshot component (also called the SNAPSHOT UPGRADE FEATURE (SUF)) of XBM for DB2 is designed to work with certain BMC high-performance utilities to allow you to run the utilities against your data while that data remains available for updates.

The BMC utilities for DB2 that can use the snapshot component are:

- CHECK PLUS for DB2
In addition to enabling online utility functionality, the snapshot component provides the following functionality for the utilities:

- **Restartable snapshot copies in COPY PLUS**.
  This feature allows you to restart failed COPY PLUS Snapshot Copy jobs while maintaining the original quiesce point.

- **Referential constraint checking in LOADPLUS**
  This feature allows you to check referential constraints during your load job.

For basic instructions about how to perform snapshots, see “Enabling software snapshots” on page 109 or “Enabling hardware snapshots” on page 133.

### Standard DB2 data set names requirement

XBM supports snapshot processing for standard DB2 data set names.

DB2 requires that data set names have the following formats:

- **cluster name**:
  
  - `db2cat.DSNDBC.dbname.tsname.Innnn.Annn` or `db2cat.DSNDBC.dbname.tsname.Jnnnn.Annn`

- **data component name**:
  
  - `db2cat.DSNDBD.dbname.tsname.Innnn.Annn` or `db2cat.DSNDBD.dbname.tsname.Jnnnn.Annn`

If the data component subsequently is renamed or altered to a nonstandard name, you cannot perform snapshot processing for those data sets. This restriction exists because XBM cannot match the name by using the pattern-matching mask that is specified in the management set.

### Parallel sysplex support for DB2 snapshots

When used with the PSS component, XBM provides snapshot utility support for DB2 in a parallel sysplex environment. The PSS component allows you to run a snapshot
utility job even though the cached objects are being updated across multiple processors in a data sharing environment.

For information about PSS component prerequisites and setup, see “Using XBM in a parallel sysplex environment” on page 65.

**Using XBM for DB2 for a snapshot utility job**

To run a snapshot utility job with XBM for DB2 and one of the BMC high-performance utilities for DB2, follow the steps outlined in “Enabling software snapshots” on page 109.

After you define and activate your configuration and snapshot template, the next step is establishing a quiesce point. All of the high-performance utilities establish their own quiesce point internally; you just set up your utility job correctly to use the snapshot functionality, then run the job.

After your snapshot job starts, you can use the XBM Utility monitor to monitor snapshot jobs for some utilities while in progress. For more information about the Utility monitor, see “Using the Utility monitor” on page 192.

**IMS snapshots**

The snapshot component (also called the SNAPSHOT UPGRADE FEATURE (SUF)) of XBM for IMS works with the BMC IMAGE COPY PLUS (ICP) product to create image copies of your IMS data while that data remains available for updates.

XBM also works with the MAXM Reorg/EP and MAXM Reorg/Online utilities. For more information, see the documentation for these products.

XBM for IMS and ICP also work with supported intelligent storage hardware devices to provide snapshot data without the need for cache (though XBM has the capability to fallback to a software snapshot if necessary).

**Parallel sysplex support for IMS snapshots**

When used with the PSS component, XBM provides snapshot utility support for IMS in a parallel sysplex environment. The PSS component allows you to run a snapshot utility job even though the cached objects are being updated across multiple processors in a data sharing environment.

For information about PSS component prerequisites and setup, see “Using XBM in a parallel sysplex environment” on page 65.
IMS VSAM SHROPTS requirements

Before targeting IMS VSAM data sets for a Snapshot Copy, ensure that the IMS VSAM share options specified for each data set allow snapshot processing to occur.

XBM provides snapshot processing for targeted data sets with share options (3,3) or (2,3). Share options (3,3) allow multiple updates to targeted data sets during snapshot processing. Share options (2,3) allow a single update to targeted data sets during snapshot processing.

Share options (1,3) also allow snapshot processing to occur for the data sets, but these share options allow no updates to run against the data sets during snapshot processing. Because no updates can occur, you gain none of the data availability benefit of snapshot processing with these share options.

VSAM snapshots

The SUF for VSAM component works with the XBM utility program to provide point-in-time copies of VSAM, IBM CICS VSAM, and sequential data sets while those data sets remain available for updates. The VSAM component and the utility program also leverage the power of supported intelligent storage hardware devices to provide hardware-assisted snapshots and Instant Snapshots.

Understanding the XBM utility program

The XBM utility program (XBMXUTIL) provides functionality similar to the IDCAMS REPRO function to allow you to take immediate advantage of the VSAM component.

In addition to using the utility to perform Snapshot Copy jobs, you can use it to perform REPRO-compatible copy operations for CICS VSAM and VSAM data sets and sequential files. For ease of use, the XBM utility program accepts IDCAMS REPRO command syntax and requires only minimal JCL modification to run the job stream.

For more information about the XBM utility program, see “Using the XBM utility program for a VSAM snapshot copy” on page 311.

VSAM SHROPTS requirements

Before targeting VSAM data sets for Snapshot Copy, ensure that the VSAM share options specified for each data set allow snapshot processing to occur.
XBM provides snapshot processing for targeted data sets with share options (3,3) or (2,3). Share options (3,3) allow multiple updates to targeted data sets during snapshot processing. Share options (2,3) allow a single update to targeted data sets during snapshot processing.

Although share options (1,3) allow snapshot processing to occur for targeted data sets, these share options allow no updates to run against the data sets during snapshot processing. Because no updates can occur, you gain none of the data availability benefit of snapshot processing.

### Specifying VSAM options

This section explains how to specify or change the values of the VSAM options. You can set VSAM options globally to allow processing of shared VSAM data sets.

XBM stores VSAM option values in the XBM repository. When you install XBM, the default values are in effect. You can specify or modify VSAM options at any time. XBM saves changes to the option values in the XBM repository and uses them immediately.

**Before you begin**

Review the options described in “VSAM options” on page 283.

**To specify VSAM options**

1. From the File List panel, choose **Options => VSAM options** and press **Enter**.

   The VSAM Options subpanel (Figure 19 on page 106) is displayed.

   **Figure 19: VSAM Options subpanel**

<table>
<thead>
<tr>
<th>VSAM Options</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict caching for cross region share options 3 or 4.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restrict caching</td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>No</td>
</tr>
<tr>
<td>Remove VSAM object tracking information while not in use.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove object information</td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>No</td>
</tr>
<tr>
<td>Note: Remove 'No' may increase memory usage in the XBM address space.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   F1=Help     F12=Cancel

2. Type the desired values for each option:
a In the **Restrict caching** field, specify **1 (Yes)** or **2 (No)** to indicate whether to restrict caching for cross-region share options 3 or 4.

b In the **Remove object information** field, specify **1 (Yes)** or **2 (No)** to indicate whether to remove object tracking information for VSAM objects that are no longer being used.

3 Press **Enter** to activate the new values and save them in the XBM repository.

---

**Note**

You can change option values at any time. Changes to the VSAM options take effect immediately.
Enabling software snapshots

The EXTENDED BUFFER MANAGER (XBM) components for DB2, IMS, and VSAM provide a snapshot component that places page images in the XBM extended buffer for point-in-time copies.

This feature allows you to create a point of consistency and then release the objects. The objects are then available for updates.

**Note**
BMC recommends that you always define the configuration and management sets necessary for software snapshot processing as a backup to the other types of snapshot processing. If you do so and a hardware snapshot fails, XBM automatically falls back to performing a software snapshot to complete the snapshot job that the BMC utility requested.

Supported software

The XBM snapshot component works with the following BMC utilities to perform concurrent processing of page images in the XBM extended buffer for point-in-time copies:

- BMC utilities for DB2:
  - COPY PLUS for DB2
  - CHECK PLUS for DB2
  - LOADPLUS for DB2
  - REORG PLUS for DB2
  - UNLOAD PLUS for DB2
- BMC utilities for IMS:
  - IMAGE COPY PLUS (ICP)
Overview of the extended buffer

This section explains the extended buffer and the function that it performs in snapshot processing. This section includes the following topics:

- The structure of the extended buffer
- How the snapshot utilities populate the extended buffer
- How XBM caches pages
- The different types of cache that XBM supports for snapshot processing

Structure of the extended buffer

The extended buffer consists of a storage type defined in the configuration definition that you create. Storage in the extended buffer allocated to one of the supported types is called a cache.

Note

For snapshot processing, BMC recommends that you use data space cache or pageable virtual storage for the extended buffer.

How XBM and snapshot utilities populate the extended buffer

When a configuration and a management set containing a snapshot template are activated and a snapshot utility job is then started, the utility registers the objects that will be processed with XBM.

The following steps describe this process:
1 XBM targets the registered objects as active.

2 The utility establishes a point of consistency (a quiesce point). How the quiesce point is established depends on the utility being used.

3 The snapshot job starts. As the snapshot job progresses, XBM monitors write requests that update the targeted objects.

4 If a write request is issued for a targeted object, XBM places an image of the page before it is updated (called a preimage) in the extended buffer. If the utility subsequently issues a read request for the updated page, XBM satisfies the request by using the preimage from the extended buffer.

   If the preimage is needed by the utility but is not available in cache (because of a cache failure or some other problem), XBM sends a return code and reason code to the utility. The utility determines whether to continue or terminate the operation.

5 After the utility uses the preimage, the used preimage is removed from the XBM cache.

   Note
For restartable snapshot jobs, preimages continue to be cached in the extended buffer, though the utility job might have temporarily stopped. XBM does not remove the preimages from the extended buffer until the job is complete or you manually terminate the job (for example, by specifying TERM SNAPSHOT). For information about restartable parameter keywords, options, and use, see the documentation for the supported utility.

### How XBM caches pages

Based on information in the object definition, XBM uses the following logic to determine whether to cache a page:

1 *Is the cache type of the managed object available in the extended buffer?*

   ■ If the current extended buffer, which is determined by the active configuration, does not include cache of the type that is specified for the managed object, XBM does not cache the preimage and the snapshot job might fail.

   ■ If the extended buffer does include the cache type, go to step 2.

2 *Has the managed object reached its cache limit?*

   ■ If the managed object has not reached its limit and the cache is not full, cache the page.
If the managed object reached its limit and the cache is full, do not cache the page.

Choosing cache types

For XBM to provide reliable snapshot processing, you must specify an appropriate cache type of sufficient size for the extended buffer and for managed objects. This cache balances system impact with the probability that the cache is large enough to handle all of the preimages that will be stored in the cache at one time.

System impact usually consists of increased system paging, such as:

- Paging of XBM address space control structures
- Paging of data in the XBM virtual storage caches
- Paging of other address spaces as the result of XBM central storage allocation

To specify an appropriate cache, you must know what resources are available to your system and what kind of activity occurs on the system.

Note
For more about managing system resources, see the IBM MVS System Tuning Guide and the MVS System Tuning Reference.

Cache size

Ensure that the configuration you specify provides sufficient cache of the type needed to support the cache limit in the snapshot template you create. If you do not specify sufficient cache space and XBM has no room to cache a preimage of updated data, your snapshot job will be invalid if the utility subsequently issues a request for that data. You might also need to consider the availability of auxiliary (paging) storage.

Cache types supported by XBM

A cache type is specified both in a configuration and in the object definition for a managed object:
The active configuration determines what cache type is available in the extended buffer.

The active snapshot template, which contains object definitions, determines what cache type can be used by the various managed objects, if that type is available in the current configuration.

The extended buffer can support the following cache types:

- Fixed virtual storage
- Pageable virtual storage
- Data space
- ESO hiperspace (not recommended for snapshot object definitions)

**Note**

BMC strongly recommends that you use data space or pageable virtual storage as the cache type for snapshots.

Table 30 on page 113 describes these cache types in more detail.

**Table 30: Cache types for snapshot processing**

<table>
<thead>
<tr>
<th>Cache type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed virtual storage</td>
<td>Fixed virtual storage is backed by real storage frames. However, you must ensure that your system resources can support a fixed virtual storage cache before using this cache type. General characteristics of fixed virtual storage are:</td>
</tr>
<tr>
<td></td>
<td>■ The size can be up to 511 GB.</td>
</tr>
<tr>
<td></td>
<td>■ Data is directly addressable.</td>
</tr>
<tr>
<td></td>
<td>■ Cache is nonpageable.</td>
</tr>
<tr>
<td></td>
<td>■ Cache is backed by real storage.</td>
</tr>
<tr>
<td></td>
<td>■ Cache size might be limited by the XBM region size.</td>
</tr>
</tbody>
</table>
### Cache type advantages and disadvantages

<table>
<thead>
<tr>
<th>Cache type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Pageable virtual storage | A pageable virtual storage cache can be effective if it is backed by sufficient real storage and auxiliary storage. Pageable virtual storage is also a good choice for tables that benefit from compression. This type of storage is your best choice for object definitions for snapshot utilities when you need more than 2 GB. General characteristics of pageable virtual storage are:  
  - The size can be up to 511 GB.  
  - Data is directly addressable.  
  - Cache is pageable.  
  - Cache is backed by real and auxiliary storage.  
  - Cache size is limited by the XBM region size. |
| Data space          | A data space cache can be effective if it is backed by real and auxiliary storage. It is a good choice when you are using compression. It is probably your best choice for snapshot utilities object definitions. A data space has the following characteristics:  
  - The size can be up to 2 GB.  
  - Data is directly addressable.  
  - Cache is pageable.  
  - Cache is backed by real and auxiliary storage. |
| ESO hiperspace      | (Not recommended for snapshot utilities object definitions.) An ESO hiperspace is, in general, a very good choice for read-only buffers like the XBM cache. However, if your system is heavily used, the system could steal frames from the hiperspace cache, resulting in read failures from the cache. A cache read failure might cause a snapshot job to fail. |

**Table 31 on page 115** summarizes the advantages and disadvantages of the various cache types. Whether a cache type and size are effective for you depends on your available resources and the activity on your system.
Table 31: Cache type advantages and disadvantages for snapshot processing

<table>
<thead>
<tr>
<th>Cache type</th>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Best use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed virtual storage</td>
<td>■ Fast access ■ No paging ■ Good compression performance ■ Extremely large</td>
<td>■ Most expensive resource: backed by real storage ■ Most likely to impact system performance ■ Practical only for small caches on non-</td>
<td>■ Small mission-critical tables under special circumstances ■ Use compression when effective</td>
</tr>
<tr>
<td></td>
<td>caches (up to 511 GB on z/OS systems)</td>
<td>caches on non-z/OS systems ■ Use compression when effective ■ Small mission-critical tables on non-z/OS systems</td>
<td></td>
</tr>
<tr>
<td>Pageable virtual</td>
<td>■ Fast (when backed by sufficient real storage) ■ Good compression performance</td>
<td>■ Pageable ■ Moderately expensive resource: must be backed by sufficient real and auxiliary storage ■ Can affect overall system performance</td>
<td>■ Use compression when effective ■ Small mission-critical tables on non-z/OS systems</td>
</tr>
<tr>
<td></td>
<td>■ Extremely large caches (up to 511 GB on z/OS systems)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data space</td>
<td>■ Good compression performance ■ Large caches (up to 2 GB) ■ Pageable ■ Can affect overall system performance</td>
<td>■ Moderately expensive resource: backed by real storage and auxiliary storage ■ Pageable ■ Can affect overall system performance</td>
<td>■ Compressed tables ■ Recommended for snapshot utilities object definition</td>
</tr>
</tbody>
</table>

Choosing cache types
<table>
<thead>
<tr>
<th>Cache type</th>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Best use</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESO hiperspace</td>
<td>■ Expanded storage only</td>
<td>■ Pages can be stolen on busy systems</td>
<td>Not recommended for snapshot utilities object definition</td>
</tr>
<tr>
<td></td>
<td>■ No paging</td>
<td>■ Not quite as effective as the other cache types for compression, but still effective.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Less expensive resource</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Large caches (up to 2 GB)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Simulate mode and snapshot processing**

Simulate mode is not valid for snapshot utilities activity. If simulate mode is enabled in the active configuration and a utility tries to use the snapshot component, object registration cannot occur.

**Using compression**

XBM allows you to compress objects that are stored in any of the caches allocated by the active configuration.

XBM compresses data at the page or control-interval level. This means that XBM compression can be effective for data that is already compressed by Data Packer or other DBMS-specific compression products.

**Determining candidates for compression**

While cached objects with 4-KB blocks fit into 4-KB memory frames, objects without 4-KB block sizes do not.

XBM has two cache page sizes available to allow you to customize the product:

- The standard extended buffer cache size is 4 KB.
- When cache compression is enabled in the active configuration, the extended buffer cache size is 1 KB.
It is beneficial to use XBM compression when there is enough free-space or run-length compression to save at least 1 KB of data. Compression also saves space if the object page fits in less than a 4-KB (or multiple of 4 KB) page.

For example, a 6-KB control interval requires two 4-KB pages of uncompressed cache or six 1-KB pages when compression is enabled. Enabling compression for the configuration allows the use of 1-KB cache pages and saves space for objects that do not have 4-KB block sizes.

**Enabling compression**

For XBM to compress data, compression must be enabled both for the managed object in the management set and the cache type in the configuration.

For example, a managed object could be enabled for compression and for caching in the data space cache. If the active configuration creates a data space cache but disables it for compression, no data cached in the data space will be compressed.

---

**Note**

When compression is enabled for a cache type specified in a configuration, XBM processes 1-KB pages instead of 4-KB pages, regardless of whether data is actually being compressed. This processing requires additional CPU overhead. Consequently, when you specify compression for a configuration ensure that you also specify compression for an associated management set to prevent wasted CPU resources.

---

**Enabling compression for a managed object**

To enable compression for a managed object, specify compression for the managed object when you define the object’s management set.

**Enabling compression for a cache type**

To enable compression for a cache type, specify compression for the cache type when you define the configuration.

**Monitoring compression**

The XBM monitor provides compression percentage statistics for cache in the extended buffer and for data sets.

The Extended Buffer panel shows compression statistics for the entire extended buffer and for each individual cache. The Data Set statistics show compression statistics for individual data sets. By using selection criteria for data set statistics, you
can restrict the statistics to a single management set or individual data set. This feature allows you to display the compression percentage for the data sets that comprise an object definition, or the compression percentage for all data sets in a management set.

Performing a software snapshot

Before you perform a software snapshot using the BMC snapshot-enabled utility, you must first set up XBM and the SUF technology.

Subsequent sections describe how to perform the following setup tasks:

1. Defining the configuration for the extended buffer
2. Creating a snapshot template
3. Activating a configuration
4. Activating a management set
5. Planning for a point of consistency
6. Running the utility
7. Reviewing the status

Defining an extended buffer in a configuration

This procedure explains how to define a configuration to describe the extended buffer. Only one configuration can be active at a time. If you activate a configuration, the previous active configuration becomes inactive.

Before you begin

Before defining your extended buffer, perform the following tasks:

- Review the following sections:
  — “Understanding XBM pattern-matching” on page 255
  — “Overview of the extended buffer” on page 110
  — “Using compression” on page 116
Install and configure XBM as described in the installation guide.

Configure XBM as described in “Configuring and managing the XBM subsystem” on page 35 and “Using XBM in a parallel sysplex environment” on page 65.

Review the options described in “Cache options for the extended buffer” on page 284 to understand the information that you will specify for each cache type.

To define a configuration

1. Create a new configuration file.

   a. From the File List panel, choose **File => New** and press **Enter** to display the New File Type subpanel (Figure 20 on page 119).

   ![Figure 20: New File Type subpanel](image)

   From the New File Type subpanel, type **2** (Configuration) in the selection entry field and press **Enter** to display the Configuration Edit panel (Figure 21 on page 119).

   ![Figure 21: Configuration Edit panel (before specification)](image)

   b. From the New File Type subpanel, type **2** (Configuration) in the selection entry field and press **Enter** to display the Configuration Edit panel (Figure 21 on page 119).
Simulate mode is not valid for snapshot processing. Always leave the value of this field as 2 (No) when you are using XBM for snapshot processing.

2 Select a cache type, and specify cache information.

   a On the Configuration Edit panel, select the type of storage that you have chosen for the extended buffer.

   Note
   To help you choose the appropriate cache type for your buffer, see “Cache type advantages and disadvantages” on page 114.

   b Press Enter to display the Cache Information subpanel (Figure 22 on page 120).

   The Cache Information subpanel is displayed for the storage type that you selected on the Configuration Edit panel. The Cache name and Description fields identify the type of cache that you are defining.

Figure 22: Cache Information subpanel for data space

   In the Cache size and Cache size in fields, specify the size and units of measures to use for the cache that you are defining.

   For detailed information and guidelines for the Cache size and Cache size in fields, see “Cache options for the extended buffer” on page 284.

   d In the Compression selection field, specify whether you want to enable compression:
- Type **1** (Compression) to enable compression for this storage type cache.
- Type **2** (No compression) to disable compression for this type of cache.

For more information about using compression for cache, see “Using compression” on page 116.

e  Press **Enter**.

The Configuration Edit panel is displayed and now shows the values that you specified for the selected cache type (Figure 23 on page 121).

**Figure 23: Configuration Edit panel (after specification)**

<table>
<thead>
<tr>
<th>S</th>
<th>Name</th>
<th>Cache Description</th>
<th>Size</th>
<th>Size Type</th>
<th>Compress</th>
</tr>
</thead>
<tbody>
<tr>
<td>_</td>
<td>FVS</td>
<td>Fixed Virtual</td>
<td>0</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>PVS</td>
<td>Paged Virtual</td>
<td>0</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>DSP</td>
<td>Data Space</td>
<td>100 MB</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>HSP</td>
<td>Hiperspace</td>
<td>0</td>
<td>N</td>
<td></td>
</tr>
</tbody>
</table>

3  Save the configuration file.

a  From the Configuration Edit panel, choose **File => Save** and press **Enter** to display the Save as subpanel.

b  In the **New file name** entry field, type the name of the new configuration.

**Note**  
You can include underscores (_) in the configuration name. However, XBM ignores them when you use them as preceding or trailing characters in the name.

Do not use the name DEFAULT_CONFIG when you create a configuration. When XBM is recycled, the DEFAULT_CONFIG configuration is reset to empty.

c  Press **Enter** to save the configuration in the repository.

The Configuration Edit panel appears again and displays a message above the Command line informing you that the configuration has been saved.

4  On the Configuration panel, press **F12** to return to the File List panel.
Creating a snapshot template for software snapshots

Creating a snapshot template for software snapshots

The next step in setting up a software snapshot is defining the snapshot template. This template determines the cache to use for data sets that a snapshot job includes. The snapshot template is defined in a management set.

Before you begin

Complete the following tasks before creating a snapshot template:

- Create a configuration to define the extended buffer, as described in “Defining an extended buffer in a configuration” on page 118.

- Review the following sections:
  — “Specifying a snapshot template” on page 95
  — If you are creating templates for VSAM or IMS data sets, review one of the following sections for information about SHROPTS requirements:
    — “VSAM SHROPTS requirements” on page 105
Review the options available in “Snapshot template options for software snapshots” on page 286 to determine the characteristics for the snapshot template that you want to define.

To create a snapshot template

1  Create a new management set file.

   a  From the File List panel, choose File => New and press Enter to display the New File Type subpanel.

   b  From the New File Type subpanel, type 1 (Management Set) in the selection entry field and press Enter to display the Object Type Selection subpanel (Figure 25 on page 123).

Figure 25: Object Type Selection subpanel

<table>
<thead>
<tr>
<th>Component</th>
<th>1. DB2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Snapshot</td>
</tr>
<tr>
<td>3. IMS</td>
<td></td>
</tr>
</tbody>
</table>

Performing a software snapshot

Chapter 5  Enabling software snapshots  123
Performing a software snapshot

2 On the Object Type Selection subpanel, type **2 (Snapshot)** in the selection field and press **Enter** to display the Snapshot Managed Object Information subpanel (Figure 26 on page 124).

**Figure 26: Snapshot Managed Object Information subpanel**

On the Snapshot Managed Object Information subpanel, complete the fields.

For more information about the fields, see “Snapshot template options for software snapshots” on page 286.

---

**Note**

On the Snapshot Managed Object Information subpanel, the **Object** field always shows the literal: **BMCXBM.SNAPSHOT_TEMPLATE**

---

3 On the Snapshot Managed Object Information subpanel, complete the fields.

4 When you finish entering information, press **Enter**.

The Snapshot template options subpanel (Figure 27 on page 124) is displayed.

**Figure 27: Snapshot template options subpanel**
**Note**

This subpanel allows you to specify SSI-assisted (hardware) snapshots. For prerequisites and instructions for performing SSI-assisted snapshots, see “Enabling hardware snapshots” on page 133. For a software snapshot, you do not use this option.

5 On the Snapshot template options subpanel, leave 2 (No) unchanged in the selection field and press **Enter**.

The Management Set Edit - Summary panel appears.

6 Save the management set.

   a On the Management Set Edit - Summary panel, choose **File => Save**.

   b On the Save As subpanel, enter the name of the management set in the **New file name** field and press **Enter**.

   c Press **F12** to return to the File List panel.

**Activating a configuration**

After you have created or changed a configuration in the repository, you can activate the configuration to create the extended buffer it defines. This procedure explains the different methods you can use to activate a configuration.

You can create an unlimited number of configurations and save them in the XBM repository. However, only one configuration can be active at any given time for a snapshot job. If another configuration is activated during a snapshot job, the snapshot job will likely fail.

You can use one of the following methods to activate an existing configuration:

- File action bar
- Action code
- Console action bar
- ACTIVATE CONFIGURATION command

**To activate a configuration with the File action bar**

1 From the File List panel, select the configuration that you want to activate.
2 Choose File => Activate and press Enter to activate the configuration.

A message is displayed that indicates that the configuration has been activated.

**To activate a configuration by using the action code**

1 On the File List panel, type 2 (Activate) in the action field of the configuration that you want to activate.

2 Press Enter to activate the configuration.

**To activate a configuration by using the Console action bar**

1 On the File List panel, choose Console => Configurations and press Enter to display the XBM Console - Configuration subpanel (Figure 28 on page 126).

   **Figure 28: Console - Configuration subpanel**

   File View Options Console Monitor User Help

   Viewing XBM4(XBMIQA) from XBM4
   Row 5 to 17 of 108

   Select 1=Open S A
   Name
   F1=Help F12=Cancel

2 On the XBM Console - Configuration subpanel, type the name of the configuration that you want to activate in the Name field.

3 Press Enter to activate the configuration.

**To activate a configuration by using the ACTIVATE CONFIGURATION command**

1 From the MVS system console, type the following command:

   \[ ssid ACTIVATE CONFIGURATION name \]

   The variable \( ssid \) represents the name of the XBM subsystem.

**Where to go from here**

When you finish activating the configuration, you should activate the management set as described in “Activating a management set” on page 127.
Activating a management set

After you have created or changed a snapshot template in a management set and saved it in the repository, you can activate the management set to begin using it for a snapshot job.

This procedure describes the different methods of activating a management set. Any number of management sets can be active at the same time. To process snapshots, XBM uses the management set that was most recently activated.

You can use one of the following methods to activate an existing management set:

- File action bar
- Action code
- Console action bar
- ACTIVATE MANAGEMENT SET command

To activate a management set by using the File action bar

1. On the File List panel, select the management set that you want to activate.
2. Choose File => Activate and press Enter to activate the management set.

To activate a management set by using the action code

1. On the File List panel, type 2 (Activate) in the action field of the management set that you want to activate.
2. Press Enter to activate the management set.
To activate a management set by using the Console action bar

1. On the File List panel, choose **Console => Management Sets** and press **Enter** to display the XBM Console - Management Set subpanel (Figure 29 on page 128).

   **Figure 29: Console - Management Set subpanel**

   - **File**
   - **View**
   - **Options**
   - **Console**
   - **Monitor**
   - **User**
   - **Help**

   Viewing XBM4(XBMQA) from XBM4  Row 5 to 17 of 108

   Select |                  Console - Management Set                   |
   -------|----------------------------------------------------------------|
   S      | Enter management set command information and press Enter.    |
   _      | Name . . . *                                               |
   _      | F1=Help F12=Cancel                                        |

2. On the Console - Management Set subpanel, type the name of the management set that you want to activate in the **Name** field.

   **Note**
   
   You can use XBM pattern-matching characters in the **Name** field. For more information about pattern matching, see “Understanding XBM pattern-matching” on page 255.

3. Type **2** (Activate) in the **Command** entry field and press **Enter** to activate the management set.

To activate a management set by using the ACTIVATE MANAGEMENT SET command

You can use the ACTIVATE MANAGEMENT SET command from the MVS system console to activate management sets.

1. Type the following command:

   ```
   ssid ACTIVATE MANAGEMENT SET name
   ```

   The variable **ssid** represents the name of the XBM subsystem, and the variable **name** represents the name of the management set.

Planning for a point of consistency

How a point of consistency, the quiesce point, is established depends on the utility that you use for your snapshot job.
Consequently, planning for the quiesce depends on the utility that you use. For more information about planning a point of consistency, review the documentation for the utility that you are using with XBM to create your snapshot.

**Running the utility job**

Snapshot jobs require that you specify job-processing information for the utility that you plan to use.

When you submit your utility job, the XBM snapshot component is invoked and the utility’s control statements include syntax that identifies the objects to be processed. The utility registers the objects with XBM, and the objects use the cache defined for the snapshot template.

**Note**

To identify XBM to the utility, you supply the XBM subsystem ID (SSID) specified when XBM was installed. In a data sharing environment you can use the XBMGROUP name of the cross-system coupling facility (XCF) group to which XBM belongs instead of the XBM subsystem ID.

For snapshots of DB2 and IMS data sets, see the reference manual that came with your utility software for the appropriate syntax to use in your job control card.

For snapshots of VSAM data sets, see “Using the XBM utility program for a VSAM snapshot copy” on page 311 for details about the syntax required for the XBM utility program.

**Utility syntax**

When you invoke a BMC utility that supports XBM, the utility job control card includes syntax that registers data sets to XBM for caching.

If updates are issued to those registered data sets, the data sets will be cached up to the cache limit specified in the snapshot template.

Use XBMID ssid to specify the XBM subsystem for the utility to use when starting the snapshot. For the utility to process the snapshot, the XBMID value must be specified in either the utility control cards or the utility options.

For more detailed information about specifying the proper command syntax for your utility, including the use of wildcards to register multiple data sets, see the documentation for your utility.
**Restartable snapshot utility jobs**

When running restartable snapshot utility jobs, you should promptly restart jobs in restart pending status.

XBM continues to cache preimages for targeted data while in restart pending status. XBM does not flush the preimages from cache until the job completes or is manually terminated. If the job waits in restart pending status for an extended period of time, the cache can fill and the job might not complete successfully.

---

**Note**

You must restart a restartable snapshot utility job on the XBM subsystem and LPAR upon which it failed. You cannot start it on another system.

---

If you decide that terminating the utility job is a better alternative to restarting it, use the same utility ID and the TERM parameter via the utility JCL. Doing so cleans up the utility ID for that run. This process also signals XBM to terminate all the active registered data sets in XBM for that utility run. If you do not use this process, XBM cannot re-register and process any “restart pending” objects from the failed attempt in a new utility job run unless you manually terminate the objects.

If you terminate the utility job by any other process and must manually terminate the objects that have been left in restart pending status, perform one of the following actions:

- Stop and restart all XBM subsystems that were involved in processing the objects.
- Use the Term Snapshot option on the Snapshot data sets panel (Figure 30 on page 130) to terminate each data set object that remained in restart pending status.

---

**Note**

You cannot terminate snapshots if you are displaying a remote XBM subsystem. You must connect to the XBM subsystem locally to terminate snapshots through the XBM ISPF interface.

---

For more information about accessing the Snapshot data set panel, see “Displaying data set statistics for snapshot utilities” on page 180.

**Figure 30: Snapshot data set panel**

Select actions on the following data sets, then press enter.

<table>
<thead>
<tr>
<th>S</th>
<th>A</th>
<th>Data set name</th>
<th>RRate</th>
<th>CBlocks</th>
<th>Cmpl%</th>
</tr>
</thead>
<tbody>
<tr>
<td>_</td>
<td>_</td>
<td>DBAHCAT.DSNDBD.KCT.T1.I0001.A001</td>
<td>2</td>
<td>0</td>
<td>100%</td>
</tr>
<tr>
<td>_</td>
<td>_</td>
<td>DBAHCAT.DSNDBD.RYCARU01.RYCARU01.I0001.A001</td>
<td>1</td>
<td>0</td>
<td>100%</td>
</tr>
<tr>
<td>_</td>
<td>_</td>
<td>DBAHCAT.DSNDBD.RYCARU01.RYCARU01.I0001.A002</td>
<td>1</td>
<td>0</td>
<td>100%</td>
</tr>
<tr>
<td>_</td>
<td>_</td>
<td>DBAHCAT.DSNDBD.RYCARU01.RYCARU01.I0001.A003</td>
<td>1</td>
<td>0</td>
<td>100%</td>
</tr>
</tbody>
</table>

Command ===> ______________________________________________________________
Restartable jobs that fail might not be restartable due to an unrecoverable error. You can identify the data sets for these jobs by an exclamation point (!) in the Active column on the Data Set Statistics panel. To clear these jobs, you have three options:

- Attempt to restart the job. This action causes the job to fail and subsequently be cleaned up.
- Terminate the job through XBM by using the TERM SNAPSHOT option.
- Terminate the job by using the termination function of the utility.

**Reviewing the status of a software snapshot job**

This section describes some of the messages that XBM produces that can help you determine the status of your XBM job.

For a more detailed explanation of specific messages, access the messages section of the BMC Documentation Center from the BMC Support Central site (http://www.bmc.com/support).

In a sysplex environment, each participating XBM subsystem issues messages. Certain messages identify the subsystem where the reported action has occurred.

**Start messages**

When a data set is registered by a supported snapshot utility for a software or hardware snapshot, XBM produces the following message:

```
BMC73551I  11.00.55  xbmssid Data set dsn registered for Snapshot at xbmssid
```

When the utility starts the snapshot job, XBM generates the following message that shows the job, the name of the data set, and which XBM subsystem is processing the job. The specified XBM subsystem might be a remote subsystem.

```
BMC73552I  11.11.59  xbmssid Snapshot started for job jobname, data set dsn at xbmssid
```

**Stop messages**

When a snapshot job stops, XBM displays the following message that indicates the name of the job, the data set, and which XBM subsystem processed the job.
Where to go from here

If a snapshot job abnormally ends without sending a Stop command to XBM, XBM performs termination cleanup for the snapshot job and generates the following message:

BMC73550I  11.01.01  xbmssid Termination cleanup performed for SNAPSHOT job jobname (asid), step stepname

Review the following table to determine where to look for information about the next task that you want to perform.

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring snapshot utilities</td>
<td>“Monitoring BMC snapshot-enabled utilities” on page 171</td>
</tr>
<tr>
<td>(VSAM only) Using the XBM utility program for a VSAM snapshot copy</td>
<td>“Using the XBM utility program for a VSAM snapshot copy” on page 311</td>
</tr>
</tbody>
</table>
Enabling hardware snapshots

The Storage Systems Integration (SSI) component of the EXTENDED BUFFER MANAGER (XBM) product, when used with supported BMC high-performance utilities, provides snapshot functionality by leveraging the power of intelligent storage devices.

When the SSI component starts, it determines the status of the supported storage devices that are available. This device discovery process determines the hardware snapshot capability of each device. For each device, the SSI component determines whether to allow volume-level or data-set-level snapshots (or both). For a complete description of the SSI component, see “How the SSI component works” on page 90.

Although SSI-assisted, or hardware, snapshots require no software cache to provide a preimage for snapshot utilities, BMC recommends that you configure XBM to enable software snapshots, with requisite software cache, as a backup. Doing so allows XBM to fall back to a software snapshot if the hardware snapshot cannot be performed.

This chapter describes how to enable hardware snapshots.

Understanding hardware snapshots

This section describes the software and hardware necessary when using the SSI component of XBM to perform a snapshot. It also explains how to suspend and resume mirrors and the options that you set to enable snapshots.

Supported software

For SSI-assisted snapshots, XBM supports the following utilities:

- BMC utilities for DB2:
  - COPY PLUS for DB2
— LOADPLUS for DB2

- BMC utilities for IMS:
  - IMAGE COPY PLUS (ICP)
  - MAXM Reorg/EP
  - MAXM Reorg/Online

- XBM utility program (a VSAM and sequential data set copy utility)

For more information about how a particular utility works with XBM, see the documentation for that utility.

**Supported hardware**

XBM supports the following intelligent hardware storage devices for SSI-assisted snapshots:

- EMC Symmetrix

- Hitachi 7700E/9900 devices capable of PPRC or FlashCopy version 2 operations

- IBM Enterprise Storage Subsystem (Shark) devices capable of PPRC or FlashCopy 2 operations (including Extended Address Volumes (EAV))

- IBM RAMAC Virtual Array (RVA)

- Oracle StorageTek Shared Virtual Array (SVA)

- any other storage device capable of generic peer-to-peer remote copy (PPRC)

**Note**

Support for IBM RAMAC Virtual Array (RVA) and Oracle StorageTek Shared Virtual (SVA) products will be phased out in a future release of XBM.

**Suspending and resuming mirrors**

For environments that support hardware mirroring, you can use XBM for DB2 with a BMC utility to temporarily suspend and resume the mirroring capability.
The utility sends XBM the names of the data sets or volumes whose mirrors might be suspended. XBM determines the volumes on which the data sets reside. If the utility sends a SUSPEND request to XBM for those volumes, XBM suspends mirroring. XBM resumes mirroring when it receives a RESUME request from the utility. XBM can suspend or resume multiple data sets at once.

**Note**
To use the suspend/resume feature, you must have XBM for DB2 and System Recover for DB2 version 1.1 or later.

### Enabling SSI snapshots in SSI options and snapshot templates

In both the SSI options and the snapshot template, you specify values that control whether XBM enables SSI snapshots. You must enable SSI processing in both places for snapshot processing to work.

This characteristic allows flexibility in complex environments. When you change SSI options, you change the options globally for all snapshots that this XBM subsystem handles. You can make changes to SSI options only through the ISPF interface. Conversely, you can use a batch job or command line to activate and deactivate a management set containing a snapshot template. Doing so allows you to modify the snapshot processing attributes on a per job basis if you use multiple management sets and snapshot templates to define different attributes for the snapshot jobs.

**Note**
You should have only one management set containing a snapshot template active at any given time. If more than one active management set contains a snapshot template, XBM uses the snapshot processing attributes from the last management set that was activated.

The following example shows how to activate a management set in a job card. This job card activates a management set named SNAP_NO_SSI. A subsequent job card could deactivate this management set or activate another management set.

```bash
//JOBCARD
// COMMAND 'XBM ACT MS SNAP_NO_SSI'
//****
//COPY EXEC PGM=ACPMAIN
//
```

If multiple snapshot utilities are actively processing data when a different management set is activated, XBM uses the management set that was active when the data sets were registered to process the specific object. Plan your job scheduling
carefully to ensure that the right management set is active when XBM registers the data sets.

An alternative to changing the active management set is to set up multiple XBM subsystems. For each subsystem, you could set up global SSI options and a single snapshot template in a management set to handle processing for snapshots of that type.

Performing hardware snapshots

Before you can use the BMC snapshot-enabled utilities to perform SSI-assisted (hardware) snapshots, you must set up the hardware devices and set up XBM.

The topics in this section describe how to prepare for and perform hardware snapshots:

1. Setting up the hardware environment
2. Setting up SSI options for hardware snapshots
3. Creating a snapshot template
4. Activating the management set
5. Running the utility
6. Reviewing the job

Note
In addition to these required tasks, BMC recommends that you establish a software cache. Doing so allows XBM to fall back to a software snapshot if the hardware where the targeted data resides is unavailable. XBM handles this fallback automatically, if necessary. For information about establishing a software cache, see “Enabling software snapshots” on page 109.

Setting up the hardware environment

Hardware snapshots rely on user-controlled mirrored pairs or the data set snap capability to obtain a preimage of registered data sets.

Mirrors must be synchronized with the standard volume before the snapshot can begin. Consult your storage device documentation or vendor to ensure that your pairs are set up and working correctly before beginning a hardware snapshot. The
SSI component requires the installation and configuration of software and hardware products as explained in the following sections.

---

**Note**

If the source data set resides on one volume, the target data set will not be spread across multiple volumes unless you specify a `volcount` value in the DFDSS control cards even if you specify candidate volumes. Sufficient space on a single target volume must be available.

---

**XBM components**

To use the SSI component, you must install and configure the snapshot features of one or more of the following additional XBM components:

- VSAM component
- DB2 component
- IMS component

**Storage devices**

The SSI component requires one of the supported vendors’ intelligent storage devices and appropriate supporting software.

These devices and their accompanying software should be installed, configured, and running successfully on your system.

Contact your intelligent storage hardware vendor to ensure that the software for your devices has appropriate PTFs and microcode installed to support XBM hardware snapshot processing.

For a list of supported devices, see “Supported software” on page 133.

**Additional software for EMC devices**

Before you can use an EMC Symmetrix device in a hardware snapshot or any EMC-specific functions from the XBM ISPF monitor, you must have one of the following:

- EMC Symmetrix Control Facility (SCF) subsystem installed and functioning.
- EMC devices that support Flashcopy (contact EMC for licensing information)
If you use EMC SCF, the EMC SCF link library contains the required API modules that were previously shipped with XBM. To obtain the necessary EMC components, contact EMC and request the most recent version of the ResourcePak-Base for OS/390 and z/OS.

EMC Symmetrix devices also require certain levels of microcode to be installed on the devices themselves to support different snapshot methods. Table 32 on page 138 lists the minimum required EMC microcode levels.

Table 32: Required EMC Symmetrix microcode levels

<table>
<thead>
<tr>
<th>Hardware snapshot type</th>
<th>Required EMC microcode level 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>volume-level</td>
<td>5x63 or later</td>
</tr>
<tr>
<td>data-set-level</td>
<td>5x66 or later</td>
</tr>
</tbody>
</table>

For more information about the SCF and EMC microcode, see your EMC Symmetrix documentation.

In addition, if you have EMC TimeFinder version 5.3.1 or later, you might need two EMC products. If you are doing mirroring, you will need the EMC TimeFinder/Mirror product. If you are doing data-set-level or Instant Snapshots, you will need EMC TimeFinder/Snap. EMC separated the mirroring and snap capability in the 5.3.1 release of EMC TimeFinder. For more information, see the EMC documentation.

If you have the EMC Symmetrix Automated Replication (SAR) feature of SRDF in your environment, XBM will not use active members in a SAR relationship for snapshot processing. XBM recognizes these volumes and automatically bypasses them to use alternate BCVs. Doing so avoids any potential conflicts from occurring between the EMC SAR feature and XBM.

Additional considerations and restrictions for FlashCopy

To use FlashCopy Version 2 with XBM, you must meet the following requirements:

- For the operating system, the DFSMS level must be OS/390 2.10 or z/OS 1.3 (or later) and all appropriate IBM maintenance must be installed.
- You must configure XBM with the security authority to create and delete the database objects upon which you are performing hardware snapshots.
- For FlashCopy Version 2, you must ensure that all IBM-provided APARs that enable FlashCopy version 2 to support data-set-level operations have been applied. FlashCopy Version 2 did not initially support the data-set-level operations.
operations that XBM requires to perform hardware snapshots. These IBM APARs provide the required operations, such as copying to an existing data set.

The following restrictions exist when using XBM with FlashCopy to produce data-set-level snapshots:

- Hardware snapshot processing uses the FASTREPLICATION(REQUIRED) keyword when the SSI option or the value supplied by the utility for DATAMOVER(.....) has a value of NONE or nulls. If the value is something other than NONE or nulls, hardware snapshot processing uses the FASTREPLICATION(PREFERRED) keyword.

**Note**

PTF BPE0316 changed the functionally of the XBM SET DATAMOVER option. The DATAMVR parameter of the snapshot-enabled utility now overrides the XBM SET DATAMOVER option entirely.

The default value of the DATAMVR parameter of snapshot-enabled utility is **NONE** if it not used. Therefore, if the snapshot-enabled utility does *not* request to use the DATAMVR feature, any XBM SET DATAMOVER option is ignored and is not used. If the utility issues the DATAMVR parameter, the XBM SET DATAMOVER option is overridden and the DATAMVR setting of the utility is used (FDR, DSS, and so on.).

- You must be able to use the DFSMSdss COPY command with FASTREPLICATION(REQUIRED) keyword in batch mode to use FlashCopy.

The following functional IBM restrictions currently affect FlashCopy use:

- FlashCopy requires all volumes containing target data set extents to reside in the volume list. XBM adds the required volumes if necessary.

- All source volumes in a multiple-volume data set must reside within the same IBM Shark or Hitachi enclosure. This restriction applies to System Managed Storage (SMS) and non-SMS managed data sets.

- The ESOTERIC unit parameter is not supported.

- The SMS classes of the data source and target volumes can affect the expected results, as shown in Table 33 on page 140.
Table 33: SMS class results

<table>
<thead>
<tr>
<th>Source</th>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
</table>
| SMS source      | SMS target     | ■ The default class is in the same SMS class as a source.  
                |                | ■ The snapshot options, supported utility, or Automatic Class Selection (ACS) routines can specify an alternate SMS class. |
| non-SMS target  |                | ■ A non-SMS target is supported only if a target data set already exists. The snapshot uses existing extents.  
                |                | ■ If the target data set does not exist, the snapshot ignores the volume list and the target is in the same SMS class as the source. |
| non-SMS source  | SMS target     | The class is specified through an XBM or utility input or through ACS routines. |
| non-SMS target  |                | ■ If a target data set does not exist, the snapshot uses the user-supplied or XBM-supplied volumes.  
                |                | ■ If the target data set exists, the snapshot adds the volumes of the target data set to the volume list.  
                |                | ■ If an existing target is in a different storage enclosure, the snapshot fails. |

When you set up an XBM subsystem to process hardware snapshots with any of the supported hardware devices (regardless of vendor), BMC recommends that you disable volume allocation or volume pooling software to avoid their affecting XBM. Because XBM is a long-running task and because of the way that FlashCopy processes hardware snapshots, any products that manage storage allocations might accrue excessive entries over time if you do not disable allocation control for XBM.

An example of such products is the BMC MainView SRM product. To prevent MainView SRM from changing the snapshot allocations, specify the following DD statement in the XBM started task:

```
//PROIGN DD DUMMY
```

For more information about controlling allocation, see the MainView SRM documentation or the documentation for your volume allocation or pooling software.
You can use XBM with FlashCopy to produce hardware snapshots in an all SMS-managed database environment or in a mixed SMS-managed and non SMS-managed environment. Table 34 on page 141 shows how allocations will work in these environments with and without ACS rules.

### Table 34: Allocation considerations for hardware snapshots

<table>
<thead>
<tr>
<th>Source</th>
<th>ACS rule exists and volume list passed</th>
<th>No ACS rule exists and volume list passed</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS-managed data set</td>
<td>allocation controlled by ACS rule</td>
<td>allocation on same SMS storage class as source</td>
</tr>
<tr>
<td>non-SMS-managed data set</td>
<td>allocation controlled by ACS rule</td>
<td>allocation will use the volume list that was passed</td>
</tr>
</tbody>
</table>

As seen in Table 34 on page 141, if the target for the hardware snapshots needs to reside on a specific SMS volume pool, you should have ACS rules set up to control that allocation.

### Additional software for Hitachi and generic PPRC devices

Hitachi devices and generic PPRC devices require an appropriate version of MVS that supports PPRC operations.

Contact your operating system vendor to ensure that the version of MVS you plan to use supports PPRC operations.

### Additional software for IBM RVA and STK SVA devices

To support data set-level snapshots using IBM RVA or STK SVA devices, XBM requires the SIBBATCH program.

The SIBBATCH program is an IBM Extended Facilities Product (IXFP) utility program. The library for the SIBBATCH program must be copied to an APF-authorized library on your system.

Reference the location of the SIBBATCH library by using your MVS linklist or the XBMXTASK DD statement in the JCL generated for the XBM PROC.

**Note**

If you reference the location of the SIBBATCH library in your MVS linklist, remove or comment out the XBMXTASK DD statement in the XBM PROC JCL.

IBM RVA and Oracle StorageTek SVA products will be phased out in a future release of XBM.
Setting SSI options for hardware snapshots

This procedure explains how to set the SSI options so that you can perform hardware snapshots.

Before you begin

Complete the following tasks before setting SSI options:

- Review the information in “Enabling SSI snapshots in SSI options and snapshot templates” on page 135.
- Ensure that the hardware is set up correctly, as described in “Setting up the hardware environment” on page 136.
- Review (“SSI options for hardware snapshots” on page 287) for the SSI options that you want to define. This worksheet identifies the information that you enter on each panel when you set the SSI options.

Note

XBM stores these user-specified options in the XBM repository. XBM uses default values for these options when you start XBM for the first time.

To specify or change the values of the SSI options

1. From the File List panel, choose Options => SSI options and press Enter to display the SSI Options subpanel (Figure 31 on page 142).

   Figure 31: SSI Options subpanel

2. On the SSI Options subpanel, specify which devices that you want XBM to identify when the XBM subsystem or SSI component is started. Also specify...
whether to allow hardware (SSI-assisted) snapshots and Instant Snapshots. Press Enter.

3 Did you allow SSI-assisted snapshots on the SSI Options subpanel?

- If no, you have completed setting your SSI options and the ISPF interface returns you to the File List panel. You cannot perform hardware snapshots until you return and allow SSI-assisted snapshots.

- If yes, complete the SSI Snapshot Options subpanel (Figure 32 on page 143) and press Enter.

The SSI Snapshot Options subpanel allows you to specify whether to allow XBM to perform data set snapshots and volume mirror splitting when processing hardware snapshots.

Figure 32: SSI Snapshot Options subpanel

File View Options Console Monitor User Help

Viewing XOAJ(XBMOA2) from XOAJ Row 1 to 23 of

|                        SSI Options                       |                        |
| e|                                                          |
|o|  Device discovery . . 2   1.  Supported functionality   |   elec|                                                          |
|p|  .-----------------------------------------------. |
|A|  |               SSI Snapshot Options            |   a|
||  |                                               |   |
||  |   Allow dataset snap . . . . . 2  1. Yes   | |
||  |         2. No    | |
||  |   Allow virtual volume snap . . 1  1. Yes | |
||  |         2. No    | |
||  |   Virtual Volume SnapPool  . . . __________   | |
||  |   Allow volume mirror split  . . 1  1. Yes   | |
||  |         2. No   | |
||  |    F1=Help   F12=Cancel                       | |
||  |    F1=H .----------------------------------------------. |

Note

If you specify Yes for both the Allow data set snap and Allow volume mirror split fields, XBM will first attempt to do a data set snap. Be sure that this is the processing behavior that you want.

If you set Allow virtual volume snap and the Allow volume mirror split to 1 (Yes), XBM attempts to perform a virtual volume snapshot before a volume mirror split.

4 Did you allow data set snap on the SSI Snapshot Options subpanel?

- If no, continue to Step 3 on page 143.

- If yes, complete the information on the SSI Dataset Snap Options subpanel (Figure 33 on page 144).
The SSI Dataset Snap Options subpanel allows you to limit the output data set to your specified data-set characteristics.

**Figure 33: SSI Dataset Snap Options subpanel**

5. Did you allow volume mirror splitting on the SSI Snapshot Options subpanel?

- If **no**, you have completed setting your SSI options and the XBM ISPF interface returns you to the File List panel. Continue with the procedure “Creating a snapshot template for a hardware snapshot” on page 145.

- If **yes**, the Remote SSI Snapshot Options subpanel (Figure 34 on page 144) is displayed. Complete the information on this panel, and press **Enter**. This panel allows you to set values that control remote and local volume mirror splitting.

**Figure 34: Remote SSI Snapshot Options subpanel**

After you complete the Remote SSI Snapshot Options subpanel and press **Enter**, you return to the File List panel.

**Where to go from here**

You can change SSI options at any time. Changes to SSI options take effect when you exit the SSI Options subpanel, except for the value that you specify for the Device discovery option. A change to the Device discovery option is saved to the repository when you exit the SSI Options subpanel. However, discovery of devices does not occur until XBM or the SSI component is restarted.

When you finish setting SSI options, follow the steps described in “Creating a snapshot template for a hardware snapshot” on page 145 to set up the snapshot template.
Creating a snapshot template for a hardware snapshot

You create a snapshot template to set up the cache required to store preimages of data sets registered to XBM by your utility.

Before you begin

Complete the following tasks before creating a snapshot template:

- Review the information in “Enabling SSI snapshots in SSI options and snapshot templates” on page 135.
- Set SSI options as described in “Setting SSI options for hardware snapshots” on page 142.
- Review the options described in “Snapshot template options for hardware snapshots” on page 291. These options determine the characteristics for the snapshot template that you define. The section identifies the information that you enter on each panel when you define the snapshot template.

To create a snapshot template for a hardware snapshot

1. Create a new template.
   
a. From the File List panel, choose File => New and press Enter to display the New File Type subpanel.
b  From the New File Type subpanel, type 1 (Management Set) in the selection entry field and press Enter to display the Object Type Selection subpanel (Figure 35 on page 146).

**Figure 35: Object Type Selection subpanel**

```
<table>
<thead>
<tr>
<th>Management Set Edit - Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Set: *** NEW FILE ***</td>
</tr>
<tr>
<td>Modified: 05/05/2012</td>
</tr>
</tbody>
</table>

Select actions | Object Type Selection | Enter. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1=Change 2=Remo</td>
<td>Component</td>
<td>***************</td>
</tr>
<tr>
<td>S</td>
<td>1. DB2</td>
<td>2. Snapshot</td>
</tr>
<tr>
<td></td>
<td>3. IMS</td>
<td></td>
</tr>
</tbody>
</table>

F1=Help F12=Cancel
```

c  In the Component field, type 2 (Snapshot) and press Enter.

The Snapshot Managed Object Information subpanel (Figure 36 on page 146) is displayed.

**Figure 36: Snapshot Managed Object Information subpanel**

```
<table>
<thead>
<tr>
<th>Snapshot Managed Object Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management set: *** NEW FILE ***</td>
</tr>
<tr>
<td>Object : BMCXB.MSNAPSHOT_TEMPLATE</td>
</tr>
</tbody>
</table>

Cache limit . . . . 0
Limit in (units) : 1
1. KB Cache type : 1
   1. None
   2. MB
   3. GB
   4. TB
   5. PB
   6. EB
2. MB
3. GB
4. TB
5. PB
6. EB

Priority . . . . 0 (0=low - 9999=high)
Compression . . 2
1. Compression
2. No compression

F1=Help F12=Cancel
```

2  On the Snapshot Managed Object Information subpanel, provide information for the fields described in “Snapshot template options for hardware snapshots” on page 291. if you are defining a template to be used by both hardware and software snapshots. Otherwise, leave the values at their default settings.

3  When you finish entering information, press Enter.
The Snapshot template options subpanel (Figure 37 on page 147) is displayed.

**Figure 37: Snapshot Template Options subpanel**

<table>
<thead>
<tr>
<th>Manag</th>
<th>Management set : *** NEW FILE ***</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>1=Cha</td>
<td>Allow SSI assisted snapshots . . . . . . . . 1 1. Yes 2. No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cache Limit Allow SSI assisted snapshots . . . . . . . 1 1. Yes 2. No</td>
<td></td>
</tr>
<tr>
<td>Prior</td>
<td>Compr F1=Help F12=Cancel</td>
<td></td>
</tr>
<tr>
<td>F1=H</td>
<td>F1=Help F12=Cancel</td>
<td></td>
</tr>
<tr>
<td>F7=B</td>
<td>F1=Help F12=Cancel</td>
<td></td>
</tr>
</tbody>
</table>

4 On the Snapshot template options subpanel, type 1 (Yes) in the selection field to enable SSI snapshots and press Enter.

The SSI Assisted Snapshot Options subpanel (Figure 38 on page 147) is displayed.

**Figure 38: SSI Assisted Snapshot Options subpanel**

<table>
<thead>
<tr>
<th></th>
<th>SSI Assisted Snapshot Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prior Compr</td>
<td>Perform synchronize volume mirror at register . . . . . 2 1. Yes 2. No</td>
</tr>
<tr>
<td>Cache type .</td>
<td>Resynchronize volume mirror after completion . . . . . . 1 1. Yes 2. No</td>
</tr>
<tr>
<td>F1=Help</td>
<td>F1=Help F12=Cancel</td>
</tr>
</tbody>
</table>

5 On the SSI Assisted Snapshot Options subpanel, specify the information shown in “Snapshot template options for hardware snapshots” on page 291.

6 Press Enter to display the Management Set Edit - Summary panel.

7 Save the template.

   a On the Management Set Edit - Summary panel, choose File => Save.

   b On the Save As subpanel, enter the name of the management set in the New file name field and press Enter.

   c Press F12 to return to the File List panel.
Where to go from here

When you finish creating your snapshot template, activate the management set containing the template, as described in “Activating the management set” on page 148.

**Note**

Be sure to create an appropriate configuration to support the cache that you specified in your snapshot template. Failure to do this prohibits XBM from falling back to a software snapshot in case the SSI-assisted snapshot cannot be successfully completed.

Activating the management set

This task explains how to activate the management set containing your SSI snapshot template by using the File action bar.

For additional methods of activating management sets, see “Activating a management set” on page 127.

1. From the File List panel, select the management set that contains the snapshot template.

2. Choose **File => Activate** and press **Enter** to activate the management set.

Running the utility job

Initiate your utility job by following the instructions provided in the documentation that came with your snapshot utility.

When the snapshot job begins, XBM first attempts an SSI-assisted snapshot to provide preimages to the snapshot utility. If the appropriate mirrored pair or data set snap capability are unavailable and you have specified a software cache, XBM falls back to a traditional software snapshot to successfully complete the snapshot job.

Reviewing the status of a hardware snapshot job

You can review the status of your snapshot jobs in the following ways:
You can review the messages generated by XBM during the snapshot.

You can use the XBM monitors to review the status of DASD.

You can use the SSI monitor to check and manage the status of your hardware devices.

**Snapshot messages**

This section describes some of the messages that XBM produces that can help you determine the status of your XBM job.

For a more detailed explanation of specific messages, BMC Documentation Center from the BMC Support Central site (http://www.bmc.com/support). In a sysplex environment, each participating XBM subsystem issues messages. Certain messages identify the subsystem where the reported action occurred.

**Start messages**

When a data set is registered by a supported snapshot utility for a software or hardware snapshot, XBM displays the following message:

```
BMC73551I  11.00.55  xbmssid Data set dsn registered for Snapshot at xbmssid
```

When the utility starts the snapshot job, XBM generates the following message that shows the job, the name of the data set, and which XBM subsystem is processing the job. The specified XBM subsystem might be a remote subsystem.

```
BMC73552I  11.11.59  xbmssid Snapshot started for job jobname, data set dsn at xbmssid
```

**Hardware snapshot messages**

If a hardware data set snapshot is processed, XBM generates the following message:

```
BBMC73358I 11.11.59  xbmssid Snap data set for dsn is target dsn
BMC73354I 11.11.59  xbmssid Requested hardware_feature action successfully initiated
```

If a hardware volume mirror snapshot is processed, the messages that XBM generates depend on the vendor or feature.

- For a PPRC or HTC device, XBM displays the following messages:
  ```
  BMC73354I  11.12.05  RCUX Requested Suspend action successfully initiated
  BMC73356I  11.12.05  xbmssid PPRC device 5308(0016)
  BMC73559I  11.12.05  xbmssid PPRC or HTC hardware features used for data set dsn
  ```
For an EMC TimeFinder device, XBM displays the following messages:

- BMC73354I 11.30.04 xbmssid Requested Split action successfully initiated
- BMC73355I 11.30.04 xbmssid STD device B234(0234), BCV device B234(0599)
- BMC73354I 11.30.04 xbmssid Requested BcvHold action successfully initiated
- BMC73356I 11.30.04 xbmssid BCV device B234(0599)
- BMC73559I 11.12.05 xbmssid EMC TimeFinder hardware features used for data set dsn

If XBM is processing a hardware data set snapshot and the snapshot utility has grouped the data sets for collective action, XBM generates the following message:

- BMC73367I 11.11.59 xbmssid Prior SNAP action used for xbmssid

### Snapshot stop messages

When a snapshot job stops, XBM generates the following message that indicates the name of the job, the data set, and which XBM subsystem processed the job:

- BMC73553I 14.26.49 xbmssid Snapshot stopped for job jobname, data set dsn, return code = 0, reason code = 0 at xbmssid

If a snapshot job ends abnormally without sending a stop command to XBM, XBM performs termination cleanup for the snapshot job and generates the following message:

- BMC73550I 11.01.01 xbmssid Termination cleanup performed for SNAPSHOT job jobname (asid), step stepname

### DASD volume status

The XBM SSI monitor displays the status of DASD and provides comprehensive statistical information regarding the use of those devices.

For instructions on displaying DASD status, see the section “Displaying generic DASD volumes” on page 212.

### Performing hardware functions online

Through vendor-specific object panels in the SSI monitor, you can use XBM to perform functions at the volume level on hardware devices while online.

For instructions on performing functions against hardware devices, see “Monitoring and managing storage devices” on page 209.
Enabling Instant Snapshots

The Storage Systems Integration (SSI) component of the EXTENDED BUFFER MANAGER (XBM) product, when used with supported BMC utilities, creates Instant Snapshots by exploiting the capabilities of intelligent storage devices.

These Instant Snapshots are physical data copies that are almost instantaneous because they require no I/O. In addition to a near-instantaneous copy process, Instant Snapshots offer a near-instant restore phase during database recovery. Figure 39 on page 151 shows an example of this process.

Figure 39: Example of an Instant Snapshot

This chapter describes how to enable XBM to process Instant Snapshots.

An Instant Snapshot requires specific additional software and hardware to process the snapshot. In addition to XBM, you must have one of the supported BMC utilities and supported intelligent hardware devices.

This section describes the software and hardware required to do an Instant Snapshot. It also describes the way that XBM uses these utilities and storage devices to process the Instant Snapshot.
Supported software

XBM supports the following BMC utilities for Instant Snapshot:

- COPY PLUS for DB2
- RECOVER PLUS for DB2
- REORG PLUS for DB2
- IMAGE COPY PLUS
- RECOVERY PLUS for IMS
- MAXM Reorg/EP
- MAXM Reorg/Online
- XBM utility program (a VSAM and sequential data set copy utility)
- RECOVERY UTILITY for VSAM

For more information about how a particular utility works with XBM, see the documentation for that utility.

Supported hardware

XBM supports the following intelligent storage devices for Instant Snapshot:

- EMC Symmetrix hardware with TimeFinder or FlashCopy software
- Hitachi 7700E/9900 devices with FlashCopy Version 2
- IBM RAMAC Virtual Array (RVA) with a supporting version of IBM Extended Facilities Product
- IBM Enterprise Storage Subsystem (Shark) devices capable of PPRC or FlashCopy 2 operations (including Extended Address Volumes (EAV))
- Oracle StorageTek Shared Virtual Array (SVA) with a supporting version of IBM Extended Facilities Product or StorageTek SVA Administrator
Note
Support for IBM RAMAC Virtual Array (RVA) and Oracle StorageTek Shared Virtual (SVA) products will be phased out in a future release of XBM.

How Instant Snapshots work

Instant Snapshots differ significantly from software and hardware snapshots.

Because they require no I/O, Instant Snapshots are nearly instantaneous. Instant Snapshots require no snapshot template. The XBM control mechanism for Instant Snapshots is the SSI Options subpanel.

Instant Snapshots typically involve the following steps:

1. The storage hardware is properly configured, and the targeted data resides on the hardware.

2. XBM SSI options are set to enable Instant Snapshot.

3. A supported BMC utility specifically requests an Instant Snapshot.

4. If a quiesce was specified in the snapshot job, the utility quiesces the data before executing the snapshot.

5. XBM ensures that an appropriate hardware configuration exists for the data and issues the appropriate request to the hardware.

6. The data on the source device is duplicated on the target device (can be the same device or another device within the same control unit or frame) and the snapshot is complete.

If a restore operation is requested through a BMC recovery utility, XBM restores the original data by copying, or snapping, the data back to the original location on the source device. The recovery utility applies any subsequent log records to complete the recovery.

Performing Instant Snapshots

Before you can use the snapshot-enabled utilities to create an Instant Snapshot, you must set up the hardware environment and XBM.

1. Setting up the hardware environment
Setting up the hardware environment

Instant Snapshots rely on intelligent storage devices to duplicate physical data.

You should consult your storage device documentation or vendor to make sure that your hardware is set up and working correctly before beginning an Instant Snapshot. The following sections list the software and hardware required for Instant Snapshots.

**XBM components**

To use the SSI component for Instant Snapshots, you must also install and configure the snapshot features of one of the following XBM components:

- the VSAM component
- the DB2 component
- the IMS component

**Storage devices**

The SSI component requires one of the supported vendors’ intelligent storage devices and appropriate supporting software for Instant Snapshots.

These devices and their accompanying software should be installed, configured, and running successfully on your system.
For the list of supported hardware, see “Supported hardware” on page 134.

---

**Note**
The source and target disks must be online to the host.

---

Contact your intelligent storage hardware vendor to ensure that the software for your devices has appropriate PTFs and microcode installed to support XBM hardware-assisted snapshot processing.

### Additional considerations for EMC devices

Before you can use an EMC Symmetrix device in a hardware snapshot or any EMC-specific functions from the XBM ISPF monitor, you must have one of the following:

- EMC Symmetrix Control Facility (SCF) subsystem installed and functioning.
- EMC devices that support Flashcopy (contact EMC for licensing information)

---

**Note**
If you use EMC SCF, the EMC SCF link library now contains the required API modules that were previously shipped with XBM. To obtain the necessary EMC components, contact EMC and request the most recent version of the ResourcePak-Base for OS/390 and z/OS.

---

EMC Symmetrix devices require microcode level 5x66 or later to support Instant Snapshots. BMC recommends that you use the latest EMC-recommended levels of microcode for your device configuration.

In addition, if you have EMC TimeFinder version 5.3.1 or later, you might need two EMC products. If you are doing mirroring, you will need EMC TimeFinder/Mirror product. If you are doing data-set-level or Instant Snapshots, you will need EMC TimeFinder/Snap. EMC separated the mirroring and snap capability in the 5.3.1 release of EMC TimeFinder. For more information, see the EMC documentation.

---

**Note**
If you have the EMC Symmetrix Automated Replication (SAR) feature of SRDF in your environment, XBM will not use the active members in a SAR relationship for snapshot processing. XBM recognizes these volumes and automatically bypasses them to use alternate BCVs. Doing so avoids any potential conflicts from occurring between the EMC SAR feature and XBM.

### Additional considerations and restrictions for FlashCopy

To use FlashCopy version 2 with XBM, you must meet the following requirements:
For the operating system, the DFSMS level must be OS/390 2.10 or z/OS 1.3 (or later) and all appropriate IBM maintenance must be installed.

You must configure XBM with the security authority to create and delete the database objects upon which you are performing Instant Snapshots.

For FlashCopy version 2, you must ensure that all IBM-provided APARs that enable FlashCopy version 2 to support data-set-level operations have been applied. FlashCopy version 2 did not initially support the data-set-level operations that XBM requires to perform an Instant Snapshot. These IBM APARs provide the required operations, such as copying to an existing data set.

The following restrictions exist when using XBM with FlashCopy:

Instant Snapshot processing uses the FASTREPLICATION(REQUIRED) keyword when the SSI option or the value supplied by the utility for DATAMOVER(.....) has a value of NONE or nulls. If the value is something other than NONE or nulls, Instant Snapshot processing uses the FASTREPLICATION(PREFERRED) keyword.

**Note**

PTF BPE0316 changed the functionally of the XBM SET DATAMOVER option. The DATAMVR parameter of the snapshot-enabled utility now overrides the XBM SET DATAMOVER option entirely.

The default value of the DATAMVR parameter of snapshot-enabled utility is **NONE** if it not used. Therefore, if the snapshot-enabled utility does not request to use the DATAMVR feature, any XBM SET DATAMOVER option is ignored and is not used. If the utility issues the DATAMVR parameter, the XBM SET DATAMOVER option is overridden and the DATAMVR setting of the utility is used (FDR, DSS, etc.).

You must be able to use the DFSMSdss COPY command with FASTREPLICATION(REQUIRED) keyword in batch mode to use FlashCopy.

The following functional IBM restrictions currently affect FlashCopy use:

FlashCopy requires all volumes containing target data set extents to reside in the volume list. XBM adds the required volumes if necessary.

All source volumes in a multiple-volume data set must reside within the same IBM Shark or Hitachi enclosure. This restriction applies to System Managed Storage (SMS) and non-SMS managed data sets.

The ESOTERIC unit parameter is not supported.

The SMS classes of the data source and target volumes can affect the expected results, as shown in Table 35 on page 157.
**Table 35: SMS class results**

<table>
<thead>
<tr>
<th>Source</th>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS source</td>
<td>SMS target</td>
<td>▪ The default class is in the same SMS class as a source.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ The snapshot options, supported utility, or Automatic Class Selection (ACS) routines can specify an alternate SMS class.</td>
</tr>
<tr>
<td>non-SMS target</td>
<td></td>
<td>▪ A non-SMS target is supported only if a target data set already exists. The snapshot uses existing extents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ If the target data set does not exist, the snapshot ignores the volume list and the target is in the same SMS class as the source.</td>
</tr>
<tr>
<td>non-SMS source</td>
<td>SMS target</td>
<td>▪ The class is specified through an XBM or utility input or through ACS routines.</td>
</tr>
<tr>
<td>non-SMS target</td>
<td></td>
<td>▪ If a target data set does not exist, the snapshot uses the user-supplied or XBM-supplied volumes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ If the target data set exists, the snapshot adds the volumes of the target data set to the volume list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ If an existing target is in a different storage enclosure, the snapshot fails.</td>
</tr>
</tbody>
</table>

When you set up an XBM subsystem to process Instant Snapshots with any of the supported hardware devices (regardless of vendor), BMC recommends that you disable volume allocation or volume pooling software to avoid their affecting XBM. Because XBM is a long-running task and because of the way that FlashCopy processes Instant Snapshots, any products that manage storage allocations might accrue excessive entries over time if you do not disable allocation control for XBM.

An example of such products is the BMC MainView SRM product. To prevent MainView SRM from changing the Instant Snapshot allocations, specify the following DD statement in the XBM started task:

```
//PROIGN DD DUMMY
```

For more information about controlling allocation, see the MainView SRM documentation or the documentation for your volume allocation or pooling software.
You can use XBM with FlashCopy to produce Instant Snapshots in an all SMS-managed database environment or in a mixed SMS-managed and non SMS-managed environment. **Table 36 on page 158** shows how allocations will work in these environments with and without ACS rules.

### Table 36: Allocation considerations

<table>
<thead>
<tr>
<th>Source</th>
<th>ACS rule exists and volume list passed</th>
<th>No ACS rule exists and volume list passed</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS-managed data set</td>
<td>allocation controlled by ACS rule</td>
<td>allocation on same SMS storage class as source</td>
</tr>
<tr>
<td>non-SMS-managed data set</td>
<td>allocation controlled by ACS rule</td>
<td>allocation will use the volume list that was passed</td>
</tr>
</tbody>
</table>

As seen in **Table 36 on page 158**, if the target for the Instant Snapshot needs to reside on a specific SMS volume pool, you should have ACS rules set up to control that allocation.

### Additional considerations for IBM RVA and STK SVA devices

To support Instant Snapshots using IBM RVA or STK SVA devices, XBM requires the SIBBATCH program.

The SIBBATCH program is an IBM Extended Facilities Product (IXFP) utility program. The library for the SIBBATCH program must be copied to an APF-authorized library on your system.

Reference the location of the SIBBATCH library by using your MVS linklist or the XBMXTASK DD statement in the JCL generated for the XBM PROC.

**Note**

If you reference the location of the SIBBATCH library in your MVS linklist, remove or comment out the XBMXTASK DD statement in the XBM PROC JCL.

### Setting SSI options for Instant Snapshots

You use options from the SSI Options subpanel to control Instant Snapshots.

XBM stores these user-specified options in the XBM repository. When you start XBM for the first time, XBM uses default values for these options.
Note

Unlike software and SSI-assisted snapshots, Instant Snapshots do not require a snapshot template. The utility requesting the snapshot and the SSI options control the Instant Snapshots.

Before you begin

- You can change SSI options at any time. Changes to SSI options take effect when you exit the SSI Options subpanel, except for the value that you specify for the Device discovery option. A change to the Device discovery option is saved to the repository when you exit the SSI Options subpanel. However, discovery of devices does not occur until the XBM subsystem or the SSI component is restarted.

- Review “SSI options for Instant Snapshots” on page 293 for information about the SSI options that you need to define. This section identifies the information that you enter on each panel when you set the SSI options.

To specify or change the values of the SSI options

1. From the File List panel, choose Options => SSI options and press Enter to display the SSI Options subpanel (Figure 40 on page 159).

   **Figure 40: SSI Options subpanel**

   ![SSI Options subpanel]

   2. On the SSI Options subpanel, provide information for the fields described in “SSI options for Instant Snapshots” on page 293. Ensure that you set Allow Instant Snapshots to 1 (Yes).

   3. Press Enter to activate the new values and save them in the XBM repository.
Running the utility job

Initiate your utility job by following the instructions provided in the documentation that came with your snapshot utility.

The utility job must specifically request an Instant Snapshot (referred to by some utilities as a DSSNAP). Consult the documentation for your BMC utilities for more information.

Note
If you are using the XBM utility program to create the snapshot, see “Using the XBM utility program for a VSAM snapshot copy” on page 311.

Reviewing the status of an Instant Snapshot job

This section describes different techniques that you can use to review the status of your snapshot job.

- You can review the messages generated by XBM during the snapshot.
- You can use the XBM monitors to review the status of DASD.
- You can use the SSI monitor to check and manage the status of your hardware devices.

Snapshot messages

This section describes some of the messages that XBM produces that can help you determine the status of your XBM job.

For a more detailed explanation of specific messages, see messages in the BMC Documentation Center. In a sysplex environment, each participating XBM subsystem issues messages. Certain messages identify the subsystem where the reported action occurred.
If an Instant Snapshot is used to create the snapshot, XBM generates the following messages:

BMC73358I 11.11.59  xbmssid  Snap data set for  dsn  is  targetdsn  
BMC73354I 11.11.59  xbmssid  Requested  hardware_feature  
          action successfully initiated

**DASD volume status**

The XBM SSI monitor displays the status of DASD and provides comprehensive statistical information regarding the use of those devices.

For instructions on displaying DASD status, see the section “Displaying generic DASD volumes” on page 212.

**Performing hardware functions online**

Through vendor-specific object panels in the SSI monitor, you can use XBM to perform functions at the volume level on hardware devices while online.

For instructions on performing functions against hardware devices, see “Monitoring and managing storage devices” on page 209.
Getting started with monitoring

The EXTENDED BUFFER MANAGER (XBM) product provides monitoring features that allow you to display the following information:

- XBM status information through the consoles

status of utility processing:

- status of certain snapshot-enabled utilities through the Utility monitor
  These utilities include the XBM utility program, COPY PLUS for DB2, and REORG PLUS for DB2.

- information about supported intelligent storage devices through the Storage Systems Integration (SSI) monitor

- status of suspend/resume groups through the S/R monitor

In addition, the SSI monitor allows you to manage and manipulate the storage devices.

Note
XBM also supports diagnostic and trace monitors, which BMC Support uses when diagnosing problems. For more information about these monitors, contact BMC Support.

This chapter provides introductory information about each type of monitors. For more in-depth information, see subsequent chapters.

Displaying information through the XBM consoles

You can use the XBM consoles to display the following information:

- status of the DB2, IMS, VSAM, SSI, and PSS components
- activation status of management sets
- summary information about the XBM installation

**To display information through the XBM consoles**

1. From the File list panel, select **Console => consoleType**.

   The variable `consoleType` represents the console that you are displaying. You can display the consoles for components, management sets, or XBM. The consoles for Configurations and Data sets do not allow you to display information.

2. In the Console window, enter the search criteria, select **Display**, and press **Enter**.

   You can use a wildcard character in the **Name** field.

3. If you are working in a parallel sysplex environment, select an XBM subsystem at the Destination Subsystem panel and press **Enter**.

   For more information about selecting the XBM subsystem, see “Displaying detailed information for a remote XBM subsystem” on page 80.

4. Review the information in the Console Output panel.

   Figure 41 on page 164 shows how this panel might look if you selected the XBM console.

   **Figure 41: Example of console output**

   ```
   Console Output Row 1 to 11 of 21
   BMC73050I  11.24.28 XBMA DISPLAY XBM
   BMC73007I* 11.24.28 XBMA XBMA Version 6.1.00 (c) copyright BMC SOFTWARE, INC. 1993-2013, U.S. Patents 5,664,217 and 6,202,136
   BMC73150I* 11.24.28 XBMA XBMA Version 6.1.00 initialization complete at 00:12:42 on Dec 15,2012
   BMC73059I  11.24.28 XBMA Full support for component ZIIP enabled
   BMC73059I  11.24.28 XBMA Snapshot support for component PSS enabled
   BMC73833I* 11.24.28 XBMA CF Structure XBMDB2_CACHE1 storage: used = 2K, HWM = 2 K, total allocation = 517588 K
   Command ===>
   F1=Help     F7=Bkwd     F8=Fwd     F12=Cancel
   ```

   For more information about displaying XBM information through the consoles, see the procedure for the type of information that you want to display:

   - “Displaying the status of the XBM subsystem” on page 54
   - “Displaying the status of an XBM component” on page 60
   - “Displaying the status of a management set” on page 171
What type of performance and statistical information is available through the monitors

The XBM performance monitors provide records of activity and statistical information from the XBM subsystem. You can display the XBM monitor output on the screen, or you can print the output to the ISPF print data set. You can use the statistics to analyze and tune the performance of your XBM subsystem.

XBM performance monitor

Through the XBM performance monitor, you can review information about the extended buffer, data sets, and PSS information.

To display statistics and information for the PSS environment, the PSS component must be started.

For more information, see the following sections:

■ “Displaying data set statistics for snapshot utilities” on page 180

■ “Displaying PSS statistics” on page 83

Managing information within the monitors

From these monitors, you have the ability to perform the following functions:

■ If you are in a parallel sysplex environment, you can choose to monitor information about a remote XBM subsystem from the one into which you are logged. The remote XBM subsystem must be in the same XCF group.

For more information, see “Displaying detailed information for a remote XBM subsystem” on page 80.

■ XBM provides the option of recording historical information about the subsystem’s operation to System Management Facilities (SMF) records. You can analyze these records to detect trends and to determine the effectiveness of XBM over time.
What status information is available about the snapshot-enabled utilities

XBM also provides monitors that allow you to display information for select snapshot-enabled utilities.

These monitors include the Suspend/Resume (S/R) monitor and the XBM Utility monitor.

Using the S/R monitor

The S/R monitor provides information about the status of suspend/resume groups and their data sets, as well as the associated utility’s intention to suspend mirroring.

This procedure explains how to display suspend/resume group status information. For detailed information about the S/R monitor, see “Displaying suspend/resume group status” on page 175.

To access the S/R monitor

1. From the File List panel, choose Monitor => S/R monitor and press Enter.

2. Access the Suspend Resume Monitor Selection subpanel.

3. Enter filtering criteria and press Enter.

4. On the S/R Groups panel, review information about the suspend/resume groups that match your selection criteria.

   From this panel, you can select individual suspend/resume groups and display their status.

Figure 42 on page 166 shows an example of the S/R Groups monitor.

Figure 42: Example of the S/R monitor

<table>
<thead>
<tr>
<th>Group Name</th>
<th>State</th>
<th>Job</th>
<th>Entries</th>
<th>Volumes</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBMQA</td>
<td>Suspended</td>
<td>XBMESM</td>
<td>10</td>
<td>1</td>
</tr>
</tbody>
</table>

---

166  EXTENDED BUFFER MANAGER and SNAPSHOT UPGRADE FEATURE User Guide
Using the XBM Utility monitor

The XBM Utility monitor allows you to monitor your snapshot utility jobs as they run.

You can analyze statistics gathered about the performance of select snapshot-enabled utilities. From this monitor, you can display statistics for the XBM utility program, COPY PLUS, and REORG PLUS. You can also send utility commands to the Utility monitor. For detailed information, see “Using the Utility monitor” on page 192.

To access the Utility monitor

1. From the File List panel, choose Monitor => Utility Monitor and press Enter.

2. At the Utility Job Selection panel, select the job that you want to manage.

You can use filtering criteria to filter the job list, and you can sort by various fields. Figure 43 on page 167 shows an example of the Utility monitor.

How to display and manage storage devices within XBM

You use the SSI monitor to monitor and control intelligent hardware devices through the XBM ISPF interface. To use the SSI monitor, the SSI component must be started and properly configured for the XBM subsystem that you are accessing.

XBM gathers information about the supported devices during the discovery process when you start the SSI component. For more information about the SSI component, see “How the SSI component works” on page 90.
Types of activities

You can perform the following types of activities through the SSI monitor:

■ display volume status information for direct access storage devices (DASD)
  When you display information for DASD devices, you have the option to display summary and general information for devices that match criteria that you enter and detailed information for individual DASD volumes.
  For information about displaying DASD volume status information, see “Displaying generic DASD volumes” on page 212.

■ perform functions at the volume level on hardware devices
  The functions that you can perform depend on the type of hardware devices. Examples of functions include displaying device information, establishing and suspending pairs, displaying mirrors, and so on.
  For more information, see the section for your type of hardware device:
    — “Managing PPRC objects” on page 216
    — “Managing EMC TimeFinder objects” on page 225
    — “Managing Hitachi ShadowImage and Remote Copy objects” on page 235

Using the SSI monitor

This section provides a general overview for using the SSI monitor.

For a more detailed description, see “Monitoring and managing storage devices” on page 209.

To access the SSI monitor

1 From the File List panel, select Monitors => SSI monitor.

2 Access the SSI selection panel, enter the necessary search criteria to find the device that you want to manage, and press Enter.
   This search criteria includes such things as the type of device (PPRC, EMC, or Hitachi), the starting address, the ending address, the VOLSER, and so on.

3 At the SSI status selection panel, select the status of the devices that you want to display (online, offline, or all) and press Enter.
The SSI monitor lists the devices that match your criteria. From this panel, you can drill down to display devices in more detail or perform actions on the devices.

**Note**
You can manage hardware devices associated with a remote XBM subsystem in the SSI monitor instead of the local subsystem to which you are currently connected. To do so, see “Displaying detailed information for a remote XBM subsystem” on page 80.

Figure 44 on page 169 shows an example of the SSI monitor for Hitachi devices.

**Figure 44: Example of the SSI monitor**

```
File  View  Options  Console  Monitor  User  Help

Viewing XOSI(XBMQA2) from XOSI  Row 1 to 9 of 500

Hitachi Objects
Simplex devices . . :     61        Primary devices . . :    439
Duplex devices  . . :    439        Secondary devices . . :      0

Select actions on the following Hitachi objects, then press enter.
1=Zoom 2=EstPair 3=EstPair(Resync) 4=Suspend 5=DelPair 6=Recover
S  Addr  DType  Status   Volser  SSid  CUSNum  CCA  L  STATE
5300 3390   Online  BCSSI1 0030  40118  00 P DUPLEX
5301 3390   Online  SYZO2C 0030  40118  01 P DUPLEX
5302 3390   Online  DBAWK1 0030  40118  02 P DUPLEX
5303 3390   Online  DEVS93 0030  40118  03 P DUPLEX
5304 3390   Online  HT5304 0030  40118  04 SIMPLEX
5305 3390   Online  HT5305 0030  40118  05 SIMPLEX
5306 3390   Online  HT5306 0030  40118  06 P DUPLEX
5307 3390   Online  MM5307 0030  40118  07 P DUPLEX
5308 3390   Online  --5308 0030  40118  08 P DUPLEX

BMC73957I View is by Address. View selection filtering is active.
```
Monitoring BMC snapshot-enabled utilities

This chapter describes how to use XBM to monitor snapshot jobs.

Displaying XBM status information

XBM provides status information to help you monitor its operation.

You can display the status of

- the XBM subsystem
- an XBM component (DB2, VSAM, IMS, or PSS)
- a management set

You can access the displays from the XBM ISPF interface or through the MVS system console.

This section describes how to display the status of a management set.

For information about displaying the status of an XBM subsystem or component, see “Displaying the status of the XBM subsystem” on page 54.

Displaying the status of a management set

You use the DISPLAY MANAGEMENT SET command to determine whether a management set is active or to display the status of all management sets.

You can do this through either the ISPF interface or the MVS system console.
To display the status by using the ISPF interface

1 On the File List panel, choose **Console => Management Set** and press **Enter** to display the Console - Management Set subpanel (Figure 45 on page 172).

**Figure 45: Console - Management Set subpanel**

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Options</th>
<th>Console</th>
<th>Monitor</th>
<th>User</th>
<th>Help</th>
</tr>
</thead>
</table>

Viewing XBM4(XBMQA) from XBM4  Row 1 to 13 of 108

```
Select Console - Management Set
  1=Ope
  S  A
  Enter management set command information and press Enter.
  
  Name ... *
  
  Command ...
  1. Display
  2. Activate
  3. Deactivate
  4. Reset statistics

F1=Help F12=Cancel
```

2 In the **Name** field, type the name of the management set that you want to display.

---

**Note**

You can use any XBM pattern-matching character in the **Name** entry field. For example, type * in the field to display all management sets. For more information about pattern matching, see “Understanding XBM pattern-matching” on page 255.

---

3 Type **1** (Display) in the **Command** entry field, and press **Enter** to display the output of the command (Figure 46 on page 172).

---

**Note**

The output is also written to the XBM subsystem SYSPRINT data set.

**Figure 46: DISPLAY MANAGEMENT SET command output**

```
BMC730501 16.54.30 XOSO DISPLAY MANAGEMENT SET *
BMC730561 16.54.30 XOSO Management set DBAD_ALL_NC is active
BMC730561 16.54.30 XOSO Management set DBZ_ALL_NC is active
BMC730561 16.54.30 XOSO Management set DEBS_XBM is active
BMC730561 16.54.30 XOSO Management set DEBX_ALL_NC is active
BMC730561 16.54.30 XOSO Management set DECA_DSNDBXX is not active
BMC730561 16.54.30 XOSO Management set DECA_XBM is active
```

To display the status by using the MVS system console

1 From the MVS system console, you can use the DISPLAY MANAGEMENT SET command to display management sets in the following ways:
To display a specific management set from the MVS system console, type the following command:

```
ssid DISPLAY MANAGEMENT SET name
```

To display all management sets that have names that begin with the specified leading characters, type the following command:

```
ssid DISPLAY MANAGEMENT SET partialName*
```

To display all management sets contained in the XBM repository, type the following command:

```
ssid DISPLAY MANAGEMENT SET *
```

The variable `ssid` represents the name of the XBM subsystem. The variable `name` represents the name of the management set, and the variable `partialName` represents the initial characters in the names of the management sets that you want to match.

### Displaying performance statistics and status

XBM provides several monitors to display performance statistics and status for your XBM objects and processes.

This section contains procedures for using the XBM monitors to display suspend/resume group status and statistics for the snapshot utilities.

Table 37 on page 173 provides a complete list of the types of snapshot monitors.

**Table 37: Types of monitoring**

<table>
<thead>
<tr>
<th>Category</th>
<th>Descriptions</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSI DASD Volume Status</td>
<td>■ Summary DASD volume status—information about the number of online and offline DASD volumes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ General DASD volume status—comprehensive information about the status of all DASD volumes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Individual DASD volume status—detailed information about the status of a specific DASD volume</td>
<td></td>
</tr>
</tbody>
</table>

“Displaying generic DASD volumes” on page 212
<table>
<thead>
<tr>
<th>Category</th>
<th>Descriptions</th>
<th>Reference</th>
</tr>
</thead>
</table>
| Suspend/Resume Group Status      | ■ General suspend/resume group status—general information about the mirroring status of suspend/resume groups, including number of groups defined as suspend/resume and the number of groups currently suspended or resumed.  
■ Summary suspend/resume group status—comprehensive information about the mirroring status of all suspend/resume groups  
■ Individual suspend/resume status—detailed information about the mirroring status of a specific suspend/resume group  
■ Individual suspend/resume group entry detail—detailed information about a specified data set in a suspend/resume group | “Displaying suspend/resume group status” on page 175                                                                                               |
| Snapshot Utilities Statistics    | ■ General snapshot utilities data set statistics—general information about the performance of all snapshot utilities data sets. A selection option allows you to display the performance of a subset of snapshot utilities data sets that match the selection criteria.  
■ Summary snapshot utilities data set statistics—comprehensive information about the performance of all snapshot utilities data sets with read and write activity  
■ Individual snapshot utilities data set statistics—information about the performance of a specific snapshot utilities data set  
■ Detail snapshot utilities data set statistics—detailed information about a specific snapshot utilities data set | “Displaying data set statistics for snapshot utilities” on page 180                                                                                   |
Displaying suspend/resume group status

The Suspend/Resume (S/R) monitor provides information about the status of suspend/resume groups and their data sets, as well as the associated utility’s intention to suspend mirroring.

This procedure explains how to display suspend/resume group status information.

The following suspend/resume group information is available:

- **General suspend/resume group status**—general information about the mirroring status of suspend/resume groups, including number of groups defined as suspend/resume and the number of groups currently suspended or resumed

- **Summary suspend/resume group status**—comprehensive information about the mirroring status of all suspend/resume groups

- **Individual suspend/resume status**—detailed information about the mirroring status of a specific suspend/resume group

- **Individual suspend/resume group entry detail**—detailed information about a specified data set in a suspend/resume group

**To display suspend/resume group status**

1. From the File List panel, choose **Monitor => S/R monitor** and press **Enter**.

   **Tip**
   
   Alternatively, enter the SRMON Fastpath command.

2. Access the Suspend Resume Monitor Selection subpanel.

   - If you have **View selection on Monitor entry** set to **Yes**, the Suspend Resume Monitor Selection subpanel is automatically displayed.

   - Otherwise, choose **View => Selection** on the S/R Groups panel to open the Suspend Resume Monitor Selection subpanel.

3. On the Suspend Resume Monitor Selection subpanel (Figure 47 on page 175), enter **Group name** filtering criteria and press **Enter**.

   **Figure 47: Suspend Resume Monitor Selection subpanel**

   ```
   Suspend Resume Monitor Selection
   Enter filtering criteria for the field below.
   Group name . . *
   Pattern match characters (*, %, ?) may be used in name fields.
   F1=Help   F12=Cancel
   ```
4 (optional) On the S/R Groups panel, choose **View => fieldName** to sort the list of groups by a particular field. You can sort the list by the following fields:

- group name
- state
- job
- entries
- volumes

5 On the S/R Groups panel, review information about the suspend/resume groups that match your selection criteria. The following table describes the type of information that is available and how to access it.

<table>
<thead>
<tr>
<th>Type of status</th>
<th>To access the status information</th>
</tr>
</thead>
<tbody>
<tr>
<td>general</td>
<td>Review the top portion of the S/R Groups panel.</td>
</tr>
<tr>
<td>summary</td>
<td>Review the bottom portion of the S/R Groups panel.</td>
</tr>
<tr>
<td>individual status</td>
<td>On the S/R Groups panel, type <code>1 (Zoom)</code> in the selection field next to the suspend/resume group for which you want to display status and press <code>Enter</code> to display the S/R Groups entries subpanel.</td>
</tr>
</tbody>
</table>
| individual S/R group entry detail | 1 On the S/R Groups panel, type `1 (Zoom)` in the selection field next to the suspend/resume group for which you want to display status and press `Enter`.  
                                    | 2 On the S/R Groups entries subpanel, type `/` in the selection next to the entry you want to display and press `Enter` to display the S/R entry detail subpanel. |

**Displaying general status information for suspend resume groups**

The top portion of the S/R Groups panel provides general information about suspend/resume groups.
This information includes values for all suspend/resume groups that match the selection criteria that you have specified.

**Figure 48: S/R Groups panel — General status information**

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Options</th>
<th>Console</th>
<th>Monitor</th>
<th>User</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S/R Groups on 08/14/2012 at 09:42:25</td>
<td>Row 1 to 1 of 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Groups . . :</td>
<td>1</td>
<td>Suspended . . :</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuspIntent :</td>
<td>1</td>
<td>Resumed . . . :</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Displaying summary status for suspend resume groups**

The lower portion of the S/R Groups panel shows the summary status for suspend/resume groups.

**Figure 49: S/R Groups panel — Summary status for groups**

<table>
<thead>
<tr>
<th>1=Zoom 2=Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>S   A</td>
</tr>
<tr>
<td>XBMQA</td>
</tr>
</tbody>
</table>

********************** Bottom of data **********************

Table 38 on page 177 describes the fields on the lower portion of the S/R Groups panel.

**Table 38: Summary status information for suspend / resume groups**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>the selection column for performing actions on the associated suspend/resume group</td>
</tr>
<tr>
<td>A</td>
<td>whether the suspend/resume group is active</td>
</tr>
<tr>
<td></td>
<td>This column contains an asterisk (*) if the group is active and is blank if it is not active.</td>
</tr>
<tr>
<td>Group Name</td>
<td>the name of the suspend/resume group</td>
</tr>
</tbody>
</table>
The following states can be displayed:

- **NoIntent**—Intent to suspend mirroring has not been designated for this group.
- **SuspIntent**—Intent to suspend mirroring has been designated for this group.
- **Suspended**—Mirroring for members of this group is currently suspended.
- **SuspError**—An attempt was made to suspend mirroring for members of this group; however, one or more of the associated volumes were not successfully suspended.
- **Resumed**—Mirroring for members of this group has resumed for this group.
- **ResError**—An attempt was made to resume mirroring this group; however, one or more of the associated volumes were not successfully resumed.

### Displaying status of an individual suspend resume group

The S/R Group entries subpanel provides summary information about the individual data sets in the suspend/resume group.
To display this information, select a group from the lower portion of the S/R Groups panel and press Enter.

Figure 50: S/R Group Entries subpanel

Table 39 on page 179 describes the status information available on the S/R Group entries subpanel.

Table 39: Status information for individual suspend / resume groups

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>select column</td>
</tr>
<tr>
<td>A</td>
<td>whether the entry is active</td>
</tr>
<tr>
<td>Entry</td>
<td>the entry names for the individual entries in a group</td>
</tr>
<tr>
<td>State</td>
<td>the state of the entry in the group</td>
</tr>
<tr>
<td></td>
<td>The following states can be displayed:</td>
</tr>
<tr>
<td></td>
<td>■ NoIntent—Intent to suspend mirroring has not been designated for this entry.</td>
</tr>
<tr>
<td></td>
<td>■ SusIntent—Intent to suspend mirroring has been designated for this entry.</td>
</tr>
<tr>
<td></td>
<td>■ Suspended—Mirroring for this entry is currently suspended.</td>
</tr>
<tr>
<td></td>
<td>■ SuspError—An attempt was made to suspend mirroring for this entry, but the suspension was not successful.</td>
</tr>
<tr>
<td></td>
<td>■ Resumed—Mirroring for this entry has resumed for the group in which this entry resides.</td>
</tr>
<tr>
<td></td>
<td>■ ResError—An attempt was made to resume mirroring this entry, but the resume was not successful.</td>
</tr>
</tbody>
</table>
Displaying detail information for an individual suspend resume entry

The S/R Entry Detail subpanel provides detailed information about a specified data set in a suspend/resume group.

- To display this information, select a data set on the S/R Groups entries subpanel and press Enter.

**Figure 51: S/R Entry Detail subpanel**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job</td>
<td>the job name</td>
</tr>
</tbody>
</table>

Table 40 on page 180 describes the information available on the S/R Entry Detail subpanel.

**Table 40: Detail statistics for suspend / resume entries**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Requests</td>
<td>the total number of read requests by the users’ application</td>
</tr>
<tr>
<td>Prefetch reads</td>
<td>the total number of prefetch reads issued by XBM</td>
</tr>
<tr>
<td>Prefetch hits</td>
<td>the total number of read requests by the users’ application that were satisfied from the prefetch buffers</td>
</tr>
<tr>
<td>Hit pct</td>
<td>the percentage of application read requests that were satisfied by the prefetch buffers</td>
</tr>
<tr>
<td>DiskXfer</td>
<td>the time (in seconds per block) spent reading data from DASD</td>
</tr>
<tr>
<td>Return Code</td>
<td>the return code returned from the last prefetch read request</td>
</tr>
<tr>
<td>Reason Code</td>
<td>the reason code returned from the last prefetch read request</td>
</tr>
</tbody>
</table>

Displaying data set statistics for snapshot utilities

The XBM monitor provides statistics for data sets being processed by the snapshot component. This procedure explains how to display statistics for these data sets.
The following types of snapshot data set information are available:

- **General snapshot utilities data set statistics**—general information about the performance of all snapshot utilities data sets. A selection option allows you to display the performance of a subset of snapshot utilities data sets that match the selection criteria.

- **Summary snapshot utilities data set statistics**—comprehensive information about the performance of all snapshot utilities data sets with read and write activity

- **Individual snapshot utilities data set statistics**—information about the performance of a specific snapshot utilities data set

- **Detail snapshot utilities data set statistics**—detailed information about a specific snapshot utilities data set

**Note**
Snapshot Copy jobs that have been restarted accumulate statistics from the initial submission of the job, not from the restart point. Even if you restart a job several times, the statistics are not reset; they continue to accumulate.

**To display statistics for snapshot utilities**

1. From the File List panel, choose **Monitor => XBM performance** and press **Enter** to display the Extended Buffer panel.

2. From the Extended Buffer panel, choose **View => Data sets** and press **Enter** to display the Data sets panel.

3. From the Data sets panel, choose **View => Selection** and press **Enter** to display the Monitor Selection subpanel.

   **Note**
   The Monitor Selection subpanel is displayed automatically if you have the **View selection on monitor entry** option set to Yes.

4. In the **File type** field, type 2 (Snapshot Activity) to choose the snapshot utilities data set monitoring function.

   **Note**
   The **File type** field allows you to make a choice between two different types of statistics—I/O activity on data sets and snapshot utilities data set activity. It is not a selection criteria filtering factor. After you choose a file type, any selection criteria that you specify selects only from that file type.

5. Press **Enter** to display the Component Type Selection subpanel.
6 On the Component Type Selection subpanel, select the component type for the data sets that you want to display as described in the following table:

<table>
<thead>
<tr>
<th>Component type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>displays statistics for objects from all XBM components</td>
</tr>
<tr>
<td>DB2</td>
<td>displays DB2 objects only</td>
</tr>
<tr>
<td>IMS</td>
<td>displays IMS objects only</td>
</tr>
</tbody>
</table>

**Note**

Only objects from licensed XBM components can be displayed.

7 Press **Enter** to display the Snapshot data sets panel.

The panel limits the displayed statistics to the snapshot utilities data sets that satisfy any selection criteria that you specified.

8 On the Snapshot data sets panel, review the statistics for the snapshot utilities. Table 41 on page 182 lists the types of statistics that are available and how to access them.

**Table 41: Accessing data sets statistics for snapshot utilities**

<table>
<thead>
<tr>
<th>Type of statistics</th>
<th>To access the statistics</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>general</td>
<td>Review the top portion of the Snapshot data sets panel.</td>
<td>“Displaying general statistics for data sets processed by snapshot utilities” on page 183</td>
</tr>
<tr>
<td>summary</td>
<td>Review the bottom portion of the Snapshot data sets panel.</td>
<td>“Displaying summary statistics for data sets processed by snapshot utilities” on page 185</td>
</tr>
<tr>
<td>individual snapshot data set</td>
<td>On the Snapshot data sets panel, type 1 (Zoom) in the selection field next to the data set for which you want to display statistics and press <strong>Enter</strong> to display the Snapshot detail subpanel.</td>
<td>“Displaying statistics for individual data sets processed by snapshot utilities” on page 186</td>
</tr>
</tbody>
</table>
**Type of statistics** | **To access the statistics** | **Reference**
--- | --- | ---
individual data set information | 1. On the Snapshot data sets panel, type 1 (Zoom) in the selection field next to the suspend/resume group for which you want to display statistics and press Enter.
| 2. On the Snapshot data set detail subpanel, type / in the selection next to the entry you want to display and press Enter to display the Data Set Detail subpanel. | “Displaying detail statistics for a data set processed by snapshot utilities” on page 190

---

**Displaying general statistics for data sets processed by snapshot utilities**

The top portion of the Snapshot data sets panel provides general performance statistics about data sets being processed by the snapshot component.

These statistics include data for all snapshot utilities data sets that fit the selection criteria that you have specified.

**Figure 52: Snapshot Data Sets panel — General statistics for snapshot utilities**

```
File  View  Options  Console  Monitor  User  Help

Snapshot data sets on 02/25/2012 at 22:00:42
Allocated : 2457600 KB  Used pct : 0 %  Compress pct : 0 %
Data sets : 24     Hit pct : 1 %  IHit pct : 0 %
Reads : 13065  ReadRate : 82  IReadRate : 0
Writes : 264  WriteRate : 1  IWriteRate : 0
CReads : 94  CReadRate : 0  CReadXfer : 0.003666
CWrites : 243  CWritesRate : 1  CWritesXfer : 0.000484
DReads : 12971  DReadRate : 81  DReadXfer : 0.002709
DWrites : 264  DWriteRate : 3  DWriteXfer : 0.053117

Select data sets and press Enter.
```

Table 42 on page 183 describes the general information about the snapshot utility available on the top portion of the Snapshot data sets panel.

**Table 42: General statistics for data sets processed by snapshot utilities**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Allocated | the combined cache limit for the selected data sets  
  The value of this field might be greater than the size of the extended buffer. This value is the amount available to hold preimages. |
| Used pct | the percentage of the total cache limit for the selected data sets that is currently being used to cache preimages |
### Displaying performance statistics and status

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Compress pct   | the compression ratio for the selected data set  
The compression percentage is calculated as the original number of bytes for a data set minus the number of bytes to cache the data set, divided by the original number of bytes, times 100. A high compression ratio value indicates compression is working effectively. A negative compression rate indicates that expansion is occurring.  
Compression must be enabled for both the cache and the managed object for compression to be used.  
**Note:** Negative compression figures will be calculated for data blocks which do not fit evenly into the extended buffer page size. The standard XBM cache page size is 4 KB unless compression is enabled in the active configuration, in which case XBM uses 1-KB pages. Enabling compression in the active configuration will allow better utilization of the extended buffer cache for non-4-KB pages. |
| Data sets      | the number of data sets that fit the selection criteria                                                                                                                                                       |
| Hit pct        | the percentage of read requests by the snapshot-enabled utility that were satisfied from the extended buffer for the selected data sets  
This value also indicates the percentage of pages for which preimage pages were retrieved from the extended buffer.                                                                 |
| IHit pct       | the percentage of read requests by the snapshot-enabled utility that were satisfied from the extended buffer for the selected data sets during the most recently completed statistics interval  
These hits are preimages of data pages that were cached in the extended buffer. The actual data page has been updated since the snapshot utility job was registered. |
| Reads          | the total number of blocks read for the selected data sets by the snapshot-enabled utility  
(The reads might be from the extended buffer, from DASD, or from both.)                                                                                                                                     |
| ReadRate       | the read access rate (in blocks per second) of the snapshot-enabled utility for the selected data sets since XBM was started (or since statistics were reset)                                                               |
| IReadRate      | the read access rate (in blocks per second) of the snapshot-enabled utility for the selected data sets during the most recently completed statistics interval                                                                 |
| Writes         | the total number of blocks written to DASD by the DBMS for the selected data sets  
This statistic relates to updates that occur to the data sets while the XBM is processing the snapshot request. These writes cause preimages of data pages to be read into the extended buffer for snapshot processing. |
<p>| WriteRate      | the write access rate (in blocks per second) by the DBMS for the selected data sets since XBM was started (or since statistics were reset)                                                                     |
| IWriteRate     | the write access rate (in blocks per second) by the DBMS for the selected data sets during the most recently completed statistics interval                                                                         |
| CReads         | the number of preimage data pages that were read by the snapshot-enabled utility from the extended buffer since the data sets were first activated                                                               |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CReadRate</td>
<td>the read access rate (in blocks per second) of the snapshot-enabled utility from the extended buffer while processing the snapshot</td>
</tr>
<tr>
<td>CReadXfer</td>
<td>the time (in seconds per block) that the snapshot-enabled utility spent reading data from the extended buffer for the selected data sets while processing the snapshot. Besides the actual extended buffer read time, the transfer time includes XBM processing time to bypass the DASD I/O request.</td>
</tr>
<tr>
<td>CWrites</td>
<td>the total number of blocks written to the extended buffer for the selected data sets during snapshot processing</td>
</tr>
<tr>
<td>CWriteRate</td>
<td>the write access rate (in blocks per second) to the extended buffer for the selected data sets</td>
</tr>
<tr>
<td>CWriteXfer</td>
<td>the time (in seconds per block) spent writing data to the extended buffer for the selected data sets</td>
</tr>
<tr>
<td>DReads</td>
<td>the total number of reads from DASD by the snapshot-enabled utility for the selected data sets during snapshot processing</td>
</tr>
<tr>
<td>DReadRate</td>
<td>the disk read access rate (in blocks per second) by the snapshot-enabled utility for the selected data sets during snapshot processing</td>
</tr>
<tr>
<td>DReadXfer</td>
<td>the time (in seconds per block) that the snapshot-enabled utility spent reading data from DASD for the selected data sets</td>
</tr>
<tr>
<td>DWrites</td>
<td>the total number of blocks written to DASD by the DBMS for the selected data sets. This statistic relates to updates that occur to the data sets while the XBM is processing the snapshot request. These writes cause preimages of data pages to be read into the extended buffer for snapshot processing.</td>
</tr>
<tr>
<td>DWriteRate</td>
<td>the write access rate (in blocks per second) to DASD by the DBMS for the selected data sets</td>
</tr>
<tr>
<td>DWriteXfer</td>
<td>the time (in seconds per block) that the DBMS spent writing data to DASD for the selected data sets</td>
</tr>
</tbody>
</table>

### Displaying summary statistics for data sets processed by snapshot utilities

The bottom portion of the Snapshot data sets panel provides summary information about the data sets that match the criteria that you selected.

**Figure 53: Snapshot Data Sets panel — Summary statistics for snapshot utilities**

<table>
<thead>
<tr>
<th>S</th>
<th>AG</th>
<th>Data set name</th>
<th>RRate</th>
<th>CBlocks</th>
<th>Cmpl%</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>DBADCAT.DSNDBD.ACPDB40.TS40N1.I0001.A001</td>
<td>6</td>
<td>0</td>
<td>100 %</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>DBADCAT.DSNDBD.ACPDB40.TS40P1.I0001.A001</td>
<td>6</td>
<td>0</td>
<td>100 %</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>DBADCAT.DSNDBD.ACPDB40.TS40P1.I0001.A002</td>
<td>6</td>
<td>0</td>
<td>70 %</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>DBADCAT.DSNDBD.ACPDB40.TS40P1.I0001.A003</td>
<td>6</td>
<td>2</td>
<td>0 %</td>
<td></td>
</tr>
</tbody>
</table>

Table 43 on page 186 describes the fields of the snapshot utilities summary portion of the Snapshot data sets panel.
Table 43: Summary statistics for data sets processed by snapshot utilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A (Active)</td>
<td>whether the data set is active (being managed by XBM)</td>
</tr>
<tr>
<td></td>
<td>The following statuses can be displayed:</td>
</tr>
<tr>
<td></td>
<td>■ An asterisk (*) indicates that the data set is active.</td>
</tr>
<tr>
<td></td>
<td>■ A plus sign (+) indicates that the Snapshot Copy has been restarted for this data set after a failure in utility processing.</td>
</tr>
<tr>
<td></td>
<td>■ A minus sign (-) indicates that the Snapshot Copy is restartable and was active for this data set, but a utility failure is causing the Snapshot Copy to wait to be restarted.</td>
</tr>
<tr>
<td></td>
<td>■ An exclamation point (!) indicates that the Snapshot Copy was restartable for this data set, but an unrecoverable error now prohibits a restart; this data set will remain in this status until you issue the TERM command or attempt a restart. (An attempted restart clears the job.)</td>
</tr>
<tr>
<td>G (Global)</td>
<td>whether the data set is enabled for snapshot processing in a sysplex environment</td>
</tr>
<tr>
<td></td>
<td>If the data set is enabled, an asterisk appears in this column.</td>
</tr>
<tr>
<td>Data set name</td>
<td>the fully qualified name of the data set</td>
</tr>
<tr>
<td>RRate</td>
<td>the read access rate (measured in blocks per second) of the snapshot-enabled utility for this data set</td>
</tr>
<tr>
<td>CBlocks</td>
<td>the number of blocks currently in the extended buffer for this data set</td>
</tr>
<tr>
<td>Cmpl %</td>
<td>the percentage of the managed object for which the snapshot-enabled utility has completed snapshot processing</td>
</tr>
<tr>
<td></td>
<td>XBM calculates this value by using RBA values to determine how much of the object has been processed</td>
</tr>
</tbody>
</table>

Displaying statistics for individual data sets processed by snapshot utilities

The Snapshot data set detail subpanel provides details about a data set processed by the snapshot utility.

■ To display the information for a specific data set, select a data set on the Snapshot data sets panel and press **Enter**.
Tip
Alternatively, you can select a data set, choose File => Zoom, and then press Enter to display the Snapshot data set details subpanel.

Figure 54: Snapshot Data Set Details subpanel

Table 44 on page 187 describes the fields on the Snapshot data set details subpanel that provide statistics for the specified data set processed by the snapshot utility.

Table 44: Statistics for individual data sets processed by snapshot utilities

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data set</td>
<td>the fully qualified data set name</td>
</tr>
<tr>
<td>Job name</td>
<td>the name of the utility job that processed the data set</td>
</tr>
<tr>
<td>Step name</td>
<td>the name of the job step that ran the utility</td>
</tr>
<tr>
<td>Job date</td>
<td>the date that the utility registered this data set for snapshot processing</td>
</tr>
<tr>
<td>Job time</td>
<td>the time at which the utility registered this data set for snapshot processing</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Restartable</td>
<td>whether the snapshot utility is restartable for this data set and, if restartable, the current state of the data set. The following values can be displayed:</td>
</tr>
<tr>
<td></td>
<td>— NO—the snapshot for this data set is not restartable.</td>
</tr>
<tr>
<td></td>
<td>— YES, ACTIVE—the snapshot for this data set is still running but it is restartable should it fail.</td>
</tr>
<tr>
<td></td>
<td>— YES, PENDING—the snapshot for this data set has terminated due to a utility failure, and it can be restarted.</td>
</tr>
<tr>
<td></td>
<td>— YES, RESTARTED—the snapshot for this data set was restarted after a utility failure temporarily interrupted processing.</td>
</tr>
<tr>
<td>XBM SSid</td>
<td>the ID of the XBM subsystem upon which the snapshot-enabled utility is executing.</td>
</tr>
<tr>
<td>Cache limit</td>
<td>the maximum amount of the extended buffer that will be allocated to this data set. The cache limit is defined on the Managed Object Information subpanel.</td>
</tr>
<tr>
<td>Priority</td>
<td>the priority of the managed object (a numerical value between 0 and 9999)</td>
</tr>
<tr>
<td>Bytes used</td>
<td>the actual number of bytes currently used in the extended buffer to cache the data set.</td>
</tr>
<tr>
<td>Max bytes used</td>
<td>the maximum number of bytes used to cache pages for this object.</td>
</tr>
<tr>
<td>Used %</td>
<td>the percentage of the cache limit that is currently being used to cache the data set.</td>
</tr>
<tr>
<td>Compress %</td>
<td>the compression ratio for the data set. The compression percentage is calculated as the original number of bytes for a data set minus the number of bytes to cache the data set, divided by the original number of bytes, times 100. A high compression ratio value indicates compression is working effectively. A negative compression rate indicates that expansion is occurring. Compression must be enabled for both the cache and the managed object for compression to be used.</td>
</tr>
<tr>
<td></td>
<td>Note: Negative compression figures will be calculated for data blocks which do not fit evenly into the extended buffer page size. The standard XBM cache page size is 4 KB unless compression is enabled in the active configuration, in which case XBM uses 1-KB pages. Enabling compression in the active configuration will allow better utilization of the extended buffer cache for non 4-KB pages.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Compress      | whether compression is enabled for the data set  
Compression is also enabled or disabled for the different types of cache in the active configuration. For compression to take place, compression must be enabled for both the managed object and the cache.                                                                                      |
| Blocks in cache | the number of blocks in the extended buffer for this data set                                                                                                                                                                                                                      |
| Hits %        | the percentage of read requests for the data set that were satisfied from the extended buffer or the extended prefetch buffer while the data set is actively managed  
These hits are preimages of data pages that were cached in the extended buffer. The actual data page has been updated since the snapshot utilities data set was registered.                                      |
| Complete %    | the percentage of the of the data set for which the utility has completed snapshot processing                                                                                                                                                                                       |
| Total - Reads | the total number of blocks read for the data set by the utility job using the snapshot component  
This value is the total number of read requests for the data set. Depending on the status of the data set, the number can include reads from the extended buffer, the extended prefetch buffer, or DASD, or both.                     |
| Failures - Reads | the number of times that the utility job processing the snapshot tried to read from the extended buffer and failed  
In the case of a read failure, the utility requesting the snapshot is notified that the updated page was returned, because the preimage page was not available. The utility determines whether to continue or terminate.  
Cache read failures occur when you are using an ESO hiperspace cache. (The system can steal pages from an ESO hiperspace cache.) |
| Rate - Read   | the read access rate (in blocks per second) for the individual data set by the utility job that is processing the snapshot                                                                                                                                                        |
| Total - Writes | the number of writes to DASD by DB2 or VSAM for the data set  
A write causes a preimage of the data page to be read into the extended buffer for the snapshot.                                                                                                                                                              |
| Failures - Writes | the number of times that an attempt to write to the cache failed  
This problem occurs when the system cannot provide a new ESO hiperspace page when requested.  
This statistic relates to the updates performed while the snapshot was running. These writes cause a preimage of the data page to be read into the extended buffer for snapshot processing. On a write failure the snapshot continues, but will receive a read failure if the preimage page is needed by the utility. |
| Rate - Writes | the number of blocks (measured in blocks per second) written to DASD by DB2 or VSAM for this data set  
These writes might have caused preimages of data pages to be read into the extended buffer for the snapshot utilities.                                                                                                                                   |
Displaying performance statistics and status

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Status      | the status of a snapshot request  
The following states can be displayed:                                         |
|             | — REGISTERED—The snapshot-enabled utility coordinating the snapshot request has notified XBM of the data set name. XBM is initialized to start monitoring and caching updates to this data set. |
|             | — STARTED—The snapshot-enabled utility has issued the command to establish a point of consistency and has released the data set for update processing. XBM is caching pre-image data and providing these data blocks to the utility requesting the snapshot. A restartable snapshot request will continue to be in the STARTED status from start to finish. If the utility aborts, a restartable snapshot is still STARTED and caching pre-image data for use when the utility is restarted. |
|             | — STOPPED—Snapshot processing has completed. The cached data is released from the cache. The data set is no longer cached or monitored. |
|             | — TERMINATED—A restartable snapshot was aborted with the TERMINATE command in the XBM ISPF interface. The TERMINATE command frees the XBM cache blocks that were being held for the snapshot-enabled utility and eliminates the possibility of restarting the snapshot request for this data set. |
| Return code | the return code from the last snapshot request  
For more information about codes issued by the snapshot component, access the messages section of the BMC Documentation Center from the BMC Support Central site (http://www.bmc.com/support). |
| Reason code | the reason code from the last snapshot request  
For information about codes issued by the snapshot component, access the messages section of the BMC Documentation Center from the BMC Support Central site (http://www.bmc.com/support).  
*Note:* On the Snapshot subpanel, you can press F5 to get an explanation of the reason code. |

**Displaying detail statistics for a data set processed by snapshot utilities**

The Data Set Detail subpanel displays detailed read and write information for a specified data set.
To access this information, press F6 on the Data Set Details subpanel when reviewing the statistics for an individual data set that was processed by a snapshot utility.

**Figure 55: Data Set Detail subpanel**

![Data Set Detail subpanel](image)

Table 45 on page 191 describes the information available of the Data Set Detail subpanel.

**Table 45: Detail statistics for data set processed by snapshot utilities**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache - Reads</td>
<td>the total number of reads from the extended buffer by the utility job using</td>
</tr>
<tr>
<td></td>
<td>the snapshot component for the data set for this copy</td>
</tr>
<tr>
<td></td>
<td>This value indicates the number of cache blocks that were read to provide</td>
</tr>
<tr>
<td></td>
<td>preimage information.</td>
</tr>
<tr>
<td>CacheRate - Reads</td>
<td>cache read access rate (measured in blocks per second) by the latest utility job</td>
</tr>
<tr>
<td></td>
<td>using the snapshot component for this copy</td>
</tr>
<tr>
<td>CacheXfer - Reads</td>
<td>the time (measured in seconds per block) for reading data from the extended</td>
</tr>
<tr>
<td></td>
<td>buffer for this data set by the utility job using the snapshot component</td>
</tr>
<tr>
<td></td>
<td>Besides the actual extended buffer read time, the transfer time includes XBM</td>
</tr>
<tr>
<td></td>
<td>processing time to bypass the DASD I/O request.</td>
</tr>
<tr>
<td>Disk - Reads</td>
<td>the total number of reads from DASD for this data set by the latest utility job</td>
</tr>
<tr>
<td></td>
<td>using the snapshot component</td>
</tr>
<tr>
<td>DiskRate - Reads</td>
<td>disk read access rate (measured in blocks per second) by the utility job using</td>
</tr>
<tr>
<td></td>
<td>the snapshot component</td>
</tr>
<tr>
<td>DiskXfer - Reads</td>
<td>the time (measured in seconds per block) for reading data from DASD for this</td>
</tr>
<tr>
<td></td>
<td>data set by the utility job using the snapshot component</td>
</tr>
<tr>
<td></td>
<td>This value includes the time required to update the page with the preimage</td>
</tr>
<tr>
<td></td>
<td>from cache.</td>
</tr>
<tr>
<td>Cache - Writes</td>
<td>the total number of blocks written to the extended buffer by the latest utility job for the data set</td>
</tr>
<tr>
<td></td>
<td>This value indicates number of preimage data pages that were stored in the extended buffer for the snapshot component.</td>
</tr>
<tr>
<td>CacheRate - Writes</td>
<td>cache write access rate (measured in blocks per second) of the latest utility job</td>
</tr>
<tr>
<td></td>
<td>for the data set</td>
</tr>
<tr>
<td>CacheXfer - Writes</td>
<td>the time (measured in seconds per block) for writing data to the extended buffer for the data set</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk - Writes</td>
<td>the total number of writes to DASD by DB2 or VSAM for this data set since the copy started</td>
</tr>
<tr>
<td>DiskRate - Writes</td>
<td>disk write access rate (measured in blocks per second) by DB2 or VSAM for this copy</td>
</tr>
</tbody>
</table>
| DiskXfer - Writes | the time (measured in seconds per block) for writing data to DASD by the latest utility job for this data set  
This includes the time required to read preimages before allowing the write to complete. |

### Statistics to check

The cache size that you specify for XBM jobs should be at least large enough to hold the maximum number of preimages that you expect to concurrently occupy the extended buffer.

To see if you specified an adequate cache size, use the extended buffer statistics to display the percentage of cache used. If your percentage of cache used is 100 percent, XBM jobs could fail because of a full cache.

One way to ensure successful XBM jobs is to over allocate the extended buffer by specifying a larger cache size than necessary. This technique works well because XBM allocates only enough cache space to hold the preimages that are concurrently cached. Any unused cache space is not allocated by XBM.

### Using the Utility monitor

The XBM Utility monitor allows you to monitor your snapshot utility jobs as they run.

From this monitor, you can display statistics for the XBM utility program, COPY PLUS, and REORG PLUS. This section explains how to display and monitor these jobs.

**Note**

For more information about the XBM utility program, see “Using the XBM utility program for a VSAM snapshot copy” on page 311.

In addition, the XBM Utility monitor also provides a convenient method for managing snapshot utility jobs when used with BMC high-performance utilities. This section describes how to use the Utility monitor to perform the following tasks:
- Send commands to utilities that accept them.
- Display the last command that you sent to a utility.

### Displaying utility job statistics with the Utility monitor

This procedure explains how to access the Utility monitor and locate the snapshot utility job that you want to manage or display.

1. From the File List panel, choose **Monitor => Utility Monitor**.

   **Tip**
   You can also access the Utility monitor by issuing the UTILMON Fastpath command. For more information about Fastpath navigation, see “XBM ISPF Fastpath commands” on page 279.

2. Press **Enter** to display the Utility Job Selection subpanel (**Figure 56 on page 193**).

**Figure 56: Utility Job Selection subpanel of the XBM Utility monitor**

The Utility Job Selection subpanel shows snapshot utility jobs currently available to the Utility monitor. This subpanel shows the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| A       | whether the utility job is currently active in the system.  
<pre><code>     | If the job is active, an asterisk appears in this column. |
</code></pre>
<p>| Jobname | the name of the utility job      |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Utility name</td>
<td>the name of the utility associated with the specified job</td>
</tr>
<tr>
<td>C (Commandable)</td>
<td>whether the utility can have commands entered to change utility parameters</td>
</tr>
<tr>
<td></td>
<td>while the utility is running</td>
</tr>
<tr>
<td></td>
<td>If the utility can process commands, it is considered Commandable and this</td>
</tr>
<tr>
<td></td>
<td>column contains a value of C.</td>
</tr>
</tbody>
</table>

3 (optional) Enter selection criteria to filter the list of jobs:

a On the Utility Job Selection subpanel, choose View => Selection (Figure 57 on page 194).

**Figure 57: View pull-down menu on the Utility Job Selection subpanel**

<table>
<thead>
<tr>
<th>S File View Options Console Monitor User Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Se File View Command Options Options Console Monitor User Help</td>
</tr>
<tr>
<td>S 1. By active status 2. By Jobname 3. By utility name 4. By commandable 5. Selection...</td>
</tr>
<tr>
<td>S 1. By active status 2. By Jobname 3. By utility name 4. By commandable 5. Selection... last command name C</td>
</tr>
</tbody>
</table>

b Press Enter to display a second Utility Job Selection subpanel (Figure 58 on page 194).

**Figure 58: Utility Job Selection subpanel for displaying viewing criteria**

<table>
<thead>
<tr>
<th>Utility Job Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter filtering criteria for the fields below.</td>
</tr>
</tbody>
</table>
| Job name . . . . . . . | *
| Utility name . . . . . | *
| Commandable . . . . . | 1. All 2. Commandable only 3. Not commandable only |

Pattern match characters (*, %, ?) may be used in name fields.

F1=Help  F12=Cancel

c In the following fields, enter the criteria for the jobs that you want to display:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value to enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>the name of the job to display</td>
</tr>
<tr>
<td></td>
<td>You can use pattern-matching characters to select only job names that contain</td>
</tr>
<tr>
<td></td>
<td>a specific, positional string of characters. For example, an asterisk in the</td>
</tr>
<tr>
<td></td>
<td>entry field selects all jobs. An M* in the entry field selects jobs beginning</td>
</tr>
<tr>
<td></td>
<td>with the character M.</td>
</tr>
</tbody>
</table>
### Field | Value to enter
--- | ---
Utility name | the name of the utility that is processing the jobs
As with the **Job name** entry field, you can use pattern-matching characters to select matching utility names.

Commandable | the type (commandable or not commandable) of utility jobs to display
You can choose from the following options:
- **All**—Include both commandable and not commandable utility jobs in the display list
- **Commandable only**—Include only those utility jobs that can accept commands from the Utility monitor in the display list.
- **Not commandable only**—Exclude utility jobs that can accept commands from the list.

---

d Press **Enter** to filter the main Utility Job Selection subpanel.

4 *(optional)* On the Utility Job Selection subpanel, choose **View => fieldName** to sort the list of jobs by a particular field. You can sort the list by the following attributes:
- active status
- job name
- utility name
- whether you can issue commands to the job

5 To see statistics for a job, type `/` or `S` in the selection field next to the job and press **Enter**. More job statistics are available, but the method by which you access them depends on the utility associated with the job.

For information about the statistics shown for the utility job that you selected and how to access additional statistics, see the following sections:

- “Displaying XBM utility program job statistics” on page 196
- “Displaying COPY PLUS utility job statistics” on page 199
- “Displaying REORG PLUS Online feature utility job statistics” on page 202
Displaying XBM utility program job statistics

The XBM Utility monitor provides the following panels to review statistics from the XBM utility program:

- XBM Utility (Task)
- XBM Utility (Snapshot) panel

XBM Utility (Task) panel

When you select an XBM utility program job from the Utility monitor, the first statistics panel that is displayed is the XBM Utility (Task) panel.

The panel displays the current execution status of XBM utility program jobs and lists the active tasks being processed.

Figure 59: XBM Utility (Task) panel

Table 46 on page 196 describes the information that is available on the XBM Utility (Task) panel.

Table 46: Statistics for tasks in the XBM utility program

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>the name of the utility job</td>
</tr>
<tr>
<td>Step name</td>
<td>the name of the job step that ran the utility</td>
</tr>
<tr>
<td>Job date</td>
<td>the date that the selected utility job was started</td>
</tr>
<tr>
<td>Job time</td>
<td>the time that the selected utility job was started</td>
</tr>
<tr>
<td>Current copy command</td>
<td>the current command that is being processed and the total number of commands that will be processed in the job stream</td>
</tr>
<tr>
<td>Snapshot</td>
<td>whether snapshot processing is being invoked for this execution of the utility</td>
</tr>
<tr>
<td>Data sets processed in group</td>
<td>the total number of data sets that are being processed for the current command that share a single quiesce point.</td>
</tr>
</tbody>
</table>
### XBM Utility (Snapshot) panel

When displaying Snapshot Copy jobs (indicated by a **Yes** in the **Snapshot** field) from the XBM Utility (Task) panel, you can press **F4** to display the XBM Utility (Snapshot) panel.

Alternatively, from the **View** pull-down menu, select the **Snapshot** menu option to display the panel.

The XBM Utility (Snapshot) panel provides general information about the performance of the Snapshot Copy processing of the XBM utility. The top portion of the panel displays the job information. In the bottom portion of the panel, a scrollable list displays the active data sets being processed.

![Figure 60: XBM Utility (Snapshot) panel](image)

**Table 47 on page 197** describes the information that is available on the XBM Utility (Snapshot) panel.

**Table 47: Statistics for snapshot performance in the XBM utility program**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>the name of the utility job</td>
</tr>
</tbody>
</table>

---

**Raw Text**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Group</td>
<td>the group that is currently being processed</td>
</tr>
<tr>
<td>Task</td>
<td>the number of the task that is currently being processed</td>
</tr>
<tr>
<td>Data set name</td>
<td>the data set names currently being processed</td>
</tr>
<tr>
<td></td>
<td>When no data sets are being processed, this field displays the</td>
</tr>
<tr>
<td></td>
<td>task state.</td>
</tr>
</tbody>
</table>

---

**Summary**

- The XBM Utility (Snapshot) panel provides information about the performance of Snapshot Copy jobs for the XBM utility.
- The top portion displays job information, while the bottom portion shows active data sets.
- The panel can be accessed from the XBM Utility (Task) panel or the View pull-down menu.
- Table 47 on page 197 describes the available information in the panel.

---

**Table 47 on page 197**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>the name of the utility job</td>
</tr>
</tbody>
</table>

---

**Chapter 9  Monitoring BMC snapshot-enabled utilities**

197
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step name</td>
<td>the name of the job step that ran the utility</td>
</tr>
<tr>
<td>Job date</td>
<td>the date that the selected utility job was started</td>
</tr>
<tr>
<td>Job time</td>
<td>the time that the selected utility job was started</td>
</tr>
<tr>
<td>Current copy command</td>
<td>the current command that is being processed and the total number of commands that will be processed in the job stream</td>
</tr>
<tr>
<td>Data sets processed in group</td>
<td>the total number of data sets that are being processed for the current command that share a single quiesce point.</td>
</tr>
<tr>
<td>Current group</td>
<td>the group that is currently being processed</td>
</tr>
<tr>
<td>A (Active)</td>
<td>whether the data set is active (that is, being managed by XBM)</td>
</tr>
<tr>
<td></td>
<td>■ If the data set is active, an asterisk (*) appears in this column.</td>
</tr>
<tr>
<td></td>
<td>■ If the snapshot-enabled utility did not successfully complete for this data set and has a pending restart, a minus sign (-) appears in this column.</td>
</tr>
<tr>
<td></td>
<td>■ If the snapshot has been restarted for this data set, a plus sign (+) appears in this column.</td>
</tr>
<tr>
<td></td>
<td>■ If the snapshot was restartable for this data set but an unrecoverable error now prohibits a restart, an exclamation point (!) appears. The data set will remain in this status until you issue the TERM command or attempt a restart (an attempted restart clears the job).</td>
</tr>
<tr>
<td>Data set name</td>
<td>the fully qualified name of the data set</td>
</tr>
<tr>
<td>RRate (Read Rate)</td>
<td>the read access rate (in blocks per second) for this data set</td>
</tr>
<tr>
<td>CBlocks</td>
<td>the number of blocks currently in the extended buffer for this data set</td>
</tr>
<tr>
<td></td>
<td>For snapshot data sets, this statistic relates to the buffers used to store preimage reads for snapshot processing.</td>
</tr>
<tr>
<td>Cmpl%</td>
<td>the percentage of the managed object for which the snapshot-enabled utility has completed snapshot processing</td>
</tr>
<tr>
<td></td>
<td>XBM calculates this value by using RBA values to determine how much of the object has been processed.</td>
</tr>
</tbody>
</table>

From the XBM Utility (Snapshot) panel, you can display the individual data set statistics for the data set. Type / or S in the selection field next to the data set, and press Enter.

For a description of the fields displayed on this panel, see “Displaying general statistics for data sets processed by snapshot utilities” on page 183.
Displaying COPY PLUS utility job statistics

The Utility monitor provides the following panels to review statistics from COPY PLUS utility jobs:

- COPY PLUS (Task) panel
- COPY PLUS (Snapshot) panel

COPY PLUS (Task) panel

When you select a COPY PLUS job from the Utility Job Selection panel, the first statistics panel that is displayed is the COPY PLUS (Task) panel.

The panel displays the current execution status of COPY PLUS jobs and lists the active tasks being processed.

Figure 61: COPY PLUS (Task) panel

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>the name of the utility job</td>
</tr>
<tr>
<td>Step name</td>
<td>the name of the job step that ran the utility</td>
</tr>
<tr>
<td>Job date</td>
<td>the date that the selected utility job was started</td>
</tr>
<tr>
<td>Job time</td>
<td>the time that the selected utility job was started</td>
</tr>
<tr>
<td>Current copy command</td>
<td>the current COPY PLUS command that is being processed and the total number of commands that will be processed in the job stream</td>
</tr>
<tr>
<td>Snapshot</td>
<td>whether Snapshot Copy processing is being invoked for this execution of the utility</td>
</tr>
<tr>
<td>Data sets processed in group</td>
<td>the total number of data sets that are being processed for the current command and which data set is currently being processed</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Task | the task number of the active task that is being processed by the utility
Data set name | the name of the data sets that are currently being processed
Alternatively, the task state will be displayed when no data sets are being processed.

### COPY PLUS (Snapshot) panel

When displaying Snapshot Copy jobs (indicated by a **Yes** in the **Snapshot** field) from the COPY PLUS (Task) panel, you can press **F4** to display the COPY PLUS (Snapshot) panel.

**Tip**

Alternatively, choose **View => Snapshot** to display the panel.

The COPY PLUS (Snapshot) panel provides you with general information about the performance of the Snapshot Copy processing of COPY PLUS. The top portion of the panel displays the job information. In the bottom portion of the panel a scrollable list displays the active data sets being processed.

**Figure 62: COPY PLUS (Snapshot) panel**

<table>
<thead>
<tr>
<th>Job name</th>
<th>XBMDX8SS</th>
<th>Step name</th>
<th>ACPCOPY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job date</td>
<td>04/22/2012</td>
<td>Job time</td>
<td>17:18:21</td>
</tr>
<tr>
<td>Current copy command . . . .</td>
<td>1 of 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data sets processed in group</td>
<td>14 of 20</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Select actions on the following data sets, then press enter.

<table>
<thead>
<tr>
<th>Data set name</th>
<th>RRate</th>
<th>CBlocks</th>
<th>Cmpl%</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBBACAT.DSNDBD.P322IBMD.T322IBMS.I0001.A020</td>
<td>0</td>
<td>0</td>
<td>0 %</td>
</tr>
<tr>
<td>DBBACAT.DSNDBD.P322IBMD.T322IBMS.I0001.A001</td>
<td>0</td>
<td>0</td>
<td>100 %</td>
</tr>
<tr>
<td>DBBACAT.DSNDBD.P322IBMD.T322IBMS.I0001.A002</td>
<td>0</td>
<td>0</td>
<td>100 %</td>
</tr>
<tr>
<td>DBBACAT.DSNDBD.P322IBMD.T322IBMS.I0001.A003</td>
<td>0</td>
<td>0</td>
<td>100 %</td>
</tr>
<tr>
<td>DBBACAT.DSNDBD.P322IBMD.T322IBMS.I0001.A004</td>
<td>0</td>
<td>0</td>
<td>100 %</td>
</tr>
<tr>
<td>DBBACAT.DSNDBD.P322IBMD.T322IBMS.I0001.A005</td>
<td>0</td>
<td>0</td>
<td>100 %</td>
</tr>
</tbody>
</table>

**Table 49 on page 201** describes the information that is available on the COPY PLUS (Snapshot) panel.
### Table 49: Statistics for COPY PLUS snapshot performance

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>the name of the utility job</td>
</tr>
<tr>
<td>Step name</td>
<td>the name of the job step that ran the utility</td>
</tr>
<tr>
<td>Job date</td>
<td>the date that the selected utility job was started</td>
</tr>
<tr>
<td>Job time</td>
<td>the time that the selected utility job was started</td>
</tr>
<tr>
<td>Current copy command</td>
<td>the current COPY PLUS command that is being processed and the total number of commands that will be processed in the job stream</td>
</tr>
<tr>
<td>Data sets processed in group</td>
<td>the total number of data sets that are being processed for the current command and which data set is currently being processed</td>
</tr>
<tr>
<td>A (Active)</td>
<td>whether the data set is active (that is, being managed by XBM)</td>
</tr>
<tr>
<td>Data set name</td>
<td>the fully qualified name of the data set</td>
</tr>
<tr>
<td>RRate (Read Rate)</td>
<td>the read access rate (in blocks per second) for this data set</td>
</tr>
<tr>
<td>CBlocks</td>
<td>the number of blocks currently in the extended buffer for this data set</td>
</tr>
<tr>
<td></td>
<td>For snapshot data sets, this statistic relates to the buffers used to store preimage reads for snapshot processing.</td>
</tr>
<tr>
<td>Cmpl%</td>
<td>the percentage of the managed object for which the snapshot-enabled utility has completed snapshot processing</td>
</tr>
<tr>
<td></td>
<td>XBM calculates this value by using RBA values to determine how much of the object has been processed.</td>
</tr>
</tbody>
</table>

From the COPY PLUS (Snapshot) panel, you can display snapshot utility statistics for an individual data set. Type `/` or `S` in the selection field next to the data set, and press **Enter**. For a description of the fields displayed on this panel, see “Displaying statistics for individual data sets processed by snapshot utilities” on page 186.
Displaying REORG PLUS Online feature utility job statistics

The Utility monitor provides the following panels to review statistics from REORG PLUS Online utility jobs:

- REORG PLUS Online (Snapshot) panel
- REORG PLUS Online (Log Apply) panel

After you select a REORG PLUS job from the Utility Job Selection panel, the panel that is displayed depends on the current phase of the REORG PLUS utility job.

- In the initial phases of a REORG PLUS utility job, the first panel that is displayed is the REORG PLUS Online (Snapshot) Statistics panel. This panel shows data set statistics from the Snapshot Copy job as it copies registered table spaces for reorganization.

- When the snapshot phase is complete, the REORG PLUS Online (Log Apply) Statistics panel is displayed. This panel shows statistics of the log apply phase and numbers and application rates for log records.

Subsequent sections describe these panels in detail.

REORG PLUS Online (Snapshot) statistics

The REORG PLUS Online (Log Apply) Statistics panel allows you to type over values in certain fields to send new values to the REORG PLUS utility to alter the job as it runs.

For more information about sending commands to REORG PLUS, see “Issuing commands from the XBM Utility monitor” on page 207.

Figure 63: REORG PLUS Online (Snapshot) statistics

<table>
<thead>
<tr>
<th>Job name</th>
<th>Step name</th>
<th>Job date</th>
<th>Job time</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARUAVR$A</td>
<td>LARREORG</td>
<td>04/22/2012</td>
<td>09:36:44</td>
</tr>
</tbody>
</table>

Phase: REORG Log final
Log threshold: 1000 Deadline: NONE
Longlog action: CONTINUE Maximum R/O: DEFER seconds
Delay: 300 seconds

Select actions on the following data sets, then press enter.

1=Zoom
S Data set name
- * D8AVCAT.DSNDBD.R$AAA1RB.$AAA1RBA.10001.A001 41 0 100 %

Command ===>
Table 50 on page 203 describes the information that is available on the REORG PLUS Online (Snapshot) panel.

Table 50: Statistics for REORG PLUS Online snapshot performance

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>the name of the utility job that processed the data set</td>
</tr>
<tr>
<td>Job date</td>
<td>the date that the selected utility job was started</td>
</tr>
<tr>
<td>Step name</td>
<td>the name of the job step that ran the utility</td>
</tr>
<tr>
<td>Job time</td>
<td>the time that the selected utility job was started</td>
</tr>
<tr>
<td>Phase</td>
<td>the utility phase that is currently processing or the phase that was processing last</td>
</tr>
</tbody>
</table>
| Log threshold    | the maximum number of log records that should be left to be applied (for all objects) before entering log final phase  
                  | At log final phase, the objects are in read-only mode while the remaining log records are applied. Until the log final phase begins, you can type over this value to dynamically change it for REORG PLUS. |
| Long log action  | the action that will be taken when REORG PLUS determines that the DB2 subsystem is generating log records for the objects being reorganized faster than REORG PLUS is applying them  
                  | The action will be invoked after the Delay time limit expires, if the Longlog condition still exists. Possible actions are TERM, QUIESCE, DRAIN, and CONTINUE. Until the log final phase begins, you can type over this value and dynamically change it for REORG PLUS. |
| Delay            | the amount of time to wait after a Longlog condition has been detected before checking to see if the condition still exists  
                  | If the Longlog condition still exists after the delay time expires, the Longlog action will be invoked. Until the log final phase begins, you can type over this value and dynamically change it for REORG PLUS. |
| Log final        | the specification of when the utility started the final log processing  
                  | You can initiate Log final processing by typing over this field with the current or previous timestamp. The field also accepts time of day, which is then converted to a timestamp. |
| Deadline         | the specification of when REORG PLUS must be finished processing  
                  | If REORG PLUS determines that this deadline will not be met, it terminates the reorganization.  
<pre><code>              | Until the log final phase begins, you can type over this value and dynamically change it for REORG PLUS. This field accepts a timestamp or time of day, which is then converted to a timestamp. |
</code></pre>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum read only         | when to end the log apply phase and enter log final phase  
An integer value specifies the maximum time in seconds that the log final phase should run. If REORG PLUS estimates that it can complete Log final phase in this amount of time, it will start this phase. A value of DEFER tells REORG PLUS to keep applying log records indefinitely. A value of DEFER must be changed to allow log final processing to begin. Note that during the log final phase the data sets are in read-only status. Until the Log final phase begins, you can overtype this value to send to REORG PLUS. |
| A (Active)                | whether the data set is active (that is, being managed by XBM)  
- If the data set is active, an asterisk appears in this column.  
- If the snapshot-enabled utility did not successfully complete for this data set and has a pending restart, a minus sign (-) appears in this column.  
- If the snapshot has been restarted for this data set, a plus sign (+) appears in this column.  
- If the snapshot was restartable for this data set but an unrecoverable error now prohibits a restart, an exclamation point (!) appears. The data set will remain in this status until you issue the TERM command or attempt a restart (an attempted restart clears the job). |
| Data set name             | the fully qualified name of the data set                                                                                                                                                                   |
| RRate (Read Rate)         | the read access rate (in blocks per second) for this data set                                                                                                                                              |
| CBlocks                   | the number of blocks currently in the extended buffer for this data set  
For snapshot data sets, this statistic relates to the buffers used to store preimage reads for snapshot processing.                                                                                       |
| Cmpl%                     | the percentage of the managed object for which the snapshot-enabled utility has completed snapshot processing  
XBM calculates this value by using RBA values, to determine how much of the object has been processed.                                                                                                     |

**REORG PLUS Online (Log Apply) statistics**

The REORG PLUS Online (Log Apply) Statistics panel shows statistics of the log apply phase.
This panel shows statistics for numbers and application rates for log records.

**Figure 64: REORG PLUS Online (Log Apply) statistics**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>the name of the utility job that processed the data set</td>
</tr>
<tr>
<td>Job date</td>
<td>the date that the selected utility job was started</td>
</tr>
<tr>
<td>Step name</td>
<td>the name of the job step that ran the utility</td>
</tr>
<tr>
<td>Job time</td>
<td>the time that the selected utility job was started</td>
</tr>
<tr>
<td>Phase</td>
<td>the utility phase that is currently processing or the phase that was processing last</td>
</tr>
<tr>
<td>Log threshold</td>
<td>the maximum number of log records that should be left to be applied (for all objects) before entering log final phase At log final phase, the objects are in read only mode while the remaining log records are applied. Until the log final phase begins, you can type over this value to dynamically change it for REORG PLUS.</td>
</tr>
<tr>
<td>Longlog action</td>
<td>the action that will be taken when REORG PLUS determines that the DB2 subsystem is generating log records for the objects being reorganized faster than REORG PLUS is applying them The action will be invoked after the Delay time limit expires, if the Longlog condition still exists. Possible actions are TERM, QUIESCE, DRAIN, and CONTINUE. Until the log final phase begins, you can type over this value and dynamically change it for REORG PLUS.</td>
</tr>
</tbody>
</table>

Table 51 on page 205 describes the information that is available on the REORG PLUS Online (Log Apply) panel.

**Table 51: Statistics for REORG PLUS Online log apply performance**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>Applied</td>
</tr>
<tr>
<td>IX</td>
<td>23464</td>
</tr>
<tr>
<td>TS</td>
<td>11742</td>
</tr>
</tbody>
</table>

BMC73404I View is by Direction.
Command ==>> _______________________________________________________________
F1=Help   F2=Split    F3=Exit    F7=Bkwd    F8=Fwd    F9=Swap
F10=Actions F12=Cancel

Table 51 on page 205 describes the information that is available on the REORG PLUS Online (Log Apply) panel.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Deadline           | the specification of when REORG PLUS must be finished processing  
If REORG PLUS determines that this deadline will not be met, it terminates the reorganization.  
Until the log final phase begins, you can type over this value and dynamically change it for REORG PLUS. This field accepts a timestamp or time of day, which is then converted to a timestamp.   |
| Delay              | the amount of time to wait after a Longlog condition has been detected before checking to see if the condition still exists  
If the Longlog condition still exists after the delay time expires, the Longlog action will be invoked. Until the log final phase begins, you can type over this value and dynamically change it for REORG PLUS.   |
| Log final          | the specification of when the utility started the final log processing  
It is possible to initiate log final processing by typing over this field with the current or previous time stamp.   |
| Maximum read only  | when to end the log apply phase and enter log final phase  
An integer value specifies the maximum time in seconds that the log final phase should run. If REORG PLUS estimates that it can complete Log final phase in this amount of time, it will start this phase. A value of DEFER tells REORG PLUS to keep applying log records indefinitely. A value of DEFER must be changed to allow log final processing to begin. Note that during the log final phase the data sets are in read-only status. Until the Log final phase begins, you can overtype this value to send to REORG PLUS.   |
| Long log active    | whether the Longlog process is active  
A value of **No** indicates that Longlog processing is not active. A value of **Yes** indicates that Longlog is currently active and shows the time when Longlog processing started.   |
| Long log action time| the time at which the current Longlog action specification will be processed   |
| TYPE               | whether the row of statistics is for all index spaces (IX) or table spaces (TS)   |
| Applied            | the number of log records that have currently been applied for index or table spaces   |
| Queued             | the number of log records that are currently queued to be applied for index or table spaces   |
| ArrRate            | the rate (per second) that new log records are being created for all index or table spaces   |
| AppRate            | the rate (per second) that log records are being applied for all index or table spaces   |
| D (Direction)      | whether REORG PLUS is applying log records faster (+) or slower (-) than their arrival rate   |
Issuing commands from the XBM Utility monitor

This procedure explains how to send commands to a utility that is commandable.

To determine if a job can accept commands, refer to the Utility Job Selection panels. Jobs with a C listed in the C (Commandable) field can accept commands.

1. From the Utility Job Selection subpanel, type 2 (Send New Command) next to the job to which you want to send the command.

2. On the Send New Command panel (Figure 65 on page 207, type in the command in the Command entry field and press Enter.

   **Figure 65: Send New Command subpanel**

   File  View  Options  Console  Monitor  User  Help
   *--------------------------------------------------------------------------
   | Viewing XBM4(XBMQA) from XBM4         Row 83 to 95 of 108 |
   | S  | ----| Send New Command                           |
   | _  |     | Job name . . : ARUAVR$A                   |
   | _  |     | Utility name : REORG PLUS Online          |
   | _  | Sele| Enter command below, then press Enter.    |
   | _  | then| Command . . . DISPLAY VERBOSE            |
   | 7  | ****|                                                                 |
   | _  | /   |                                                                 |
   | Comm |****|                                                                 |
   | Co | ****|                                                                 |
   | F1=Help      F2=Split     F3=Exit      F7=Bkwd      F8=Fwd |
   | F9=Swap      F10=Actions   F12=Cancel   |
   | F1=Help      F2=Split     F3=Exit      F7=Bkwd      F8=Fwd |
   | F9=Swap      F10=Actions   F12=Cancel   |
   | F7=Bkwd      F8=Fwd       F9=Swap      F10=Actions  F12=Cancel |
   | F7=Bkwd      F8=Fwd       F9=Swap      F10=Actions  F12=Cancel |

For information about which REORG PLUS commands can be sent from XBM and what those commands do, see the *REORG PLUS for DB2 Reference Manual*.

Displaying the last command sent to a utility

This procedure explains how to display the last command you sent to a utility through the XBM Utility monitor.

1. From the Utility Job Selection subpanel, select the job in the list for which you want to display the last command sent.

2. From the Command pull-down, choose View Last to display the View Last Command subpanel (Figure 66 on page 208).
Alternatively, enter the Fastpath command **Viewlast**.

**Figure 66: View Last Command subpanel**

```
--- | File View Command Options Console Monitor User Help | -----
     View Last Command  Row 1 to 5 of 53

S | Job name . . : ARUAVR$A
S | Utility name : REORG PLUS Online
| Command . . : DISPLAY VERBOSE

Following response received return code : 8
BMC50803 LOG APPLY DISPLAY AT 04/22/2012 09:58:40
BMC50822 CURRENT PHASE: LOGAPPLY, STARTED: 04/22/2012 09:49:04
BMC50804 LOG APPLY TASKS : 1 TASKS, 1 STARTED, 0 FINISHED
BMC50805 1 RECORDS QUEUED, 2564 RECORDS APPLIED
BMC50807 TASK 102: STARTED

Command ===> ____________________________________________________________
C  F1=Help     F2=Split    F3=Exit     F7=Bkwd     F8=Fwd      F9=Swap
   F10=Actions F12=Cancel
```
Monitoring and managing storage devices

This chapter introduces the SSI monitor that the EXTENDED BUFFER MANAGER (XBM) product provides for monitoring and controlling intelligent hardware devices. This monitor allows you to perform the following functions:

■ display direct access storage devices (DASD) volume status information
■ perform functions at the volume level on hardware devices through vendor-specific object panels in the XBM ISPF interface

Using the SSI monitor

This section describes how to use the SSI monitor to access information about DASD volume status and gain access to hardware-specific panels that allow you to issue commands to the hardware component through the SSI monitor.

Note

If you want to manage hardware devices associated with a remote XBM subsystem in the SSI monitor instead of the local subsystem to which you are currently connected, perform the steps in “Displaying detailed information for a remote XBM subsystem” on page 80.

Understanding DASD volume status information

The SSI monitor displays the status of DASD and provides comprehensive statistical information regarding the usage of those devices.

To determine the devices that are present in the MVS system with valid paths, choose Monitor => SSI monitor from the File List panel in the XBM ISPF interface. The resulting SSI Objects panel displays the status of all of the devices that were discovered during startup (unless View filtering is active). If any expected devices are not included, it is likely that XBM did not discover them during its initialization.
When the SSI component starts, it attempts to discover all of the DASD accessible to the MVS image. To be found, a device must be *genned* with a valid unit control block (UCB) and at least one validated path to the device must exist. If no path exists, no discovery I/O is issued, which avoids a very long delay on each UCB for path validation or truly absent devices.

Devices used as mirrors are sometimes *genned* as offline devices, which means that path validation does not occur during an Initial Program Load (IPL), and consequently XBM does not find them during discovery. In these cases, you can use the Devserv Path command after an IPL to identify the range of general devices that are offline. Executing this command allows XBM to find these devices during the subsequent discovery, so that you can display them in the XBM monitor and use them for snapshot or other mirroring activity.

The following example shows the syntax for the Devserv Path command.

---

**Example**

To display the status of device number 077F, enter:

```plaintext
DS P,077F
```

To display the status of all offline devices with device numbers 0770 through 077F, enter:

```plaintext
DS P,0770,16,OFF
```

---

### Accessing the SSI monitor

This procedure explains how to access the SSI monitor so that you can perform volume-level functions on hardware devices.

1. On the File List panel, choose **Monitor => SSI monitor** and press **Enter**.

2. Access the SSI Selection subpanel (Figure 67 on page 211):

   - If you enabled the **View selection on monitor entry** option, the SSI Selection subpanel is displayed automatically.
Otherwise, at the SSI Objects panel, choose View => Selection and press Enter.

**Figure 67: SSI Selection subpanel**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value to enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functionality</td>
<td>the functionality of the type of device to display</td>
</tr>
<tr>
<td></td>
<td>■ All—does not filter device by functionality</td>
</tr>
<tr>
<td></td>
<td>■ Peer-to-peer remote copy—displays all generic PPRC devices</td>
</tr>
<tr>
<td></td>
<td>■ EMC TimeFinder—displays all EMC TimeFinder devices</td>
</tr>
<tr>
<td></td>
<td>■ Hitachi Remote Copy—displays all Hitachi Remote Copy devices</td>
</tr>
<tr>
<td>Start address</td>
<td>the starting address in a range of devices that you want to display</td>
</tr>
<tr>
<td>End address</td>
<td>the ending address in a range of devices that you want to display</td>
</tr>
<tr>
<td>Device count</td>
<td>the maximum number of devices to display in the device list</td>
</tr>
<tr>
<td>Dtype</td>
<td>the type of device (for example, 3390)</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of the device</td>
</tr>
<tr>
<td>Voluse</td>
<td>the volume usage of the device (for example, PRIVATE or SMS)</td>
</tr>
<tr>
<td>Mfg</td>
<td>the manufacturer of the device</td>
</tr>
</tbody>
</table>

3 On the SSI Selection subpanel, enter the display criteria as described in the following table.

You can use wildcard characters in the Dtype, Volser, Voluse, and Mfg fields.

4 When you finish entering filtering criteria, press Enter.
5 If the SSI Status Selection subpanel is displayed (Figure 68 on page 212), enter the
status of the devices that you want to display, and press Enter.

**Figure 68: SSI Status Selection subpanel**

<table>
<thead>
<tr>
<th>Status Selection</th>
<th>Enter status type to be displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>1. All</td>
</tr>
<tr>
<td>F1=Help</td>
<td>F12=Cancel</td>
</tr>
</tbody>
</table>

The XBM ISPF interface shows the objects panel for the type of devices that you specified. The following sections describe the devices and functions that XBM supports:

<table>
<thead>
<tr>
<th>Device</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>All DASD objects (regardless of functionality)</td>
<td>“Displaying generic DASD volumes” on page 212</td>
</tr>
<tr>
<td>Peer-to-peer remote copy objects</td>
<td>“Managing PPRC objects” on page 216</td>
</tr>
<tr>
<td>EMC TimeFinder objects</td>
<td>“Managing EMC TimeFinder objects” on page 225</td>
</tr>
<tr>
<td>Hitachi ShadowImage and remote copy objects</td>
<td>“Managing Hitachi ShadowImage and Remote Copy objects” on page 235</td>
</tr>
</tbody>
</table>

**Displaying generic DASD volumes**

You access generic information about the DASD devices through the SSI monitor.

You access the SSI objects panel if you do not enter filtering criteria while opening
the SSI monitor or if you chose to not to filter by functionality by selecting 1 (All) on
the SSI Selection subpanel.

The following table describes the type of information that is available and the panel
upon which it is located.

<table>
<thead>
<tr>
<th>DASD statistics</th>
<th>To access statistics</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>summary information for the devices that match the specified criteria</td>
<td>Review the top portion of the SSI objects panel.</td>
<td>“Displaying summary information about the DASD volume status” on page 213</td>
</tr>
<tr>
<td>general information for individual devices that match the specified criteria</td>
<td>Review the bottom portion of the SSI objects panel.</td>
<td>“Displaying general information for an individual DASD volume” on page 214</td>
</tr>
</tbody>
</table>
DASD statistics | To access statistics | Reference
---|---|---
detailed information for individual DASD volumes | 1 On the SSI objects panel, type 1 (Zoom) in the selection field next to the DASD volume for which you want to display information and press **Enter**.  2 Review the device panel. | “Displaying detailed information about individual DASD volumes” on page 215

**Note**
If you do not filter by specific functionality, you cannot perform actions upon the hardware devices. You can only display detailed information for the devices.

## Displaying summary information about the DASD volume status

The top portion of the SSI objects panel provides the number of DASD volumes that are online and offline. These statistics include data for all DASD volumes that satisfy the *selection criteria* that you have specified.

![Figure 69: SSI Objects panel — Summary DASD volume status](image)

**Figure 69: SSI Objects panel — Summary DASD volume status**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online 3390</td>
<td>the number of online 3390 devices that are listed</td>
</tr>
<tr>
<td>Offline 3390</td>
<td>the number of offline 3390 devices that are listed</td>
</tr>
<tr>
<td>Online 3380</td>
<td>the number of online 3380 devices that are listed</td>
</tr>
<tr>
<td>Offline 3380</td>
<td>the number of offline 3380 devices that are listed</td>
</tr>
<tr>
<td>Online other</td>
<td>the number of online devices that are listed of a device type other than 3380 or 3390</td>
</tr>
</tbody>
</table>

**Table 52 on page 213** describes the fields that contain status information from the top portion of the SSI objects panel.
### Displaying general information for an individual DASD volume

The lower portion of the SSI objects panel shows general information about DASD volumes that match the selection criteria that you specified.

#### Figure 70: SSI Objects panel — General DASD volume status

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>selection entry column that you use to display detailed (zoom) information about the device</td>
</tr>
<tr>
<td>Addr</td>
<td>the address of the device</td>
</tr>
<tr>
<td>CUSSid</td>
<td>the subsystem ID of the control unit</td>
</tr>
<tr>
<td>DType</td>
<td>the device type of this device</td>
</tr>
<tr>
<td>Status</td>
<td>the current status of the device—online or offline</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of the device</td>
</tr>
<tr>
<td>Voluse</td>
<td>the volume usage description for this device</td>
</tr>
</tbody>
</table>

#### Table 53: General status information for individual DASD volumes

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offline other</td>
<td>the number of offline devices that are listed of a device type other than 3380 or 3390</td>
</tr>
<tr>
<td>Total online</td>
<td>the total number of online devices that are listed</td>
</tr>
<tr>
<td>Total offline</td>
<td>the total number of offline devices that are listed</td>
</tr>
</tbody>
</table>

Figure 70 on page 214 describes the fields that contain information from the lower portion of the SSI objects panel.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPRC</td>
<td>whether Peer-to-Peer Remote Copy (PPRC) support is available for this device</td>
</tr>
<tr>
<td>Mfg</td>
<td>the manufacturer of this device</td>
</tr>
<tr>
<td>Functionality</td>
<td>the type of vendor-specific functionality that this device is defined to use</td>
</tr>
</tbody>
</table>

For more information about vendor-specific functions, see the documentation provided by that vendor.

---

### Displaying detailed information about individual DASD volumes

The device subpanel shows detailed status information for an individual hardware device. To display this information, select an SSI object from the lower portion of the SSI objects panel and press **Enter**.

The title and layout of this subpanel depends on the type of device being viewed. Figure 71 on page 215 shows an example for an EMC TimeFinder device.

**Figure 71: DASD volume status subpanel**

```
EMC TimeFinder device on 04/01/2008 at 11:25:29
Address . . . . : 5612                      Status . . . . : Online
Device type . . : 3390-A               Cyls/Blks . . : 3339
Volser . . . . : SN5612              Voluse . . . . : PRIVATE
CU type . . . . : 3990                     CUSSID . . . . : 00D8

Symmtrix STD(CKD) device number 0012
Internal volser : Shared . . . . : No
Mirror . . . . : M1/M2               Last paired : None
BCV status . . : Synchronized           Paired device : None
Sync type . . . : Establish/ReEstablish Inv tracks . . : 0
```

Table 54 on page 215 lists the fields of the individual DASD volume status. Not all status fields shown below are applicable to each manufacturer’s devices. Depending on the device you select, some status fields shown in this table might not appear.

**Table 54: Status information for individual DASD volumes**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>the address of the device</td>
</tr>
<tr>
<td>Status</td>
<td>the status of the device—online or offline</td>
</tr>
<tr>
<td>Device type</td>
<td>the device type</td>
</tr>
<tr>
<td>Cyls/Blks</td>
<td>the total number of cylinders or blocks of the device</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of the device</td>
</tr>
</tbody>
</table>
### Managing PPRC objects

This section describes how to use the SSI monitor to display information about and manage PPRC devices.

This section contains the following topics:

- “Displaying PPRC devices” on page 217
- “Establishing a PPRC pair” on page 221
- “Reestablishing a PPRC pair” on page 223
- “Suspending PPRC operations for a pair” on page 223
- “Removing a pair from PPRC operations” on page 223
- “Recovering a secondary PPRC device” on page 224
- “Displaying information about a mirrored PPRC device” on page 225

**Note**

Authorization to manipulate device relationships is controlled by RACF. For more information, see the “Configuring RACF security” on page 39.
Displaying PPRC devices

You access PPRC objects information through the SSI monitor.

The following table describes the type of information that is available and the panel upon which it is located.

<table>
<thead>
<tr>
<th>Type of information</th>
<th>To access information</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>summary statistics about all PPRC objects that match the criteria that you specified</td>
<td>Review the top portion of the PPRC objects panel.</td>
<td>“Displaying summary statistics for PPRC objects” on page 217</td>
</tr>
<tr>
<td>general information for PPRC objects</td>
<td>Review the bottom portion of the PPRC objects panel.</td>
<td>“Displaying general information for individual PPRC objects” on page 218</td>
</tr>
<tr>
<td>detailed information for a single PPRC object</td>
<td>1 On the PPRC objects panel, type 1 (Zoom) in the field next to the device you want to display and press Enter.</td>
<td>“Displaying detailed information for a PPRC device” on page 219</td>
</tr>
<tr>
<td></td>
<td>2 Review the information on the PPRC device subpanel.</td>
<td></td>
</tr>
</tbody>
</table>

Displaying summary statistics for PPRC objects

The top portion of the PPRC objects panel allows you to display summary information about PPRC objects. It contains statistics for all PPRC objects that match the criteria you specified in the SSI Selection subpanel.

Figure 72: PPRC Objects panel — Summary statistics

Table 55 on page 218 describes the summary statistics that are available on the PPRC objects panel.
Table 55: Summary statistics for PPRC objects

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simplex devices</td>
<td>the number of simplex devices displayed in the list</td>
</tr>
<tr>
<td></td>
<td>Simplex state is the initial state of the volumes before any PPRC pairs have been defined. It is also the state of the volumes after the PPRC pairs have been terminated by using the CDELPAIR command.</td>
</tr>
<tr>
<td>Primary devices</td>
<td>the number of primary devices displayed in the list</td>
</tr>
<tr>
<td></td>
<td>Primary devices are devices to which a secondary device can be mirrored.</td>
</tr>
<tr>
<td>Duplex devices</td>
<td>the number of duplex devices displayed in the list</td>
</tr>
<tr>
<td></td>
<td>Duplex state indicates that PPRC is complete and the pairs are synchronized.</td>
</tr>
<tr>
<td>Secondary devices</td>
<td>the number of secondary devices displayed in the list</td>
</tr>
<tr>
<td></td>
<td>A secondary device is a device that can be a candidate to be mirrored to from a primary device.</td>
</tr>
</tbody>
</table>

Displaying general information for individual PPRC objects

The bottom portion of the PPRC objects panel lists each device that was returned for the selection criteria that you specified.

Figure 73: PPRC Objects panel — Individual objects

Table 56 on page 218 describes the information available that is available on this panel for each PPRC object.

Table 56: General information for individual PPRC objects

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>selection column that allows you to perform actions on the selected device</td>
</tr>
<tr>
<td>Addr</td>
<td>the address of the device</td>
</tr>
<tr>
<td>DType</td>
<td>the type of device</td>
</tr>
</tbody>
</table>

Command ==>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>the current status of the device—online or offline</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of this device</td>
</tr>
<tr>
<td>SSid</td>
<td>the subsystem ID of the control unit</td>
</tr>
<tr>
<td>CUSNum</td>
<td>the serial number of the control unit</td>
</tr>
<tr>
<td>CCA</td>
<td>the channel connection address</td>
</tr>
<tr>
<td>LS</td>
<td>the logical subsystem (LSS) of the 2105 IBM Shark device</td>
</tr>
<tr>
<td>Mfg</td>
<td>the manufacturer of the device</td>
</tr>
<tr>
<td>L (level)</td>
<td>the PPRC level of this device (Primary, Secondary, or blank)</td>
</tr>
<tr>
<td></td>
<td>■ Primary (P) indicates that this volume is the source volume in a mirrored</td>
</tr>
<tr>
<td></td>
<td>(duplex) pair.</td>
</tr>
<tr>
<td></td>
<td>■ Secondary (S) indicates that this volume is the target volume in a mirrored</td>
</tr>
<tr>
<td></td>
<td>(duplex) pair.</td>
</tr>
<tr>
<td></td>
<td>■ A blank value indicates a volume that has not been mirrored.</td>
</tr>
<tr>
<td>STATE</td>
<td>the PPRC state of the device</td>
</tr>
<tr>
<td></td>
<td>■ DUPLEX indicates that the volume is currently mirrored to another volume</td>
</tr>
<tr>
<td></td>
<td>or the secondary volume has been suspended.</td>
</tr>
<tr>
<td></td>
<td>■ SIMPLEX indicates that the volume is not currently mirrored to another</td>
</tr>
<tr>
<td></td>
<td>volume.</td>
</tr>
<tr>
<td></td>
<td>■ A blank value indicates that the PPRC state was not determined during</td>
</tr>
<tr>
<td></td>
<td>device discovery.</td>
</tr>
</tbody>
</table>

**Displaying detailed information for a PPRC device**

The PPRC device subpanel displays detailed information about a single PPRC object. To access this information, type 1 (Zoom) next to the desired device on the PPRC objects panel and press **Enter**.
Figure 74: PPRC Device subpanel

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>the address of the device</td>
</tr>
<tr>
<td>Status</td>
<td>the current status of the device—online or offline</td>
</tr>
<tr>
<td>Device Type</td>
<td>the type of device</td>
</tr>
<tr>
<td>Cyls/Blks</td>
<td>the total number of cylinders or blocks (depending on device)</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of this device</td>
</tr>
<tr>
<td>Voluse</td>
<td>the volume usage description for this device</td>
</tr>
<tr>
<td>CU type</td>
<td>the device type of the control unit</td>
</tr>
<tr>
<td>CUSSid</td>
<td>the subsystem ID of the control unit</td>
</tr>
<tr>
<td>SSid - Primary</td>
<td>the subsystem ID of the control unit for the current (or last connected) primary volume in a duplex pair</td>
</tr>
<tr>
<td>CUSNum - Primary</td>
<td>the serial number of the control unit for the current (or last connected) primary volume in a duplex pair</td>
</tr>
<tr>
<td>CCA - Primary</td>
<td>the channel connection address of the current (or last connected) primary volume in a duplex pair</td>
</tr>
<tr>
<td>LSS - Primary</td>
<td>the logical subsystem number of the primary volume in a duplex pair</td>
</tr>
<tr>
<td>SSid - Secondary</td>
<td>the subsystem ID of the control unit for the current (or last connected) secondary volume in a duplex pair</td>
</tr>
<tr>
<td>CUSNum - Secondary</td>
<td>the serial number of the control unit for the current (or last connected) secondary volume in a duplex pair</td>
</tr>
<tr>
<td>CCA - Secondary</td>
<td>the channel connection address of the current (or last connected) secondary volume in a duplex pair</td>
</tr>
</tbody>
</table>

Table 57 on page 220 explains describes the detailed information about a PPRC device that is available on this subpanel.

Table 57: Detailed information for a PPRC device
## Establishing a PPRC pair

This procedure explains how to use the SSI monitor to issue the CESTPAIR command to establish a PPRC pair.

1. Access the PPRC objects panel, as described in “Accessing the SSI monitor” on page 210.
2 On the PPRC objects panel, locate the secondary device and record the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSid</td>
<td>the four-digit hexadecimal value that represents the control unit subsystem ID of the secondary device</td>
</tr>
<tr>
<td>CUSNum</td>
<td>the control unit serial number of the secondary device</td>
</tr>
<tr>
<td>CCA</td>
<td>the two-digit hexadecimal value that represents the channel connection address for the secondary device</td>
</tr>
<tr>
<td>LSS</td>
<td>the two-digit hexadecimal value that represents the logical subsystem for the secondary device</td>
</tr>
</tbody>
</table>

**Note**
If the device is remote and you cannot access the information through the monitor, gather this information about the device outside of XBM.

3 On the PPRC objects panel, type 2 (EstPair) in the selection field next to the primary device for which you want to establish a mirrored device and press Enter.

**WARNING**
Ensure that the mirrored device is offline before attempting to establish the pair. If you establish a pair with an online device, you can overwrite the information on that device.

The PPRC Establish Pair subpanel (Figure 75 on page 222) is displayed.

**Figure 75: PPRC Establish Pair subpanel**

4 On the PPRC Establish Pair subpanel, enter information for the secondary device.

5 When you finish entering the information, press Enter.

The SSI action response subpanel indicates that the establish pair action was initiated.

6 On the SSI action response subpanel, press F12 to return to the PPRC objects panel.
Reestablishing a PPRC pair

This procedure explains how to use the SSI monitor to issue the CESTPAIR RESYNC command against a suspended device to reestablish a PPRC pair.

1. Access the PPRC objects panel, as described in “Accessing the SSI monitor” on page 210.

2. On the PPRC objects panel, type `EstPair(Resync)` in the selection field next to the suspended device for which you want to reestablish a secondary device and press Enter.

   XBM gathers the information for the secondary device that was previously associated with that primary device.

3. On the SSI action response subpanel, press F12 to return to the PPRC objects panel.

Suspending PPRC operations for a pair

This procedure describes how to use the SSI monitor to issue the CSUSPEND command to suspend PPRC operations between a primary and secondary device. This command stops updates sent to the mirrored volume from the primary volume.

1. Access the PPRC objects panel, as described in “Accessing the SSI monitor” on page 210.

2. On the PPRC objects panel, type `Suspend` in the selection field next to the primary device for which you want to suspend PPRC operations and press Enter.

   The SSI action response subpanel indicates that the suspend action has been initialized.

3. On the SSI action response subpanel, press F12 to return to the PPRC objects panel.

Removing a pair from PPRC operations

This procedure explains how to use the SSI monitor to issue the CDELPAIR command to remove a primary and secondary device from PPRC operations.

1. Access the PPRC objects panel, as described in “Accessing the SSI monitor” on page 210.
Recovering a secondary PPRC device

This procedure describes how to use the SSI monitor to issue the CRECOVER command to give control of a secondary device to a recovery system. It also allows you to change the volume ID if you require the volume to be varied online to the same system as the primary volume.

1. Access the PPRC objects panel, as described in “Accessing the SSI monitor” on page 210.

2. On the PPRC objects panel, type 6 (Recover) in the selection field next to the device that you want to use and press Enter.

The PPRC Recover subpanel (Figure 76 on page 224) is displayed.

3. On the PPRC Recover subpanel, enter information for the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>What you enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSid</td>
<td>the four-digit hexadecimal value that represents the control unit subsystem ID of the secondary device</td>
</tr>
<tr>
<td>CUSNum</td>
<td>the control unit serial number of the secondary device</td>
</tr>
<tr>
<td>CCA</td>
<td>the two-digit hexadecimal value that represents the channel connection address of the secondary device</td>
</tr>
<tr>
<td>LSS</td>
<td>(optional) the two-digit hexadecimal value that represents the logical subsystem for the secondary device, if required</td>
</tr>
</tbody>
</table>
| New volser| (optional) a new volume serial number for the secondary device  
Use this field to put a new volume ID on the device so it can be brought online. |
Note

XBM will populate the value of all fields except **New volser** with values for the last secondary device associated with the selected primary device.

4 When you finish entering values, press **Enter**. The SSI action response subpanel indicates that the recover action has been initialized.

5 On the SSI action response subpanel, press **F12** to return to the PPRC options panel.

Displaying information about a mirrored PPRC device

This procedure explains how to use the SSI monitor to display a mirror of a PPRC device. XBM displays a single mirror for a device. If a device has multiple PPRC mirrors (currently limited to Hitachi ShadowImage), XBM displays the mirror returned by the PPRC query. Selecting any mirror, however, will display the correct source device.

1 Access the PPRC objects panel, as described in “Accessing the SSI monitor” on page 210.

2 Enter 1 (Zoom) next to the device whose mirror you want to display and press **Enter**.

3 On the PPRC device subpanel, press **F5**. If the device does not have a mirror, an error message is displayed. Otherwise, the device selection panel is displayed.

4 On the device selection subpanel, type `/` in the field next to the mirror that you want to display and press **Enter**. The mirror information is displayed in a PPRC device subpanel.

Managing EMC TimeFinder objects

This section describes how to use the SSI monitor to display information about and manage EMC TimeFinder devices.

This section contains the following topics:

- “Displaying EMC TimeFinder devices” on page 226
- “Establishing a standard device BCV pair” on page 230
Displaying EMC TimeFinder devices

You access information about EMC TimeFinder devices through the SSI monitor.

The following table describes the type of information that is available and the panel upon which it is located.

<table>
<thead>
<tr>
<th>Type of information</th>
<th>To access information</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>summary statistics about all EMC TimeFinder devices</td>
<td>Review the top portion of the EMC Objects panel.</td>
<td>“Displaying summary statistics for EMC TimeFinder devices” on page 226</td>
</tr>
<tr>
<td>general information for EMC TimeFinder devices</td>
<td>Review the bottom portion of the EMC Objects panel.</td>
<td>“Displaying general information about EMC devices” on page 227</td>
</tr>
<tr>
<td>detailed information for a single EMC TimeFinder device</td>
<td>1 On the EMC Objects panel, type 1 (Zoom) next to the device you want to review and press Enter.</td>
<td>“Displaying detailed information for an EMC TimeFinder device” on page 228</td>
</tr>
<tr>
<td></td>
<td>2 Review the information on the EMC TimeFinder device subpanel.</td>
<td></td>
</tr>
</tbody>
</table>

Displaying summary statistics for EMC TimeFinder devices

The top portion of the EMC Objects panel allows you to display summary statistics for EMC TimeFinder devices. It contains statistics for all devices that match the criteria you specified in the SSI Selection subpanel.

Note
Authorization to manipulate device relationships is controlled by RACF. For more information, see the installation guide.
Figure 77: EMC Objects panel — Summary statistics

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STD devices</td>
<td>the number of standard (STD) devices that match the selection criteria you specified</td>
</tr>
<tr>
<td>BCV devices</td>
<td>the number of Business Continuance Volumes (BCVs) that match the selection criteria that you specified</td>
</tr>
<tr>
<td>Synchronized</td>
<td>the number of standard (STD) devices that are synchronized with a BCV device</td>
</tr>
<tr>
<td>Sync in progress</td>
<td>the number of BCV mirrors that are in the process of establishing or restoring a connection with a STD device</td>
</tr>
<tr>
<td>Virtual vol. devs</td>
<td>the number of virtual devices that match the selection criteria that you specified</td>
</tr>
<tr>
<td>SRDF sources</td>
<td>the number of STD devices that are source volumes for a mirror to a Symmetrix Remote Data Facility (SRDF) volume</td>
</tr>
<tr>
<td>SRDF targets</td>
<td>the number of SRDF targets for STD devices</td>
</tr>
</tbody>
</table>

Table 58: Summary statistics for EMC TimeFinder objects

Table 59 on page 228 describes the information available on the EMC TimeFinder Objects panel for each device.

Displaying general information about EMC devices

The bottom portion of the EMC Objects panel lists each device that was returned as a result of the selection criteria that you specified.

Figure 78: EMC Objects panel — Individual objects

Select actions on the following EMC TimeFinder objects, then press enter.

<table>
<thead>
<tr>
<th>Addr</th>
<th>DType</th>
<th>Status</th>
<th>Volser</th>
<th>DNum</th>
<th>Type</th>
<th>Sync</th>
<th>PDev</th>
<th>SRDF</th>
</tr>
</thead>
<tbody>
<tr>
<td>0BC0</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC0</td>
<td>0602</td>
<td>STD</td>
<td>Yes</td>
<td>0627</td>
<td>No</td>
</tr>
<tr>
<td>0BC1</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC1</td>
<td>0603</td>
<td>STD</td>
<td>Yes</td>
<td>0628</td>
<td>No</td>
</tr>
<tr>
<td>0BC2</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC2</td>
<td>0604</td>
<td>STD</td>
<td>Yes</td>
<td>0629</td>
<td>No</td>
</tr>
<tr>
<td>0BC3</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC3</td>
<td>0605</td>
<td>STD</td>
<td>Yes</td>
<td>062A</td>
<td>No</td>
</tr>
<tr>
<td>0BC4</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC4</td>
<td>0606</td>
<td>STD</td>
<td>Yes</td>
<td>062B</td>
<td>No</td>
</tr>
<tr>
<td>0BC5</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC5</td>
<td>0607</td>
<td>STD</td>
<td>Yes</td>
<td>062C</td>
<td>No</td>
</tr>
<tr>
<td>0BC6</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC6</td>
<td>0608</td>
<td>STD</td>
<td>Yes</td>
<td>062D</td>
<td>No</td>
</tr>
<tr>
<td>61B1</td>
<td>3390</td>
<td>Offline</td>
<td>10DD</td>
<td>VVD</td>
<td>No</td>
<td>0A5D</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>61B2</td>
<td>3390</td>
<td>Offline</td>
<td>10DE</td>
<td>VVD</td>
<td>No</td>
<td>0A5A</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>61B4</td>
<td>3390</td>
<td>Offline</td>
<td>10E0</td>
<td>VVD</td>
<td>No</td>
<td>0A5B</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Table 59 on page 228 describes the information available on the EMC TimeFinder Objects panel for each device.
### Table 59: General information for individual EMC TimeFinder objects

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>selection column that allows you to perform actions on the selected device</td>
</tr>
<tr>
<td>Addr</td>
<td>the address of the device</td>
</tr>
<tr>
<td>DType</td>
<td>the device type of this device</td>
</tr>
<tr>
<td>Status</td>
<td>the current status of the device—online or offline</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of this device</td>
</tr>
</tbody>
</table>
| DNum  | the device number of the device  
This number is specific to a hardware unit. |
| Type  | the type of Symmetrix volume—standard, BCV, or Virtual Volume (VVD) |
| Sync  | whether the device is synchronized  
This field can also display whether a device is in held status by displaying the term Held. If the device is held, no other TimeFinder operations can be performed against the device until the device is released. However, snapshots can be performed by using this device. It will be released for that purpose. |
| PDev  | the device number of a paired device  
This number will point to the BCV or the STD device number for a mirror connection. The value in this field will be NONE if a STD device is not currently synchronized or if a BCV has never been synchronized. Otherwise, the field will display the last paired device number. |
| SRDF  | whether this device has an SRDF defined and, for SRDF devices, whether the SRDF is destination or source |

### Displaying detailed information for an EMC TimeFinder device

The EMC TimeFinder device subpanel provides detailed information about a single EMC TimeFinder device.
To access this subpanel, type **1 (Zoom)** next to a device on the EMC TimeFinder Objects panel and press **Enter**.

**Figure 79: EMC TimeFinder Device subpanel**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>the address of the device</td>
</tr>
<tr>
<td>Status</td>
<td>the current status of the device — online or offline</td>
</tr>
<tr>
<td>Device type</td>
<td>the type of device</td>
</tr>
<tr>
<td>Cyls/Blks</td>
<td>the total number of cylinders or blocks (depending on the device)</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of the device</td>
</tr>
<tr>
<td>Voluse</td>
<td>the volume usage description of the device</td>
</tr>
<tr>
<td>CU Type</td>
<td>the device type of the control unit</td>
</tr>
<tr>
<td>CUSSid</td>
<td>the subsystem ID of the control unit</td>
</tr>
</tbody>
</table>
| Symmetrix device number | the BCV device number 027E  
| Symmetrix       | the type of Symmetrix volume (STD or BCV)                                  |
| device number    | the device number of the device                                             |
| Internal volser  | the internal volume serial number, if applicable                            |
| Shared           | whether the device is currently shared                                      |
| Mirror           | a list of defined mirror volumes for this device                             |
| Last Paired      | the address of the last device to be paired to this unit                    |
|                  | A value of NONE indicates that this field is not applicable for the current |
|                  | device.                                                                     |
| BCV status       | the status of the BCV (whether the BCV is synchronized, split, or held)     |

**Table 60 on page 229** describes the detailed information displayed on this subpanel for the selected EMC TimeFinder device.

**Table 60: Detailed information for an EMC TimeFinder device**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>the address of the device</td>
</tr>
<tr>
<td>Status</td>
<td>the current status of the device — online or offline</td>
</tr>
<tr>
<td>Device type</td>
<td>the type of device</td>
</tr>
<tr>
<td>Cyls/Blks</td>
<td>the total number of cylinders or blocks (depending on the device)</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of the device</td>
</tr>
<tr>
<td>Voluse</td>
<td>the volume usage description of the device</td>
</tr>
<tr>
<td>CU Type</td>
<td>the device type of the control unit</td>
</tr>
<tr>
<td>CUSSid</td>
<td>the subsystem ID of the control unit</td>
</tr>
<tr>
<td>Symmetrix</td>
<td>the type of Symmetrix volume (STD or BCV)</td>
</tr>
<tr>
<td>device number</td>
<td>the device number of the device</td>
</tr>
<tr>
<td>Internal volser</td>
<td>the internal volume serial number, if applicable</td>
</tr>
<tr>
<td>Shared</td>
<td>whether the device is currently shared</td>
</tr>
<tr>
<td>Mirror</td>
<td>a list of defined mirror volumes for this device</td>
</tr>
<tr>
<td>Last Paired</td>
<td>the address of the last device to be paired to this unit</td>
</tr>
<tr>
<td></td>
<td>A value of NONE indicates that this field is not applicable for the current</td>
</tr>
<tr>
<td></td>
<td>device.</td>
</tr>
<tr>
<td>BCV status</td>
<td>the status of the BCV (whether the BCV is synchronized, split, or held)</td>
</tr>
</tbody>
</table>
### Establishing a standard device BCV pair

This procedure explains how to issue the Establish command to create a relationship between a standard device and a BCV. Every track from the standard device is copied to the BCV.

1. Access the EMC Objects panel, as described in “Accessing the SSI monitor” on page 210.

2. On the EMC Objects panel, type 2 (Establish) in the selection field next to the standard device for which you want to establish a pair and press **Enter**.

   **Note**

   If you attempt to perform an Establish operation on a device that is already online to one or more systems, XBM prompts you whether to continue the Establish attempt.
The EMC TimeFinder device selection subpanel (Figure 80 on page 231) is displayed. It lists all available BCVs and indicates the device that was last established as the BCV in the Information field.

**Figure 80: EMC TimeFinder device selection subpanel**

<table>
<thead>
<tr>
<th>S</th>
<th>Addr</th>
<th>DNum</th>
<th>IVolser</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>570E</td>
<td>010E</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>570F</td>
<td>010F</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5710</td>
<td>0110</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5711</td>
<td>0111</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5712</td>
<td>0112</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5713</td>
<td>0113</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>571E</td>
<td>011E</td>
<td></td>
<td></td>
<td>Last Established BCV</td>
</tr>
</tbody>
</table>

3 Type `/` or `S` in the selection field next to the BCV that you want to associate with the standard device and press **Enter**.

The SSI action response subpanel indicates that the Establish operation has been initialized.

4 Press **F12** to return to the EMC TimeFinder Objects panel.

**Reestabishing a standard device BCV pair**

This procedure explains how to use the SSI monitor to issue the Reestablish command to recreate a link between a standard device and a BCV. Only tracks invalidated since the devices were split are copied to the BCV.

1 Access the EMC Objects panel, as described in “Accessing the SSI monitor” on page 210.

2 On the EMC Objects panel, type 3 (ReEstablish) in the selection field next to the device for which you want to reestablish a link and press **Enter**.

The EMC TimeFinder device selection subpanel is displayed. It shows the information for the last BCV to which the standard device was linked, assuming the device is currently available.

3 Type `S` or `/` in the selection field next to the desired BCV and press **Enter**.

The SSI action response subpanel indicates that the Reestablish command has been initialized.
4 Press **F12** to return to the EMC Objects panel.

**Splitting a standard device BCV pair**

This procedure explains how to use the SSI monitor to issue the Split command to terminate the link between a standard device and a BCV.

1 Access the EMC Objects panel, as described in “Accessing the SSI monitor” on page 210.

2 On the EMC Objects panel, type **4** (Split) in the selection field next to the device for which you want to split the link, and press **Enter**.

   The SSI action response subpanel indicates that the split command has been initialized.

3 Press **F12** to return to the EMC Objects panel.

**Restoring data to a standard device from a BCV**

This procedure explains how to use the SSI monitor to restore the data on a standard device from a BCV by using a regular or incremental restore. For a regular restore, all tracks from the BCV are copied to the standard device. An incremental restore copies only that data on the BCV that has been invalidated since the devices were split to the standard device.

1 Access the EMC Objects panel, as described in “Accessing the SSI monitor” on page 210.

2 On the EMC Objects panel, type **5** (Restore) or **6** (IncRestore) in the selection field next to the device for which you want to restore the data and press **Enter**.

3 On the EMC TimeFinder device selection subpanel, type **S** or **/** in the selection field next to the BCV from which you want to restore and press **Enter**.

4 On the SSI action response subpanel, press **F12** to return to the EMC TimeFinder Objects panel.
Holding and releasing a BCV

This procedure explains how to use the SSI monitor to hold or release BCVs. When you hold a BCV, no other TimeFinder devices can perform actions against that BCV. When you release a held BCV, you allow other TimeFinder devices to start performing operations against that device again. The ReleaseBCV command can also release the hold on standard devices put there by data set snap requests, such as when XBM is processing a snapshot.

1. Access the EMC Objects panel, as described in “Accessing the SSI monitor” on page 210.

2. On the EMC Objects panel, type 7 (HoldBCV) or 8 (ReleaseBCV) in the selection field next to the BCV device that you want to hold or release and press Enter.

3. On the SSI action response subpanel, press F12 to return EMC TimeFinder Objects panel.

Displaying information about a BCV

This procedure explains how to use the SSI monitor to display a BCV for an EMC TimeFinder device. XBM will display whatever BCVs exist for the chosen standard device.

1. Access the EMC Objects panel, as described in “Accessing the SSI monitor” on page 210.

2. Enter 1 (Zoom) next to the device whose BCV you want to display and press Enter.

3. On the EMC TimeFinder device subpanel, press F5. If the device does not have a BCV, an error message is displayed. Otherwise, the EMC TimeFinder device selection panel is displayed.

   Tip

   The EMC TimeFinder device subpanel indicates whether a device is mirrored on the lower half of the panel.

4. On the EMC TimeFinder device selection subpanel, type / in the field next to the mirror that you want to display and press Enter. The BCV information is displayed in an EMC TimeFinder device subpanel.
Monitoring and managing virtual volumes

You can monitor and manage virtual volumes through the SSI monitor.

The EMC objects panel now identifies the number of virtual devices that match your criteria. In the list of devices, the panel identifies virtual devices by showing VVD in the Type field (Figure 81 on page 234).

Figure 81: Example of the EMC Objects panel

<table>
<thead>
<tr>
<th>EMC Objects</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>STD devices</td>
<td>1831</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BCV devices</td>
<td>103</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Synchronized</td>
<td>1544</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sync in progress</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Select actions on the following EMC TimeFinder objects, then press Enter.

1=Zoom  2=Establish  3=ReEstablish  4=Split  5=Restore  6=IncRestore  7=HoldBCV  8=ReleaseBCV  9=StartVirtVolSnap  A=StopVirtVolSnap

<table>
<thead>
<tr>
<th>Addr</th>
<th>DType</th>
<th>Status</th>
<th>Volser</th>
<th>DNum</th>
<th>Type</th>
<th>Sync</th>
<th>PDev</th>
<th>SRDF</th>
</tr>
</thead>
<tbody>
<tr>
<td>0BC0</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC0</td>
<td>0602</td>
<td>STD</td>
<td>Yes</td>
<td>0627</td>
<td>No</td>
</tr>
<tr>
<td>0BC1</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC1</td>
<td>0603</td>
<td>STD</td>
<td>Yes</td>
<td>0628</td>
<td>No</td>
</tr>
<tr>
<td>0BC2</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC2</td>
<td>0604</td>
<td>STD</td>
<td>Yes</td>
<td>0629</td>
<td>No</td>
</tr>
<tr>
<td>0BC3</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC3</td>
<td>0605</td>
<td>STD</td>
<td>Yes</td>
<td>062A</td>
<td>No</td>
</tr>
<tr>
<td>0BC4</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC4</td>
<td>0606</td>
<td>STD</td>
<td>Yes</td>
<td>062B</td>
<td>No</td>
</tr>
<tr>
<td>0BC5</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC5</td>
<td>0607</td>
<td>STD</td>
<td>Yes</td>
<td>062C</td>
<td>No</td>
</tr>
<tr>
<td>0BC6</td>
<td>3390</td>
<td>Online</td>
<td>AFXBC6</td>
<td>0608</td>
<td>STD</td>
<td>Yes</td>
<td>062D</td>
<td>No</td>
</tr>
<tr>
<td>0BC7</td>
<td>3390</td>
<td>Offline</td>
<td>10DD</td>
<td></td>
<td>VVD</td>
<td>No</td>
<td>0AD5</td>
<td>No</td>
</tr>
<tr>
<td>0BC8</td>
<td>3390</td>
<td>Offline</td>
<td>10DF</td>
<td></td>
<td>VVD</td>
<td>No</td>
<td>0A5B</td>
<td>No</td>
</tr>
<tr>
<td>0BC9</td>
<td>3390</td>
<td>Offline</td>
<td>10DE</td>
<td></td>
<td>VVD</td>
<td>No</td>
<td>0A54</td>
<td>No</td>
</tr>
<tr>
<td>0B10</td>
<td>3390</td>
<td>Offline</td>
<td>10DF</td>
<td></td>
<td>VVD</td>
<td>No</td>
<td>0A58</td>
<td>No</td>
</tr>
<tr>
<td>0B11</td>
<td>3390</td>
<td>Offline</td>
<td>10DE</td>
<td></td>
<td>VVD</td>
<td>No</td>
<td>0A58</td>
<td>No</td>
</tr>
<tr>
<td>0B12</td>
<td>3390</td>
<td>Offline</td>
<td>10E1</td>
<td></td>
<td>VVD</td>
<td>No</td>
<td>0A58</td>
<td>No</td>
</tr>
<tr>
<td>0B13</td>
<td>3390</td>
<td>Offline</td>
<td>10E2</td>
<td></td>
<td>VVD</td>
<td>No</td>
<td>0A54</td>
<td>No</td>
</tr>
</tbody>
</table>

Viewing detailed information

To view detailed information about a virtual volume device from the EMC Objects panel, enter 1 in the selection field next to the device and press Enter.

The detailed information includes:

- device type
- number of cylinders or blocks emulated by the device
- volume serial number of the device
- volume usage description for the device
- device type of the control unit
- device number of the device’s hardware unit
- device number of the last-paired standard device for this virtual volume
Managing virtual devices

The SSI monitor provides the following commands for EMC devices on the File menu and on the command list:

- **StartVirtVolSnap** starts a snapshot to a virtual volume.
- **StopVirtVolSnap** stops an active snapshot to a virtual volume.

For more information about EMC commands, see the vendor documentation.

Managing Hitachi ShadowImage and Remote Copy objects

This section describes how to use the SSI monitor to display information about and manage Hitachi ShadowImage and Remote Copy devices.

This section contains the following topics:

- “Displaying Hitachi ShadowImage and Remote Copy devices” on page 236
- “Establishing a PPRC pair with Hitachi devices” on page 240
- “Reestablishing a pair for a suspended Hitachi device” on page 241
- “Suspending PPRC operations for Hitachi devices” on page 242
- “Removing the relationship between a pair of a Hitachi devices” on page 242
- “Reestablishing a pair for a suspended Hitachi device” on page 241
- “Displaying information about a mirrored Hitachi device” on page 244

**Note**

Authorization to manipulate device relationships is controlled by RACF. For more information, see the configuration guide.
Displaying Hitachi ShadowImage and Remote Copy devices

You access information about Hitachi ShadowImage and Remote Copy devices through the SSI monitor.

The following table describes the type of information that is available and the panel upon which it is located.

<table>
<thead>
<tr>
<th>Type of information</th>
<th>To access information</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>summary statistics for Hitachi ShadowImage and Remote Copy devices that match the criteria that you specified</td>
<td>Review the top portion of the HTC Remote Copy Objects panel.</td>
<td>“Displaying summary statistics for Hitachi ShadowImage and Remote Copy devices” on page 236</td>
</tr>
<tr>
<td>general information for Hitachi ShadowImage and Remote Copy devices</td>
<td>Review the bottom of the HTC Remote Copy Objects panel.</td>
<td>“Displaying general information for Hitachi devices” on page 237</td>
</tr>
<tr>
<td>detailed information for a single Hitachi ShadowImage or Remote Copy device</td>
<td>1 At HTC Remote Copy Objects panel, type 1 (Zoom) next to the device you want to display.</td>
<td>“Displaying detailed information for a Hitachi device” on page 238</td>
</tr>
<tr>
<td></td>
<td>2 Review the information on HTC RemoteCopy device subpanel.</td>
<td></td>
</tr>
</tbody>
</table>

Displaying summary statistics for Hitachi ShadowImage and Remote Copy devices

The HTC Remote Copy Objects panel allows you to display statistical information for ShadowImage and Remote Copy objects.

**Figure 82: HTC Remote Copy Objects panel — Summary statistics**

```
File View Options Console Monitor User Help
--------------------------------------------------------------------------
HTC Remote Copy Objects on 04/22/2008 at 21:14: Row 1 to 10 of 506
Simplex devices . . : 460 Primary devices . . : 14
Duplex devices . . : 14 Secondary devices . . : 0
```

The top portion of the HTC Remote Copy Objects panel provides you with the information described in Table 61 on page 237.
Table 61: Summary statistics for HTC Remote Copy objects

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simplex devices</td>
<td>the number of simplex devices displayed in the list</td>
</tr>
<tr>
<td></td>
<td>Simplex state is the initial state of the volumes before any PPRC pairs have</td>
</tr>
<tr>
<td></td>
<td>been defined. It is also the state of the volumes after the PPRC pairs have</td>
</tr>
<tr>
<td></td>
<td>been terminated by using the CDELPAR command.</td>
</tr>
<tr>
<td>Primary devices</td>
<td>the number of primary devices displayed in the list</td>
</tr>
<tr>
<td></td>
<td>Primary devices are devices to which a secondary device can be mirrored.</td>
</tr>
<tr>
<td>Duplex devices</td>
<td>the number of duplex devices displayed in the list</td>
</tr>
<tr>
<td></td>
<td>Duplex state indicates that PPRC is complete and the pairs are synchronized.</td>
</tr>
<tr>
<td>Secondary devices</td>
<td>the number of secondary devices displayed in the list</td>
</tr>
<tr>
<td></td>
<td>A secondary device is a device that can be a candidate to be mirrored from</td>
</tr>
<tr>
<td></td>
<td>a primary device.</td>
</tr>
</tbody>
</table>

Displaying general information for Hitachi devices

The bottom portion of the HTC Remote Copy Objects panel lists each device that was returned for the selection criteria that you specified.

Figure 83: HTC Remote Copy Objects panel — Individual objects

Select actions on the following Hitachi objects, then press enter.
1=Zoom 2=EstPair 3=EstPair(Resync) 4=Suspend 5=DelPair 6=Recover
S   Addr  DType  Status   Volser  SSid  CUSNum  CCA  L  STATE
_   2300  3390   Online   JC2300  0090   30363   00  P  DUPLEX
_   2301  3390   Online   JC2301  0090   30363   01  P  DUPLEX
_   2302  3390   Online   JC2302  0090   30363   02  P  DUPLEX
_   2303  3390   Online   JC2303  0090   30363   03  P  DUPLEX
_   2304  3390   Online   JC2304  0090   30363   04  P  DUPLEX
_   2305  3390   Online   JC2305  0090   30363   05  P  DUPLEX
_   2306  3390   Online   JC2306  0090   30363   06  P  DUPLEX
_   2307  3390   Online   JC2307  0090   30363   07  P  DUPLEX
_   2308  3390   Online   JC2308  0090   30363   08  P  DUPLEX
_   2309  3390   Online   JC2309  0090   30363   09  P  DUPLEX

This portion of the panel provides the information described in Table 62 on page 237 for each Remote Copy object.

Table 62: General information for individual HTC Remote Copy objects

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>selection column that allows you to perform actions on the selected device</td>
</tr>
<tr>
<td>Addr</td>
<td>the address of the device</td>
</tr>
<tr>
<td>DType</td>
<td>the type of device</td>
</tr>
<tr>
<td>Status</td>
<td>the current status of the device—online or offline</td>
</tr>
<tr>
<td>Volser</td>
<td>the volume serial number of this device</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>SSid</td>
<td>the subsystem ID of the control unit</td>
</tr>
<tr>
<td>CUSNum</td>
<td>the serial number of the control unit</td>
</tr>
<tr>
<td>CCA</td>
<td>the channel connection address</td>
</tr>
<tr>
<td>L (level)</td>
<td>the PPRC level of this device (Primary, Secondary, or blank)</td>
</tr>
<tr>
<td></td>
<td>- Primary (P) indicates that this volume is the source volume in a mirrored (duplex) pair.</td>
</tr>
<tr>
<td></td>
<td>- Secondary (S) indicates that this volume is the target volume in a mirrored (duplex) pair.</td>
</tr>
<tr>
<td></td>
<td>- A blank value indicates a volume that has not been mirrored.</td>
</tr>
<tr>
<td>STATE</td>
<td>the PPRC state of the device</td>
</tr>
<tr>
<td></td>
<td>- DUPLEX indicates that the volume is currently mirrored to another volume or the secondary volume has been suspended.</td>
</tr>
<tr>
<td></td>
<td>- SIMPLEX indicates that the volume is not currently mirrored to another volume.</td>
</tr>
<tr>
<td></td>
<td>- A blank value indicates that the PPRC state was not determined during device discovery.</td>
</tr>
</tbody>
</table>

## Displaying detailed information for a Hitachi device

The HTC RemoteCopy device subpanel provides detailed information about a single Hitachi device. To access this subpanel, type 1 (Zoom) next to a device on the HTC Remote Copy Objects panel and press Enter.

### Figure 84: HTC RemoteCopy device subpanel

<table>
<thead>
<tr>
<th>HTC RemoteCopy device on 01/17/2013 at 10:28:42</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address . . . : 5300</td>
</tr>
<tr>
<td>Device type . . . : 3390-A</td>
</tr>
<tr>
<td>Volser . . . : BCSSI1</td>
</tr>
<tr>
<td>CU type . . . : 3990</td>
</tr>
<tr>
<td>SSid . . . : 0016</td>
</tr>
<tr>
<td>CUSNam . . . : 40118</td>
</tr>
<tr>
<td>CCA . . . : 00</td>
</tr>
<tr>
<td>LSS . . . : 01</td>
</tr>
<tr>
<td>State . . . : DUPLEX</td>
</tr>
<tr>
<td>Level . . . : PRIMARY</td>
</tr>
<tr>
<td>Critical . . . : No</td>
</tr>
<tr>
<td>First cyl pend . : 0</td>
</tr>
<tr>
<td>Last cyl pend . : 0</td>
</tr>
<tr>
<td>Copy . . . : 0 %</td>
</tr>
<tr>
<td>F1=Help</td>
</tr>
<tr>
<td>F4=Print</td>
</tr>
<tr>
<td>F5=Mirrors</td>
</tr>
<tr>
<td>F6=Paths</td>
</tr>
<tr>
<td>F12=Cancel</td>
</tr>
</tbody>
</table>
Table 63 on page 239 explains the information for the selected Hitachi device that is available on this subpanel.

### Table 63: Detailed information for a Hitachi device

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address</strong></td>
<td>the address of the device</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>the current status of the device—online or offline</td>
</tr>
<tr>
<td><strong>Device type</strong></td>
<td>the type of device</td>
</tr>
<tr>
<td><strong>Cyls/Blks</strong></td>
<td>the total number of cylinders or blocks (depending on device)</td>
</tr>
<tr>
<td><strong>Volser</strong></td>
<td>the volume serial number of this device</td>
</tr>
<tr>
<td><strong>Voluse</strong></td>
<td>the volume usage description for this device</td>
</tr>
<tr>
<td><strong>CU Type</strong></td>
<td>the device type of the control unit</td>
</tr>
<tr>
<td><strong>CUSSid</strong></td>
<td>the subsystem ID of the control unit</td>
</tr>
<tr>
<td><strong>SSID - Primary</strong></td>
<td>the subsystem ID of the control unit for the current (or last connected) primary volume in a duplex pair</td>
</tr>
<tr>
<td><strong>CUSNam - Primary</strong></td>
<td>the serial number of the control unit for the current (or last connected) primary volume in a duplex pair</td>
</tr>
<tr>
<td><strong>CCA - Primary</strong></td>
<td>the channel connection address of the current (or last connected) primary volume in a duplex pair</td>
</tr>
<tr>
<td><strong>LSS - Primary</strong></td>
<td>the logical subsystem number of the primary volume in a duplex pair</td>
</tr>
<tr>
<td><strong>SSID - Secondary</strong></td>
<td>the subsystem ID of the control unit for the current (or last connected) secondary volume in a duplex pair</td>
</tr>
<tr>
<td><strong>CUSNam - Secondary</strong></td>
<td>the serial number of the control unit for the current (or last connected) secondary volume in a duplex pair</td>
</tr>
<tr>
<td><strong>CCA - Secondary</strong></td>
<td>the channel connection address of the current (or last connected) secondary volume in a duplex pair</td>
</tr>
<tr>
<td><strong>LSS - Secondary</strong></td>
<td>the logical subsystem of the current secondary volume in a duplex pair</td>
</tr>
<tr>
<td><strong>State</strong></td>
<td>the PPRC state of the device</td>
</tr>
<tr>
<td></td>
<td>• DUPLEX indicates that the volume is currently mirrored to another volume or the secondary volume has been suspended.</td>
</tr>
<tr>
<td></td>
<td>• SIMPLEX indicates that the volume is not currently mirrored to another volume.</td>
</tr>
<tr>
<td></td>
<td>• A blank value indicates that the PPRC state was not determined during device discovery.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>First cyl pend</td>
<td>the lowest cylinder that is out of synchronization</td>
</tr>
<tr>
<td>Level</td>
<td>the PPRC level for this device</td>
</tr>
<tr>
<td></td>
<td>■ PRIMARY indicates that this volume is the source volume in a mirrored</td>
</tr>
<tr>
<td></td>
<td>(duplex) pair.</td>
</tr>
<tr>
<td></td>
<td>■ SECONDARY indicates that this volume is the target volume in a mirrored</td>
</tr>
<tr>
<td></td>
<td>(duplex) pair.</td>
</tr>
<tr>
<td></td>
<td>■ A blank value indicates a volume that has not been mirrored.</td>
</tr>
<tr>
<td>Last cyl pend</td>
<td>the highest cylinder that is out of synchronization</td>
</tr>
<tr>
<td>Critical</td>
<td>the value of the CRIT parameter as specified on the CESTPAIR command</td>
</tr>
<tr>
<td>Copy</td>
<td>the percent complete for a copy operation</td>
</tr>
<tr>
<td></td>
<td>This value is displayed only on a primary volume.</td>
</tr>
</tbody>
</table>

### Establishing a PPRC pair with Hitachi devices

This procedure explains how to use the SSI monitor to issue the CESTPAIR command to establish a relationship between a primary and secondary device.

1. Access the HTC Remote Copy Objects panel, as described in “Accessing the SSI monitor” on page 210.

2. On the HTC Remote Copy Objects panel, type 2 (EstPair) in the selection field next to the device for which you want to establish a mirror and press **Enter**.

**WARNING**

Ensure that the mirrored device is offline before attempting to establish the pair. If you establish a pair with an online device, you can *overwrite* the information on that device.
The HTC RemoteCopy Establish Pair subpanel (Figure 85 on page 241) is displayed.

<table>
<thead>
<tr>
<th>Field</th>
<th>What you enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSid</td>
<td>the four-digit hexadecimal value for control unit subsystem ID of the secondary device</td>
</tr>
<tr>
<td>CUSNum</td>
<td>the control unit serial number of the secondary device</td>
</tr>
<tr>
<td>CCA</td>
<td>the two-digit hexadecimal value for the channel connection address of the secondary device</td>
</tr>
</tbody>
</table>
| LSS    | the two-digit hexadecimal value for the logical subsystem of the secondary device  
|        | Do not enter a value in this field if the secondary device is a ShadowImage objects because the primary and mirror are on the same logical subsystem.  
|        | Note: This field is displayed only if the volume is on a 2105 device.           |

3 On the HTC RemoteCopy Establish Pair subpanel, enter the following information for the secondary device:

4 When you finish entering the information, press Enter.

The SSI action response subpanel indicates that the establish pair action was initiated.

5 On the SSI action response subpanel, press F12 to return to the HTC Remote Copy Objects panel.

Reestablishing a pair for a suspended Hitachi device

This procedure explains how to use the SSI monitor to issue the CESTPAIR RESYNC command against a suspended primary device to reestablish the relationship between a primary and secondary device.

1 Access the HTC Remote Copy Objects panel, as described in “Accessing the SSI monitor” on page 210.
2. On the HTC Remote Copy Objects panel, type `EstPair(Resync)` in the selection field next to the device for which you want to reestablish a mirror and press Enter.

XBM gathers the information for the mirrored device that was previously associated with that device.

3. On the SSI action response subpanel, press F12 to return to the HTC Remote Copy Objects panel.

**Suspending PPRC operations for Hitachi devices**

This procedure describes how to issue the CSUSPEND command to suspend PPRC operations. This command stops updates sent to the mirror volume from the primary volume, but retains the relationship between the devices.

1. Access the HTC Remote Copy Objects panel, as described in “Accessing the SSI monitor” on page 210.

2. On the HTC Remote Copy Objects panel, type `Suspend` in the selection field next to the device whose relationship you want to suspend and press Enter.

   The SSI action response subpanel indicates that the suspend action has been initialized.

3. On the SSI action response subpanel, press F12 to return to the HTC Remote Copy Objects panel.

**Removing the relationship between a pair of a Hitachi devices**

This procedure explains how to use the SSI monitor to issue the CDELPAIR command to remove the relationship between a primary and secondary device.

1. Access the HTC Remote Copy Objects panel, as described in “Accessing the SSI monitor” on page 210

2. On the HTC Remote Copy Objects panel, type `DelPair` in the selection field next to the device for which you want to delete the pair and press Enter.
Recovering a secondary Hitachi device

This procedure describes how to use the SSI monitor to issue the CRECOVER command to give control of a secondary device to a recovery system.

It also allows you to change the volume ID if you require the volume to be varied online to the same system as the primary volume.

To recover a secondary Hitachi device

1. Access the HTC Remote Copy Objects panel, as described in “Accessing the SSI monitor” on page 210.

2. On the HTC Remote Copy Objects panel, type 6 (Recover) in the selection field next to the device that you want to use and press Enter.

3. On the PPRC Recover subpanel, enter information for the following fields:

   It also allows you to change the volume ID if you require the volume to be varied online to the same system as the primary volume.

   **| What you enter |
   --|----------------|
   SSId | the control unit subsystem ID of the secondary device |
   CUSTNum | the control unit serial number of the secondary device |
   CCA | the channel connection address of the secondary device |
   LSS | the logical subsystem for the secondary device |
   New volser | (optional) a new volume serial number for the secondary device Use this field to put a new volume ID on the device so it can be brought online. |

   **Note:** Do not complete the LSS field for ShadowImage objects because both the primary and secondary image are on the same logical subsystem.

4. When you finish entering values, press Enter.

   The SSI action response subpanel indicates that the recover action has been initialized.

5. On the SSI action response subpanel, press F12 to return to the PPRC options panel.
Displaying information about a mirrored Hitachi device

This procedure explains how to use the SSI monitor to display a mirror of a Hitachi device.

If a device has multiple PPRC mirrors (currently limited to Hitachi ShadowImage), XBM displays the mirror returned by the PPRC query. Selecting any mirror, however, will display the correct source device.

**To display information about a mirrored Hitachi device**

1. Access the HTC RemoteCopy objects panel, as described in “Accessing the SSI monitor” on page 210.

2. Enter 1 (Zoom) next to the device whose mirror you want to display and press Enter.

3. On the HTC RemoteCopy device subpanel, press F5. If the device does not have a mirror, an error message is displayed. Otherwise, the device selection panel is displayed.

4. On the device selection subpanel, type / in the field next to the mirror that you want to display and press Enter. The mirror information is displayed in an HTC RemoteCopy device subpanel.
Navigating the XBM ISPF interface

This appendix explains how to use the ISPF interface for the EXTENDED BUFFER MANAGER (XBM) product. You use the ISPF interface to define configurations, management sets, and options for XBM. You also use the ISPF interface to monitor the extended buffer and snapshot utilities.

The ISPF interface contains a Help index. The index contains information about using XBM. The information through the HINDEX ISPF Fastpath command or by selecting the Help Index option under the Help action bar pull-down.

Introducing the File List panel

When you start the XBM ISPF interface, the XBM logo panel is displayed.

**Figure 86: XBM logo panel**
When XBM finishes loading and the ISPF interface is ready to use, the XBM File List panel replaces the XBM logo panel. Figure 87 on page 246 illustrates the XBM File List panel.

**Figure 87: XBM File List panel**

- **File View Options Console Monitor User Help**

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Options</th>
<th>Console</th>
<th>Monitor</th>
<th>User</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>1=Open</td>
<td>2=Activate</td>
<td>3=Deactivate</td>
<td>4=Print</td>
<td>5=Delete</td>
<td>6=Rename</td>
<td>7=Resetsta</td>
</tr>
<tr>
<td>S</td>
<td>A</td>
<td>File list name</td>
<td>Typ</td>
<td>Userid</td>
<td>Modified</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>*</td>
<td>DBZ_GLBL_COMP_GROUP</td>
<td>GRP</td>
<td>RDADWJ2</td>
<td>09/14/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>*</td>
<td>DBZ_HS50M_GLBL_COMP_NOPRF</td>
<td>MS</td>
<td>RDADWJ4</td>
<td>07/14/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>*</td>
<td>DS50M_COMP_SSI_SS</td>
<td>MS</td>
<td>RDADWJ</td>
<td>03/24/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>*</td>
<td>DS50M_HS100M_COMP</td>
<td>CFG</td>
<td>RDADXB2</td>
<td>03/04/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td></td>
<td>BMCCBM_HS75M_VSAM_COMP</td>
<td>MS</td>
<td>RDADWJ2</td>
<td>07/21/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td></td>
<td>BMCCBM_KSDSPLAT_HS50M_COMP</td>
<td>MS</td>
<td>RDADWJ2</td>
<td>07/15/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td></td>
<td>CXM_MS</td>
<td>MS</td>
<td>RDACXM2</td>
<td>09/21/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td></td>
<td>DBAD_HS10M_COMP_PRF</td>
<td>MS</td>
<td>RDADWJ2</td>
<td>11/24/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td></td>
<td>DBAD_150_ANY50M_COMP_NOPRF</td>
<td>MS</td>
<td>RDADWJ4</td>
<td>10/08/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td></td>
<td>DBAD_150_ANY50M_COMP_PRF</td>
<td>MS</td>
<td>RDADWJ4</td>
<td>10/07/2012</td>
<td></td>
</tr>
<tr>
<td>_</td>
<td></td>
<td>DBAD_25M_ANY_COMP</td>
<td>MS</td>
<td>RDADWJ3</td>
<td>07/08/2012</td>
<td></td>
</tr>
</tbody>
</table>

BMC73957I View is by Active Status. View selection filtering is not active.

Command ===> ______________________________________________________________

F1=Help      F2=Split     F3=Exit      F4=Open      F5=Activate  F6=Deact
F7=Bkwd      F8=Fwd       F9=Swap     F10=Actions  F12=Cancel

The File List panel is the main XBM panel. From this panel, you initiate most of your interaction with XBM. Unless otherwise specified, all procedures in the documentation that begin with the selection of menu items from the action bar originate from the File List panel.

In the first line of text under the menu bar, the panel identifies the XBM subsystem that you are currently viewing, the data sharing group to which this XBM subsystem belongs (if applicable), and the local XBM subsystem. Figure 88 on page 246 describes the format of this text.

**Figure 88: Identifying the XBM subsystem in the ISPF interface**

For information about selecting a different XBM subsystem to display, see “Displaying detailed information for a remote XBM subsystem” on page 80.

From the File List panel, you have access to all other XBM functions. Use the XBM CUA-compliant ISPF interface to perform the following tasks:
- monitor the XBM subsystem
- display the status of XBM and components
- check the status of a snapshot job
- issue XBM commands
- define and display management sets, configurations, and XBM options
- monitor and manipulate the status of DASD volumes
- access remote XBM subsystems within the same XCF group as the local XBM subsystem in a data sharing environment

XBM dialogs use object-action sequences. This means that you choose an object (for example, a management set) and then select an action (for example, Activate) to apply to the management set. The object-action approach allows you to review the actions that you can perform on an object before you actually perform any of those actions.

**Understanding panel elements**

This section explains the structure of an XBM ISPF interface panel.

- **Figure 89 on page 248** illustrates general ISPF panel elements.
- **Figure 90 on page 249** illustrates pull-down options.
- **Figure 91 on page 250** illustrates fields.
General panel elements

Figure 89 on page 248 illustrates the general features of the interface panel.

Figure 89: Panel elements

Table 64 on page 248 explains each panel element.

Table 64: Features of an XBM ISPF interface panel

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| action bar      | The action bar consists of a horizontal list of actions. The action choices in Figure 90 on page 249 are File, View, Options, Console, Monitor, User, and Help. By placing the cursor on an action and pressing Enter, you display the pull-down list of options for the action.  
Note: Pressing F10 moves the cursor to the action bar; pressing F12 moves the cursor back to the panel. |
| panel title     | The panel title is the name used to identify the panel.                                                                                                                                               |
| action codes    | These codes provide a faster method of applying an action to an object. When you type an action code in the selection entry field for an object and press Enter, XBM performs that action on the object. Using an action code involves fewer steps than using action bar pull-down options. |
### Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>selection entry field</td>
<td>You use the selection entry field to select an object on which to perform an action. You select the object by typing / or S in the entry field and pressing Enter. For more information, see “Fields” on page 250.</td>
</tr>
<tr>
<td>selection list</td>
<td>A selection list is a listing of the objects on which you can perform actions from the panel. For more information, see “Displaying files on the File List panel” on page 250.</td>
</tr>
<tr>
<td>command line</td>
<td>Some panels contain a command line. By typing ISPF Fastpath commands at Command and pressing Enter, you can perform actions on objects and also navigate through the ISPF interface. The available ISPF Fastpath commands are described in “XBM ISPF Fastpath commands” on page 279.</td>
</tr>
<tr>
<td>function keys</td>
<td>Function keys provide an ISPF Fastpath means of performing actions on objects and navigating through the ISPF interface.</td>
</tr>
</tbody>
</table>

## Pull-down and action bar menu options

When you select an action from the action bar, the interface displays a pull-down option menu.

The pull-down options are the actions that you perform on objects. Some XBM actions (for example, New) do not require objects. Figure 90 on page 249 shows an example of a pull-down options menu.

**Figure 90: Pull-down options**

![Pull-down options](image)

Table 65 on page 249 describes the different action bar menu options.

### Table 65: Action menus

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>to perform actions (such as save, activate, and open) on items in the file list You also can use this menu to exit XBM.</td>
</tr>
</tbody>
</table>
**Menu option** | **Use**
---|---
View | to order list views by selected fields, or to change the XBM subsystem that you are viewing. You can also use the Selection menu item to enter filtering criteria.
Options | to set options for various XBM components. You can use this menu option to set options for the XBM, VSAM, IMS, PSS, and SSI components.
Console | to use the consoles to control configurations, components, management sets, the XBM subsystem, and data sets.
Monitor | to access XBM monitors.
User | to specify whether to display selection screens before accessing the monitors. To accommodate a large environment with many objects, you can specify that you want to enter selection criteria before displaying items in a monitor. Doing so speeds up display time.
Help | to display Help for XBM.

### Fields

Figure 91 on page 250 illustrates the different types of fields in which you can enter values:

- In a *selection choice* field, you select one choice from a list of available choices.
- In an *entry* field, you enter a value.

**Figure 91: Entry field and selection choice**

![Figure 91: Entry field and selection choice](image)

### Displaying files on the File List panel

The File List panel gives you access to all XBM functions.

The default display shows all files in file name order. However, you might find it more convenient to work with a subset of files. You can manipulate the list of displayed files as follows:
- Use the ISPF Fastpath command **Locate**.
- Sort the files.
- Use selection criteria to filter the list.

You can also print a list of files.

**Using the Locate command**

When viewing a list, you can use the **Locate** command (abbreviated **L**) to sort through long lists.

From the **Command** line, type **L** and then the string for which you want to search. **Locate** works on the currently sorted (View by) fields for nonnumeric fields. **Locate** looks for an equal to (=) or greater than (>) value. For more information about where you can use the **Locate** command, see “**XBM ISPF Fastpath commands**” on page 279.

**Sorting the files**

You can use the **View** action bar pull-down to choose options for sorting the file list for display.

**Figure 92 on page 251** illustrates these options.

**Figure 92: View pull-down menu**

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Options</th>
<th>Console</th>
<th>Monitor</th>
<th>User</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>XBMA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>By name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>By type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>By ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>By modify date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>By active status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Selection...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>View XBM subsystem...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CPD_ANY50M_NOCOMP_ALL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CXM_CFG</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can sort the list by any of the following items:

- file name
- file type (configuration or management set)
- user ID
- date the file was modified

Appendix A  Navigating the XBM ISPF interface 251
Using selection criteria to view files

You can also choose **View => Selection** to specify selection criteria for displaying a list of XBM files.

Figure 93 on page 252 provides an example of the File List Selection subpanel.

The subpanel consists of the following entry and selection fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>the name of the file to display</td>
</tr>
<tr>
<td></td>
<td>You can use pattern-matching characters to select only names that contain</td>
</tr>
<tr>
<td></td>
<td>a specific, positional string of characters. For example, an asterisk in</td>
</tr>
<tr>
<td></td>
<td>the entry field selects all files; an M* in the entry field selects files</td>
</tr>
<tr>
<td></td>
<td>that begin with the character M. For more information about supported</td>
</tr>
<tr>
<td></td>
<td>pattern-matching characters, see “Using the pattern-matching characters” on</td>
</tr>
<tr>
<td></td>
<td>page 255.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
--- | ---
User ID | the user ID of the file’s creator or modifier
As with the Name field, you can use pattern-matching characters to select only user IDs containing a specific, positional string of characters.

Type | the type of file to display
The choices are as follows:
- All displays all management sets, and configurations.
- Configuration displays only configurations.
- Management Set displays only management sets.

File status | the status of the files to display
The choices are as follows:
- All ignores status and displays all files in the display list.
- Active only displays only active files in the display list.
- Inactive only displays only inactive files in the display list.

---

**Printing file lists**

You can print file lists by using the Print option of the File pull-down menu.

The Print selected option confines the output to data sets that you have selected by typing a / or S in the selection field of the File List panel. The printed output is produced in the order that the View option specifies.

**Performing ISPF actions**

The XBM ISPF interface offers different methods for performing most actions:

- using the action bar pull-down
- using action codes
- using function keys
- using ISPF Fastpath commands
Using the action bar pull-down

You can perform virtually all actions and panel navigation by using the action bar choices.

1. Select the object on which to perform the action. (Some actions do not require an object.)

2. In the action bar, place the cursor on the action menu of your choice, and press Enter to display the action options for the selected object.

3. In the pull-down selection field, type the number of the action that you want to perform.

4. Press Enter to perform the action on the selected object.

Using action codes

You can perform a subset of actions by using action codes.

The action codes that you can use on an XBM panel are listed below the panel title. For an example, see the File List panel in “Introducing the File List panel” on page 245.

1. In the object’s selection entry field, type the action code for the action that you want to perform.

2. Press Enter to perform the action on the selected object.

Using function keys

You can perform a subset of actions by using function keys.

1. If the action requires an object, select the object on which to perform the action.

2. Press the function key to perform the action.

Using ISPF Fastpath commands

You can perform all actions by using ISPF Fastpath commands.
On the **Command** line, type the command.

Press **Enter** to perform the action.

Not all commands can be issued from each panel. “**XBM ISPF Fastpath commands**” on page 279 shows which commands can be issued from the panels.

To display a list of valid commands for each panel, place the cursor on the **Command** line of the panel and press **F1** (Help).

---

**Understanding XBM pattern-matching**

With XBM, you can use pattern-matching characters (wildcards) instead of fully qualified names or versions. You can use pattern-matching characters in the following items:

- lists
- pattern masks for object definitions
- MVS system console commands
- communications among XBM subsystems in a sysplex environment
- communications with snapshot utilities that support pattern matching
- the XBM$OPTS member

---

**Using the pattern-matching characters**

XBM supports the following pattern-matching characters: ?, *, %, and @.

**? (Query)**

The wildcard ? represents a single arbitrary character in a name element. You can use ? anywhere in the name.
Example

X?Z includes these values in its qualifying set:
XYZ, XXZ, X1Z

It does not include these values:
X123Z, XZ, XYYZ

* (Asterisk)

The wildcard * represents zero or more characters in a name or numeric element, or the most recent version, release, or maintenance (v.r.mmm) level in a numeric element. The use of * is restricted to the following conditions:

- You can use * to represent the entire name element. The following example specifies a pattern mask for an object definition:

  
  | Space name . . . . .*.________ |
  | Data set number . .*.__________ |

  In this case, all table spaces and index spaces of the database specified in the pattern mask fall under the scope of the pattern mask name and will be selected.

  **Note**
  
  For IMS, * is valid only as the last character of the data set name.

- You can use * only as the trailing character in a name. The following example specifies a pattern mask for an object definition:

  
  | Space name . . . . .TSX*.______ |
  | Data set number . .00*.________ |

  The first example, TSX*, includes all table spaces and index spaces beginning with the characters TSX.

  The second example, 00*, includes partitions 1 through 9 of a partitioned table space or index space in the scope of the object definition. If the table space or index space were nonpartitioned and less than 2 GB in size, 00* would include only 001 in the scope of the object definition.

- You can use * to represent the entire numeric element. The following example finds the active XBM subsystem of the most recent version:

  
  * |

- You can use * preceding a numeric element. The following example finds the XBM subsystem of the most recent version that is no later than 5.3.00:

  
  * 5.3.00 |

- You can use * as a trailing character in a numeric element or trailing the entire numeric element. The following example finds an active XBM subsystem of version 5.6:

  
  5.6* |
Use * with caution. Although selecting many objects by using * is convenient, the resulting selection can easily return many more objects than you intend.

**% (Percent)**

You can use % instead of *.

**@ (at symbol)**

The @ symbol restricts a query for an XBM subsystem qualifier to a particular version, release, or maintenance (v.r.mm) level. An @ symbol must precede the v.r.mm number or numbers.

**Example**

- XBMA@5.1 includes these values in its qualifying set:
  - XBMA at version 5.1.00 and XBMA at version 5.1.01
  - It does not include these values:
    - XBMA at version 5.0.00 or XBMB at version 5.1.00

- XBM?@5.1* includes these values in its qualifying set:
  - XBMA at version 5.1.00, XBMB at version 5.1.01, and XBMC at version 5.1.01
  - It does not include these values:
    - XBMD at version 5.0.00 or XBAM at version 5.0.01

**Finding XBM subsystems**

XBM interprets searches for name elements of XBM subsystems in two distinct ways, depending on the number of characters that you enter for the search:

- When you enter four or fewer characters (including pattern-matching characters) as the name element, XBM searches for an XBM subsystem. For example, XBM interprets a search on XBMA or XBM? as a search for a specific XBM subsystem ID (SSID).

- When you enter five or more characters (including pattern-matching characters) as the name element, XBM searches for an XBM cross-system coupling facility (XCF) group within a sysplex. XBM interprets a search for XBMGROUP1 or XBMGROUP* as a search for an XBM XCF group name.
XBM interprets searches for name elements as described, regardless of any numeric element information appended to the name element. These rules apply to XBM SSIDs or XCF group names that appear in the following areas:

- MVS system console commands
- communications among XBM subsystems in a sysplex environment
- communications with snapshot utilities that support these rules
- the XBMS$OPTS member

**Using pattern-matching characters in the XBMS$OPTS member**

If you are using XBM in a data sharing environment, BMC recommends that you specify a pattern mask in the XBMSSID parameter of the XBMS$OPTS member.

Doing so allows you to use the ISPF interface to access all XBM subsystems that match the pattern, using only a single CLIST and XBMS$OPTS member. Otherwise, you would need a different XBMS$OPTS member for each XBM subsystem.

For example, if you name your XBM subsystems XBMA, XBMB, and XBMC, you can specify the pattern XBM* as the xbmssid value in the XBMS$OPTS member to access all of these subsystems. Figure 94 on page 258 shows an example of the XBMS$OPTS member.

**Figure 94: Sample XBMS$OPTs member**

```rexx
/* REXX */
/* XBM(TM) VERSION 6.1.XX  */
XBMSSID = 'XBM*'  /* XBM SUBSYSTEM ID              */
XBMLLIB = 'hlq.XXLINK'
XBMLLIB = 'hlq.XXLINK'
XBMLIB = 'hlq.XXPLIB'
XBMLIB = 'hlq.XXPLIB'
ADDRESS ISPEXEC "VPUT (XBMSSID) SHARED"
ADDRESS ISPEXEC "VPUT (XBMLLIB) SHARED"
ADDRESS ISPEXEC "VPUT (XBMLLIB) SHARED"
ADDRESS ISPEXEC "VPUT (XBMLIB) SHARED"
ADDRESS ISPEXEC "VPUT (XBMTLIB) SHARED"
```

**Using Help for the ISPF interface**

The ISPF interface contains three levels of Help: field-level Help, extended Help, and a Help index.
**Field-level Help**

To display field-level Help, put the cursor on the field value and press F1.

Figure 95 on page 259 illustrates types of fields in which you can press F1.

**Figure 95: Obtaining field-level help**

![Field-level Help Diagram](image)

**Extended help**

If you press F1 when the cursor is not in a data or value area, extended Help is displayed.

From field-level Help, you can display extended Help for a panel by pressing F5.

**Help index**

The ISPF interface contains a Help index.

The index contains information about using XBM. The information through the HINDEX ISPF Fastpath command or by selecting the **Help Index** option under the **Help** action bar pull-down.
XBM commands

This chapter lists the commands that the EXTENDED BUFFER MANAGER (XBM) product provides to help control your snapshot environment.

Two different types of command are available:

- You can launch commands from the MVS console to do such things as activate management sets and start and stop components. For more information, one of the following sections:
  - “Commands for managing XBM objects and subsystems” on page 261
  - “Commands for managing SSI options” on page 272
  - “Commands for generating tracing information” on page 276

- You can launch commands from the Command line within the XBM ISPF interface. These types of commands are call Fastpath commands. These commands allow you to do such things as locate a file on a list panel, start a monitor, delete a selected object, and so on. For more information, see “XBM ISPF Fastpath commands” on page 279.

Commands for managing XBM objects and subsystems

XBM supports launching the following XBM commands from the MVS console to manage XBM objects and subsystems:

- ACTIVATE
- DEACTIVATE
- DISPLAY
- PING
- RESETSTA
- ROUTE
- SEND
- SET SIMULATE
- START
- STOP

Figure 96 on page 263 introduces the syntax for these commands.

For XBM commands, \textit{ssid} represents the name of the XBM subsystem, and \textit{xbmgroup} represents the name of the cross-system coupling facility (XCF) group:

- The XBM subsystem ID must be different than the DB2 subsystem ID and any other XBM subsystem IDs.

- The XBMGROUP name should be at least five characters in length; otherwise, XBM interprets this name as an SSID.

You can use XBM pattern-matching characters for configurations, management sets, component names, subsystem IDs, and XCF group names.
**Note**
The DISPLAY, START, and STOP commands apply to either "XBM" as a whole or to an individual component. The components to which these commands apply include the DB2, IMS, PSS, SSI, and VSAM components.

**Figure 96: XBM commands**

![Diagram of XBM commands]

**Tip**
You can use the first three letters of the command name as a shortcut to typing the entire command (for example, type SEN to use the SEND command or STA to use the START command).

**ACTIVATE command**

You use the ACTIVATE command to activate configurations and management sets.
Figure 97: Syntax for ACTIVATE command

Table 66 on page 264 lists the keywords that you can use with this command.

Table 66: Keywords for the ACTIVATE command

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONFIGURATION or CONF</td>
<td>indicates that the object to activate is a configuration. The name value identifies the configuration to activate. There is only one active configuration in an XBM subsystem. Activating a configuration implicitly deactivates the configuration that was active when the command was issued.</td>
</tr>
<tr>
<td>MANAGEMENT SET or MS</td>
<td>indicates that the object to activate is a management set. You can specify one of the following values for the MANAGEMENT SET keyword: [\begin{itemize} \item An asterisk (*) activates all management sets in the repository. \item The name value identifies the management set to activate. You can use pattern-matching characters in the name. \end{itemize}]</td>
</tr>
</tbody>
</table>

Comment command

You use the comment command, "* " (asterisk followed by a space), to include comments with other XBM commands you issue.

XBM ignores the content of the text but echoes the text to SYSPRINT.

Figure 98: Syntax for comment command

The * indicates that the subsequent text is comment only.

Note

The asterisk must be immediately followed by a space.
DEACTIVATE command

You use the DEACTIVATE command to deactivate management sets.

Figure 99: Syntax for DEACTIVATE command

Table 67 on page 265 lists the keywords that you can use with this command.

Table 67: Keywords for the DEACTIVATE command

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANAGEMENT SET or MS</td>
<td>indicates that the object to deactivate is an active management set</td>
</tr>
<tr>
<td></td>
<td>You can specify one of the following values for the MANAGEMENT SET keyword:</td>
</tr>
<tr>
<td></td>
<td>■ An asterisk (*) deactivates all management sets in the repository.</td>
</tr>
<tr>
<td></td>
<td>■ The name value identifies the management set to deactivate. You can use pattern-matching characters in the name.</td>
</tr>
</tbody>
</table>

DISPLAY command

You use the DISPLAY command to display the status of management sets, the component, and the active configuration.

You can also use the DISPLAY command to determine the version of XBM that you have installed.

Figure 100: Syntax for DISPLAY command

Note

The DISPLAY command cannot be used on the snapshot component.

Table 68 on page 266 lists the keywords that you can use with this command.
### Table 68: Keywords for the DISPLAY command

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBM</td>
<td>displays the following information:</td>
</tr>
<tr>
<td></td>
<td>■ version of XBM that you have installed</td>
</tr>
<tr>
<td></td>
<td>■ status of components</td>
</tr>
<tr>
<td></td>
<td>■ name of the active configuration</td>
</tr>
<tr>
<td></td>
<td>■ names of all active management sets</td>
</tr>
<tr>
<td>COMPONENT</td>
<td>displays the status of the specified component</td>
</tr>
<tr>
<td></td>
<td>You can specify one of the following values for the COMPONENT keyword:</td>
</tr>
<tr>
<td></td>
<td>■ An asterisk (*) displays the status of all components.</td>
</tr>
<tr>
<td></td>
<td>■ The <em>name</em> value identifies the component for which to display status</td>
</tr>
<tr>
<td></td>
<td>(DB2, IMS, PSS, SSI, VSAM, or ZIIP). You can use pattern-matching</td>
</tr>
<tr>
<td></td>
<td>characters in the name.</td>
</tr>
<tr>
<td>MANAGEMENT SET or MS</td>
<td>displays the status of management sets</td>
</tr>
<tr>
<td></td>
<td>You can specify one of the following values for the MANAGEMENT SET keyword:</td>
</tr>
<tr>
<td></td>
<td>■ An asterisk (*) displays the status of all management sets.</td>
</tr>
<tr>
<td></td>
<td>■ The <em>name</em> value identifies the management set for which to display</td>
</tr>
<tr>
<td></td>
<td>status. You can use pattern-matching characters in the name.</td>
</tr>
<tr>
<td>ZIIPSTATISTICS or</td>
<td>display statistics for the zIIP component</td>
</tr>
<tr>
<td>ZIIPSTATS</td>
<td>Messages BMC73050I and BMC73900I/BMC73890I report the results of the</td>
</tr>
<tr>
<td></td>
<td>DISPLAY command. An example follows:</td>
</tr>
<tr>
<td></td>
<td>BMC73050I 12.29.31 XBMA DIS ZIIPS</td>
</tr>
<tr>
<td></td>
<td>BMC73900I* 12.29.31 XBMA ZIIP ENF Enclave Statistics:</td>
</tr>
<tr>
<td></td>
<td>Time on ZIIP= 0.01 SEC, Time on CP= 0.00 SEC.</td>
</tr>
<tr>
<td></td>
<td>BMC73900I* 12.29.31 XBMA ZIIP IOS Enclave Statistics:</td>
</tr>
<tr>
<td></td>
<td>Time on ZIIP= 683.14 SEC, Time on CP= 4.85 SEC.</td>
</tr>
<tr>
<td></td>
<td>BMC73900I* 12.29.31 XBMA ZIIP MIO Enclave Statistics:</td>
</tr>
<tr>
<td></td>
<td>Time on ZIIP= 193.46 SEC, Time on CP= 1.35 SEC.</td>
</tr>
<tr>
<td></td>
<td>BMC73900I* 12.29.31 XBMA ZIIP GUE Enclave Statistics:</td>
</tr>
<tr>
<td></td>
<td>Time on ZIIP= 0.01 SEC, Time on CP= 0.00 SEC.</td>
</tr>
<tr>
<td></td>
<td>BMC73900I* 12.29.31 XBMA ZIIP Total Enclave Statistics:</td>
</tr>
<tr>
<td></td>
<td>Time on ZIIP= 886.21 SEC, Time on CP= 6.70 SEC.</td>
</tr>
</tbody>
</table>
PING command

Use the PING command to display the status of the XBM subsystems on a CPU.

The PING command can be sent by the ROUTE command ("ROUTE command" on page 268) to display the status of all XBM subsystems in a data sharing group.

Figure 101: Syntax for the PING command

Note
If the PSS component is inactive, you can only PING the XBM subsystem that is processing the command.

RESETSTA command

You use the RESETSTA command to reset the statistics for management sets and data sets.

Figure 102: Syntax for the RESETSTA command

Note
The RESETSTA command cannot be used on the snapshot component.

Table 69 on page 267 lists the keywords that you can use with this command.

Table 69: Keywords for the RESETSTA command

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANAGEMENT SET or MS</td>
<td>resets the statistics for management sets</td>
</tr>
<tr>
<td></td>
<td>You can specify one of the following values for the MANAGEMENT SET keyword:</td>
</tr>
<tr>
<td></td>
<td>■ An asterisk (*) resets the statistics for all management sets.</td>
</tr>
<tr>
<td></td>
<td>■ The name value identifies the management set for which statistics are reset. You can use pattern-matching characters in the name.</td>
</tr>
</tbody>
</table>
You can specify one of the following values for the DATASET keyword:

- An asterisk (*) resets the statistics for all data sets.
- The name value identifies the data sets for which statistics are reset. You can use pattern-matching characters in the name.

**Note:** Use the * with caution. Using an unqualified * may result in XBM action on a large number of data sets, which can consume a large portion of system resources.

### ROUTE command

You use the ROUTE command to send commands to one or more XBM subsystems in the same data sharing group.

**Figure 103: Syntax for the ROUTE command**

![ROUTE command syntax](image)

**Note**

If the PSS component is inactive, you can route only to the XBM subsystem that is processing the command.

Table 70 on page 268 lists the keywords that you can use with this command.

**Table 70: Keywords for ROUTE command**

<table>
<thead>
<tr>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ssid</td>
<td>issues the ROUTE command from this XBM subsystem</td>
</tr>
</tbody>
</table>
| xbmgroup    | issues the ROUTE command from any XBM subsystem in the data sharing group
   The command is routed from any XBM subsystem residing on the MVS subsystem where the command is issued. The xbmgroup name must be at least five characters in length. Otherwise, XBM treats this name as an XBM subsystem ID. |
| *           | routes a command to all XBM subsystems in the data sharing group         |
| name        | routes a command to a specific XBM subsystem in the data sharing group  
   You can use pattern-matching characters in the name to route to more than one XBM subsystem in the data sharing group. |
### Value | Meaning
--- | ---
*command* | specifies the command that you want sent  
A list of valid commands includes:
- ACTIVATE—activates the specified XBM control structure  
- DEACTIVATE—deactivates the specified XBM control structure  
- DISPLAY—displays the status of the specified XBM component  
- PING—displays the status of all XBM subsystems in the data sharing group  
- SEND—sends a command to a commandable BMC utility.  
- START—starts any specified XBM component except the PSS component  
- STOP—stops any specified XBM component except the PSS component

### SEND command

You use the SEND command to issue commands to commandable BMC utilities, such as COPY PLUS.

**Figure 104: Syntax for the SEND command**

```
ssid SEND jobname [jobID] command
```

Table 71 on page 269 describes the keywords for this command.

### Table 71: Keywords for the SEND command

<table>
<thead>
<tr>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>jobname</em></td>
<td>identifies the name of the utility job for which you want to issue the command</td>
</tr>
</tbody>
</table>
| *jobID* | identifies the ID of the utility job for which you want to issue the command  
This value is required if you have jobs using the same name running concurrently on different systems. |
| *command* | specifies the command you want to send  
For a list of valid commands and the functions those commands perform, see the documentation supplied with your utility. |
SET SIMULATE command

You use the SET SIMULATE command to turn off XBM simulate mode.

In simulate mode, XBM does not satisfy read requests from the extended buffer.

Figure 105: Syntax for the SET SIMULATE command

```
ssid  SET SIMULATE OFF
```

The OFF keyword turns simulate mode off in the active configuration. It does not change the simulate mode setting specified in the configuration file in the XBM repository.

START command

You use the START command to start an XBM component.

Figure 106: Syntax for the START command

```
ssid  START  COMPONENT  *  name
```

Note

The START command cannot be used on the snapshot component.

The only keyword for the START command is COMPONENT. You can specify the following values for the COMPONENT keyword:

- An asterisk (*) starts all enabled XBM components.
- The `name` value identifies the name of the XBM component to start (DB2, IMS, PSS, SSI, VSAM, or ZIIP). You can use pattern-matching characters in the name.

STOP command

You use the STOP command to stop XBM subsystems and components.

Note

The STOP command cannot be used on the snapshot component.

Figure 107: Syntax for the STOP command

```
ssid  STOP  XBM  COMPONENT  *  name
```

EXTENDED BUFFER MANAGER and SNAPSHOT UPGRADE FEATURE User Guide

270
Table 72 on page 271 lists the keywords that you can use with this command.

Table 72: Keywords for the STOP command

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBM</td>
<td>stops the XBM subsystem identified by the subsystem identifier (ssid)</td>
</tr>
<tr>
<td>COMPONENT</td>
<td>stops the specified XBM component provided no busy condition exists (such as a currently active snapshot job)</td>
</tr>
<tr>
<td></td>
<td>If a busy condition exists, XBM will not process the command but does issue error messages that explain why the component could not be stopped.</td>
</tr>
<tr>
<td></td>
<td>You can specify the following values for the COMPONENT keyword:</td>
</tr>
<tr>
<td></td>
<td>■ An asterisk (*) stops all XBM components except for those in a busy condition. Components that are not busy stop, but components in a busy condition do not stop.</td>
</tr>
<tr>
<td></td>
<td>■ The name value identifies the XBM component (DB2, IMS, PSS, SSI, VSAM, or ZIIP) to stop. You can use pattern-matching characters in the name.</td>
</tr>
<tr>
<td>Note: If you use the STOP command to stop a component, the component will remain in that state until you restart it with the START command. If you stop and restart the XBM subsystem, the components will resume the state they were in when the XBM subsystem was stopped.</td>
<td></td>
</tr>
<tr>
<td>FORCE</td>
<td>forces the XBM subsystem to terminate immediately, regardless of what jobs it may be supporting</td>
</tr>
<tr>
<td></td>
<td>FORCE can be issued against an XBM subsystem only; FORCE cannot be issued against components. However, issuing FORCE against an XBM subsystem also stops the components on that subsystem.</td>
</tr>
</tbody>
</table>

**XCFCleanup command**

In a sysplex environment, you can use the XCFCLEANUP command to delete inactive members of cross-system coupling facility (XCF) groups.

After you issue this command, XBM sends the resulting messages to the console through message BMC738311. You can delete inactive members from the target XCF group if they have been in an inactive status (XCF created, left, or failed) for the specified number of days. Deleting all members from a group also deletes the group.
**WARNING**

You can issue this command for any XCF group. However, some DBMS systems rely on previous status information and could be adversely affected if an inactive member is deleted from such a group. Before you use this command on any XCF groups other than XBM groups, ensure that the affected product allows deletion of inactive members.

You can run this command in a simulated mode before issuing the actual command. The simulated mode is the default value.

**Figure 108: Syntax for the XCFCleanup command**

```
  XCFCleanup numberDays xcfGroup [pattern] [SIMULATE] [NOSIMULATE]
```

Table 73 on page 272 lists the keywords that you can use with this command.

**Table 73: Keywords for XCFCleanup command**

<table>
<thead>
<tr>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>numberDays</td>
<td>specifies the number of days during which an XCF group member should be inactive before it is deleted</td>
</tr>
<tr>
<td>xcfGroup</td>
<td>the name of the XCF group on which to run the command on. You can specify a pattern, such as XBMG*, to run the command on all XCF groups that start with those characters. You can also use an asterisk to specify all XCF groups.</td>
</tr>
<tr>
<td>SIMULATE</td>
<td>runs the command in simulated mode without deleting members. This value (the default) allows you to see what would be deleted before you actually run the command. You can shorten the keyword to SIM.</td>
</tr>
<tr>
<td>NOSIMULATE</td>
<td>runs the command and deletes the members. You can shorten the keyword to NOSIM.</td>
</tr>
</tbody>
</table>

**Commands for managing SSI options**

XBM provides SSI options that you can specify at startup (xbmxinit) or through a console command to override some hardware device settings.

These commands include:

- **DISPLAY SETTINGS**
- **SET DATAMOVER**

272  *EXTENDED BUFFER MANAGER and SNAPSHOT UPGRADE FEATURE User Guide*
- SET ENQWAIT
- SET EXTALLOC
- SET FCTOPPRCPRIMARY
- SET MAXTASKS
- SET MAXVOLS
- SET NOTIFYWHENCOMPLETE
- SET OUTDYNAM
- SET VOLS

**SSI commands syntax**

The basic syntax for these options is as follows.

```
ssid optionName keyword
```
Figure 109 on page 274 displays the syntax for the commands.

**Figure 109: Syntax for SSI override options**

![Diagram](image-url)  

### SSI commands descriptions

Table 74 on page 275 describes the commands in more detail.
### Table 74: Commands for setting SSI override settings

<table>
<thead>
<tr>
<th>SSI command</th>
<th>Description</th>
<th>Keywords</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISPLAY SETTINGS</td>
<td>displays the SSI override settings that are enabled for the specified XBM subsystem identifier (SSID)</td>
<td>- A blank (no keyword) displays the settings for the SSI options.</td>
</tr>
<tr>
<td></td>
<td>The following example illustrates how this information is displayed:</td>
<td>- DIAG displays the tracing settings (“Commands for generating tracing information” on page 276).</td>
</tr>
<tr>
<td></td>
<td>BMC73050I 18.04.18 XBMG DISPLAY SETTING</td>
<td>- ALL displays the SSI options and tracing settings.</td>
</tr>
<tr>
<td></td>
<td>BMC73087I 18.04.18 XBMG MAXTASKS is 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BMC73087I 18.04.18 XBMG OUTDYNAM/VOLS is ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BMC73087I 18.04.18 XBMG EXTALLOC is OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BMC73087I 18.04.18 XBMG ENQWAIT is OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BMC73087I 18.04.18 XBMG DATAMOVER is NONE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ A blank (no keyword) displays the settings for the SSI options.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ DIAG displays the tracing settings (“Commands for generating tracing information” on page 276).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ ALL displays the SSI options and tracing settings.</td>
<td></td>
</tr>
<tr>
<td>SET DATAMOVER</td>
<td>sets the DATAMOVER option for hardware devices</td>
<td>■ NONE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ FDR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ DSS</td>
</tr>
<tr>
<td>SET ENQWAIT</td>
<td>sets the ENQWAIT option for hardware devices</td>
<td>■ ON (enables)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ OFF (disables)</td>
</tr>
<tr>
<td>SET EXTALLOC</td>
<td>sets the EXTALLOC option for hardware devices</td>
<td>■ ON (enables)</td>
</tr>
<tr>
<td></td>
<td>Note: For EMC devices, the AUTO value specifies to try the snapshot with the OFF value first. If the snapshot fails, it falls back to using the ON mode.</td>
<td>■ OFF (disables)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ AUTO</td>
</tr>
<tr>
<td>SET FCTOPRCPRI</td>
<td>specifies whether to generate the FCTOPRCPRI DFDSS keyword</td>
<td>■ ON (enables)</td>
</tr>
<tr>
<td></td>
<td>This command applies only to Hitachi DASD. It has no effect on other manufacturers' DASD.</td>
<td>■ OFF (disables)</td>
</tr>
<tr>
<td></td>
<td>WARNING: Only set to ON if the Hitachi controller supports this feature, otherwise instant snap requests might fail.</td>
<td></td>
</tr>
<tr>
<td><strong>SSI command</strong></td>
<td><strong>Description</strong></td>
<td><strong>Keywords</strong></td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><strong>SET MAXTASKS</strong></td>
<td>sets the number of tasks to use for hardware devices during Instant Snapshot processing</td>
<td>any integer from 1 through 9</td>
</tr>
<tr>
<td></td>
<td><strong>WARNING:</strong> Increase this value only in small increments while carefully assessing performance. Setting this value too high for your environment can cause abends or other problems due to insufficient storage in the XBM subsystem.</td>
<td>This value specifies the number of tasks to use during Instant Snapshot processing. Increasing the value might improve performance for Instant Snapshot processing.</td>
</tr>
<tr>
<td><strong>SET MAXVOLS</strong></td>
<td>specifies the number of volumes that are available for snapshot processing</td>
<td>any integer from 4 to 56</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> The command SET MAXVOLS 32 results in 32 volumes being made available to snapshot jobs that use XBMX subsystem ID.</td>
<td>The default value is 16. If you specify a value of 3 or less, XBM sets the value to 4. If you specify a value of 57 or higher, XBM sets the value to 56.</td>
</tr>
<tr>
<td><strong>SET NOTIFYWHENCOMPLETE</strong></td>
<td>sets the NOTIFYWHENCOMPLETE option for EMC hardware devices</td>
<td>▶ ON (enables)</td>
</tr>
<tr>
<td></td>
<td>This option specifies that EMC devices issue a message when the copy completes.</td>
<td>▶ OFF (disables)</td>
</tr>
<tr>
<td><strong>SET OUTDYNAM</strong></td>
<td>specifies whether to generate volume lists during hardware snapshots that use FlashCopy</td>
<td>▶ ON (enables)</td>
</tr>
<tr>
<td></td>
<td>▶ OFF (disables)</td>
<td></td>
</tr>
<tr>
<td><strong>SET VOLS</strong></td>
<td>specifies whether to generate volume lists during hardware snapshots</td>
<td>▶ ON (enables)</td>
</tr>
<tr>
<td></td>
<td>▶ OFF (disables)</td>
<td></td>
</tr>
</tbody>
</table>

For more information about the hardware settings or option keywords, see your hardware vendor’s documentation.

**Commands for generating tracing information**

XBM includes tracing features to help with problem diagnosis and resolution.

BMC Customer Support might ask you to run these traces if you encounter an issue and need assistance.

These commands include:

- PRINT DTRACE
- PRINT ETRACE
- SET PRINTTRACE
- SET SHUTDOWNTRACE
- SET ABENDTRACE

**WARNING**

These commands can cause excessive output that can impact system performance. Use these commands *only* when directed by BMC Customer Support to diagnose a problem.

The basic syntax for these options is as follows.

```
ssid commandName keyword
```

Message BMC73089I displays this diagnostic information. You can also send this information to the XBM SYSPRINT file.

**Trace commands syntax**

Figure 110 on page 277 illustrates the syntax for the trace commands.

**Figure 110: Syntax for trace commands**

![Syntax diagram for trace commands]

**Trace commands descriptions**

Table 75 on page 278 describes the commands in more detail.
Table 75: Commands for generating trace information

<table>
<thead>
<tr>
<th>New tracing command</th>
<th>Description</th>
<th>Keywords</th>
</tr>
</thead>
</table>
| PRINT DTRACE        | prints diagnostic trace information | ■ A blank (no keyword) prints the last 100 diagnostic trace items.  
                      |             | ■ ALL prints the entire diagnostic trace table.  
                      |             | ■ A number prints the specified number of diagnostic trace items. |
| PRINT ETTRACE       | prints exception trace information | ■ A blank value prints the last 50 exceptional trace items.  
                      |             | ■ ALL prints the entire exceptional trace table.  
                      |             | ■ A number prints the specified number of exceptional trace items |
| SET PRINTTRACE      | specifies that the DTRACE information should be printed as messages in the XBM SYSPRINT file as the messages are generated | ■ ON sends new messages issued by the PRINT DTRACE command to the XBM SYSPRINT file and the diagnostic trace table.  
                      |             | ■ OFF disables the SET PRINTTRACE command. |
| SET SHUTDOWNTRACE   | specifies that trace information should be printed as messages in the XBM SYSPRINT file when the XBM subsystem shuts down | ■ ON enables the SET SHUTDOWNTRACE command.  
                      |             | ■ OFF disables the SET SHUTDOWNTRACE command. |
| SET ABENDTRACE      | specifies the number of lines of existing trace information that should be printed as messages to the XBM SYSPRINT file if the XBM subsystem abends | ■ OFF disables the SET ABENDTRACE command. No trace information is printed.  
                      |             | ■ A number specifies the number of trace entries to report. |
XBM ISPF Fastpath commands

The XBM ISPF Fastpath commands can be issued from within the XBM ISPF interface.

Table 76 on page 279 lists the available commands and the ISPF panels from which they can be used.

The first row indicates the panel that the command is available one.

- C=Configuration Edit panel
- E=Extended Buffer and Data Set Monitor panels
- G=Group Edit panel
- H=SSI Monitor panel
- I=IMS Monitor panel
- L=File List panel
- M=Management Set Edit panel
- S=Save to Management Set panel
- T=Monitor Trace panels
- U=Utility Monitor

Table 76: ISPF Fastpath commands

<table>
<thead>
<tr>
<th>ISPF Fastpath command</th>
<th>C</th>
<th>E</th>
<th>G</th>
<th>H</th>
<th>L</th>
<th>M</th>
<th>S</th>
<th>T</th>
<th>U</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABOUT-About XBM</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>ACTIVATE-Activate selected object</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADD-Add object to management set</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALL-Select all data sets in the list</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHANGE-Modify object</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>COMPONENT-Display Console - Component subpanel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>CONFIG-Display Console - Configurations subpanel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DEACT-Deactivate selected object</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DELETE-Delete selected object</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DETAIL-Switch to Management Set Edit Detail panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>ISPF Fastpath command</td>
<td>C</td>
<td>E</td>
<td>G</td>
<td>H</td>
<td>L</td>
<td>M</td>
<td>S</td>
<td>T</td>
<td>U</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>DSET-Display Console - Data sets subpanel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>DTRACE-Display diagnostic trace</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>ETRACE-Display exception trace</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FIND-Find a string that you provide</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>GROUP-Display Console - Group subpanel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HELP-Display field-level or extended help</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HELPHP-Display help for help</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HELPN-Display help added since last release</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HINDEX-Display help index</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>IMSOPTS-Display IMS options</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>KEYHELP-Display valid keys</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>L (locate) string-Search the currently sorted field (nonnumeric fields only) (^a)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCACHE-Switch to Extended Buffer Statistics panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>MSET-Display Console - Management Sets subpanel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>NEW-Create a new file</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>NONE-Deselect all selected data sets</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>OPEN-Open file</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>PRINT-Print entire object</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>PRINTSEL-Print selected object</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>PSSOPTS-Display PSS options</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>RFIND-Repeat the previous FIND command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>REMOVE-Remove object from management set</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>RENAME-Rename selected object</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>RESETSTA-Reset statistics for management sets</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SAVE-Save file</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SAVEAS-Save as new name</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SAVETOMS-Save to management set</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SENDNEW-Send new command to utility</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SSIMON-Switch to SSI monitor panel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SSIOPPTS-Display SSI options</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>ISPF Fastpath command</td>
<td>C</td>
<td>E</td>
<td>G</td>
<td>H</td>
<td>L</td>
<td>M</td>
<td>S</td>
<td>T</td>
<td>U</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>SUMMARY-Switch to Management Set Summary panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTILMON-Switch to Utility monitor</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>UTLOGAP-Switch to Utility Monitor Log Apply panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTSNAP-Switch to Utility Monitor Snapshot panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTTASKS-Switch to Utility Monitor Task panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWACTV-Sort by active status</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWADDR-View by device address</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWAR-View by asynchronous reads</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>VIEWARP-View by asynchronous read pages</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VIEWCBLK-Sort by blocks in cache</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>VIEWCCA-View by channel connection address</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VIEWCMPL-Sort by completion percent of the data set being processed by the utility job using the snapshot component (available only from Snapshot Utilities monitor)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VIEWCOMM-Sort by command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWCSID-View by device control unit ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>VIEWCUSN-View by control unit serial number</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VIEWDB1-Sort by database name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWDB21-Sort by DB2 subsystem</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWDR-View by direct reads</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWDTYP-View by device type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWLSS-View by logical subsystem</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>VIEWFUNC-View by device functionality</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VIEWHITP-Sort by hit percent</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>VIEWID1-Sort by userid</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VIEWJOB-Sort by utility job name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWLAST-View the last command sent to utility</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VIEWMDAT-Sort by modify date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>VIEWMFG-Sort by device manufacturer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VIEWNAME1-Sort by name</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWPSET-Sort by page set name</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWPSID-Sort by page set ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### XBM ISPF Fastpath commands

<table>
<thead>
<tr>
<th>ISPF Fastpath command</th>
<th>C</th>
<th>E</th>
<th>G</th>
<th>H</th>
<th>L</th>
<th>M</th>
<th>S</th>
<th>T</th>
<th>U</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIEWRRAT-Sort by read rate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSE1-Modify selection criteria</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSE1-Switch to I/O activity</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSE2-Switch to Snapshot Utilities activity</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSE3-Switch to EMC TimeFinder activity</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSE4-Switch to Hitachi Remote Copy activity</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSSID-View by control unit subsystem ID</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSPI-Sort by space name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSR-DB2: view by synchronous reads; IMS: view by sequential reads</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSRBL-View by sequential read blocks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSRCI-View by sequential read control intervals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSRDF-View by SRDF-type devices</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSTAT-View by device status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWSYNC-View by device synchronization status</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWTYPE1-Sort by type</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWUTIL-View the utility name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWVOLS-View by volume serial number</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWVOLUM-View by volume usage</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEWXBMS-Display the XBM Subsystem Selection panel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>VSAMOPTS-Display VSAM options</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>XBM-Display Console - XBM subpanel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>XBMMON-Switch to Extended Buffer monitor</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>XBMMONCF-Switch to Coupling Facility monitor</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>XBMMOND-Switch to Data Set monitor</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>XBOPTS-Edit XBM options</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>ZOOM-Display detailed information about selected object</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*a The Locate command is available and works on the currently sorted (view by) field. Locate looks for an equal (=) or greater than (>) value.*
XBM options

To configure XBM and SUF for snapshot processing, you set options through the ISPF interface. This appendix describes the following options:

- “VSAM options” on page 283
- “Cache options for the extended buffer” on page 284
- “Snapshot template options for software snapshots” on page 286
- “SSI options for hardware snapshots” on page 287
- “Snapshot template options for hardware snapshots” on page 291
- “SSI options for Instant Snapshots” on page 293

VSAM options

If you want to process snapshots for VSAM data sources, you must specify options on the VSAM Options panel.

VSAM Options panel

Restrict caching

Specify whether to restrict caching for cross-region share options 3 or 4:

- Valid values are 1 (Yes) or 2 (No). The default value is 1 (Yes).
- If you specify Yes, XBM does not cache objects that are defined to allow cross-system updates. VSAM objects with the following share options can be cached:
  - (1,3)
  - (1,4)
  - (2,3)
VSAM objects with other share options that XBM can determine to be on nonshared DASD

- If you specify No, you allow XBM to cache VSAM objects that can be shared across systems. To allow caching, both this option and the specific managed object must be set to RESTRICT=NO.

**WARNING**

BMC does not recommend caching any data sets that are shared by multiple systems. If data sets are updated by multiple systems while cached with XBM, it could result in a data-integrity problem. This VSAM option allows you to cache data sets with shareable attributes (share options 3 or 4) when the data set is not really shared across systems. If a data set with share options 3 or 4 is accessed with DISP=OLD, XBM allows caching.

---

Remove object information

Specify whether to remove VSAM object tracking information while not in use: _______________________

- Valid values are 1 (Yes) or 2 (No). The default value is 1 (Yes).

- If you specify Yes, the object tracking information for VSAM objects is removed after the objects are no longer being used, unless the VSAM object has been defined under a management set with RETAIN=YES.

- If you specify No, the information is not removed and memory usage in the XBM address space might be increased.

---

**Cache options for the extended buffer**

To enable software snapshots, you must configure the cache options for the extended buffer on the Cache Information panel.

Complete this panel for each type of cache you are enabling. For information about the different cache types and best uses, see “Choosing cache types” on page 112.

**Cache Information panel**

**Cache size and Cache size in**

Enter the maximum amount of storage to allocate to the cache when the configuration is activated. Enter the numerical portion of the maximum
storage amount in the **Cache size** field and the units of measure in the **Cache size in field**:

You can specify the cache size in KB, MB, GB, or as a percentage of online storage. The size is rounded upward to the 4-KB boundary.

If you use hiperspace (HSP) or database (DSP) cache, the size of the cache is limited to 2 GB in size. If you need a larger cache and operate in 64-bit mode, you can use virtual storage (PVS or FVS) to create a cache up to 511 GB. If you attempt to define a size larger than the maximum allowable, you will receive an “Out of range” message.

When selecting the cache limit, consider the following guidelines:

- If you set the **Limit excessive cache** option to Yes, XBM will not activate the configuration if it detects that the amount of requested cache could have a negative impact on the system. If you do not have this option set, you could negatively impact your system if the amount of storage requested is too large.

- BMC recommends that you be conservative in the cache limit that you initially set and adjust this amount gradually until you reach a good balance between performance and cache size.

**Note**

For fixed virtual, data space, and paged virtual caches, the percentage online refers to the number of online real frames available on the system. For hiperspace cache on a pre-ESAME system, it refers to the number of online expanded storage frames. (Note that this value is ignored for hiperspace caches on an ESAME system—in that case, a size of 4 KB is used). If you specify cache size as a percentage of online storage, the size allocated for the cache is determined by available system resources at the time that the configuration is activated.

**WARNING**

A cache size that is too large for available resources can seriously impact your system. If you select a DSP or PVS cache, you must ensure that you have sufficient paging space to support the cache size that you specify, and that amount of space remains available to XBM while it is running. If other applications also use the space and the space becomes unavailable, the system can fail.

**Compression**

Indicate whether to enable or disable the managed object for compression:
Valid values are 1 (Compression) and 2 (No compression). The default value is 2 (No compression).

For compression to take place, compression must be enabled for both the managed object in the management set and the cache in the configuration.

For more information about using compression for caches, see “Using compression” on page 116.

Snapshot template options for software snapshots

To enable XBM and SUF to perform software snapshots, you must specify a snapshot template. These options are available on the Snapshot Managed Object Information panel.

Snapshot Managed Object Information panel

Cache limit

Specify the cache limit for the snapshot template: ___________________

- This amount can be defined in kilobytes (KB), megabytes (MB), gigabytes (GB), terabytes (TB), petabytes (PB), or exabytes (EB). The range is from 0 to 8191 PB or 7 EB.

- When setting the limit, consider the amount of update activity that typically affects objects after your utility establishes a point of consistency. Setting the cache limit too low could cause the preimage copy of an updated page to be unavailable for processing by the utility. However, because pages are released as they are copied, the cache does not need to hold all preimage pages; it needs to accommodate only those pages that will be copied concurrently.

- When running a restartable Snapshot Copy job, you should specify a higher cache limit than normal. You need a larger cache because XBM continues to cache targeted data sets until the job successfully completes or you terminate the job for each targeted data set. A normal-sized cache might work well for a restartable Snapshot Copy job that requires no restart, but if several restarts are required, the same cache can fill, leaving no space for preimages.
**Note**

XBM applies the snapshot template values to each data set when the snapshot is initiated. The cache limit is the maximum amount of the cache that the snapped data set can occupy.

---

**Compression**

Specify whether you want to use compression for the template:

- Valid values are 1 (Compression) and 2 (No compression). The default value is 2 (No compression).

- Freespace compression is available for snapshot utility object definitions. For more information, see “Using compression” on page 116.

---

**Cache type**

Specify the type of cache that you want to use for the template:

- The valid values are 1 (None), 2 (Any), 3 (Fixed Virtual), 4 (Paged Virtual), 5 (Data Space), and 6 (Hiperspace).

- BMC recommends that you use data space for snapshot templates. ESO hiperspace is not recommended because the system can steal pages, causing the preimage copy of an updated page to be unavailable for utility processing.

- Ensure that the configuration that will be active during snapshot utilities processing supports the cache type that you specify.

- For more information, see “Choosing cache types” on page 112.

---

**SSI options for hardware snapshots**

You specify SSI options to control hardware snapshots through the SSI Options, the SSI Snapshot Options, the SSI Data Set Snap Options, and Remote SSI Snapshot Options subpanels.
SSI Options subpanel

Device discovery

Specify what hardware devices you want XBM to display when the XBM subsystem or the SSI component is started: _______________

- You can choose to have XBM display all hardware devices or only those hardware devices that are supported by XBM for SSI-assisted snapshots.

- Valid values are 1 (Supported functionality DASD devices only) and 2 (All DASD devices). The default value is 1 (Supported functionality DASD devices only).

Allow SSI assisted snapshots

Specify whether SSI-assisted snapshots are allowed for the snapshot utilities if supported hardware devices are available: _______________

- Valid values are 1 (Yes) and 2 (No). The default value is 1 (Yes).

- In addition to this option, you must also enable the SSI-assisted snapshot option on the Snapshot template options subpanel. For more information, see “Creating a snapshot template for a hardware snapshot” on page 145. The SSI specification in the snapshot template allows you to control specific runs without altering this global setting.

Allow Instant Snapshots

Specify whether Instant Snapshots are allowed for the snapshot utilities that support them: _______________

- Valid values are 1 (Yes) and 2 (No). The default value is 2 (No).

- For more information about Instant Snapshots, see “Enabling software snapshots” on page 109.

- A utility must specifically request an Instant Snapshot (via a keyword) before XBM can perform one.

SSI Snapshot Options subpanel

Allow dataset snap

Specify whether XBM should attempt to perform a data-set-level snapshot before a volume-level snapshot: _______________

- Valid values are 1 (Yes) and 2 (No). The default value is 1 (Yes).
If you set both this field and **Allow volume mirror split** to **Yes**, XBM attempts to do a data set snapshot before a volume mirror split.

### Allow volume mirror split

Specify whether XBM should attempt to split a currently established mirror if data-set-level snapshots are unavailable or are not allowed: _______________

- Valid values are 1 (Yes) and 2 (No). The default value is 1 (Yes).
- If you set both **Allow dataset snap** and this field to **Yes**, XBM attempts to do a data set snapshot before a volume mirror split.

### Allow virtual volume snap

Specify whether XBM should attempt to perform a virtual volume snapshot on EMC devices: _______________

- Valid values are 1 (Yes) and 2 (No). The default value is 2 (No).
- If you set **Allow virtual volume snap** and the **Allow volume mirror split** to 1 (Yes), XBM attempts to perform a virtual volume snapshot before a volume mirror split.

### Virtual volume SnapPool

Specify the name of the snap pool: _______________

- This value lets you specify the name of the snapshot that XBM should use when processing the snapshot for virtual volumes.

### SSI Data Set Snap Options subpanel

Complete this subpanel only if you allowed data-set-level snapshots on the SSI Options subpanel.)

---

**Note**

These values will be applied to all hardware snapshots.

---

**Storage class**

Specify the qualifier for the storage class: _______________

This value allows you to direct the output data set to the specified SMS storage class.
Management class

Specify the qualifier for the management class: _______________

This value allows you to direct the output data set to the specified SMS management class.

Data class

Specify the qualifier for the data class: _______________

This value allows you to direct the output data set to the specified SMS data class.

Esoteric unit

Specify the qualifier that limits output to the specified esoteric unit: _______________

**Note**
BMC recommends that you do not use global esoteric units, such as SYSALLDA.

Volume count

Specify the qualifier for the volume count: _______________

The default value is 0.

Dataset HLQ

Specify the high-level qualifier to use for the temporary data set: _______________

**Remote SSI Snapshot Options subpanel**

Allow remote mirror volume split

Specify whether XBM should attempt to split a mirror attached to the remote target volume: _______________

- The remote target volume is a mirror volume located on a hardware storage device physically separated from the primary volume.
- Valid values are 1 (Yes) and 2 (No). The default value is 2 (No).

**Note**: Remote mirror volume splitting is currently available only for EMC Symmetrix devices attached with a Symmetrix Remote Data Facility (SRDF) link. The local mirrored pair (source) and remote mirrored pair (target)
devices must be attached to the same host running the snapshot utility. The SRDF link must be synchronous or semi-synchronous.

Favor local or remote volume

Specify whether XBM should first attempt to split a local or remote mirror for the snapshot: ______________

- Valid values are 1 (Local) and 2 (Remote). The default value is 1 (Local).
- If the attempt to split the favored mirror cannot occur, XBM then attempts to split the secondary mirror for the snapshot.

Note: XBM processes the option to synchronize a local volume mirror when a snapshot is registered before it processes this option to favor a local or remote volume to split. Consequently, it is unnecessary to synchronize a local volume when the snapshot is registered if a remote volume is favored for split.

Snapshot template options for hardware snapshots

To set up XBM and SUF for processing hardware snapshots, you must set snapshot template options on the Snapshot Managed Object Information, Snapshot template options, and SSI Assisted Snapshot Options panels.

Snapshot Managed Object Information panel

Enter these values only if you are creating a template for use for both software and hardware snapshots.

Cache limit

Enter the cache limit for the object if you are creating a template to be used by both hardware and software snapshots: ______________

- If you are not creating a template for both software snapshots and hardware snapshots, leave this field at the default value of 0.
- For more information about the Cache limit field, see “Snapshot template options for software snapshots” on page 286.
Priority

Enter a value for the priority (from 0 to 9999) of the object if you are creating a template to be used by hardware and software snapshots:

If you are not creating a template for both software snapshots and hardware snapshots, leave this field at the default value of 0.

For more information about the Priority field, see “Snapshot template options for software snapshots” on page 286.

Compression

Specify whether to allow compression if you are creating a template to be used by hardware and software snapshots:

If you are not creating a template for both software snapshots and hardware snapshots, leave this field at the default value of 2 (No).

For more information about the Compression field, see “Snapshot template options for software snapshots” on page 286.

Cache type

Specify the type of cache to use if you are creating a snapshot template to be used both in hardware and software snapshots:

If you are not creating a template for both software snapshots and hardware snapshots, leave this field at its default value of 1 (None).

For more information about the Cache type field, see “Snapshot template options for software snapshots” on page 286.

Snapshot template options panel

Allow SSI assisted snapshots

Enter 1 to specify that SSI-assisted snapshots (hardware) are allowed for the snapshot utilities if supported hardware devices are available:

Valid values are 1 (Yes) and 2 (No). The default value is 2 (No).
SSI Assisted Snapshot Options panel

Performs synchronize volume mirror at register

Specify whether XBM should synchronize a local volume mirror to the primary volume when the snapshot is registered: ______________

- Valid values are 1 (Yes) and 2 (No). The default value is 2 (No).
- XBM selects a mirror from the list of available mirrors. To be selected, a mirror must be local and must not be online to any system or synchronized. The default prevents mirror volume synchronization.
- XBM currently supports this option for EMC Symmetrix devices only.

Note
Due to the delay incurred by the synchronization process, snapshot utility jobs will be correspondingly delayed. However, the DBMS outage times will be unaffected.

Resynchronize volume mirror after completion

Specify whether XBM should resynchronize the mirror volume with the primary volume after the hardware snapshot job is complete: ______________

- Valid values are 1 (Yes) and 2 (No). The default value is 1 (Yes).
- If the mirror volume was originally split and Perform synchronize volume mirror at register is specified, XBM ignores this option and attempts to leave the volume in its split, pre-snapshot state. The default resynchronizes the mirror volume.

SSI options for Instant Snapshots

When you want to use Instant Snapshots, you define the following options on the SSI Options suppanel.

SSI Options subpanel

Device discovery

Specify what hardware devices you want XBM to display when the XBM subsystem or the SSI component is started: ______________
- You can choose to have XBM display all hardware devices or only those hardware devices that are supported by XBM for SSI-assisted snapshots.

- Valid values are 1 (Supported functionality DASD devices only) and 2 (All DASD devices).

- The default value is 1 (Supported functionality DASD devices only).

Allow SSI assisted snapshots

Specify whether to allow hardware snapshots for the snapshot utilities if supported hardware devices are available: ___________________

- Valid values are 1 (Yes) and 2 (No). The default value is 1 (Yes).

- If you disable this parameter, Instant Snapshots can occur, but XBM cannot perform hardware snapshots.

Allow Instant Snapshots

Specify whether to allow Instant Snapshots for the snapshot utilities that support them: ___________________

Valid values are 1 (Yes) and 2 (No). The default value is 2 (No).
SMF reporting

The EXTENDED BUFFER MANAGER (XBM) product gives you the option of recording historical information about the subsystem’s operation to System Management Facilities (SMF) records.

These records can then be analyzed to detect trends and to determine the effectiveness of XBM over time.

This appendix includes a description of the record layout for cache statistics and data set statistics of the SMF records. Both tables include the SAS format, for use with SAS reports you may want to create to analyze and format this information.

You turn on SMF reporting through setting XBM options. For more information, see Setting XBM options on page 62.

Note
Some of the character strings are "C" null terminated strings. This should not affect SAS reporting.

Cache statistics record layout

Table 77 on page 295 shows the record layout for cache statistics.

Table 77: Cache statistics record layout

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
<tr>
<td>2</td>
<td>Binary</td>
<td>1</td>
<td>Record number</td>
<td>PIB1.</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>8</td>
<td>SMF Timestamp</td>
<td>SMFSTAMP8</td>
</tr>
<tr>
<td>11</td>
<td>Char</td>
<td>4</td>
<td>SID</td>
<td>$4.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>----------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>XBM header</strong></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Binary</td>
<td>1</td>
<td>Record Type</td>
<td>PIB1.</td>
</tr>
<tr>
<td>16</td>
<td>Char</td>
<td>4</td>
<td>XBM SSID</td>
<td>$4.</td>
</tr>
<tr>
<td>20</td>
<td>Char</td>
<td>8</td>
<td>Version text</td>
<td>$8.</td>
</tr>
<tr>
<td>28</td>
<td>Binary</td>
<td>1</td>
<td>Number of sections</td>
<td>PIB1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Cache statistics section</strong></td>
<td></td>
</tr>
<tr>
<td>00</td>
<td>Binary</td>
<td>4</td>
<td>Length of Section</td>
<td>PIB4.</td>
</tr>
<tr>
<td>04</td>
<td>Binary</td>
<td>4</td>
<td>Object ID (Cache = 106)</td>
<td>PIB4.</td>
</tr>
<tr>
<td>08</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>2</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>2</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Char</td>
<td>4</td>
<td>Eye-catcher 'CACH'</td>
<td>$4.</td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Char</td>
<td>6</td>
<td>Cache name</td>
<td>$5.</td>
</tr>
<tr>
<td>34</td>
<td>Char</td>
<td>22</td>
<td>Cache description</td>
<td>$22.</td>
</tr>
<tr>
<td>56</td>
<td>Binary</td>
<td>1</td>
<td>Cache type</td>
<td>PIB1.</td>
</tr>
<tr>
<td>57</td>
<td>Binary</td>
<td>1</td>
<td>Compress switch</td>
<td>PIB1.</td>
</tr>
<tr>
<td>58</td>
<td>Binary</td>
<td>1</td>
<td>Simulate switch</td>
<td>PIB1.</td>
</tr>
<tr>
<td>59</td>
<td>Binary</td>
<td>1</td>
<td>Acquire resource switch</td>
<td>PIB1.</td>
</tr>
<tr>
<td>60</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>68</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>72</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>76</td>
<td></td>
<td>8</td>
<td>Cache creation time</td>
<td></td>
</tr>
<tr>
<td>84</td>
<td>Binary</td>
<td>8</td>
<td>Cache size in bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>92</td>
<td>Binary</td>
<td>8</td>
<td>Used bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>100</td>
<td>Binary</td>
<td>8</td>
<td>Original bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>108</td>
<td>Binary</td>
<td>8</td>
<td>Compressed bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>116</td>
<td>Binary</td>
<td>8</td>
<td>Writes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>124</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of Writes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>132</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of Writes1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>140</td>
<td>Binary</td>
<td>8</td>
<td>Write request failures</td>
<td>PIB8.</td>
</tr>
<tr>
<td>148</td>
<td>Binary</td>
<td>8</td>
<td>Reads</td>
<td>PIB8.</td>
</tr>
<tr>
<td>156</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of Reads</td>
<td>PIB8.</td>
</tr>
<tr>
<td>164</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of Reads1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>172</td>
<td>Binary</td>
<td>8</td>
<td>Read request failures</td>
<td>PIB8.</td>
</tr>
<tr>
<td>180</td>
<td>Binary</td>
<td>8</td>
<td>Write access bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>188</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of WBYTES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>196</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of WBYTES1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>204</td>
<td>Binary</td>
<td>8</td>
<td>Write access time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>212</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of WTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>220</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of WTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>228</td>
<td>Binary</td>
<td>8</td>
<td>Read access bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>236</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of RBYTES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>244</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of RBYTES1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>252</td>
<td>Binary</td>
<td>8</td>
<td>Read access time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>260</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of RTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>268</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of RTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>276</td>
<td></td>
<td>8</td>
<td>Timestamp</td>
<td></td>
</tr>
<tr>
<td>284</td>
<td>Binary</td>
<td>8</td>
<td>Total data sets</td>
<td>RB8.</td>
</tr>
<tr>
<td>292</td>
<td>Binary</td>
<td>8</td>
<td>Interval seconds</td>
<td>RB8.</td>
</tr>
<tr>
<td>300</td>
<td>Char</td>
<td>35</td>
<td>Configuration name</td>
<td>$32.</td>
</tr>
<tr>
<td>340</td>
<td>Binary</td>
<td>8</td>
<td>Cache high water mark</td>
<td>PIB8.</td>
</tr>
</tbody>
</table>

Configuration start statistics section

| 00 | Binary | 4 | Length of Section | PIB4. |
| 04 | Binary | 4 | Object ID (Start record = 1) | PIB4. |
| 08 | Char   | 8 | User ID            | $8.   |
| 17 | Char   | 32| Configuration       | $32.  |
| 50 | Char   | 32| Management set name | $32.  |
| 83 | Char   | 32| Group name         | $32.  |

Configuration stop statistics section

| 00 | Binary | 4 | Length of Section | PIB4. |
| 04 | Binary | 4 | Object ID (Stop record = 2) | PIB4. |
### Data set statistics record layout

Table 78 on page 298 shows the record layout for data set statistics.

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
</tbody>
</table>

---

**Table 78 on page 298 shows the record layout for data set statistics.**

**Table 78: Data set statistics record layout**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMF header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Binary</td>
<td>1</td>
<td>System indicator</td>
<td>PIB1.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>----------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>2</td>
<td>Binary</td>
<td>1</td>
<td>Record number</td>
<td>PIB1.</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>8</td>
<td>SMF timestamp</td>
<td>SMFSTAMP8.</td>
</tr>
<tr>
<td>11</td>
<td>Char</td>
<td>4</td>
<td>SID</td>
<td>$4.</td>
</tr>
</tbody>
</table>

**XBM header**

| 15          | Binary | 1      | Record Type                      | PIB1.      |
| 16          | Char   | 4      | XBM SSID                         | $4.        |
| 20          | Char   | 8      | Version text                     | $8.        |
| 28          | Binary | 1      | Number of sections               | PIB1.      |

**Data set statistics section**

<p>| 00          | Binary | 4      | Length of Section                | PIB4.      |
| 04          | Binary | 4      | Object ID (Data Sets = 113)      | PIB4.      |
| 08          |        | 4      | Reserved                         |           |
| 12          |        | 4      | Reserved                         |           |
| 16          |        | 2      | Reserved                         |           |
| 18          |        | 2      | Reserved                         |           |
| 20          |        | 8      | Create timestamp                 |           |
| 28          |        | 8      | Statistics timestamp             |           |
| 36          |        | 8      | Interval time in seconds         | RB8.      |
| 44          |        |        | Reserved                         |           |
| 48          | Binary | 1      | Compress switch                  | PIB1.      |
| 49          | Binary | 1      | Active switch                    | PIB1.      |
| 50          | Binary | 1      | Cache type                       | PIB1.      |
| 51          | Char   | 45     | Data set name                    | $44        |
| 96          | Binary | 4      | Priority                         | PIB4.      |
| 100         | Char   | 33     | Activating management set        | $32.       |
| 133         |        | 7      | Reserved                         |           |
| 140         | Binary | 8      | Cache used bytes                 | PIB8.      |
| 148         | Binary | 8      | Cache original bytes             | PIB8.      |
| 156         | Binary | 8      | Cache compressed bytes           | PIB8.      |
| 164         | Binary | 8      | Blocks written to DASD           | PIB8.      |
| 172         | Binary | 8      | Snapshot of WRITES               | PIB8.      |
| 180         | Binary | 8      | Snapshot of WRITES1              | PIB8.      |</p>
<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>188</td>
<td>Binary</td>
<td>8</td>
<td>Blocks written to cache</td>
<td>PIB8.</td>
</tr>
<tr>
<td>196</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of CWRITES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>204</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of CWRITES1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>212</td>
<td>Binary</td>
<td>8</td>
<td>Cache write failures</td>
<td>PIB8.</td>
</tr>
<tr>
<td>220</td>
<td>Binary</td>
<td>8</td>
<td>Block read while inactive (from DASD)</td>
<td>PIB8.</td>
</tr>
<tr>
<td>228</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of READS</td>
<td>PIB8.</td>
</tr>
<tr>
<td>236</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of READS1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>244</td>
<td>Binary</td>
<td>8</td>
<td>Blocks read while active (from cache and DASD)</td>
<td>PIB8.</td>
</tr>
<tr>
<td>252</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AREADS</td>
<td>PIB8.</td>
</tr>
<tr>
<td>260</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AREADS1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>268</td>
<td>Binary</td>
<td>8</td>
<td>Blocks satisfied from cache</td>
<td>PIB8.</td>
</tr>
<tr>
<td>276</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of HITS</td>
<td>PIB8.</td>
</tr>
<tr>
<td>284</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of HITS1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>292</td>
<td>Binary</td>
<td>8</td>
<td>Cache read failures</td>
<td>PIB8.</td>
</tr>
<tr>
<td>300</td>
<td>Binary</td>
<td>8</td>
<td>Bytes output to disk</td>
<td>PIB8.</td>
</tr>
<tr>
<td>308</td>
<td>Binary</td>
<td>8</td>
<td>Output time in microseconds</td>
<td>PIB8.</td>
</tr>
<tr>
<td>316</td>
<td>Binary</td>
<td>8</td>
<td>Bytes written to cache</td>
<td>PIB8.</td>
</tr>
<tr>
<td>324</td>
<td>Binary</td>
<td>8</td>
<td>Write time in microseconds</td>
<td>PIB8.</td>
</tr>
<tr>
<td>332</td>
<td>Binary</td>
<td>8</td>
<td>Bytes read from cache</td>
<td>PIB8.</td>
</tr>
<tr>
<td>340</td>
<td>Binary</td>
<td>8</td>
<td>Read time in microseconds</td>
<td>PIB8.</td>
</tr>
<tr>
<td>348</td>
<td>Binary</td>
<td>8</td>
<td>Bytes input from DASD</td>
<td>PIB8.</td>
</tr>
<tr>
<td>356</td>
<td>Binary</td>
<td>8</td>
<td>Input time in microseconds</td>
<td>PIB8.</td>
</tr>
<tr>
<td>364</td>
<td>Binary</td>
<td>8</td>
<td>Cache high water mark</td>
<td>PIB8.</td>
</tr>
<tr>
<td>372</td>
<td>Binary</td>
<td>8</td>
<td>Accumulated cache writes before resetting statistics (0 if statistics are not reset)</td>
<td>PIB8.</td>
</tr>
<tr>
<td>380</td>
<td>Binary</td>
<td>8</td>
<td>Accumulated bytes written to cache before resetting statistics</td>
<td>PIB8.</td>
</tr>
<tr>
<td>388</td>
<td>Char</td>
<td>1</td>
<td>Dynamic cache flag ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>389</td>
<td>Char</td>
<td>1</td>
<td>Statistics reset ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>390</td>
<td>Char</td>
<td>1</td>
<td>Dynamic deactivate ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>391</td>
<td>Char</td>
<td>1</td>
<td>Inefficient blocksize ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>-----------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>392</td>
<td>Binary</td>
<td>4</td>
<td>Listable flag</td>
<td>PIB4.</td>
</tr>
<tr>
<td>396</td>
<td>Binary</td>
<td>4</td>
<td>Self address</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Char</td>
<td>1</td>
<td>Global IO enabled ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>401</td>
<td></td>
<td>3</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>404</td>
<td>Binary</td>
<td>8</td>
<td>Cache byte limit</td>
<td>PIB8.</td>
</tr>
</tbody>
</table>

**Snapshot data set statistics section**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Binary</td>
<td>4</td>
<td>Length of Section</td>
<td>PIB4.</td>
</tr>
<tr>
<td>04</td>
<td>Binary</td>
<td>4</td>
<td>Object ID (Data Sets = 113)</td>
<td>PIB4.</td>
</tr>
<tr>
<td>08</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>2</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>2</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>8</td>
<td>Create timestamp</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td>8</td>
<td>Statistics timestamp</td>
<td>RB8.0</td>
</tr>
<tr>
<td>36</td>
<td></td>
<td>8</td>
<td>Interval time in seconds</td>
<td>RB8.0</td>
</tr>
<tr>
<td>44</td>
<td>Binary</td>
<td>4</td>
<td>Cache byte limit</td>
<td>PIB4.</td>
</tr>
<tr>
<td>48</td>
<td>Binary</td>
<td>1</td>
<td>Compress switch</td>
<td>PIB1.</td>
</tr>
<tr>
<td>49</td>
<td>Binary</td>
<td>1</td>
<td>Active switch</td>
<td>PIB1.</td>
</tr>
<tr>
<td>50</td>
<td>Binary</td>
<td>1</td>
<td>Cache type</td>
<td>PIB1.</td>
</tr>
<tr>
<td>51</td>
<td>Char</td>
<td>45</td>
<td>Data set name</td>
<td>$44</td>
</tr>
<tr>
<td>96</td>
<td>Binary</td>
<td>4</td>
<td>Priority</td>
<td>PIB4.</td>
</tr>
<tr>
<td>100</td>
<td>Char</td>
<td>33</td>
<td>Activating management set</td>
<td>$32.</td>
</tr>
<tr>
<td>133</td>
<td></td>
<td>7</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>Binary</td>
<td>8</td>
<td>Cache used bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>148</td>
<td>Binary</td>
<td>8</td>
<td>Cache original bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>156</td>
<td>Binary</td>
<td>8</td>
<td>Cache compressed bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>164</td>
<td>Binary</td>
<td>8</td>
<td>Blocks written to DASD</td>
<td>PIB8.</td>
</tr>
<tr>
<td>172</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of WRITES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>180</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of WRITES1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>188</td>
<td>Binary</td>
<td>8</td>
<td>Blocks written to cache</td>
<td>PIB8.</td>
</tr>
<tr>
<td>196</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of CWRITES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>204</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of CWRITES1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>212</td>
<td>Binary</td>
<td>8</td>
<td>Cache write failures</td>
<td>PIB8.</td>
</tr>
<tr>
<td>220</td>
<td>Binary</td>
<td>8</td>
<td>Block read while inactive</td>
<td>PIB8.</td>
</tr>
<tr>
<td>228</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of READS</td>
<td>PIB8.</td>
</tr>
<tr>
<td>236</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of READS1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>244</td>
<td>Binary</td>
<td>8</td>
<td>Blocks read while active</td>
<td>PIB8.</td>
</tr>
<tr>
<td>252</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AREADS</td>
<td>PIB8.</td>
</tr>
<tr>
<td>260</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AREADS1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>268</td>
<td>Binary</td>
<td>8</td>
<td>Blocks satisfied from cache</td>
<td>PIB8.</td>
</tr>
<tr>
<td>276</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of HITS</td>
<td>PIB8.</td>
</tr>
<tr>
<td>284</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of HITS1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>292</td>
<td>Binary</td>
<td>8</td>
<td>Cache read failures</td>
<td>PIB8.</td>
</tr>
<tr>
<td>300</td>
<td>Binary</td>
<td>8</td>
<td>Bytes output to disk</td>
<td>PIB8.</td>
</tr>
<tr>
<td>308</td>
<td>Binary</td>
<td>8</td>
<td>Output time in microseconds</td>
<td>PIB8.</td>
</tr>
<tr>
<td>316</td>
<td>Binary</td>
<td>8</td>
<td>Bytes written to cache</td>
<td>PIB8.</td>
</tr>
<tr>
<td>324</td>
<td>Binary</td>
<td>8</td>
<td>Write time in microseconds</td>
<td>PIB8.</td>
</tr>
<tr>
<td>332</td>
<td>Binary</td>
<td>8</td>
<td>Bytes read from cache</td>
<td>PIB8.</td>
</tr>
<tr>
<td>340</td>
<td>Binary</td>
<td>8</td>
<td>Read time in microseconds</td>
<td>PIB8.</td>
</tr>
<tr>
<td>348</td>
<td>Binary</td>
<td>8</td>
<td>Bytes input from DASD</td>
<td>PIB8.</td>
</tr>
<tr>
<td>356</td>
<td>Binary</td>
<td>8</td>
<td>Input time in microseconds</td>
<td>PIB8.</td>
</tr>
<tr>
<td>364</td>
<td>Binary</td>
<td>8</td>
<td>Cache high water mark</td>
<td>PIB8.</td>
</tr>
<tr>
<td>372</td>
<td>Binary</td>
<td>8</td>
<td>Accumulated cache writes before resetting statistics (0 if statistics are not reset)</td>
<td>PIB8.</td>
</tr>
<tr>
<td>380</td>
<td>Binary</td>
<td>8</td>
<td>Accumulated bytes written to cache before resetting statistics</td>
<td>PIB8.</td>
</tr>
<tr>
<td>388</td>
<td>Char</td>
<td>1</td>
<td>Dynamic cache flag ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>389</td>
<td>Char</td>
<td>1</td>
<td>Statistics reset ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>390</td>
<td>Char</td>
<td>1</td>
<td>Dynamic deactivate ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>391</td>
<td>Char</td>
<td>1</td>
<td>Inefficient blocksize ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>392</td>
<td>Binary</td>
<td>8</td>
<td>Cacheable flag</td>
<td>PIB8.</td>
</tr>
<tr>
<td>400</td>
<td>Char</td>
<td>1</td>
<td>Global IO enabled ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>401</td>
<td>Char</td>
<td>31</td>
<td>Reserved</td>
<td></td>
</tr>
</tbody>
</table>

**DB2 statistics section**
<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Binary</td>
<td>4</td>
<td>Length of Section</td>
<td>PIB4.</td>
</tr>
<tr>
<td>04</td>
<td>Binary</td>
<td>4</td>
<td>Object ID (DB2 DSN = 154)</td>
<td>PIB4.</td>
</tr>
<tr>
<td>08</td>
<td>Binary</td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Binary</td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Binary</td>
<td>2</td>
<td>DB2 DBID</td>
<td>PIB2.</td>
</tr>
<tr>
<td>18</td>
<td>Binary</td>
<td>2</td>
<td>DB2 PSID</td>
<td>PIB2.</td>
</tr>
<tr>
<td>20</td>
<td>Char</td>
<td>8</td>
<td>Database name</td>
<td>$8.</td>
</tr>
<tr>
<td>28</td>
<td>Char</td>
<td>8</td>
<td>Table space name</td>
<td>$8.</td>
</tr>
<tr>
<td>36</td>
<td>Char</td>
<td>4</td>
<td>Partition</td>
<td>$4.</td>
</tr>
<tr>
<td>40</td>
<td>Char</td>
<td>5</td>
<td>DB2 SSID</td>
<td>$4.</td>
</tr>
<tr>
<td>45</td>
<td>Char</td>
<td>1</td>
<td>Compression type key</td>
<td>$1.</td>
</tr>
<tr>
<td>46</td>
<td></td>
<td>6</td>
<td>Reserved</td>
<td>PIB8.</td>
</tr>
<tr>
<td>52</td>
<td>Binary</td>
<td>8</td>
<td>Sync reads SIOs</td>
<td>PIB8.</td>
</tr>
<tr>
<td>60</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SREADS</td>
<td>PIB8.</td>
</tr>
<tr>
<td>68</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SREADS1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>76</td>
<td>Binary</td>
<td>8</td>
<td>Sync writes SIOs</td>
<td>PIB8.</td>
</tr>
<tr>
<td>84</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWrites</td>
<td>PIB8.</td>
</tr>
<tr>
<td>92</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWrites1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>100</td>
<td>Binary</td>
<td>8</td>
<td>Sync reads total time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>108</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SRTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>116</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SRTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>124</td>
<td>Binary</td>
<td>8</td>
<td>Sync writes total time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>132</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>140</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>148</td>
<td>Binary</td>
<td>8</td>
<td>Async reads SIOs</td>
<td>PIB8.</td>
</tr>
<tr>
<td>156</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AREADS</td>
<td>PIB8.</td>
</tr>
<tr>
<td>164</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AREADS1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>172</td>
<td>Binary</td>
<td>8</td>
<td>Async writes SIOs</td>
<td>PIB8.</td>
</tr>
<tr>
<td>180</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AWRITES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>188</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AWRITES1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>196</td>
<td>Binary</td>
<td>8</td>
<td>Async reads total time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>204</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of ARTIME</td>
<td>PIB8.</td>
</tr>
</tbody>
</table>
### Data set statistics record layout

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>212</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of ARTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>220</td>
<td>Binary</td>
<td>8</td>
<td>Async writes total time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>228</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AWTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>236</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AWTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>244</td>
<td>Binary</td>
<td>8</td>
<td>Async reads total pages</td>
<td>PIB8.</td>
</tr>
<tr>
<td>252</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of ARPAGES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>260</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of ARPAGES2</td>
<td>PIB8.</td>
</tr>
<tr>
<td>268</td>
<td>Binary</td>
<td>8</td>
<td>Async write total pages</td>
<td>PIB8.</td>
</tr>
<tr>
<td>276</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AWPAGES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>284</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of AWPAGES2</td>
<td>PIB8.</td>
</tr>
<tr>
<td>292</td>
<td>Binary</td>
<td>4</td>
<td>Page size</td>
<td>PIB4.</td>
</tr>
<tr>
<td>296</td>
<td>Char</td>
<td>1</td>
<td>Statistics reset ’y’</td>
<td>$1.</td>
</tr>
<tr>
<td>297</td>
<td>Char</td>
<td>43</td>
<td>Reserved</td>
<td></td>
</tr>
</tbody>
</table>

#### Snapshot utilities statistics section

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Binary</td>
<td>4</td>
<td>Length of Section</td>
<td>PIB4.</td>
</tr>
<tr>
<td>04</td>
<td>Binary</td>
<td>4</td>
<td>Object ID (snapshot = 158)</td>
<td>PIB4.</td>
</tr>
<tr>
<td>08</td>
<td>Binary</td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Binary</td>
<td>4</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Binary</td>
<td>4</td>
<td>Function</td>
<td>PIB4.</td>
</tr>
<tr>
<td>20</td>
<td>Binary</td>
<td>4</td>
<td>Return code</td>
<td>PIB4.</td>
</tr>
<tr>
<td>24</td>
<td>Binary</td>
<td>4</td>
<td>Reason code</td>
<td>PIB4.</td>
</tr>
<tr>
<td>28</td>
<td>Binary</td>
<td>4</td>
<td>ASID</td>
<td>PIB4.</td>
</tr>
<tr>
<td>32</td>
<td>Binary</td>
<td>4</td>
<td>TCB</td>
<td>PIB4.</td>
</tr>
<tr>
<td>36</td>
<td>Char</td>
<td>9</td>
<td>Component name</td>
<td>$8.</td>
</tr>
<tr>
<td>45</td>
<td>Char</td>
<td>45</td>
<td>Data set name</td>
<td>$44.</td>
</tr>
<tr>
<td>90</td>
<td>Char</td>
<td>5</td>
<td>XBM SSID</td>
<td>$4.</td>
</tr>
<tr>
<td>95</td>
<td>Char</td>
<td>9</td>
<td>User jobname</td>
<td>$8.</td>
</tr>
<tr>
<td>104</td>
<td>Char</td>
<td>9</td>
<td>User stepname</td>
<td>$8.</td>
</tr>
<tr>
<td>113</td>
<td>Char</td>
<td>9</td>
<td>User ID</td>
<td>$8.</td>
</tr>
<tr>
<td>122</td>
<td>Char</td>
<td>1</td>
<td>Compression</td>
<td>$1.</td>
</tr>
<tr>
<td>123</td>
<td>Binary</td>
<td>4</td>
<td>Priority</td>
<td>PIB4.</td>
</tr>
<tr>
<td>127</td>
<td>Binary</td>
<td>4</td>
<td>Allocated</td>
<td>PIB4.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>131</td>
<td>Binary</td>
<td>4</td>
<td>Used bytes</td>
<td>PIB4.</td>
</tr>
<tr>
<td>135</td>
<td>Binary</td>
<td>4</td>
<td>Limit size</td>
<td>PIB4.</td>
</tr>
<tr>
<td>139</td>
<td>Binary</td>
<td>8</td>
<td>Percent used</td>
<td>PIB8.</td>
</tr>
<tr>
<td>147</td>
<td>Binary</td>
<td>8</td>
<td>Blocks</td>
<td>PIB8.</td>
</tr>
<tr>
<td>155</td>
<td>Binary</td>
<td>8</td>
<td>Active reads</td>
<td>PIB8.</td>
</tr>
<tr>
<td>163</td>
<td>Binary</td>
<td>8</td>
<td>Read hits</td>
<td>PIB8.</td>
</tr>
<tr>
<td>171</td>
<td>Binary</td>
<td>8</td>
<td>Read hit ratio</td>
<td>PIB8.</td>
</tr>
<tr>
<td>179</td>
<td>Binary</td>
<td>8</td>
<td>Writes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>187</td>
<td>Binary</td>
<td>8</td>
<td>Cache writes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>195</td>
<td>Binary</td>
<td>8</td>
<td>Maximum cache bytes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>203</td>
<td>Char</td>
<td>5</td>
<td>DB2 SSID</td>
<td>$4.</td>
</tr>
<tr>
<td>208</td>
<td>Binary</td>
<td>4</td>
<td>RBA maintained by XBM</td>
<td>PIB4.</td>
</tr>
<tr>
<td>212</td>
<td>Binary</td>
<td>4</td>
<td>RBA maintained by user</td>
<td>PIB4.</td>
</tr>
</tbody>
</table>

**VSAM statistics section**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Binary</td>
<td>4</td>
<td>Length of section</td>
<td>PIB4.</td>
</tr>
<tr>
<td>04</td>
<td>Binary</td>
<td>4</td>
<td>Object ID (VSAM=199)</td>
<td>PIB4.</td>
</tr>
<tr>
<td>08</td>
<td>Binary</td>
<td>4</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
<tr>
<td>12</td>
<td>Binary</td>
<td>4</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
<tr>
<td>16</td>
<td>Binary</td>
<td>1</td>
<td>Compression</td>
<td>PIB1.</td>
</tr>
<tr>
<td>20</td>
<td>Binary</td>
<td>4</td>
<td>Control interval size</td>
<td>PIB4.</td>
</tr>
<tr>
<td>24</td>
<td>Binary</td>
<td>4</td>
<td>Control intervals per control area</td>
<td>PIB4.</td>
</tr>
<tr>
<td>28</td>
<td>Binary</td>
<td>4</td>
<td>Share option 1</td>
<td>PIB4.</td>
</tr>
<tr>
<td>32</td>
<td>Binary</td>
<td>4</td>
<td>Share option 2</td>
<td>PIB4.</td>
</tr>
<tr>
<td>36</td>
<td>Char</td>
<td>96</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
<tr>
<td>132</td>
<td>Binary</td>
<td>8</td>
<td>Direct reads</td>
<td>PIB8.</td>
</tr>
<tr>
<td>140</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot direct reads 1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>148</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot direct reads 2</td>
<td>PIB8.</td>
</tr>
<tr>
<td>156</td>
<td>Binary</td>
<td>8</td>
<td>Direct writes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>164</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot direct writes 1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>172</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot direct writes 2</td>
<td>PIB8.</td>
</tr>
<tr>
<td>180</td>
<td>Binary</td>
<td>8</td>
<td>Direct reads time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>188</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot direct reads 1 time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>--------</td>
<td>-------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>196</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot direct reads 2 time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>204</td>
<td>Binary</td>
<td>8</td>
<td>Direct writes time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>212</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot direct writes 1 time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>220</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot direct writes 2 time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>228</td>
<td>Binary</td>
<td>8</td>
<td>Sequential reads</td>
<td>PIB8.</td>
</tr>
<tr>
<td>236</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential reads 1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>244</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential reads 2</td>
<td>PIB8.</td>
</tr>
<tr>
<td>252</td>
<td>Binary</td>
<td>8</td>
<td>Sequential writes</td>
<td>PIB8.</td>
</tr>
<tr>
<td>260</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential writes 1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>268</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential writes 2</td>
<td>PIB8.</td>
</tr>
<tr>
<td>276</td>
<td>Binary</td>
<td>8</td>
<td>Sequential reads time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>284</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential reads 1 time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>292</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential reads 2 time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>300</td>
<td>Binary</td>
<td>8</td>
<td>Sequential writes time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>308</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential writes 1 time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>316</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential writes 2 time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>324</td>
<td>Binary</td>
<td>8</td>
<td>Sequential reads pages</td>
<td>PIB8.</td>
</tr>
<tr>
<td>332</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential read pages 1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>340</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential read pages 2</td>
<td>PIB8.</td>
</tr>
<tr>
<td>348</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential write pages</td>
<td>PIB8.</td>
</tr>
<tr>
<td>356</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential write pages</td>
<td>PIB8.</td>
</tr>
<tr>
<td>364</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot sequential write pages</td>
<td>PIB8.</td>
</tr>
<tr>
<td>372</td>
<td>Char</td>
<td>1</td>
<td>Statistics reset flag ‘y’</td>
<td>$1.</td>
</tr>
<tr>
<td>373</td>
<td>Char</td>
<td>1</td>
<td>VSAM retain attribute</td>
<td>$1.</td>
</tr>
<tr>
<td>374</td>
<td>Char</td>
<td>2</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>376</td>
<td>Binary</td>
<td>1</td>
<td>VSAM attributes</td>
<td>PIB1.</td>
</tr>
<tr>
<td>377</td>
<td>Binary</td>
<td>1</td>
<td>VSAM strings</td>
<td>PIB1.</td>
</tr>
<tr>
<td>378</td>
<td>Binary</td>
<td>4</td>
<td>IMS dbrc usage indicator</td>
<td>PIB4.</td>
</tr>
<tr>
<td>382</td>
<td>Binary</td>
<td>4</td>
<td>Number of buffers</td>
<td>PIB4.</td>
</tr>
<tr>
<td>386</td>
<td>Binary</td>
<td>8</td>
<td>VSAM statistics</td>
<td>PIB8.</td>
</tr>
<tr>
<td>394</td>
<td>Binary</td>
<td>4</td>
<td>Number of index levels</td>
<td>PIB4.</td>
</tr>
<tr>
<td>398</td>
<td>Binary</td>
<td>4</td>
<td>VSAM extents</td>
<td>PIB4.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>--------</td>
<td>--------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>402</td>
<td>Binary</td>
<td>4</td>
<td>Number of user records</td>
<td>PIB4.</td>
</tr>
<tr>
<td>406</td>
<td>Binary</td>
<td>4</td>
<td>Deleted records</td>
<td>PIB4.</td>
</tr>
<tr>
<td>410</td>
<td>Binary</td>
<td>4</td>
<td>Inserted records</td>
<td>PIB4.</td>
</tr>
<tr>
<td>414</td>
<td>Binary</td>
<td>4</td>
<td>Updated records</td>
<td>PIB4.</td>
</tr>
<tr>
<td>418</td>
<td>Binary</td>
<td>4</td>
<td>Number of retrieved records</td>
<td>PIB4.</td>
</tr>
<tr>
<td>422</td>
<td>Binary</td>
<td>4</td>
<td>Bytes of freespace</td>
<td>PIB4.</td>
</tr>
<tr>
<td>426</td>
<td>Binary</td>
<td>4</td>
<td>VSAM control interval splits</td>
<td>PIB4.</td>
</tr>
<tr>
<td>430</td>
<td>Binary</td>
<td>4</td>
<td>VSAM control area splits</td>
<td>PIB4.</td>
</tr>
<tr>
<td>434</td>
<td>Binary</td>
<td>4</td>
<td>EXCPs issued</td>
<td>PIB4.</td>
</tr>
<tr>
<td>438</td>
<td>Char</td>
<td>48</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
</tbody>
</table>

**Extended prefetch statistics section**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Binary</td>
<td>4</td>
<td>Length of section</td>
<td>PIB4.</td>
</tr>
<tr>
<td>04</td>
<td>Binary</td>
<td>4</td>
<td>Object ID (PSS=272)</td>
<td>PIB4.</td>
</tr>
<tr>
<td>08</td>
<td>Binary</td>
<td>8</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
<tr>
<td>16</td>
<td>Binary</td>
<td>4</td>
<td>Buffer space allocated</td>
<td>PIB4.</td>
</tr>
<tr>
<td>20</td>
<td>Binary</td>
<td>4</td>
<td>Number of buffer acquisitions</td>
<td>PIB4.</td>
</tr>
<tr>
<td>24</td>
<td>Binary</td>
<td>4</td>
<td>Number of buffer acquisition attempts</td>
<td>PIB4.</td>
</tr>
<tr>
<td>28</td>
<td>Binary</td>
<td>32</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
<tr>
<td>60</td>
<td>Binary</td>
<td>8</td>
<td>Blocks read by Prefetch</td>
<td>PIB8.</td>
</tr>
<tr>
<td>68</td>
<td>Binary</td>
<td>8</td>
<td>Blocks read by application while Prefetch active</td>
<td>PIB8.</td>
</tr>
<tr>
<td>76</td>
<td>Binary</td>
<td>8</td>
<td>Blocks satisfied by Prefetch</td>
<td>PIB8.</td>
</tr>
<tr>
<td>84</td>
<td>Binary</td>
<td>8</td>
<td>Physical I/O requests by Prefetch</td>
<td>PIB8.</td>
</tr>
<tr>
<td>92</td>
<td>Binary</td>
<td>4</td>
<td>Return Code</td>
<td>PIB4.</td>
</tr>
<tr>
<td>96</td>
<td>Binary</td>
<td>4</td>
<td>Reason Code</td>
<td>PIB4.</td>
</tr>
<tr>
<td>100</td>
<td>Binary</td>
<td>20</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
</tbody>
</table>

**IMS statistics section**

<table>
<thead>
<tr>
<th>Offset (Dec)</th>
<th>Format</th>
<th>Length</th>
<th>Description</th>
<th>SAS format</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Binary</td>
<td>4</td>
<td>Length of Section</td>
<td>PIB4.</td>
</tr>
<tr>
<td>04</td>
<td>Binary</td>
<td>4</td>
<td>Object ID (IMS DSN=242)</td>
<td>PIB4.</td>
</tr>
<tr>
<td>08</td>
<td>Binary</td>
<td>4</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
<tr>
<td>12</td>
<td>Binary</td>
<td>4</td>
<td>Reserved</td>
<td>PIB4.</td>
</tr>
<tr>
<td>16</td>
<td>Char</td>
<td>1</td>
<td>Statistics reset</td>
<td>$1.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>--------</td>
<td>------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>17</td>
<td>Char</td>
<td>1</td>
<td>Data set type</td>
<td>$1.</td>
</tr>
<tr>
<td>18</td>
<td>Char</td>
<td>1</td>
<td>Compression type key</td>
<td>$1.</td>
</tr>
<tr>
<td>19</td>
<td>Char</td>
<td>1</td>
<td>Reserved</td>
<td>$1.</td>
</tr>
<tr>
<td>20</td>
<td>Binary</td>
<td>4</td>
<td>Block size</td>
<td>PIB4.</td>
</tr>
<tr>
<td>24</td>
<td>Char</td>
<td>20</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Binary</td>
<td>4</td>
<td>Control interval size</td>
<td>PIB4.</td>
</tr>
<tr>
<td>48</td>
<td>Binary</td>
<td>4</td>
<td>Control area size</td>
<td>PIB4.</td>
</tr>
<tr>
<td>52</td>
<td>Binary</td>
<td>4</td>
<td>Share option 1</td>
<td>PIB4.</td>
</tr>
<tr>
<td>56</td>
<td>Binary</td>
<td>4</td>
<td>Share option 2</td>
<td>PIB4.</td>
</tr>
<tr>
<td>60</td>
<td>Binary</td>
<td>8</td>
<td>Direct read SIOs</td>
<td>PIB8.</td>
</tr>
<tr>
<td>68</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of DREAD</td>
<td>PIB8.</td>
</tr>
<tr>
<td>76</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of DREAD1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>84</td>
<td>Binary</td>
<td>8</td>
<td>Direct write SIOs</td>
<td>PIB8.</td>
</tr>
<tr>
<td>92</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of DWRITES</td>
<td>PIB8.</td>
</tr>
<tr>
<td>100</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of DWRITES1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>108</td>
<td>Binary</td>
<td>8</td>
<td>Direct reads total time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>116</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of DRTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>124</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of DRTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>132</td>
<td>Binary</td>
<td>8</td>
<td>Direct writes total time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>140</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of DWTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>148</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of DWTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>156</td>
<td>Binary</td>
<td>8</td>
<td>Sync read SIOs</td>
<td>PIB8.</td>
</tr>
<tr>
<td>164</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SREAD</td>
<td>PIB8.</td>
</tr>
<tr>
<td>172</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SREAD1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>180</td>
<td>Binary</td>
<td>8</td>
<td>Sync write SIOs</td>
<td>PIB8.</td>
</tr>
<tr>
<td>188</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWTWRITE</td>
<td>PIB8.</td>
</tr>
<tr>
<td>196</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWTWRITE1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>204</td>
<td>Binary</td>
<td>8</td>
<td>Sync reads total time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>212</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SRTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>220</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SRTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>228</td>
<td>Binary</td>
<td>8</td>
<td>Sync writes total time</td>
<td>PIB8.</td>
</tr>
<tr>
<td>236</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWTIME</td>
<td>PIB8.</td>
</tr>
<tr>
<td>Offset (Dec)</td>
<td>Format</td>
<td>Length</td>
<td>Description</td>
<td>SAS format</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>244</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWTIME1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>252</td>
<td>Binary</td>
<td>8</td>
<td>Sync read total pages</td>
<td>PIB8.</td>
</tr>
<tr>
<td>260</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SRPAGE</td>
<td>PIB8.</td>
</tr>
<tr>
<td>268</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SRPAGE1</td>
<td>PIB8.</td>
</tr>
<tr>
<td>276</td>
<td>Binary</td>
<td>8</td>
<td>Sync writes total pages</td>
<td>PIB8.</td>
</tr>
<tr>
<td>284</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWPAGE</td>
<td>PIB8.</td>
</tr>
<tr>
<td>292</td>
<td>Binary</td>
<td>8</td>
<td>Snapshot of SWPAGE1</td>
<td>PIB8.</td>
</tr>
</tbody>
</table>
Using the XBM utility program for a VSAM snapshot copy

The EXTENDED BUFFER MANAGER (XBM) utility program is executed as a batch job and supports certain IDCAMS REPRO command keywords in addition to XBM-specific keywords that enable the Snapshot Copy functionality.

The XBM utility program offers the following features in addition to the standard copy features found in REPRO:

- An automatic quiesce for registered CICS VSAM data sets (requires IBM CICS Version 4.1 or later). The XBM utility program quiesces registered data sets by obtaining ENQs on all files for those data sets. After all ENQs are obtained, the snapshot job commences and the ENQs are released.

- A group feature that lets you make a Snapshot Copy of a group of VSAM or CICS VSAM data sets with the same quiesce point.

- A restartable feature that lets you restart failed Snapshot Copy jobs with the original quiesce point.

- A keyword to specify Instant Snapshots.

- A messaging feature to trigger submission of jobs for concurrent update processing. Message BMC73739I goes to the system log, and you can use it to trigger submission of jobs that update the data sets in the group.

**Note**
The XBM utility program offers an alternative method for creating simple snapshot copies for VSAM and CICS VSAM data sets. However, the XBM utility program is not intended for use as a backup and recovery method for mission-critical data and does not provide the safeguards normally associated with BMC backup and recovery utilities. BMC recommends using XBM and SUF with one of the supported BMC utilities to perform snapshots for recovery purposes.

Running a VSAM or CICS VSAM Snapshot Copy requires steps to prepare XBM for snapshot processing and steps to prepare the XBM utility program. To prepare XBM for snapshot processing, see the appropriate chapter in this book for instructions on
preparing software, hardware, or Instant Snapshots. To prepare the XBM utility program, perform the following steps:

1. Set the region size.
2. Prepare the CICS environment (for CICS VSAM snapshots only).
3. Create the JCL for the job.
4. Establish a quiesce point (done manually for VSAM data and automatically for CICS VSAM data).
5. Submit the job.
6. Review the output.

Each of these steps is explained in the following sections.

### Setting region size

Specify a minimum region size of **2M** in the REGION parameter of the XBM utility program job.

### Preparing the CICS environment

The XBM utility program requires that you perform the following steps before initiating a Snapshot Copy for CICS VSAM data.

These steps define XBM programs to CICS and prepare your CICS environment.

*Note*

XBM is record-level sharing (RLS) tolerant of CICS version 4.2 and later.

1. Add the SDFHEXCI CICS load module library to the STEPLIB concatenation of your XBM utility program job.
2. Set up CICS so inter-region communication is enabled.
3. Add the XBM distribution library, containing the XBMVCLOS load module, to the DFHRPL concatenation in your CICS startup JCL.
Add the definitions for the XBMVCLOS load module and the XVCL transaction ID to your CICS System Definition (CSD) data set.

Adding these two definition names to your CSD enables XBM to perform a quiesce on registered CICS VSAM data sets. Examples of the syntax to accomplish these definitions are shown in Figure 111 on page 313 and Figure 112 on page 313.

**Note**

If your site requires specific naming conventions for items defined in your CSD, XBM allows you to change the default for the XBMVCLOS load module name and the XVCL transaction ID. To change the default name for XBMVCLOS, first rename the load module in the XBM distribution library and then define the new name in your CSD. To change the default transaction ID for XVCL, define a new name in your CSD. No renaming is required. If you define nondefaults in your CSD, you must add the CLOSTRAN and CLOSPROG keywords to the JCL for the XBM utility program job. For more information, see “Valid XBM utility program keywords” on page 316.

**Figure 111: Sample XBMVCLOS load module definition**

```
DEFINE PROGRAM(XBMVCLOS) GROUP(XBMGROUP)
   LANGUAGE(ASSEMBLER)
```

**Figure 112: Sample XVCL transaction ID definition**

```
DEFINE TRANSACTION(XVCL) GROUP(XBMGROUP)
   PROGRAM(DFHMIRS)
   PROFILE(DFHCICSA)
```

In these two examples, the XBMVCLOS load module and the XVCL transaction ID are defined to the group XBMGROUP. You define a group name in your CSD by using this statement:

```
ADD GROUP (xbmgroup) LIST (listname)
```

---

**Creating JCL**

The XBM utility program supports the basic syntax of the IDCAMS REPRO command in addition to XBM-specific keywords that enable the Snapshot Copy.

The IDCAMS REPRO keywords have the same meanings and abbreviations when used with the XBM utility program.

You can use IDCAMS REPRO job streams by changing the PGM= specification to XBMXUTIL on the EXEC card and including a STEPLIB DD statement pointing to the XBM load library.
The XBM utility program supports cluster names for input. Output can be one of several forms and may be empty or nonempty files:

- sequential data set
- entry-sequenced data set (ESDS)
- key-sequenced data set (KSDS)
- relative record data set (RRDS)

**Note**
The XBM utility program does not support VSAM data sets defined with keyrange, imbed, or replicate parameters.

Use XBMIN DD, SYSIN DD, or both to supply control cards to the XBM utility program. Control cards in XBMIN DD are always processed first and are processed as SYSIN cards.

For example, assume that you have an existing IDCAMS REPRO job with a SYSIN DD that points to a set of control cards in a partitioned data set (PDS). To use snapshot utilities without changing the control cards, perform the following steps:

**To specify JCL**

1. Add XBMIN DD statement to the JCL.
2. Change PGM=IDCAMS to PGM=XBMXUTIL.
3. Include a SETXBM command with the XBMIN DD.

The SETXBM command is used to group XBM utility program commands for processing by XBM. When the SETXBM command is specified, at least one keyword must also be specified.

**Note**
SETXBM control cards cannot occupy the first-byte column of JCL you submit for the XBM utility program.
Figure 113 on page 315 shows an example of the JCL required to run a Snapshot Copy job with the XBM utility program. This example shows an existing IDCAMS REPRO job with the XBMIN DD statement added.

Figure 113: Sample JCL with modified REPRO job card

```plaintext
//XBMCOPY JOB (ACCT),'XBM SNAPSHO T COPY'
///************************************************************
//* (C)COPYRIGHT 1993-2013 BMC SOFTWARE INC.
//* AS AN UNPUBLISHED WORK.
//************************************************************
//* JCL TO RUN THE XBM UTILITY PROGRAM
//************************************************************
//XBMCOPY EXEC PGM=XBMXUTIL,REGION=4096K
//STEPLIB DD DISP=SHR,DSN=<high-level-qualifier>.LOAD
//************************************************************
//* UPDATE THE VSAM CLUSTER TO BE COPIED AND THE OUTPUT FILE
//* ALSO, PROVIDE OUTPUT FILE DCB ATTRIBUTES
//********
//INPUT DD DISP=SHR,DSN=BMCXBM.K5046.CIO2048 ***INPUT DSN***
//*
//OUTPUT DD DISP=(     ),DSN=BMCXBM.VSC46K7.VSC1,  ***OUTPUT DSN***
//     DCB=(      )  ***PROVIDE DCB INFO FOR OUTPUT DSN***
//*
//************************************************************
//****** XBMXUTIL COPY CONTROL CARDS
//XBMIN DD *,
//SETXBM XBMD(ID(XBM) CONCURRENT(REQUIRED)
//SYSIN DD *
//REPRO INFILE(INPUT) OUTFILE(OUTPUT)
//*
//SYSUDUMP DD SYSOUT=* SYSUT1=* SYSUT2=* SYSUT3=* SYSUT4=* SYSUT5=* SYSUT6=*
//******************
```

When you install XBM, the preceding sample JCL is automatically customized with your job card, STEPLIB library, and XBM subsystem ID.
Figure 114 on page 316 shows another way to run a snapshot utility job with JCL that uses the SYSIN DD statement for the SETXBXM control card.

**Figure 114: Sample JCL without XBMDD statement**

```
//XBMCOPY JOB (ACCT),'XBM SNAPSHOT COPY'
//******************************************************************
//* (C)COPYRIGHT 1993-2013 BMC SOFTWARE INC.
//* AS AN UNPUBLISHED WORK.
//******************************************************************
//* JCL TO RUN THE XBM UTILITY PROGRAM
//******************************************************************
//XBMCOPY EXEC PGM=XBMXUTIL,REGION=4096K
//STEPLIB DD DISP=SHR,DSN=<high-level-qualifier>.LOAD
//******************************************************************
//* UPDATE THE VSAM CLUSTER TO BE COPIED AND THE OUTPUT FILE
//* ALSO, PROVIDE OUTPUT FILE DCB ATTRIBUTES
//******************************************************************
//INPUT DD DISP=SHR,DSN=BMCXBM.KSD46.CI02048 ***INPUT DSN***
//OUTPUT DD DISP=(    ),DSN=BMCXBM.VSC46K7.VSC1, ***OUTPUT DSN***
//DCB=(     ) ***PROVIDE DCB INFO FOR OUTPUT DSN***
//******************************************************************
//****** XBMXUTIL COPY CONTROL CARDS
//SYSIN DD *
//SETXBXM XBID(XBM) CONCURRENT(REQUIRED)
REPRO INFILE(INPUT) OUTFILE(OUTPUT)
//******************************************************************
//SYSDUMP DD SYSOUT=*
//SYSTEM DD SYSOUT=*
//SYSPRINT DD SYSOUT=*
//******************************************************************
```

**Supported IDCAMS keywords**

The XBM utility program supports these IDCAMS REPRO keywords:

- **INFILE( dd) | INDATASET( dsn)**
- **OUTFILE( dd) | OUTDATASET( dsn)**
- **REUSE | NOREUSE**
- **SKIP() | FROMNUMBER()**
- **COUNT() | TONUMBER()**

**Valid XBM utility program keywords**

Figure 115 on page 317 shows the valid keywords for the XBM utility program.
Figure 115: Syntax diagram for XBM utility program keywords

Table 79 on page 317 defines each keyword as presented in the syntax diagram.

Table 79: Keywords for the SETXBM command

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBMID</td>
<td>the XBM subsystem to be used for subsequent snapshot utilities operation</td>
</tr>
<tr>
<td>CONCURRENT</td>
<td>whether a point-in-time copy of the data must be obtained (REQUIRED), is desired (PREFERRED), or is unnecessary (STANDARD)</td>
</tr>
<tr>
<td></td>
<td>- STANDARD (default value) means that no Snapshot Copy requirement exists. No XBM subsystem identification is required.</td>
</tr>
<tr>
<td></td>
<td>- REQUIRED terminates the job if the entire point-in-time copy cannot be completed.</td>
</tr>
<tr>
<td></td>
<td>- PREFERRED means the copy job will attempt to create a point-in-time copy, but will create a standard copy if the Snapshot Copy cannot</td>
</tr>
<tr>
<td></td>
<td>provide all of the original pages. The PREFERRED option does not terminate if the Snapshot Copy is not available, but it will return a</td>
</tr>
<tr>
<td></td>
<td>condition code 4 if the point-in-time copy could not be created.</td>
</tr>
<tr>
<td>CICSQUIESCE</td>
<td>(CICS VSAM snapshots only)</td>
</tr>
<tr>
<td></td>
<td>when set to YES, directs XBM to perform a quiesce for all data sets included in the job</td>
</tr>
<tr>
<td>Keyword</td>
<td>Meaning</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>APPLID</td>
<td>(CICS VSAM snapshots only) the IBM VTAM application ID of the CICS region that owns the data set you want to quiesce</td>
</tr>
<tr>
<td>RESTARTABLE</td>
<td>when set to YES, allows you to restart failed utility program snapshot jobs with the original quiesce point</td>
</tr>
<tr>
<td>RESTART</td>
<td>when set to YES, restarts a failed utility program snapshot job that is in restart pending mode</td>
</tr>
</tbody>
</table>
| RESYNC     | specifies whether the volume is resynchronized after the copy completes  
  - YES (default value) enables the resynchronization of the volume. If the resync value NO is specified on the snapshot template, that value overrides the value on this keyword.  
  - NO prevents the resynchronization of the volume. This value overrides the snapshot template if the value on the template is set to YES. |
| RMREGISTER | when set to YES, instructs the XBM utility program to register this backup with the BMC Software RECOVERY MANAGER for OS/390 product  
  RECOVERY MANAGER can automatically generate the JCL necessary to run the XBM utility program as a backup utility for RECOVERY MANAGER. For more information, see the RECOVERY MANAGER for OS/390 User Guide.  
  You can manually create the JCL necessary to run the XBM utility program as a backup utility for RECOVERY MANAGER. In addition to specifying RMREGISTER (YES), you must include DD statements required by RECOVERY MANAGER. For an example of these required DD statements, see Figure 117 on page 320. |
| CLOSTRAN   | (CICS VSAM snapshots only) the keyword that you use to define a nondefault transaction ID to the XBM utility program  
  Use this keyword only if you replaced the default transaction ID, XVCL, with a nondefault name when you defined the transaction in your CICS CSD.  
  XXXXX is the nondefault name you supply. |
| CLOSPROG   | (CICS VSAM snapshots only) the keyword that you use to define a nondefault load module name to the XBM utility program  
  Use this keyword only if you renamed the default load module, XBMVCLOS, with a nondefault name and then defined the renamed load module in your CICS CSD.  
  XXXXXXXXX is the nondefault name you supply. |
### Keyword | Meaning
--- | ---
DSSNAP | ■ STANDARD (default value) means that no Instant Snapshot Copy requirement exists. NO is an allowable syntax substitute.  
■ REQUIRED terminates the job if the Instant Snapshot cannot be completed. YES is an allowable syntax substitute.  
■ PREFERRED attempts an Instant Snapshot but falls back to STANDARD in case of failure. AUTO is an allowable syntax substitute.

GROUP | allows you to copy a group of VSAM data sets using a single quiesce point  
■ NO (default value) explicitly specifies the end of a group.  
■ YES specifies the start of a group. YES may also be used to implicitly specify the end of one group and the beginning of a second group.

For an example of GROUP keyword usage, see Figure 116 on page 319.

GROUPID | used to identify a specific group for BMC73739I messages  
For an example of how to use this mechanism, see Figure 116 on page 319. GROUPID is used with GROUP.

A sample of the JCL required to run a CICS VSAM Snapshot Copy job with the XBM utility program is shown in Figure 116 on page 319. CICSQUIESCE and three GROUPs are included in the example. To run the same job as a VSAM-only Snapshot Copy job, omit the CICSQUIESCE and APPLID keywords.

**Figure 116: Sample JCL for a CICS VSAM snapshot job**

```plaintext
//XBMCOPY JOB (ACCT), 'XBM SNAPSHOT COPY'  
//*******************************************************  
//* (C)COPYRIGHT 1993-2013 BMC SOFTWARE INC.  
//* AS AN UNPUBLISHED WORK.  
//*******************************************************  
//* JCL TO RUN THE XBM UTILITY PROGRAM  
//*******************************************************  
//XBMCOPY EXEC PGM=XBMXUTIL,REGION=4096K  
//STEPLIB DD DISP=SHR,DSN=<hilevel-qualifier>.LOAD  
//*******************************************************  
//* UPDATE THE VSAM CLUSTER TO BE COPIED AND THE OUTPUT FILE  
//* ALSO, PROVIDE OUTPUT FILE DCB ATTRIBUTES  
//********  
//*/  

//******** XBMXUTIL COPY CONTROL CARDS  
//XBMIN DD *  
SETXBM XBMID(XBM) CONCURRENT(REQUIRED)  
SETXBM CICSQUIESCE=YES)  
SETXBM APPLID(XBMTESTI)  
SETXBM RESTARTABLE=YES)  
//SYSIN DD *  
***BEGINNING OF GROUP 1***  
SETXBM GROUP (YES)  
```
Figure 117 on page 320 shows an example of the JCL required to use the XBM utility program as a backup utility for RECOVERY MANAGER. Note the four DD statements required by RECOVERY MANAGER when RMREGISTER is set to YES:

- **MRMMSG**—the RECOVERY MANAGER message file
- **MRMOPTS**—a pointer to the Recovery Asset Catalog (RASCAT)
- **MRMERROR**—SAS runtime errors
- **MRMPRINT**—output messages

**Figure 117: Sample JCL for a RECOVERY MANAGER CICS VSAM snapshot job**

```plaintext
//XBMCOPY JOB (ACCT) 'XBM SNAPSHOT COPY'
//*********************************************************************************
//* (C)COPYRIGHT 1993-2013 BMC SOFTWARE INC.                                      *
//* AS AN UNPUBLISHED WORK.                                                      *
//*********************************************************************************
//* JCL TO RUN THE XBMUTILITY PROGRAM WITH MRM                                   *
//*********************************************************************************
//MRMDD0001 EXEC PGM=XBMXUTIL,REGION=4096K
//STEPLIB DD DISP=SHR,DSN=<hilevel-qualifier>.LOAD
// DD DISP=SHR,DSN=<hilevel-qualifier>.SORTLIB
//****** CONTROL CARDS REQUIRED BY RECOVERY MANAGER
//MRMMSG DD DISP=SHR,DSN=<hilevel-qualifier>.CNTL(MRMMSG)
//MRMOPTS DD DISP=SHR,DSN=<hilevel-qualifier>.CNTL(MRMOPTS)
//MRMERROR DD SYSOUT*
//MRMPRINT DD SYSOUT*
//****** XBMXUTIL COPY CONTROL CARDS
//XBMIN DD *
SETXBM XBMID(XBM) CONCURRENT(REQUIRED)
SETXBM RMREGISTER(YES)
SETXBM CICSQUIESCE(YES)
SETXBM APPLID(XBMTEST1)
SETXBM RESTARTABLE(YES)
//SYSIN DD *
SETXBM GROUP (YES)
REPRO IDS(VSAM.DATASET1) ODS(VSAM.DATASET.BACKUP1)
REPRO IDS(VSAM.DATASET2) ODS(VSAM.DATASET.BACKUP2)
REPRO IDS(VSAM.DATASET3) ODS(VSAM.DATASET.BACKUP3)
//SYSDUMP DD SYSOUT=* 
//SYSTEM DD SYSOUT=* 
//SYSPRINT DD SYSOUT=* 
//*********************************************************************************
```
Figure 118 on page 321 shows an example of JCL required to use the XBM utility program for Instant Snapshots. Note the use of the output data set with DSSNAP specified as REQUIRED.

Figure 118: Sample JCL for a CICS VSAM Instant Snapshot job

```jcl
//XBMCOPY JOB (ACCT),'XBM SNAPSHOT COPY'
//******************************************************************************
//* (C)COPYRIGHT 1993-2013 BMC SOFTWARE INC.                                  *
//*     AS AN UNPUBLISHED WORK.                                              *
//*                        JCL TO RUN AN INSTANT SNAPSHOT                      *
******************************************************************************
//XBMCOPY EXEC PGM=XBMXUTIL
//STEPLIB DD DISP=SHR,DSN=HLQ.LOAD
//SYSTERM DD SYSOUT=*   //SYSPRINT DD SYSOUT=*   //****** XBMXUTIL CONTROL CARDS FOR INSTANT SNAPSHOT ***
//XBMIN DD *
SETXBM XBMID(XBM) CONCURRENT(REQUIRED)
SETXBM RESTARTABLE(YES)
SETXBM DSSNAP(REQUIRED)
REPRO IDS(INDATASET) ODS(OUTDATASET)
******************************************************************************
```

Establishing a quiesce

For CICS Snapshot Copy jobs, the XBM utility program establishes a quiesce automatically if the CICSQUIESCE (YES) keyword is specified on the control card for all data sets to be copied.

For VSAM Snapshot Copy jobs, you perform a manual quiesce by first closing the targeted files. When the files are closed, stop any batch updates to the files. The data sets are registered to XBM, and XBM subsequently issues a message (BMC73725I) that registration is complete. Updates to the files may then resume.

Running the job

When you submit the Snapshot Copy job, the XBM utility program reads control cards from the XBMIN and SYSIN DD and performs the commands serially. Command completion status is written to the SYSPRINT file.
Running restartable jobs

When you submit a job using the RESTARTABLE (YES) keyword, the utility program reads the control cards in the same manner as a regular job.

However, after the START is issued for the Snapshot Copy, registered data sets are set to RESTARTABLE (YES). If the job completes successfully, the registered data sets are returned to their normal state. If the job fails after the START is issued, the data sets enter a restart pending mode. For examples of JCL for RESTARTABLE jobs, see the two JCL samples for Snapshot Copy in “Valid XBM utility program keywords” on page 316.

To restart a job in restart pending mode, change the RESTARTABLE (YES) keyword in the control card to RESTART (YES) and resubmit the job. When the utility program reads the RESTART (YES) keyword in the control card, the snapshot restarts from the beginning of the job, retaining the original quiesce point. The preimages are flushed from cache when the job completes or is manually terminated.

Reviewing output

To ensure that the Snapshot Copy job ran successfully, check the return codes in the SYSPRINT data set when the job completes.

Some XBM error codes have an associated VSAM error code in the XBM job log. See your MVS documentation for information about VSAM error codes.

An error with a return code of 8 or 12 while processing SETXBM control cards causes the XBM utility program to terminate. A return code of 4 signifies that the job completed, but the copy taken may not be a Snapshot Copy.
Index

&SYSCLONE symbolic 48, 73
&SYSCLONE symbolic variable 56

A

ABOUT Fastpath command 279
ACTIVATE command 126, 127, 264, 279
ADD Fastpath command 279
Address field
  DASD volume status 214, 215
  EMC TimeFinder objects 227, 228
  Hitachi objects 237, 238
  PPRC objects 218, 220
ALL Fastpath command 279
allocating repository data sets 44
Allow dataset snap option 143, 288
Allow Instant Snapshots option 142, 288, 294
Allow remote mirror volume split option 290
Allow SSI-assisted snapshots option 143, 145, 161, 288, 292, 294
Allow virtual volume snap option 289
Allow virtual volume split option 143
Allow volume mirror split option 143
Allow volume split option 289
APPLID keyword 317
Automatic Class Selection (ACS) routines 138, 155
automatic quiesce 311

B

Backup and Recovery Solution (for IMS) 23
BCV devices field 227
BCV status field 215, 228
BCVs (business continuance volumes)
  EMC Symmetrix Automated Replication feature 137, 155
  establishing 230

BMC73167E message 58
BMC73566I message 75
BMC73739I message 311
BMXCXB.M.SNAPSHOT_TEMPLATE file 122, 142
Buffer fulls field 84

C

CA-ACF2 security 37
CA-Top Secret security 38
cache
  choosing sizes 112
  limit for snapshot template 145
  limiting size 62
  record layout for SMF reporting 295
  statistics 295
  structure 66
  system impact 112
Cache Information panel 284
Cache limit option 286, 291
Cache size option 284
Cache type option 287, 292
cache types
  advantages and disadvantages 114
  data space 112
  ESO hiperspace 112
  fixed virtual storage 112
  of a snapshot managed object 145
  pageable virtual storage 112
CCA - Primary field 220, 238
CCA - Secondary field 220, 238
CCA field 218, 237
CDELPAIR command 223, 242
CESTPAIR command 221, 240
CESTPAIR RESYNC command 223, 241
CFRM policy
adding structures 65, 67
cache structure 66
duplexing 67
list structure 66
REBUILD 67
updating 70
XBMGROUP 71
CHANGE Fastpath command 279
changes to the product 15
CHECK PLUS
  software snapshots 109
CHECK PLUS (for DB2) 21
CICS VSAM quiesce 311
CICSQUIESCE keyword 317
class, security 39
CLOSPOG keyword 317
CLOSTRAN keyword 317
COMPONENT Fastpath command 279
commands
  ACTIVATE 126, 127, 264
  Fastpath commands 279
  managing SSI options 272
  overview 261
  START 58, 270
  tracing 276
  ACTIVATE 126, 127, 264
  comment 264
  DEACTIVATE 265
  DISPLAY 265
  DISPLAY COMPONENT 60, 82
  DISPLAY XBM 54, 82
  PING 267
  RESETSTA 267
  ROUTE 58, 268
  SEND 269
  SET SIMULATE 270
  SETXBM 313
  START 58, 270
  STOP 58
  TERM SNAPSHOT 80, 130
  VIEWXBM 80
  XCFCLEANUP 271
command, STOP 270
comment command 53, 264
components
  authorization 24
  displaying status 60
  starting 58
  See also DB2, IMS, Parallel Sysplex Support (PSS), Storage Systems Integration (SSI), or VSAM component
components, XBM 24
compression
  determining candidate table spaces 116
  enabling 117
  of a snapshot managed object 145
Compression option 285, 287, 292
CONCURRENT keyword 317
CONFIG Fastpath command 279
CONFIG parameter 48
configurations 26, 110, 118
Connection name field 84
Console - Component subpanel 58, 60
Console - Configuration subpanel 125
Console - Management Set subpanel 127
Console - XBM subpanel 54, 82
Console Output subpanel 54
conventions, documentation 14
Copy field 220, 238
COPY PLUS
  hardware snapshots 133
  Instant Snapshots 152
  software snapshots 109
  Utility monitor 167
COPY PLUS, snapshot support 21
coupling facility
  displaying statistics 84
  monitor 279
  rebuild 67
  space usage 68
  structure types 66
coupling facility resource manager (CFRM) policy..
  See CFRM policy
creating utility syntax 129
CRECOVER command 224, 243
Critical field 220, 238
cross-system coupling facility (XCF) groups
  considerations 71
CSUSPEND command 223, 242
CU type field
  DASD volume status 215
  EMC TimeFinder objects 228
  Hitachi objects 238
  PPRC objects 220
CUSNam - Primary field 238
CUSNAm - Secondary field 238
CUSNum - Primary field 220
CUSNum - Secondary field 220
CUSNum field 218, 237
CUSSid field
  DASD volume status 214, 215
  EMC TimeFinder objects 228
  Hitachi objects 238
  PPRC objects 220
Cyls/Blks field
  DASD volume status 215
  EMC TimeFinder objects 228
  Hitachi objects 238
  PPRC objects 220

DD statements
  XBMREPnn 52
  XBMXINIT 52
  XBMXTASK 52
DEACT Fastpath command 279
DEACTIVATE command 265
DELETE Fastpath command 279
Deletes field 84
Destination subsystem subpanel 54
DETAIL Fastpath command 279
Device count field 210
Device discovery field 158
Device discovery option 142, 161, 288, 293
Device number field 228
Device type field
  DASD volume status 215
  EMC TimeFinder objects 228
  Hitachi objects 238
  PPRC objects 220
Directories field 84
Directories HWM field 84
Directory reads field 84
discovery process 142
DISPLAY command 265
DISPLAY COMPONENT command 60, 82
DISPLAY SETTINGs command 272
DISPLAY XBM command 54, 82
displaying status
  XBM component 60
  XBM subsystem 54
DNum field 227
documentation information 13
DSET Fastpath command 279
DSSNAP keyword 317
DTRACE Fastpath command 279
DType field
  DASD volume status 214
  EMC TimeFinder objects 228
  Hitachi objects 237
  PPRC objects 218
  SSI selection 210
Duplex devices field 217, 236

E
electronic documentation 13
EMC Symmetrix Control Facility (SCF) subsystem 137
EMC Symmetrix devices...
hardware snapshots 134
Instant Snapshot 22, 152
microcode levels 137
remote mirror volume split 142
volume mirrors 145
EMC TimeFinder device selection subpanel 230
EMC TimeFinder Device subpanel 228
EMC TimeFinder devices
device detail 228
object statistics 227
EMC TimeFinder Objects panel 227
End address field 210
Enforce shared repository option 71
enforcing a shared repository 77
Esoteric unit option 290
establishing
BCV pair 230
PPRC pair 221
quiesce 321
Hitachi devices 240
ETRACE Fastpath command 279
examples, resource security profile
CA-ACF2 37
CA-Top Secret 38
RACF 41
extended buffer
defining 118
cache types 112
limiting size 62
structure 110

F
Facility class, RACF security 39
Fastpath commands 279
FASTREPLICATION(PREFERRED) keyword 138, 155
FASTREPLICATION(REQUIRED) keyword 138, 155
Favor local or remote volume 291
First cyl pend field 220, 238
fixed virtual storage cache
snapshot processing 112
FlashCopy
hardware snapshots 22, 134
Instant Snapshots 22, 155
PROIGN DD statement 52
Functionality field 210, 214

G
GROUP keyword 317
GROUPID keyword 317

H
hardware devices
and volume allocation software 138
discovery 142, 161
managing 209
monitoring 209
See also EMC TimeFinder, IBM RAMAC Virtual Array (RVA), IBM Enterprise Storage Subsystem (Shark), PPRC, and StorageTek Shared Virtual Array (SVA) devices
hardware devices supported 22
hardware snapshots
SSI options 287
enabling 99
FlashCopy 22, 134, 138
redisplaying status 148
setting up hardware environment 136
snapshot template 145
software requirements 22
supported hardware 134
supported software 133
suspending and resuming mirrors 134
task overview 136
Help
online 13
HELP Fastpath command 279
HELPHELP Fastpath command 279
HELPNEW Fastpath command 279
HINDEX Fastpath command 279
hiperspace cache 112
Hitachi devices
additional software 141
deleting pair 242
device details 238
displaying objects 236
hardware snapshots 22, 134, 152
object statistics 236
HTC Remote Copy Objects panel 236
HTC RemoteCopy Device subpanel 238
IBM Enterprise Storage Subsystem (Shark) devices managing 134, 152
support 22
IBM RAMAC Virtual Array (RVA) devices hardware snapshots 22, 141
Instant Snapshots 152, 158
SIBBATCH program 158
IDCAMS command 311, 316
IMAGE COPY PLUS 21
Instant Snapshots 152
software snapshots 109
imbed parameter 313
IMS component
  architecture 24
  disabling 48
  functions of 24
  IMSOPTS command 279
  ROUTE command 58
  software snapshot utilities 21
  START command 58
  STOP command 58
IMSOPTS Fastpath command 279
INITSIZE parameter 70
installation 35
Instant Snapshots
  DSSNAP keyword 317
  example 151
  FlashCopy 22, 155
  hardware devices supported 152
  process 153
  reviewing status 160
  setting up hardware environment 154
  software requirements 22
  steps to perform 153
  supported software 152
  task overview 153
Internal volser field 215, 228
Inv tracks field 215, 228
ISPF interface
displaying generic DASD volumes 212
displaying remote XBM subsystems 80
managing Hitachi devices 235
managing TimeFinder devices 225
setting PSS options 79
specifying XBM options 63
starting the ISPF interface 54
starting XBM 47

J
Join sysplex group when PSS started option 48

K
KEYHELP Fastpath command 279
keyrange parameter 313
keywords
  APPLID 317
  CICSQUIESCE 317
  CLOSPROG 317
  CLOSTRAN 317
  CONCURRENT 317
  DSSNAP 317
  GROUP 317
  GROUPID 317
  REREGISTER 317
  RESTART 317
  RESTARTABLE 317
  RESYNC 317
  XBM utility program 317
  XBMID 317
L
L (level) field 218, 237
L (locate) Fastpath command 279
Last cyl pend field 220, 238
Last Paired field 215, 228
Level field 220, 238
libraries, XBM 56
limit excessive cache option 62
Locate Fastpath command 279
LS field 218
LSS - Primary field 220, 238
LSS - Secondary field 220, 238
MainView SRM 138, 155
Management class option 290
management sets
   activating for a hardware snapshot 148
   activating for a software snapshot 127
described 26
manufacturer field 218
MAXM Reorg/EP 21
   hardware snapshots 133
   Instant Snapshots 152
   software snapshots 109
MAXM Reorg/Online 21
   hardware snapshots 133
   Instant Snapshots 152
   software snapshots 109
MCACHE Fastpath command 279
MDSET Fastpath command 279
Mfg field 210, 214
microcode levels 137
Mirror field 215, 228
monitor
   diagnostic trace 29
   exception trace 29
   performance statistics 29
monitoring
   performance statistics 165
   suspend/resume groups 166
MS parameter 48
MSET Fastpath command 279

NEW Fastpath command 279
NONE Fastpath command 279

Object field in snapshot managed object definition 122
Object Type Selection subpanel 122, 145
Offline 3380 field 213
Offline 3390 field 213
Offline other field 213
Online 3380 field 213
Online 3390 field 213

online Help 13
Online other field 213
OPEN Fastpath command 279
options
   limit excessive cache 62
   SMF interval 62
   SMF record number 62
   SMF recording active 62
   SSI 142
   statistics interval period 62
   WTO route codes 62
   XBM 62
output
   DISPLAY XBM command 56

PAGEABLE VIRTUAL STORAGE CACHE
snapshot processing 112
paging
   of cached data 112
   of XBM address space control structures 112
Paired device field 215, 228
Parallel Sysplex Support (PSS) component
   Remote XBM message size limit option 77
   Remote XBM system time-out option 77
   Sysplex message time-out option 77
architecture 25
configuring 65, 67
defined 24
Destination subsystem subpanel 54
disabling 48
displaying status 80
functions of 24
initializing XBM subsystems 73
Join sysplex group option 77
options 77
overview 65
PING command 267
PSSOPTS command 279
REBUILD 67
ROUTE command 82, 268
START command 58
starting 58
STOP command 58
stopping 58
using with DB2 60
XBM subsystems 73
XBMGROUP name 48, 71, 77
parameters, restricted 313
PDev field 227
peer-to-peer remote copy (PPRC). See PPRC devices
Perform synchronize volume mirror at register 293
performance
  statistics 30
PING command 267
PPRC device subpanel 220
PPRC devices
  commands 221
displaying objects 217
  field 214
managing 216
object statistics 217
PPRC Establish Pair subpanel 221
PPRC objects panel 217
PPRC Recover subpanel 224, 243
preimage
  choosing cache types 112
  restartable snapshot utility jobs 130
  software snapshots 110
Primary devices field 217, 236
PRINT DTRACE command 276
PRINT ETRACE command 276
PRINT Fastpath command 279
PRINTSEL Fastpath command 279
Priority option 292
PROC command file 53
product changes 15
profiles
  naming convention 39
  security 39
PROIGN DD statement 52, 138, 155
PSS component. See Parallel Sysplex Support (PSS) component
PSS Options subpanel 79
PSSOPTS Fastpath command 279
publications, related 13

Q
quiesce 128, 321

R
RACF. See Resource Access Control Facility (RACF)
Read Failures field 84
Read Rate field 84
REBUILD 67
record layout
  cache statistics 295
  configuration change statistics 295
  configuration start statistics 295
  configuration stop statistics 295
  data set statistics 298
  DB2 statistics 298
  snapshot data set 298
  VSAM statistics 298
recover
  Hitachi device 243
  PPRC devices 224
RECOVER PLUS
  Instant Snapshots 152
RECOVER PLUS (for DB2) 21
Recovery Management (for DB2) 23
RECOVERY MANAGER for OS/390 317
RECOVERY PLUS
  Instant Snapshots 152
RECOVERY PLUS (for IMS) 21
RECOVERY UTILITY (for VSAM) 21, 152
reestablish
  EMC TimeFinder devices 231
  Hitachi devices 241
  PPRC devices 223
REGION parameter 52
region size 312
related publications 13
releasing BCVs 233
remote arrival snapshot synchronization 75
remote copy 236
Remote SSI Snapshot Options subpanel 142, 287
remote XBM subsystem
  displaying 80
  ROUTE command 82
  size limit option 77, 80
time-out option 80
REMOVE Fastpath command 279
Remove object field 283
removing pair 223
RENAME Fastpath command 279
REORG PLUS
  Instant Snapshots 152
  software snapshots 109
REORG PLUS (for DB2) 21
REORG PLUS Online (Snapshot) panel 167
replicate parameter 313
reporting, SMF
  cache statistics record layout 295
  data set statistics record layout 298
  DB2 statistics record layout 298
  snapshot data set statistics record layout 298
  snapshot statistics record layout 298
  VSAM statistics record layout 298
repository
  backup copy 44
  global records 46
  handling errors 47
  local records 46
  maintaining concurrency 45
  PSS component 45
  record types 45
REPRO keywords 316
requirements
  hardware snapshots 22
  Instant Snapshots 22
RESETSTA command 267
  Fastpath 279
Resource Access Control Facility (RACF)
  ICHRIN03 35
  RACF resource profiles 39
  RACF user ID 39
  user authorizations for XBM 36, 39
RESTART keyword 317
RESTARTABLE keyword 317
restartable snapshot jobs
  preimages 110
restore, EMC TimeFinder devices 232
Restrict caching field 283
restricted objects 313
RESYNC keyword 317
Resynchronize volume mirror after completion 293
RLS tolerance 312
RMREGISTER keyword 317
ROUTE command 58, 268

S
SAVE Fastpath command 279
SAVEAS Fastpath command 279
SAVETOMS command 279
SDFHEXCI CICS load module library 312
Secondary devices field 217, 236
  security
class 39
  profile 39
SEND command 269
SENDNEW Fastpath command 279
SET ABENDTRACE command 276
SET DATAMOVER command 272
SET ENQWAIT command 272
SET EXTALLOC command 272
SET MAXTASKS command 272
SET MAXVOLS command 272
SET NOTIFYWHENCOMPLETE command 272
SET OUTDYNAM command 272
SET PRINTTRACE command 276
SET SHUTDOWNTRACE command 276
SET SIMULATE command 270
SET VOLS command 272
Shared field 215, 228
shared repository 45, 77
Simplex devices field 217, 236
Size field 84
SMF reporting
  cache statistics record layout 295
  data set statistics record layout 298
  DB2 statistics record layout 298
  interval option 62
  record number option 62
  recording active option 62
  snapshot data set statistics record layout 298
  snapshot statistics record layout 298
  VSAM statistics record layout 298
SMS}. See System Managed Storage (SMS)
snapshot data set statistics 298
Snapshot Managed Object Information panel 291
Snapshot Managed Object Information subpanel 122, 145
snapshot template 122
  software snapshots 286
  attributes 26
  relationship with SSI options 135
snapshot template options
  hardware snapshots 291
Snapshot template options panel 291
Snapshot template options subpanel 122, 145
SNAPSHOT UPGRADE FEATURE 23
snapshot utilities statistics 298
snapshots
link 142
SRDF destinations field 227
SRDF field 227
SRDF source field 227
Sync field 227
Sync in progress field 227
Sync type field 215, 228
Synchronized field 227
syntax
ACTIVATE command 264
DEACTIVATE command 265
DISPLAY command 265
managing SSI options 272
PING command 267
RESETSTA command 267
ROUTE 268
SEND command 269
SET SIMULATE 270
START command 270
STOP command 270
tracing commands 276
XCFCLEANUP command 271
for utilities 129
syntax statement conventions 14
SYS parameter 48
SYSPRINT
   output of DISPLAY XBM 54, 60
System Authorization Facility (SAF) 37, 38
System Display and Search Facility (SDSF) 36
System Managed Storage (SMS) 155
System Management Facilities (SMF) records 165
system-managed duplexing 67
system-managed rebuild 67

T
TERM SNAPSHOT command 80, 130
Timeouts field 84
Total offline field 213
Total online field 213
Total Reads field 84
Total Writes field 84
translation to uppercase 62
Type field 84, 227

U
UNLOAD PLUS
   software snapshots 109
UNLOAD PLUS (for DB2) 21
uppercase translation 62
Used pct field 84
user exits
   security 42
utility job
   running for hardware snapshots 148
   running for Instant Snapshot 160
   running for software snapshots 129
utility program
   JCL 313, 317
UTILMON Fastpath command 279
UTLOGAP Fastpath command 279
UTSNAP Fastpath command 279
UTTASKS Fastpath command 279

V
VIEWACTV Fastpath command 279
VIEWADDR Fastpath command 279
VIEWAR Fastpath command 279
VIEWARP Fastpath command 279
VIEWCBLK Fastpath command 279
VIEWCCA Fastpath command 279
VIEWCMPL Fastpath command 279
VIEWCOMM Fastpath command 279
VIEWCSID Fastpath command 279
VIEWCUSN Fastpath command 279
VIEWDB Fastpath command 279
VIEWDB2 Fastpath command 279
VIEWDR Fastpath command 279
VIEWDTYP Fastpath command 279
VIEWFRC Fastpath command 279
VIEWHITP Fastpath command 279
VIEWID Fastpath command 279
VIEWJOB Fastpath command 279
VIEWLAST Fastpath command 279
VIEWLSS Fastpath command 279
VIEWMDAT Fastpath command 279
VIEWMFG Fastpath command 279
VIEWNAME Fastpath command 279
VIEWPSET Fastpath command 279
VIEWPSID Fastpath command 279
VIEWRRAT Fastpath command 279
VIEWSEL Fastpath command 279
VIEWSEL1 Fastpath command 279
VIEWSEL2 Fastpath command 279
VIEWSEL3 Fastpath command 279
VIEWSEL4 Fastpath command 279
VIEWSP Fastpath command 279
VIEWSR Fastpath command 279
VIEWSRCI Fastpath command 279
VIEWSRDF Fastpath command 279
VIEWSSID Fastpath command 279
VIEWSTAT Fastpath command 279
VIEWTYPE Fastpath command 279
VIEWSYNC Fastpath command 279
VIEWTYPE Fastpath command 279
VIEWUTIL Fastpath command 279
VIEWVOLS Fastpath command 279
VIEWVOLU Fastpath command 279
VIEWXBM Fastpath command 279
Virtual volume SnapPool option 289
Volser field
  DASD volume status 214, 215
  EMC TimeFinder objects 227, 228
  HTC objects 237, 238
  PPRC objects 218, 220
  SSI selection criteria 210
Volume count option 290
Voluse field
  DASD volume status 214, 215
  EMC TimeFinder objects 228
  HTC objects 238
  PPRC device 220
  SSI selection criteria 210
VSAM component 279
  architecture 24
  disabling 48
  functions of 24
  ROUTE command 58
  software snapshot utilities 21
  START command 58
  statistics record layout 298
  STOP command 58
  stopping 58
VSAM Options panel 283
VSAMOPTS command 279
VSAMOPTS Fastpath command 279

W
wildcards 129
Write Failures field 84
Write Rate field 84
WTO Route Codes option 62

X
XBM
  Fastpath commands 279
    options 62
    upgrading 44
  XBM cataloged procedure 47, 53
  XBM initialization command file 53
  XBM Options subpanel 63
  XBM PROC 56
  XBM repository. See repository
  XBM security
    CA-Top Secret 38
    profile 39
  XBM Subsystem Selection subpanel 80
  XBM subsystems
    DISPLAY XBM command 54
    multiple 36, 56
    started task 47
  XBM utility program
    JCL 313, 317
  XBMGROUP parameter
    defined 48
    overridden by start command 58
    parameter in PROC 48
    ROUTE command 58
    scenarios 71
    software snapshot 129
    Sysplex group name 77
    XCF group name 71
  XBMID parameter 48, 317
  XBMIN DD statement 313
  XBMMON Fastpath command 279
  XBMMONCF Fastpath command 279
  XBMMOND Fastpath command 279
  XBMOPTS Fastpath command 279
  XBMREPnn DD statement 44, 52
  XBMESSID subsystem name 48
  XBMXAEX1, XBM security user exit 43
  XBMXAEX2, XBM security user exit 43
  XBXMINIT DD statement 52, 53
  XBMXTASK DD statement 52, 141
  XCF group
    default value 77
    start command 58
    XBMGROUP name 70
  XCFCLEANUP command 271

Index 333
XDB2 parameter 48
Xfer Reads field 84
Xfer Writes field 84
XIMS parameter 48
XPSS parameter 48
XSSI parameter 48
XVSAM parameter 48

Z

ZIIP processing

component 23–25, 265
authorizing 24
component 23–25, 265
DISPLAY command 265
set up 34
START COMPONENT command 58, 270
STOP COMPONENT command 58, 270
ZIIPSTATISTICS keyword 265
ZIIPSTATS keyword 265
ZOOM Fastpath command 279